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E8 Revision history

Edition notice

Where to find information

Roche Diagnostics

This publication is intended for users of the
Digital LightCycler® System.

Every effort has been made to ensure that all the
information contained in this publication is correct at the
time of publishing. However, the manufacturer of this
product may need to update the publication information
as output of product surveillance activities, leading to a
new version of this publication.

The User Assistance contains all information about the
product, including the following:

= Routine operation

= Maintenance

= Safety

= Troubleshooting information
= Software reference

= Configuration information

= Background information

The Safety Guide contains important safety information.
You must read the Safety Guide before operating the
instruments.

The User Guide focuses on routine operation and
maintenance. The content is organized according to the
normal operation workflow.

Privacy notice

When you use User Assistance online, viewing events
(topics viewed and searches performed) and IP
addresses are logged.

The data collected is for Roche internal use only and is
never forwarded to third parties. It is anonymized, and
after one year it is automatically deleted.

Viewing events are analyzed to improve User Assistance
content and search functionality. IP addresses are used
to classify regional behavior.
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Copyright
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& General attention

To avoid serious or fatal injury, ensure that you are
familiar with the system and safety information before
you use the system.

» Pay particular attention to all safety precautions.
» Always follow the instructions in this publication.

» Do not use the instruments in a way that is not
described in this publication.

» Store all publications in a safe and easily accessible
place.

& Incident reporting

» Inform your Roche representative and your local
competent authority about any serious incidents
which may occur when using this product.

Do not carry out operation tasks or maintenance actions
unless you have received training from Roche
Diagnostics. Leave tasks that are not described in the
user documentation to trained Roche Service
representatives.

The images in this publication have been added
exclusively for illustration purposes. Configurable and
variable data in screenshots, such as tests, results, or
path names visible therein must not be used for
laboratory purposes.

Any customer modification to the system renders the
warranty or service agreement null and void.

For conditions of warranty, contact your local sales
representative or refer to your warranty contract partner.

Always leave software updates to a Roche Service
representative, or perform such updates with their
assistance.

© 2022, F. Hoffmann-La Roche Ltd. All rights reserved.

Digital LightCycler® System software is protected by
contract law, copyright law, and international treaties.
Digital LightCycler® System contains a user license
between F. Hoffmann-La Roche Ltd. and a license
holder, and only authorized users may access the
software and use it. Unauthorized use and distribution
may result in civil and criminal penalties.
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Open-source and commercial software Digital LightCycler® System may include components or
modules of commercial or open-source software. For
further information on the intellectual property and other
warnings, as well as licenses pertaining to the software
programs included in Digital LightCycler® System, refer
to the electronic distribution included with this product.

This open-source and commercial software and

Digital LightCycler® System as a whole can constitute a
device regulated in accordance with applicable law. For
more detailed information, refer to the corresponding
user documentation and labeling.

Note that the respective authorization is no longer valid
according to the corresponding legislation should any

unauthorized changes be made to Digital LightCycler®
System.

Trademarks The following trademarks are acknowledged:
LIGHTCYCLER is a trademark of Roche.

All other trademarks are the property of their respective
owners.

Feedback Every effort has been made to ensure that this
publication fulfills the intended use. All feedback on any
aspect of this publication is welcome and is considered
during updates. Contact your Roche representative,
should you have any such feedback.

Approvals The Digital LightCycler® System meets the requirements
laid down in:

Regulation (EU) 2017/746 of the European Parliament
and of the Council of 5 April 2017 on in vitro diagnostic
medical devices and repealing Directive 98/79/EC and
Commission Decision 2010/227/EU.

Directive 2011/65/EU of the European Parliament and of
the Council of 8 June 2011 on the restriction of the use
of certain hazardous substances in electrical and
electronic equipment.

Directive 2014/53/EU of the European Parliament and of
the Council of 16 April 2014 on the harmonization of the
laws of the Member States relating to the making
available on the market of radio equipment and repealing
Directive 1999/5/EC.

Roche Diagnostics
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Contact adresses

Roche Diagnostics

IVD

To view the full text of the 2014/53/EU declaration of
conformity, go to the Roche Dialog global website
(dialogportal.roche.com) and choose the eLabDoc link.
If you are unable to access Roche Dialog, contact a
Roche Service representative.

Compliance with the applicable directives is provided by
means of the declaration of conformity.

This equipment has been tested and found to comply
with the limits for a Class A digital device, pursuant to
Part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful
interference when the equipment is operated in a
commercial environment. This equipment generates,
uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instruction
manual, may cause harmful interference to radio
communications. Operation of this equipmentin a
residential area is likely to cause harmful interference in
which case the user will be required to correct the
interference at his own expense.

Changes or modifications not expressly approved by the
party responsible for compliance could void the user's
authority to operate the equipment.

FCC ID for Digital LightCycler® Partitioning Engine:
2A6AL-RWR2.

The following marks demonstrate compliance:

For in vitro diagnostic use.

Complies with the provisions of the applicable EU
regulations.

Issued by Nemko for Canada and the US.

'Laboratory Equipment' is the product identifier as
shown on the name plate.

Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1




Roche Diagnostics

Roche affiliates

eLabDoc

Roche Molecular Systems, Inc.
1080 US Highway 202 South
Branchburg, NJ 08876

USA

Made in Switzerland

Roche Diagnostics GmbH
Sandhofer Strasse 116
68305 Mannheim
Germany

Distributed in the United States by:
Roche Diagnostics

9115 Hague Road

Indianapolis, IN 46256

USA

A list of all Roche affiliates can be found at:

www.roche.com/about/business/roche_worldwide.htm

Electronic user documentation can be downloaded using
the eLabDoc e-service on Roche Dialog:

dialogportal.roche.com

For more information, contact your local affiliate or
Roche Service representative.
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Intended use

Symbols and abbreviations

Product names

The Digital LightCycler® System supports a semi-
automated workflow to run Polymerase Chain Reaction
(PCR) based Nucleic Acid Testing (NAT). The system
performs digital endpoint PCR analysis of microfluidic
partitions, combining the functionalities of
instrumentation, consumables, reagents, and data
management to provide an efficient workflow from
sample partitioning to result interpretation.

The Digital LightCycler® System is a semi-automated
system for detection and absolute quantification of
nucleic acid target copy number, intended for in vitro
diagnostic use by professional users in diagnostic and
screening laboratories.

The system is comprised of the Digital LightCycler®
Analyzer, the Digital LightCycler® Partitioning Engine,
and specified consumables, core reagents and
application software. All assays are developed
independently of the Digital LightCycler® System.

Except where the context clearly indicates otherwise, the
following product names and descriptors are used.

Product name Descriptor

Digital LightCycler® System

system

Digital LightCycler® Partitioning Engine

partitioning engine

Digital LightCycler® Analyzer

analyzer

Digital LightCycler® Analyzer Software

analyzer software

Digital LightCycler® Web Application

web application

Digital LightCycler® Development Software

development software

Digital LightCycler® Universal Nanowell Plate

universal nanowell plate

Digital LightCycler® High Resolution Nanowell Plate

high resolution nanowell plate

Digital LightCycler® High Sensitivity Nanowell Plate

high sensitivity nanowell plate

Digital LightCycler® Partitioning Fluid

partitioning fluid

Digital LightCycler® Waste Bottle

liquid waste bottle

Digital LightCycler® 5x DNA Master

DNA master reagent

Digital LightCycler® 5x RNA Master

RNA master reagent

FR  Product names

Roche Diagnostics
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List item

°

'EI Cross-reference to another topic

Figure, used in figure titles and cross-
references to figures

mm Table, used in table titles and cross-
references to tables

\/x_ Equation, used in cross-references to

y equations

@{g} Code example, used in code titles and cross-
references to codes

o) Tip, used for extra information on correct use
or for useful hints

@ Extra information within a task

= Result of an action within a task

El Frequency of a task

ﬂl Duration of a task

El Materials that are required for a task

Prerequisites of a task

B

EB Symbols used in the publication

Quantity contained in the package

G‘"N Global Trade Item Number

Manufacturer

Date of manufacture

Authorized representative in the European
Community

Indicates the entity importing the medical
device into the European Union.

@i LEE

g Symbols used on product

Roche Diagnostics
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Symbol Explanation

D Distributed by

SN Serial number

HEF Catalog number

uDIi Unique device identifier

LUT Lot number

Caution

Protective earth

Consult operating instructions

Temperature limits

Humidity limits

Keep upright

Fragile handle with care

a2 @ e B P>

Keep dry

)

#B Symbols used on product

Roche Diagnostics
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Symbol Explanation

W

Do not stack

Z

3/
s

Keep away from sunlight

¢

Used to indicate that the equipment is
suitable for alternating current only; to identify
relevant terminals

Expiry date

Ry Only

To indicate that the device requires a
prescription to use

B8 Symbols used on product

Abbreviations The following abbreviations are used.

Abbreviation

Definition

pL Microliter

Abs Quant Absolute quantification

AbsQuant

AC Alternating current

ANSI American National Standards Institute

ASTM American Society for Testing and Materials

CFR Code of Federal Regulations

Cl Confidence interval

CISPR Comité International Spécial des
Perturbations Radioélectriques
(International Special Committee on Radio
Interference)

CNV Copy number variation

cp Copies

DC Direct current

EC European Community

EDI External device interface

EMC Electromagnetic compatibility

ft Foot

GB Gigabyte

GUID Globally unique identifier

HL7 Health Level Seven

IEC International Electrical Commission

#= Abbreviations

Roche Diagnostics
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Abbreviation Definition

in. Inch

indel Insertion-deletion

Indel

InDel

P Internet Protocol

ISO International Organization for
Standardization

IVD In vitro diagnostic

IVDR In vitro diagnostics regulation

LAN Local area network

Ibs Pound

LDT Laboratory-developed test

LIS Laboratory information system

MLLP Minimal Lower Layer Protocol

n/a Not applicable

N/A Not available

NAT Network Address Translation

PCR Polymerase chain reaction

RAM Random access memory

RF Radio frequency

RFID Radio frequency identification

RT Reverse transcription

SD Standard deviation

TOI Target of interest

UNG Uracil DNA glycosylase

UPS Uninterruptible power supply

WLAN Wireless LAN

gR  Abbreviations

What is new in US-specific publication version 1.1

Approvals US-specific compliance information was added.

*& Approvals (4)

Roche Diagnostics
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General safety information

Introduction

.& General attention

To avoid serious or fatal injury, read this publication
thoroughly before you use the system.

» Pay particular attention to all safety precautions.
» Always follow the instructions in this publication.

» Do not use the system in a way that is not described
in this publication.

» Keep this publication in a safe place to ensure that it
is not damaged and remains available for use.

» This publication must always be easily accessible.
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Safety classifications

Safety classifications

The safety precautions and important user notes are
classified according to the applicable standards.
Familiarize yourself with the following meanings and
icons:

A Safety alert

» The safety alert symbol is used to alert you to
potential physical injury hazards. Obey all safety
messages that follow this symbol to avoid possible
damage to the system, injury, or death.

These symbols and signal words are used for specific
hazards:

Warning...

» ...indicates a hazardous situation that, if not avoided,
could result in death or serious injury.

/5 CAUTION!

Caution...

» ...indicates a hazardous situation that, if not avoided,
could result in minor or moderate injury.

NOTICE!

Notice...

» ..indicates a hazardous situation which, if not
avoided, may result in damage to the system.

Important information that is not safety relevant is
indicated with the following icon:

-‘Q’- Tip...
..indicates additional information on correct use
or useful tips.
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General safety information

Safety precautions

In this section

Installation and transport (21)

Safe and proper use of the system (21)
Operating conditions (22)
Electromagnetic compatibility (23)

Installation and transport

Errors in installation Error during installation of a new system or new parts
can cause malfunctions.

» Leave installation activities to Roche Service
representatives.

Damage during transport Damage during transport can cause malfunctions.

» Do not attempt to relocate or transport the system.
Leave relocation and transportation to Roche Service
representatives.

Safe and proper use of the system

Missing personal protective equipment Working without personal protective equipment means
danger to life or health.

» Wear appropriate personal protective equipment,
including, but not limited to, the following items:

= Eye protection
= Lab coat
= Lab gloves

» Follow laboratory best practices and regularly change
lab gloves to minimize the risk of infection and
contamination, especially after contact with waste or
sample material.

Exchange or removal of parts Unauthorized exchange or removal of system parts can
damage the system or stop it from functioning correctly.

» Do not exchange or remove any part of the
instruments. Leave replacement of all instrument
parts to Roche Service representatives.

Non-specified consumables Use of non-specified consumables can lead to incorrect
results or damage the system.

» Only use consumables approved for the system.

Roche Diagnostics
Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1 Draft - Do Not Distribute

c
)
-
«c
=
p &
=)
(il
=
>
d
(5]
(=t
(4+]
)]
©
} S
o
c
[<b)
&)
F




Safety precautions

»@ List of available consumables and reagents (186)

Operating conditions

Unsuitable operating conditions Operation outside of the specified ranges may lead to
incorrect processing or malfunction of the system.

» Consult the specifications.

» Use the system indoors only. Avoid proximity to heat
sources and high radiation, and avoid humidity
outside of the specified range.

» Ensure that the system’s ventilation openings always
remain unobstructed.

» In case of an emergency, use the power inlets of the
partitioning engine and the analyzer as the points
where to quickly disconnect the instruments from the
mains outlets. Ensure that the power inlets are always
easily accessible.

»& Overview of the partitioning engine (71)
»& Overview of the analyzer (74)

»& Environmental conditions for the system (183)

Power interruption A power failure or momentary drop in voltage may
damage the system or lead to data loss.

» Operate with an uninterruptible power supply (UPS).
The specification of the UPS must comply with the
power requirements for the instruments. If the UPS
can barely supply the required power, the instruments
may automatically shut down. Do not connect other
devices to the UPS.

v

Ensure periodic maintenance of the UPS.

v

Perform regular backups of results.

v

To shut down the instruments, follow the shutdown
procedures in this publication. Only if immediate
shutdown is required, use the power switch of the
partitioning engine or the power button of the
analyzer. If you use the power switch or power button,
all processes are aborted. The data (e.g., partitioning
data or results) for all currently processed samples
may be lost.

*& Electric power supply (182)
»@ Shutting down the partitioning engine (437)
*@ Shutting down the analyzer (440)
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General safety information

Electromagnetic compatibility

The system complies with the emission and immunity
requirements described in the parts IEC 61326-2-6 and
IEC 61326-1.

The system complies with the emission requirements
described in FCC CFR 47, Part 15 Class A.

The system has been designed and tested to CISPR 11
Class A.

In a domestic environment, the system may cause
electromagnetic interference, in which case you must
take measures to mitigate the interference.

Non-approved accessories, transducers, and Use of non-approved accessories, transducers, and
cables cables can result in increased electromagnetic
emissions and decreased electromagnetic immunity of
the system. It can also result in improper operation.

» Only use accessories, transducers, and cables
specified or provided by the manufacturer of this
system. For more information, contact your Roche
Service representative.

» Only use cable length which complies with EMC
testing:

= USB20:<3m

= LAN/Ethernet: < 30 m (longer cable might reduce
speed performance)

= AC power input: < 30 m (longer cable can reduce
the voltage of the system)
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Safety precautions

Electromagnetic fields Strong electromagnetic fields can result in degradation
of the system performance.

» Evaluate the electromagnetic environment before
operating the system.

» Do not use portable radio frequency (RF)
communications equipment (including peripherals
such as antenna cables and external antennas) closer
than 30 cm to any part of the system, including cables
specified by the manufacturer.

v

Do not operate this system close to sources of strong
electromagnetic fields (for example, unshielded
intentional RF sources), as they may interfere with
proper operation. The distance of 30 cm for portable
RF devices (mobile phones, Wi-Fi) is considered as
normal electromagnetic fields for the system.

v

Do not use the system in proximity (< 30 cm) to
sources of strong electromagnetic radiation (for
example, microwave ovens, hand-held radio
transmitters, electric motors, RFID emitters), as they
can interfere with proper operation.

v

If it is suspected that electromagnetic interference
affects the performance, correct operation may be
restored by increasing the distance between the
equipment and the source of the interference.
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General safety information

Warning messages

Electrical safety

Electric shock Removing the covers of electronic equipment can cause
electric shock.

» Do not remove any cover of the system except those
covers specified in the instructions.

» Do not exchange or remove any part of the
instruments. Leave replacement or repair of all
instrument parts to Roche Service representatives.

Fire and burns Alcohol is a flammable substance.

» Keep all sources of ignition (such as sparks, flames,
or heat) away from the system when you perform
maintenance that involves alcohol.

» When you use alcohol on or around the system, use
no more than 20 mL at a time.
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Caution messages

Caution messages

In this section

Personal injury (26)
Incorrect, invalid, or delayed results (27)

Waste handling (33)

Personal injury

Sharps, rough edges, and/or moving parts Personal injury and infection due to sharps, rough
edges, and/or moving parts.

» Laboratory best practices can reduce the risk of
injury.

Be aware of your laboratory environment, well-
prepared, and follow this publication. Some areas of

the partitioning engine and the analyzer may have
sharps, rough edges, and/or moving parts.

v

» Wear personal protective equipment to minimize the
risk of injury from bodily contact with such parts,
especially in less accessible areas, or while cleaning
the partitioning engine or the analyzer.

v

Your personal protective equipment should be
appropriate to the degree and type of potential
hazard, e.g., suitable lab gloves, eye protection, lab
coat, and footwear.

Skin inflammation or injury Direct contact with master reagents or other working
solutions may cause skin irritation, inflammation, or
burns.

» When you handle master reagents, exercise the
precautions required for handling laboratory reagents.

» Wear appropriate personal protective equipment.

» Observe the instructions given in the Instructions for
Use.

» Observe the information given in the Safety Data
Sheets (available for Roche Diagnostics reagents and
cleaning solutions).

» If master reagents or cleaning solutions come into
contact with your skin, wash the affected area
immediately with soap and water and apply a
disinfectant.

Consult a physician.

Roche Diagnostics
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Moving drawers

Sharp aspiration needle

General safety information

The nanowell plate drawer of the partitioning engine
and the nanowell plate stack drawer of the analyzer
open and close during operation. An opening drawer
may strike you. A closing drawer may pinch your fingers.

» Keep away from the nanowell plate drawer of the
partitioning engine and the nanowell plate stack
drawer of the analyzer during operation.

» Do not try to close the nanowell plate drawer of the
partitioning engine or the nanowell plate stack
drawer of the analyzer manually by pushing against it.

» Leave sufficient free space around the partitioning
engine and the analyzer to allow for unobstructed
movement of the nanowell plate drawer and the
nanowell plate stack drawer.

The aspiration needle in the partitioning engine is sharp.
Contact with the aspiration needle may result in
personal injury.

» Carefully follow the instructions in this publication for
replacing the bottles on the partitioning engine and
for decontaminating the aspiration needle.

» When replacing the bottles on the partitioning engine
or when decontaminating the aspiration needle, pay
extra attention to the aspiration needle.

*@ Replacing the partitioning fluid bottle and/or the
liquid waste bottle on the partitioning engine (460)

»& Decontaminating the aspiration needle of the
partitioning engine (479)

Incorrect, invalid, or delayed results

Use of incorrect nanowell plate type

Roche Diagnostics

The nanowell plate types are indistinguishable by their
overall appearance. Using the wrong type of nanowell
plates may cause incorrect, invalid, or delayed results.

» To identify the nanowell plate type, refer to the color-
coded label of the nanowell plate.

» White label = Universal nanowell plate
» Violet label = High resolution nanowell plate

» Light-blue label = High sensitivity nanowell plate
»& Nanowell plates (159)

Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1 Draft - Do Not Distribute
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Caution messages

Improper handling of nanowell plates Scratches, finger prints, dust, or other artifacts on the
nanowell plate lanes compromise the image integrity,
which may cause incorrect, invalid, or delayed results.

» Open the packing of the nanowell plates only
immediately before use.

» Do not leave the nanowell plates in the open for any
length of time.

» Do not touch the nanowell plate lanes.

» Handle the nanowell plates by the long sides of the
nanowell plate frames only.

» Wear lab gloves when handling the nanowell plates.
Regularly change lab gloves.

Untested computer configuration Accessing the web application from a computer with an
untested configuration may compromise the
performance of the web application, which may cause
invalid or delayed results.

» Observe the specifications for the computer used to
access the web application.

*@ Specifications for the web application (187)

Pipetting errors Pipetting errors, e.g., confusing the positions of the
reaction mixtures on a nanowell plate, may cause
incorrect results.

» Carefully enter the sample IDs and nanowell plate IDs
when creating a sample setup in the web application.

» Use the sample setup report from the web application
as a guide for pipetting and for verification of the
sample setup in the analyzer software.

» If a pipetting error may have occurred, invalidate the
affected nanowell plate lane in the web application
before starting the run on the analyzer.

*@ Invalidating nanowell plate lanes and/or nanowell
plates in the web application (535)

Incorrect nanowell plate ID If the analyzer cannot read a nanowell plate ID
automatically, you must enter the nanowell plate ID
manually. Entering an incorrect nanowell plate ID may
cause incorrect, invalid, or delayed results.

» When you must enter a nanowell plate ID manually,
ensure that you scan or enter the correct nanowell
plate ID.

*& Resolving a nanowell plate ID reading error (521)
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Contamination of the partitioning engine

Unpartitioned nanowell plate lanes

Roche Diagnostics

Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1 Draft - Do Not Distribute

General safety information

The partitioning fluid bottles and the liquid waste bottles
are indistinguishable by their overall appearance.
Loading a liquid waste bottle in the position of the
partitioning fluid bottle may contaminate the partitioning
engine, which may cause incorrect, invalid, or delayed
results.

» Store partitioning fluid bottles and liquid waste bottles
in a way to allow for proper distinction.

» Mark all waste bottles with a permanent marker as
waste bottles. Mark empty or expired partitioning
fluid bottles as waste bottles immediately after
unloading them from the partitioning engine.

» Dispose of liquid waste bottles according to local
regulations directly after unloading them from the
partitioning engine.

» If you inadvertently loaded a liquid waste bottle in the
position of the partitioning fluid bottle, immediately
unload it again.

» Before loading a partitioning fluid bottle and using
the partitioning engine again after incorrect loading,
decontaminate the aspiration needle.

» If you inadvertently loaded a partitioning fluid bottle
after incorrect loading without decontaminating the
aspiration needle, do not use the partitioning engine.
Immediately unload the partitioning fluid bottle again
and dispose of it according to local regulations.

» Decontaminate the aspiration needle following the
decontamination procedure.

*& Decontaminating the aspiration needle of the
partitioning engine (479)

Even if a nanowell plate lane contains a reaction
mixture, the nanowell plate lane may remain
unpartitioned on the partitioning engine. Processing
nanowell plates with unpartitioned nanowell plate lanes
that contain reaction mixtures on the analyzer may
contaminate the analyzer, which may cause incorrect
results.

» Before unloading a partitioned nanowell plate from
the partitioning engine, always check the partitioning
status of the nanowell plate lanes by means of the
color of the partitioning indicators.

» If a partitioning indicator of a nanowell plate lane that
contains a reaction mixture remains gray, discard the
nanowell plate according to local regulations.

» Do not load nanowell plates with unpartitioned
nanowell plate lanes that contain reaction mixtures
on the analyzer.

*él About the Plate Setup panel (85)
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Caution messages

Leakage of sample material from nanowell
plates

Delayed processing of partitioned nanowell
plates

Incorrect run type

Missing measurements
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Pipetted and partitioned nanowell plates do not have a
physical barrier against leakage of the reaction mixtures
from the nanowell plates. Leakage of the reaction
mixtures from the nanowell plates may contaminate the
laboratory, which may cause incorrect, invalid, or
delayed results.

» After unloading the nanowell plates from the
analyzer, immediately place them in a resealable
plastic bag that you keep sealed.

» Dispose of the plastic bag that contains the nanowell
plates according to local regulations.

Delayed processing of partitioned nanowell plates on
the analyzer may cause degradation of biological
material and/or invalidation of the nanowell plates,
which may cause incorrect, invalid, or delayed results.

» Only pipette and partition nanowell plates if you can
directly run them on the analyzer afterwards.

» Ensure that you start the run directly after loading the
analyzer.

» For diagnostic runs, observe that there may be a time
limit configured in the analysis packages between
partitioning and processing of a nanowell plate. If the
time limit is exceeded, the nanowell plate is
invalidated and cannot be processed anymore.

Starting a development run on nanowell plates that are
designated for a diagnostic run, may cause invalid or
delayed results.

» As an administrator, assign the appropriate user roles
to the user accounts.

»& User management (545)

Missing measurements (e.g., because of incomplete
loading of the analyzer or invalidated nanowell plate
lanes) that are needed for result calculation may cause
invalid or delayed results.

» Ensure that you load all nanowell plates of a sample
setup on the analyzer (except invalid nanowell plates)
to enable result calculation.

» Take extra care to avoid wrongly invalidating a
nanowell plate lane that is required for result
calculation.

v

If you must invalidate a nanowell plate lane or if the
sample setup contains invalid nanowell plates that
cannot be processed on the analyzer, consider the
implications for result calculation (e.g., missing
measurements from nanowell plate lanes that contain
controls, are part of merged lanes, or contain reaction
mixtures for a different test).
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General safety information

Invalidated controls If you invalidate a nanowell plate lane that contains a
control, the system automatically invalidates all final
results of the sample setup for the affected targets,
which may cause delayed results.

» Take extra care to avoid wrongly invalidating a
nanowell plate lane that contains a control.

» If you must invalidate a nanowell plate lane that
contains a control, consider the implications for the
final results of the sample setup.

Not supported characters in sample IDs The system uses CP-1252 (code page 1252) to encode
and decode ASTM messages.

If you connect the system to an LIS via the ASTM
protocol, characters outside of code page 1252 (e.g.,
Unicode characters) are not supported in the
transmissions to the LIS. Using unsupported characters
in sample IDs may cause incorrect transmission of the
sample IDs to the LIS, which may cause invalid or
delayed results.

» If you use Unicode characters in your sample IDs,
connect the system to an LIS via HL7 protocol.

» If you connect the system to an LIS via ASTM
protocol, only use characters in the range of 0x21
(exclamation mark "") to 0x7D (closing curly bracket
") of the CP-1252 character encoding for sample

IDs.
Incorrect assignment of partitioning engine An analyzer only processes nanowell plates that were
to analyzer partitioned on an assigned partitioning engine. If the

partitioning engine you used to partition the nanowell
plates is not assigned to the analyzer you want to
process the nanowell plates on, the information from the
partitioning engine may be lost, which may cause invalid
or delayed results.

» Ensure that the partitioning engine is assigned to the
analyzer.

» Pay extra attention to the assignment of the
partitioning engines to the analyzers in a multiple
instrument configuration (multiple partitioning
engines and multiple analyzers).

*@ Partitioning engine connection (596)
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Caution messages

Weak passwords

Compromised data security
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Weak passwords may allow unauthorized access to the
system, data manipulation or loss, or unauthorized
access to personal information, which may cause
incorrect, invalid, or delayed results.

» Use strong passwords.

» Do not share passwords.

» Do not write down passwords.
» Do not share user accounts.

» As an administrator, ensure that the global password
policy configured in the analyzer software enforces
safe password handling.

»& Password settings (599)

Unprotected IT infrastructure and unrestricted physical
access to the system and attached infrastructure may
allow for infection with malicious software, manipulation
of system components, or misuse of the system.
Infection with malicious software, manipulation, or
misuse may cause incorrect, invalid, or delayed results,
or unauthorized access to personal information.

» Ensure that attached networks are secure and
monitored for security breaches. Customers are
responsible for the security of their local network,
especially in protecting it against malicious software
and attacks. This protection might include measures,
such as a firewall, to separate the system from
uncontrolled networks as well as measures that
ensure that the connected network is free of
malicious code.

» The Roche-provided firewall is mandatory and part of
the system.

v

Ensure that other computers and services on the
network are properly secured and protected against
malicious software and unauthorized access.

v

Restrict physical access to the system and all
attached IT infrastructure (computer, cables, network
equipment, etc.).

v

If parts of your network, which the system uses to
exchange data, are connected by WLAN, secure the
WLAN.

v

Ensure that any external storage devices (such as
USB flash drives) connected to the system are free of
malicious software.
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General safety information

Unprotected export files Insecure transfer or storage of backup files and archive
files may allow for data manipulation, which may cause
incorrect, invalid, or delayed results.

» Ensure that backup files and archive files are
transferred securely, are stored in a secure location,
and are protected from any unauthorized access and
disaster.

» Ensure that any external storage devices (such as
USB flash drives) that contain backup files and
archive files are protected against unauthorized
access.

Incorrect handling of master reagents Incorrect handling of master reagents may lead to
incorrect results.

» Adhere to the storage conditions defined in the
Instructions for Use for the reagents and controls. The
system does not allow the use of expired master
reagents.

» Do not use master reagents that have been dropped
on the floor or compromised in any other way.

» Do not manipulate supplies in any way not specified
in the user documentation, Instructions for Use, or
labels.

Waste handling

Environmental harm The system generates waste. Improper disposal may
contaminate the environment.

» Dispose of waste according to local regulations.
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Notices

Notices

In this section

Delay (34)
Loss of supplies (35)
Unauthorized access to personal information (36)

Damage to the instruments (36)

Delay

Incorrect loading of the partitioning engine The partitioning fluid bottles and the liquid waste bottles
are indistinguishable by their overall appearance.
Loading a liquid waste bottle in the position of the
partitioning fluid bottle may contaminate the partitioning
engine, which may cause a time delay.

» Store partitioning fluid bottles and liquid waste bottles
in a way to allow for proper distinction.

v

Mark all waste bottles with a permanent marker as
waste bottles. Mark empty or expired partitioning
fluid bottles as waste bottles immediately after
unloading them from the partitioning engine.

v

Dispose of liquid waste bottles according to local
regulations directly after unloading them from the
partitioning engine.

v

If you inadvertently loaded a liquid waste bottle in the
position of the partitioning fluid bottle, immediately
unload it again.

v

Before loading a partitioning fluid bottle and using
the partitioning engine again after incorrect loading,
decontaminate the aspiration needle.

v

If you inadvertently loaded a partitioning fluid bottle
after incorrect loading without decontaminating the
aspiration needle, do not use the partitioning engine.
Immediately unload the partitioning fluid bottle again
and dispose of it according to local regulations.

» Decontaminate the aspiration needle following the
decontamination procedure.

»& Decontaminating the aspiration needle of the
partitioning engine (479)
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General safety information

Loss of supplies

Incorrect loading of the partitioning engine The partitioning fluid bottles and the liquid waste bottles
are indistinguishable by their overall appearance.
Loading a partitioning fluid bottle in the position of the
liquid waste bottle contaminates the partitioning fluid
and the partitioning fluid bottle.

» Store partitioning fluid bottles and liquid waste bottles
in a way to allow for proper distinction.

» Mark all waste bottles with a permanent marker as
waste bottles. Mark empty or expired partitioning
fluid bottles as waste bottles immediately after
unloading them from the partitioning engine.

» If you inadvertently loaded a partitioning fluid bottle
in the position of the liquid waste bottle, immediately
unload it again.

» Do not use the partitioning fluid bottle anymore.
Instead, treat the contaminated partitioning fluid
bottle as waste and dispose of it according to local
regulations.
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Notices

Unauthorized access to personal information

Compromised data security Unrestricted physical access to the system and attached
infrastructure, and unprotected IT infrastructure may
allow for infection with malicious software, manipulation
of system components, or misuse of the system.
Infection with malicious software, manipulation, or
misuse may cause incorrect, invalid, or delayed results,
or unauthorized access to personal information.

» Do not install and/or execute any other software on
the analyzer.

» Restrict physical access to the analyzer and all
attached IT infrastructure (computer, cables, network
equipment, etc.).

v

Ensure that attached networks are secure and
monitored for security breaches. Customers are
responsible for the security of their local network,
especially in protecting it against malicious software
and attacks. This protection might include measures,
such as a firewall, to separate the system from
uncontrolled networks as well as measures that
ensure that the connected network is free of
malicious code.

» The Roche-provided firewall is mandatory and part of
the system.

» Ensure other computers and services on the network
are properly secured and protected against malicious
software and unauthorized access.

» If parts of your network, which the system uses to
exchange data, are connected by WLAN, secure the
WLAN.

» Ensure that any external storage devices (such as
USB flash drives) connected to the analyzer are free
of malicious software.

Unprotected export files Insecure transfer or storage of backup files and archive
files may allow data manipulation, which may cause
unauthorized access to personal information.

» Ensure that backup files and archive files are
transferred securely, are stored in a secure location,
and are protected from any unauthorized access and
disaster.

Damage to the instruments

Circuit breakers and fuses Improper use may result in damage to the system.
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» If a circuit breaker trips or a fuse blows, contact your
Roche Service representative.
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General safety information

Mechanical stress Shock, vibration, or pressure can damage the system.

» Keep sources of vibration away from the instruments.

» Do not place objects on top of the instruments.
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Safety labels on the system

Safety labels on the system

In this section

About safety labels on the system (38)
List of safety labels on the system (38)
Location of safety labels on the partitioning engine (39)

Location of safety labels on the analyzer (40)

About safety labels on the system

The system has warning labels to draw your attention to
areas of potential hazard. The following list explains the
meanings of the labels at the locations where you find
the labels.

The safety labels on the system comply with the following
standards: ANSI Z535, IEC 61010-2-101, IEC 61010-1, IEC
60417, or ISO 15223-1.

-‘Q’— Only Roche Service representatives may replace
damaged labels. For replacement labels, contact
your Roche Service representative.

List of safety labels on the system

General warning

Potential hazards located near this label may lead to
death or serious injury.

Refer to the user documentation for instructions on safe
operation.

Moving parts

There is a risk of hand injuries from moving parts near
this label.

Keep hands away from moving parts.
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General safety information

No heavy load
There is a risk of instrument damage near this label.

Do not place heavy objects on the instrument part.

Location of safety labels on the partitioning engine

Safety labels on the partitioning engine (front view with open nanowell plate drawer)
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Safety labels on the system

Location of safety labels on the analyzer

]

Safety labels on the analyzer (front view with open nanowell plate stack drawer)

Safety labels on the analyzer (side view)
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General safety information

Safety information for disposal

Disposal » Dispose of the system according to local regulations.
For more information, contact your Roche Service
representative.
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Safety information for disposal
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Using the User Assistance

About the User Assistance

The User Assistance supports you in your daily work. It is
available in different formats (e.g., online, offline,...). The
functionalities provided by the user interface are similar
across all formats.

The User Assistance window is divided into a main panel
and a detail panel.

:}’\D

B .
.

A Tabs for selective information access (tabs available D Global information area
depend on configuration)

B Main panel E Buttons for navigation and other functions
C Panel splitter F Detail panel

Overview of the User Assistance window

Tabs in the main panel

m Home

To view the description of the available tabs. From here,
you can access each tab directly.

Context-sensitive help

To view context-related topics when you access the User
Assistance directly from your system’s user interface.

To search for information in the whole User Assistance.
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To get an overview of the User Assistance publication.
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About the User Assistance

@ Recently viewed

To get a list of the most recent topics that you have
viewed.

i Favorites

To store your frequently used topics for direct access at
any time.
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Using the User Assistance

Overview of User Assistance functions

Enlarging images

You can enlarge an image by choosing the / button
beside it. The image is displayed in a callout in which you
can further zoom in using the zoom slider.

Browsing history

¢yl You can use the € and * navigation buttons to go
backwards and forwards in your browsing history.

Related topics

At the end of some topics, there is a list of links to other O

2> " b topics that contain related information. You can go back o

to the original topic using the < button. %
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Overview of User Assistance functions

Viewing descriptions of terms

The ((i}] button in text indicates that you can view
information about the term to the button’s left. When you
— choose the i} button, a callout is displayed containing a
description of the term.

Downloading a PDF

You can download the publication to your computer in
> . PDF format using the Download PDF button.

Download PDF

Giving feedback

In the User Assistance online, at the bottom of each
topic, you can give feedback on that topic. We use your
feedback to improve the next update of our publications.

Send feedback

Yes
& No
Was not the topic that | was looking for

Topic was not clear/understandable

{E} Cancel = Send
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Using the User Assistance

Accessing the User Assistance from the
software

NE

Roche Diagnostics

Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1

If you need support while you are using the software, you
can access the User Assistance directly within the
software.

1., . .
‘0O~ Some features are not available in the User

Assistance integrated in the software.

To access the User Assistance from
the analyzer software and the web
application

In the global information area of the analyzer software
or the web application, choose the (7} button.

= The User Assistance window is displayed with the
A tab selected. If available, topics related to the
active panel of the software are listed.

If the topic you need is not listed, choose another tab
to find it.

To access the User Assistance from
the development software

In the Navigation area of the development software,

choose File > i > Help > User Assistance.

= The User Assistance window is displayed with the
/2 tab selected. If available, topics related to the
active tab of the software are listed.

If the topic you need is not listed, choose another tab
to find it.

Draft - Do Not Distribute
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Accessing the User Assistance online

Accessing the User Assistance online

When accessing the User Assistance online, the latest
content is always available.

L .

-Q- If you have no internet access, contact your
Roche representative for a standalone version of
the User Assistance.

I_E] O PC, tablet, or smartphone (i0S or Android)
O Connection to internet
O Internet browser (Safari or Chrome)

%: O Access to the Roche Dialog portal provided by your
Roche representative

» To use the User Assistance online

1 In the browser, enter the link to the Roche Dialog
portal (dialog.roche.com).

2 Choose the Log on button and enter your Roche
DiaLog user name and password.

3 In the list of e-services, find the User Assistance
card, and then choose the Launch button in the card.

= The User Assistance publication selector is
displayed.

User Assistance

4 Use the filter settings to find the publication you
Add publications want.

- 5 Select the publication that you want, and then choose
stem

g the Add publication button, and then the Add to
Language list button.

To access a User Assistance, choose the desired
publication and then, on the detail panel, choose the
Open publication button.

Cancel

2 Using the User Assistance

Roche Diagnostics
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Accessing the User Assistance offline

You can use the standalone User Assistance offline on
your PC. No internet connection is required.

-‘Q’- To get the installer for the standalone User
Assistance, contact your Roche representative.

=] O PC

O Installer for standalone User Assistance

» To access the User Assistance offline

1 Copy the installer for the standalone User Assistance
to your PC.

2 Double-click the installer file, and then follow the
instructions in the installation wizard.

3 Once installed, start the User Assistance, by double-
clicking the User Assistance icon on your desktop.
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Searching in the User Assistance

Search options

Search in this publication

Search results

A Text search function

Use the search function in the User Assistance to find
information directly.

There are 2 search options in the User Assistance:

= Text search: Searches the text entered in the search
field.

= Faceted search: Limits the number of search results
using filters.

You can combine both search options.

Search in this publication

Search results

B Faceted search function

Search options

Search results

Topic types

Q
Q
c
«
)
R
N
/)]
<
=
o
n
-
o
=
rr)
(@)
=
[72]
-
N

Roche Diagnostics

The Search results table lists the 20 topics with the
highest ranking.

The term you searched for is highlighted. If you searched
for a deprecated term, the preferred term is highlighted.

The icon on the left of the search results shows you the
topic type:

Description

Explains concepts and gives additional background
information.

Procedure

Explains how to perform a task step-by-step.

Reference

Provides reference information.
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» To perform a search in the User
Assistance

1 In the User Assistance, choose the ,© tab.

2 To perform a simple search, enter full or partial text
entries, and then choose the & button.

Search in this publication

Search results

3 To perform a faceted search, choose the 57 button.
= The filter drop-down lists are displayed.

Search in this publication

D 4 From the drop-down lists, choose one or more search
filters.

Search results
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Overview of the system

Overview of the system

About the system components

Roche Diagnostics

The system is a nucleic acid quantification system that
uses digital PCR technology (dPCR).

The system partitions a sample into a large number of
nanowells to allow for absolute quantification of a target
nucleic acid sequence without a standard curve.

The system allows for a wide range of applications, e.g.,
in oncology by analyzing cell-free DNA, rare mutations,
copy number variations, and gene expression, or in
infectious disease diagnostics by detection and
quantification of low viral loads.

The main features of the system are:

= Digital PCR technology (dPCR) for detection of low
target concentrations

= 6 fluorescence channels for multichannel detection

= 3 analysis types (absolute quantification, CNV, indel)

= Workflows for diagnostic and development purposes

= Development software for detailed data analysis

= 5x concentrated DNA and RNA master reagents for
higher sample fraction

= Partitioning of each sample into a large number of
nanowells on a dedicated nanowell plate

= Merged lanes to emulate the partitioning of a larger
sample volume into an even higher number of
nanowells

= 3 types of nanowell plates (universal, high resolution,
high sensitivity) for different applications

= Partitioning of up to 8 samples on 1 nanowell plate in
the partitioning engine

= Processing of up to 96 samples on 12 nanowell plates
on the analyzer

The system consists of the following components:

= Nanowell plates:
A nanowell plate holds up to 8 samples in 8 nanowell
plate lanes and offers a large number of nanowells
per nanowell plate lane for partitioning of the sample.

= Partitioning engine:
The partitioning engine partitions the samples into
the nanowells on the nanowell plates and seals the
nanowells with partitioning fluid.

= Analyzer:
The analyzer performs the thermal cycling and image
acquisition.
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= Software components:
The software components (partitioning engine
software, analyzer software, web application, and
development software) control the instruments and/or
allow you to plan, perform, and analyze your runs.

About merged lanes Merged lanes emulate the partitioning of a larger sample
volume into a higher number of nanowells. The system
treats the nanowells of a set of merged lanes as if they
belong to 1 nanowell plate lane. Merged lanes therefore
facilitate detection of very low target concentrations.

Up to 8 nanowell plate lanes can be merged.

A set of merged lanes has the following characteristics:

= The same reaction mixture is pipetted into the
merged lanes.

= The merged lanes are analyzed together. A set of
merged lanes gets 1 final result.

Roche Diagnostics
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Overview of the workflows

About the diagnostic workflow

About the development workflow

Roche Diagnostics

The system supports 2 distinct workflows (diagnostic
workflow and development workflow) for different
purposes.

The diagnostic workflow is designed for diagnostic
purposes.

In diagnostic workflows, you work with the following
system components:

= Web application
= Partitioning engine
= Analyzer

As part of a diagnostic workflow, the nanowell plates are
processed in a diagnostic run on the analyzer.

There are 2 types of diagnostic workflows:
= VD workflow:

- Developed and validated by Roche.
- All supplies are provided by Roche.
= LDT workflow:

- Developed by a laboratory via a development
workflow.

- Test validation is the responsibility of the
laboratory.

- Supplies are partly provided by Roche (e.g.,
master reagents, nanowell plates) and partly by
the laboratory (e.g., primers and probes).

Depending on configuration, the raw data files from
diagnostic workflows can be used in the development
software.

»& Overview of diagnostic workflow (193)

The development workflow is designed for research and
development purposes.

In a development workflow, you work with the following
system components:

= Development software
= Partitioning engine
= Analyzer

As part of a development workflow, the nanowell plates
are processed in a development run on the analyzer.
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Roche Diagnostics

The supplies for a development workflow are partly
provided by Roche (e.g., master reagents, nanowell
plates) and partly by the laboratory (e.g., primers and
probes).

For development workflows, there are the following 2
options to plan the sample setup (i.e., the reaction
mixtures and their distribution on the nanowell plates for
the development run):

= Without unassigned sample setup:

- You plan the sample setup outside of the
development software.

- You add the information of the sample setup to
the run data in the development software after
the development run is finished.

= With unassigned sample setup:

- You plan the sample setup in the development
software before starting the development run.

- The information of the sample setup is assigned
to the run data in the development software after
the development run is finished.

*& Overview of development workflow without
unassigned sample setup (194)

*& Overview of development workflow with unassigned
sample setup (195)

Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1



Overview of the system

Overview of the system architecture and
the data flow

The following illustration gives an overview of the system
architecture and the data flow.

The following applies:

= The database of the system is located on the analyzer.

= The data transfer between the system components
takes place either via direct connection or via LAN.

= For diagnostic workflows, result calculation is done
on the analyzer.
For development workflows, result calculation is part
of the analyses in the development software.

Orders
LIS Web application Development software
—
[-__27]
Results

Analysis packages A A Raw data files
LIS orders
Partitioning data
Run data

Results )
Analysis packages
Raw data files
\ (diagnostic runs) File
>
share
LIS orders Raw data files
Sample setups v (development runs)
FortiGate 50E
\- > -
LIS orders Analysis packages
Analyzer

Partitioning engine

Partitioning data

System database
Overview of the system architecture and data flow
In diagnostic workflows, you work with the following

system components:
= Web application

Roche Diagnostics
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= Partitioning engine
= Analyzer

In a development workflow, you work with the following
system components:

= Development software
= Partitioning engine
= Analyzer

Roche Diagnostics
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Overview of the connections

About LIS connection

About AVENIO Connect

About EDI connections

Roche Diagnostics

You can connect the system to an LIS, to AVENIO
Connect, and/or to an external device via EDI.

The system behavior depends on the type of connection.

If the system is connected to an LIS, the following applies
to the diagnostic workflow:

= The web application can receive the orders
automatically from the LIS (LIS orders).

= The results are sent back from the web application to
the LIS (manually or automatically).

An LIS connection does not influence the development
workflow.

»& About LIS orders (170)

AVENIO Connect allows you to perform diagnostic
AVENIO Connect runs on the analyzer as part of an
integrated laboratory workflow.

Instead of the web application, the AVENIO Connect
Software manages the samples through the diagnostic
workflow. AVENIO Connect runs are hidden in the web
application. The results are automatically sent to the
AVENIO Connect Software and the raw data files are
automatically exported to the configured location.

A connection via EDI allows you to connect an external
device (e.g., a handler for nanowell plates) and to access
and control the analyzer remotely.

The following actions are possible on the analyzer via EDI

connection:

= Logon:
It depends on the EDI settings if a locally logged on
user is logged off from the analyzer when an EDI user
logs on.

= Log off:
EDI users are not logged off automatically from the
analyzer.

= Open nanowell plate stack drawer:
An EDI user must be logged on and the analyzer must
be in Analyzer ready status.

= Close nanowell plate stack drawer:
An EDI user must be logged on and the analyzer must
be in Analyzer ready status.
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= Start development run:
An EDI user must be logged on and the requested
run profile must exist on the analyzer.
= Start diagnostic run:
An EDI user must be logged on.
= Query analyzer status:
Possible without EDI user logged on.
= Query workflow status:
An EDI user must be logged on.

You cannot work locally on the analyzer if it is controlled
remotely via EDI.
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Overview of the partitioning engine

\
T

/
| Ny

The partitioning engine partitions the samples into the
nanowells on the nanowell plates and seals the
nanowells with partitioning fluid.

The main features of the partitioning engine are:
= Partitioning of up to 8 samples on 1 nanowell plate
= Sealing the nanowells with partitioning fluid

= Checking the partitioning status of the nanowell plate
lanes and flagging invalid nanowell plate lanes

= Connection to the analyzer via LAN

%

EF

A Touch screen monitor G Aspiration needle

B Nanowell plate drawer H Aspiration and dispensing arm
C Partitioning fluid bottle I Fluids door

D Liquid waste bottle J LAN port and USB ports

E Power switch K Cover

F Power inlet

Partitioning engine (front view and back view)

About the touch screen monitor

Roche Diagnostics

The partitioning engine is a standalone instrument
suitable for multiroom configurations. The partitioning
engine is touch screen operated.

Each partitioning engine is assigned to a specific
analyzer. To run nanowell plates on an analyzer, they
must be partitioned on an assigned partitioning engine.

*@ Partitioning engine connection (596)

The touch screen monitor displays the user interface of
the partitioning engine software and allows you to
operate the partitioning engine.
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Use your finger or a touch screen stylus on the touch
screen monitor.

»& Overview of the partitioning engine software (83)

About the nanowell plate drawer The nanowell plate drawer holds 1 nanowell plate during
partitioning.

The design of the nanowell plate drawer and the beveled
corner of the nanowell plate ensure the correct
orientation of the nanowell plate in the nanowell plate
drawer.

-‘Q’— Do not try to close the nanowell plate drawer
manually. Instead, follow the partitioning
procedure for the partitioning engine.

»@ Partitioning the nanowell plates (221)

About the fluids door The fluids door is located on the right side of the
partitioning engine. On the inside, the fluids door holds
the aspiration and dispensing arm with the aspiration
needle, the partitioning fluid bottle, and the liquid waste
bottle.

To open the fluids door, push the front edge inside until
the fluids door disengages. Then open the fluids door
completely.

To close the fluids door, push the front edge inside until
the fluids door engages with an audible click.

To replace the partitioning fluid bottle and the liquid
waste bottle, the aspiration and dispensing arm can be
moved up and down.

*@ Replacing the partitioning fluid bottle and/or the
liquid waste bottle on the partitioning engine (460)

About the power switch The power switch is located at the back of the
partitioning engine.

-Q— For routine shutdown of the partitioning engine,
do not simply press the power switch. Instead,
follow the shutdown procedure and only press
the power switch when prompted to do so.

Only press the power switch outside of the
shutdown procedure if immediate shutdown is
required, e.g., in case of system failure or
emergency shutdown.

Roche Diagnostics
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»@ Starting up the partitioning engine (231)
*@ Shutting down the partitioning engine (437)

*& Restarting an unresponsive partitioning engine (506)

About the power inlet The power inlet is located at the back of the partitioning
engine.
About the LAN port The LAN port is located at the back of the partitioning

engine. To access the LAN port, remove the cover.

About the USB ports The partitioning engine has 2 USB ports to connect
external storage devices, e.g., USB flash drives.

The USB ports are located at the back of the partitioning
engine. To access to the USB ports, remove the cover.

»& Copying the logs from the partitioning engine to an
external storage device (504)

Roche Diagnostics
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Overview of the analyzer

A Touch screen monitor

B Nanowell plate stack drawer
C Power button

D USB ports

The analyzer performs thermal cycling and image
acquisition.

The main features of the analyzer are:

= Processing of up to 96 samples on 12 nanowell plates
in 1 run

= 6 fluorescence channels for multichannel detection

E Power switch
F Power inlet
G LAN port

Analyzer (front view and side view)

About the touch screen monitor

About the nanowell plate stack drawer

Roche Diagnostics

The analyzer is a standalone instrument suitable for
multiroom configurations. The analyzer is touch screen
operated.

The touch screen monitor displays the user interface of
the analyzer software and allows you to operate the
analyzer.

Use your finger or a touch screen stylus on the touch
screen monitor. Optionally, an external keyboard and a
mouse can be connected to the USB ports of the
analyzer.

You can tilt the touch screen monitor up and down.

The nanowell plate stack drawer holds up to 12 nanowell
plates during loading and unloading of the analyzer.
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The design of the nanowell plate stack drawer and the
beveled corners of the nanowell plates ensure the
correct orientation of the nanowell plates in the nanowell
plate stack drawer.

-‘Q’— Do not try to close the nanowell plate stack
drawer manually. Instead, follow the loading and
unloading procedures for the analyzer.

*&l Loading the analyzer (225)
*@ Unloading the analyzer (227)

About the power button The analyzer has a power button to turn the analyzer on
and off during routine startup and shutdown.

The power button is located on the right side of the
analyzer next to the USB ports.

-‘Q’— For routine shutdown of the analyzer, do not
simply press the power button. Instead, follow the
shutdown procedure and only press the power
button after the touch screen turns dark.

Only press the power button outside of the
shutdown procedure if immediate shutdown is
required, e.g., in case of system failure or
emergency failure.

»@& Starting up the analyzer (235)
*& Shutting down the analyzer (440)

*&l Restarting an unresponsive analyzer (519)

About the USB ports The analyzer has 4 USB ports to connect external devices
(e.g., hand-held barcode reader, keyboard, and mouse)
and/or external storage devices (e.g., USB flash drives).

The USB ports are located on the right side of the
analyzer.

»E& About the hand-held barcode readers (77)

»& About the mouse (78)

*& About the external keyboard (79)

About the power switch The analyzer has a power switch to turn the power on
and off.

The power switch is located on the right side of the

analyzer.

Roche Diagnostics
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About the power inlet

About the LAN port

About the components inside the analyzer
A B
c D

A Detection unit
B Nanowell plate handler

C Nanowell plate park position (behind the
detection unit)

D Thermal cycler units

Roche Diagnostics

*&l Resolving an alarm of the analyzer (527)

The power inlet is located on the right side of the
analyzer next to the power switch.

The LAN port is located at the back of the analyzer.

The nanowell plate handler transfers the nanowell

plates between the nanowell plate stack drawer, the

thermal cycler units, the nanowell plate park position,
and the detection unit.

The pressurized thermal cycler units provide and
control the temperature profiles for the thermal cycling.
The analyzer has 2 thermal cycler units for 3 nanowell
plates each.

The detection unit acquires and stores the fluorescence
images of the nanowells in up to 6 channels.

After thermal cycling, nanowell plates are parked
temporarily in the nanowell plate park position.
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About the hand-held barcode readers

You can connect hand-held barcode readers to the
analyzer, to the computer running the web application,
and to the computer running the development software.

Instead of manually entering the IDs, e.g., sample IDs
and nanowell plate IDs, use a hand-held barcode reader
to scan the barcode labels.

Connect the hand-held barcode reader to a USB port on
the right side of the analyzer.

Contact your local IT support for installation and
configuration of the hand-held barcode readers.

»& About the USB ports (75)

*&l Computer specifications (187)

Roche Diagnostics
Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1



About the mouse

About the mouse

You can connect a mouse to the analyzer.

Instead of using the touch screen, use the mouse to work
with the analyzer software.

Connect the mouse to a USB port on the right side of the
analyzer.

Contact your local IT support for installation and
configuration of the mouse.

*& About the USB ports (75)

Roche Diagnostics
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About the external keyboard

You can connect an external keyboard to the analyzer.

Instead of using the virtual keyboard in the analyzer
software, use the external keyboard for data entry.

Connect the external keyboard to a USB port on the right
side of the analyzer.

Contact your local IT support for installation and
configuration of the external keyboard.

*& About the USB ports (75)

Roche Diagnostics
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Overview of the partitioning engine

software

A Global information B Work area
area

You access the partitioning engine software and operate
the partitioning engine via the user interface.

The user interface of the partitioning engine software
consists of the following elements:

= (Global information area
= Work area

In this section

About the global information area of the partitioning
engine software (83)

About the work area of the partitioning engine
software (85)

About the global information area of the partitioning

engine software

A B C D
A Menu button C Message
B Status indicator D Connection indicator

About the menu button

Roche Diagnostics

The global information area of the partitioning engine
software provides functions and information that are
always available.

The global information area is always displayed and
contains the following elements:

= Menu button

= Status indicator

= Messages

= Connection indicator

The = button allows you to access the following
functions and panels of the partitioning engine from a
drop-down menu:
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About the status indicator

About the messages

About the connection indicator

“-

<k

Roche Diagnostics

Initialize Instrument

*@ Initializing the partitioning engine (505)
Prime Instrument

»@ Priming the partitioning engine (232)
Copy Logs to USB

*@ Copying the logs from the partitioning engine to an
external storage device (504)

Event Viewer

»@ Displaying the event viewer in the partitioning engine
software (503)

Information

*@ To display the system information in the partitioning
engine software (452)

Shut Down Instrument

»@ Shutting down the partitioning engine (437)

To display the drop-down menu and to hide it again,
choose the = button.

To perform a function or to access a panel, from the

drop-down menu, choose the command.

The partitioning engine status indicator displays the
current status of the partitioning engine:

= Ready

* Busy

= Warning
= Error

If certain events occur, a message is displayed.

For each message, a corresponding event is logged in
the event viewer.

»& List of messages on the partitioning engine (499)

*@ Displaying the event viewer in the partitioning engine
software (503)

The connection indicator displays the status of the
connection of the partitioning engine to the analyzer:

Connected

Disconnected
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-Q- Do not partition nanowell plates if the partitioning
engine is disconnected from the analyzer. The
partitioning information will be lost and you will
not be able to run the nanowell plates on the
analyzer.

About the work area of the partitioning engine software

About the Plate Setup panel

A Nanowell plate ID € Function button

B Nanowell plate type D Partitioning indicator

Roche Diagnostics

The work area is the center of your activities when
working with the partitioning engine software. The work
area displays the panels.

By default, the work area displays the Plate Setup panel
and the Liquids panel.

To display the Information panel or the event viewer,
choose the = button. From the drop-down menu,
choose the corresponding command.

»& About the menu button (83)

The Plate Setup panel displays a visual representation
of a nanowell plate and contains buttons to perform
functions.

For a loaded nanowell plate, the following information is
displayed:

= Nanowell plate ID

= Nanowell plate type with color-coding

= Partitioning indicators for nanowell plate lanes

The partitioning indicators are color-coded according to
the partitioning status of the nanowell plate lanes before,
during, and after partitioning:

Gray:
The nanowell plate lane is empty, is not yet partitioned,
or was not partitioned.

Blue:
The nanowell plate lane is currently being partitioned.
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Green:
The nanowell plate lane was partitioned successfully.

Red:
Partitioning of the nanowell plate lane failed. The
nanowell plate lane is flagged and invalidated.

For invalid nanowell plate lanes, the following applies:
= The contained reaction mixture is flagged and
invalidated:

- For a sample, the final results will be invalid.

- For a control, the final results of all associated
targets or samples will be invalid.

= [f all partitioned nanowell plate lanes of a nanowell
plate are invalid, the whole nanowell plate is invalid.
You cannot process invalid nanowell plates on the
analyzer.

The function buttons on the Plate Setup panel allow you
to perform the following functions:

Prime
Primes the partitioning engine.

Load
Opens the nanowell plate drawer.

Close
Closes the nanowell plate drawer.

Start
Closes the nanowell plate drawer and starts partitioning.

The buttons change its symbol and label depending on
the availability of the corresponding functions.

*@ Priming the partitioning engine (232)

»@ Partitioning the nanowell plates (221)
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About the Liquids panel

A
B E
¢ F
D

Expiry date of the partitioning fluid

Fill percentage of partitioning fluid bottle

Fill level and status of partitioning fluid bottle
Lot number of partitioning fluid bottle

Fill percentage of liquid waste bottle

MmO ® >

Fill level and fill status of liquid waste bottle

Roche Diagnostics

Overview of the software components

The Liquids panel displays the following information
about the partitioning fluid bottle and the liquid waste
bottle:

= Expiry date of the partitioning fluid
= Fill percentage

= Fill level

= Fill status

= Lot number of the partitioning fluid

The fill status is color-coded:

Green:
Sufficient bottle volume for normal operation.

Yellow:
Bottle needs to be exchanged soon.

Red:

Bottle must be exchanged.

You cannot prime the partitioning engine or partition
another nanowell plate unless you change the bottle.

-Q— For the partitioning fluid bottle, the fill percentage
and fill level fall with each performed partitioning
run. The fill status changes when the partitioning
fluid bottle gets increasingly empty.

For the liquid waste bottle, the fill percentage and
fill level rise with each performed priming. The fill
status changes when the liquid waste bottle gets
increasingly full.

*@ Replacing the partitioning fluid bottle and/or the
liquid waste bottle on the partitioning engine (460)
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About the event viewer

The event viewer displays a list of the events with event
severity and event code.

An event can have the following severity:
= Information

= Warning

= Error

If an error event occurs, a corresponding message is
displayed in the global information area.

To display the event viewer, in the global information
area, choose the = button. From the drop-down menu,
choose the Event Viewer command.

*@ Displaying the event viewer in the partitioning engine
software (503)

*&l Copying the logs from the partitioning engine to an
external storage device (504)

About the Information panel

The Information panel displays the following
information about the partitioning engine:

= Software version
= System version
= Serial number
= Network address

To display the Information panel, in the global
information area, choose the = button. From the drop-
down menu, choose the Information command.

From the Information panel, you can copy the license.

*& Displaying system information (452)

Roche Diagnostics
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Overview of the web application

The web application is a dedicated application to plan
and to start diagnostic workflows and to review the
results.

The web application is the interface between the system
and a connected LIS.

You access and operate the web application in a browser
window.

*& Specifications for the web application (187)

The web application window consists of the following
elements:

[ ] = Global information area

= Dashboard or screen

A Global information B Dashboard
area

In this section

About the global information area of the web
application (89)

About the dashboard of the web application (91)

About the screens in the web application (94)

About the global information area of the web application

The global information area of the web application
provides functions and information that are always
available.

Roche Diagnostics
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A Application version

B URL for analyzer connection
C Dashboard button

D Screen name

About the dashboard button

About the LIS connection indicator

RAE R

About the logon indicator

Roche Diagnostics

A

FG H

E Serial number of the connected analyzer
F LIS connection indicator

G Logon indicator

H User Assistance

The global information area is always displayed and
contains the following elements:

= Application version

= URL for the connection to the analyzer

= Dashboard button &2

= Screen name

= Serial number of the connected analyzer

= LIS connection indicator

= Logon indicator

= User Assistance

To return to the dashboard from a screen, choose the &%
button.

The LIS connection indicator displays the status of the
connection to the LIS:

Connected

Disconnected

If the system is not connected to an LIS, the LIS
connection indicator is not displayed.

The logon indicator displays the currently logged on user.

To log off from the web application, choose the logon
indicator.

—‘Q’- In the web application, you can only change your
password upon request. You can change your
password at any time only in the analyzer
software.
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*@ Logging off from the web application (438)
*@& Change password (237)

*@ To change my password at logon in the web
application (238)
About the User Assistance To display the User Assistance, choose the (%) button.

The User Assistance is context-sensitive and displays
information about the screen you are currently using.

»& About the User Assistance (47)

About the dashboard of the web application

When you log on to the web application, the dashboard
is displayed.

The dashboard consists of the following elements:
= Columns
= Tiles

Roche Diagnostics
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A B C D
E F G H | J K
A Orders column G Batch tile for batch in Ready to start run status
B Sample setups column H Batch tile for batch in Pending partitioning status
C Run in progress column I Batch tile for batch in Processing status
D Results column J Completed batches tile (displays the number of
completed batches)
E View orders tile K Batch tile for batch after run finished

Create sample setup tile (displays the number of
not allocated orders)

Columns and tiles on the dashboard of the web application

To display a screen with further information, choose a tile
on the dashboard.

About the columns on the dashboard The columns on the dashboard display the tiles and are
ordered according to the consecutive steps in a
diagnostic workflow:
= Orders column:

Displays the Create sample setup tile and the View
orders tile for accessing orders.

= Sample setups column:
Displays a batch tile per confirmed but unprocessed
sample setup (i.e., the sample IDs and their
distribution on the nanowell plates for a run).

* Run in progress column:
Displays the batch tile of the sample setup that is
currently run on the analyzer. If there is currently no
diagnostic run on the analyzer, the Run in progress
column is empty.

Roche Diagnostics
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About the batch tiles

/A /B

A Number of orders C Batch status

and nanowell plates

B Batch name D Result status

Roche Diagnostics

Overview of the software components

= Results column:
Displays a batch tile per processed but not completed
batch, and the Completed batches tile if there are
completed batches on the system.

-‘Q’— A batch is processed if the run on the analyzer is
finished.

A batch is completed if all results are complete,
i.e., released and sent.

The batch tiles are ordered consecutively in the Sample
setups column and the Results column with the newest
batch at the top.

»& About the batch tiles (93)

A batch consists of the orders that are allocated to 1
confirmed sample setup. A batch is processed in 1
diagnostic run on the analyzer.

In the web application, a batch and its sample setup are
represented by a batch tile. Each batch has its own batch
tile.

When a sample setup is confirmed, a corresponding
batch tile is automatically created in the Sample setups
column on the dashboard. If a sample setup is deleted
again, the corresponding batch tile is deleted as well.

While the batch is processed, its status and the status of
its orders change and the batch tile moves through the
corresponding columns on the dashboard.

A batch tile displays the following information:

= The number of orders and the number of nanowell
plates that comprise the batch.

= The unique batch name.
By default, a batch is named:
"Batch_YYYYMMDDhhmmss"
with the date and time the batch (i.e., the sample
setup) was created.
The batch name is used as the run name on the
analyzer.

= The number of flags (if applicable).
= For unprocessed batches, the batch status:

- Incomplete setup
- Pending partitioning
- Ready to start run

- Ready to start run (loaded)
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- Processing ({percent}%) (with "{percent}"
replaced by the percentage of the run that has
already elapsed)

= For processed but not completed batches, the
number of results with the result status (with
"{count}" replaced by the applicable number):

- {count} pending to be released
- {count} pending to be sent

- {count} completed

-‘Q’- The {count} completed result status on the
batch tile summarizes the results that are in Send
queued status or Sent status on the Samples
tab on the Results of screen.

*& About the result status in the web application
(102)

»& About the columns on the dashboard (92)

»@ List of naming placeholders (154)

About the screens in the web application

About the icons for analysis packages

Roche Diagnostics

The screens of the web application display detailed
information on orders, batches, and results, and offer
corresponding functions.

To display a screen, choose a tile on the dashboard.

To return to the dashboard from a screen, in the global
information area, choose the 2 button.

The following screens are available:
= Orders

= Edit orders

= Sample setup

* Results of

= Completed batches

On the screens of the web application, analysis packages
can be marked with the following icons:

Analysis package provided by Roche.

Analysis package is in In validation status in the
analyzer software.

*& About statuses of analysis packages (580)
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About the Orders screen

s

A Toggle button to enable and disable
assignment mode

B Refresh button to update screen

Navigating to the Orders screen

About the Orders screen in assignment mode

Roche Diagnostics

Overview of the software components

In this section

About the Orders screen (95)

About the Edit orders screen (96)

About the Sample setup screen (97)

About the Results of screen (100)

About the Completed batches screen (104)

If assignment mode is enabled, the Orders screen lists
the orders that are not allocated. If assignment mode is
disabled, the Orders screen lists all orders.

To toggle between the assignment mode enabled and
disabled, on the Orders screen, choose the Assignment
mode toggle button.

—Q- On the Orders screen, a row summarizes all
orders that belong to the same sample ID, are for
tests from the same analysis package, and are in
the same status.

If the information on the Orders screen has changed, a
Refresh button is displayed. To update the screen,
choose the Refresh button.

»& About orders (169)

To display the Orders screen, on the dashboard, do one

of the following:

= To display the Orders screen in assignment mode,
choose the Create sample setup tile.

= To display the Orders screen with assignment mode
disabled, choose the View orders tile.

The Orders screen in assignment mode lists the orders
that are not allocated (an order is not allocated if it is not
assigned to a sample setup).
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About the Orders screen with assignment
mode disabled

[

About the Edit orders screen

Roche Diagnostics

If you choose rows on the Orders screen in assignment
mode, the number of orders, needed nanowell plate
lanes, and needed nanowell plates is calculated and
displayed at the top right of the table.

Alternatively, to display the same information in the
Selected orders dialog box, choose the Selection
overview button.

If you choose too many rows for 12 nanowell plates, the
number of orders, needed nanowell plate lanes, and
needed nanowell plates is displayed in red. You cannot
assign this selection to a sample setup.

-‘Q’— The web application automatically includes the
controls in the number of needed nanowell plate
lanes and needed nanowell plates. Therefore,
these numbers may be higher than the number of
chosen orders suggests.

If assignment mode is disabled, the Orders screen lists
all orders and their status, except orders belonging to
completed batches that are listed on the Completed
batches screen.

Except for not allocated orders and orders in In process
status, the order status in the Status column is a link to
the screen where the order is currently listed. For
example, if you choose an Allocated link, the Sample
setup screen for the sample setup that includes the
order is displayed.

The Edit orders screen displays sample IDs and analysis
packages to create orders manually and to delete orders
(except LIS orders).
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A B C

A Add sample ID card
B Sample IDs card
C Analysis package and test card

\A \B\C

A Analysis package C Test of order
B Test of LIS order

About the Sample setup screen

Roche Diagnostics

Overview of the software components

The Edit orders screen comprises the Add sample ID
card, the Sample IDs card, and the Analysis package
and test card.

To display the Edit orders screen, on the Orders screen
in assignment mode, choose the Add/edit order button.

If orders are selected on the Orders screen, they are
displayed on the Edit orders screen.

If no orders are selected on the Orders screen, only the
available analysis packages are displayed on the Edit
orders screen.

On the Edit orders screen, on the Sample IDs card, the
entries are color-coded:

= The analysis package is displayed in black font with a
gray background.

= The tests of LIS orders are displayed in blue font.

= The tests of all other orders are displayed in black
font.

-‘Q’- On the Edit orders screen, an entry summarizes
all orders that belong to the same sample ID, are
for tests from the same analysis package, and are
in the same status.

»& Ordering in the web application (250)

The Sample setup screen displays the sample setup in
plate view, i.e., the compiled nanowell plates for a
diagnostic run.
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D
A Column for C Estimated run
1 nanowell plate duration
B Batch name D Tile for 1 nanowell

plate lane

Navigating to the Sample setup screen

About the column headers on the Sample
setup screen

Roche Diagnostics

The Sample setup screen displays the following

information:

= Batch name (used as name of the diagnostic run on
the analyzer)

= Estimated run duration on the analyzer

= Sample setup in plate view:

- 1 column per nanowell plate with column header
and column footer

- 1 tile per nanowell plate lane

On the Sample setup screen, to deselect all tiles, press
Esc.

*& About sample setups in plate view (150)

To display the Sample setup screen, do one of the
following:

= Assign orders to a sample setup, i.e., on the Orders
screen in assignment mode, choose the orders and
choose the Assign to sample setup button.

= In the Sample setups column on the dashboard,
choose a batch tile.

= On the Orders screen with assignment mode
disabled, in the Status column, choose an Allocated
link.

In the web application, the column headers are color-
coded according to the status of the nanowell plate:

Gray:
Unpartitioned nanowell plate.

Blue:
Unpartitioned nanowell plate, column selected.

Green:
Nanowell plate partitioned successfully.

Red:

Nanowell plate information incomplete, e.g., missing
nanowell plate ID.

To display a callout with additional information, mouse
over the column header.

Invalidated nanowell plates are grayed out, regardless of
the status of the nanowell plate.

Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1



Overview of the software components

About the Plate: combo box

The Plate: combo box displays the currently available

A— information about the nanowell plate:

B— = Position of the nanowell plate in the sample setup
= Nanowell plate ID

c— = Nanowell plate information

= Invalidation status of nanowell plate
= Partitioning information

You cannot enter the nanowell plate ID of a nanowell

D—
plate that is expired, has the wrong type, is already part
of a sample setup, and/or is already partitioned.
E p—
To display the Plate: combo box, on the Sample setup
screen, choose a column header twice.
*& About the positions of nanowell plate lanes in
sample setups (153)
A Position of nanowell plate in sample setup
B Field for nanowell plate ID
C Nanowell plate information
D Check box to invalidate nanowell plate
E Partitioning information

Roche Diagnostics
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About the Sample settings: combo box

A———
B—

D———

F——

G——

>

Position of nanowell plate lane in sample
setup

Sample ID

Analysis package information

Field for notes

Check box to invalidate nanowell plate lane
Dilution factor

Field for kit ID

Partitioning flags

IO mMmMmQogOoOW®

About the Results of screen

Roche Diagnostics

The Sample settings: combo box displays the currently
available information about the nanowell plate lane:

= Position of the nanowell plate lane in the sample
setup

= Sample ID

= Analysis package information

= Notes

= Invalidation status of nanowell plate lane
= Dilution factor

= KitID

= Partitioning flags

If you choose several nanowell plate lanes, Multiple is
displayed in some fields, e.g., for the sample ID.

To display the Sample settings: combo box, on the
Sample setup screen, choose a tile twice.

*& About the positions of nanowell plate lanes in
sample setups (153)

The Results of screen displays the results for a
processed batch after the diagnostic run on the analyzer
is finished.

The Samples tab on the Results of screen displays
1 row per processed order.

The screen name is appended with the batch name, e.g.,
"Results of Batch_YYYYMMDDhhmmss'".
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A Screen name and run name F Notes indicator

B Details of sample setup G Row with tabs

C Drop-down list for analysis packages H Row with columns headers
D Run details I Results table

E Color-coded screen header

Results of screen

On the Results of screen, the results are ordered as
follows:

1. By analysis package:
To access the results for a specific analysis package,
choose the analysis package from the drop-down list.

2. By tabs:
To access results and run information, choose a tab:

- Controls
Lists results for controls (1 row only for a set of
merged lanes).

- Samples
Lists results for samples (1 row only for a set of
merged lanes).

- Plates
Lists the used nanowell plates.

- Kits
Lists the used IVD kits if the information was
added to the sample setup.

- Run notes
Lists run notes if they were added to the sample
setup.

Roche Diagnostics
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About header colors

About the result status in the web application

VV:

Roche Diagnostics

3. By columns:
The information is ordered in columns. You can sort
by columns.

To reach the result that you want to access, navigate
through this hierarchy or use the search function.

The header on the Results of screen has the same color
as the tiles in the Results column on the dashboard:

Light-green:
= There are results that are not released and/or sent
yet.

= The batch is processed, but not completed.

= There is a corresponding batch tile in the Results
column on the dashboard.

Light-brown:

= All results are released and sent.

= The batch is completed.

= There is no corresponding batch tile in the Results
column on the dashboard anymore. The batch is
listed on the Completed batches screen.

In the web application, results for samples can be in the
following statuses:

Pending release
Pending send
Send queued

Sent

—‘Q’- Results for orders with analysis packages in In
validation status have no status icon.

The result status applies to samples only.

The following applies:

= Results are incomplete if they are in Pending
release status or Pending send status.

= Results are complete if one of the following applies:

- The results are in Send queued status or Sent
status.

- The results are for orders with analysis packages
in In validation status. You cannot release or
send such results, and they have no status icon.
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-‘Q’- The {count} completed result status on the
batch tile summarizes the results that are in Send
queued status or Sent status on the Samples
tab on the Results of screen.

»& About the batch tiles (93)

On the Results of screen in the web application, the
result status for samples is displayed in the Status
column on the Samples tab.

To display a callout with the status legend, in the Status
column header on the Samples tab, choose the ¥ icon.

»E& About final results (173)

*& Releasing results manually in the web application
(265)

*&l Sending results manually in the web application
(267)

*& Sending results again in the web application (538)

Navigating to the Results of screen To display the Results of screen for a batch, do one of

the following:

= For batches with at least 1 result that is incomplete:
In the Results column on the dashboard, choose the
batch tile.

= For batches with complete results only:
In the Results column on the dashboard, choose the
Completed batches tile. On the Completed
batches screen, choose the batch and choose the
View button.

Results are complete if they are released and sent, or if
they are for orders with analysis packages in In
validation status.

*& About the result status in the web application (102)

About final results Final results are displayed on the Results of screen as
follows:
= Final quantitative results are displayed in the Result
column (with the corresponding unit in the Unit
column).
= Final qualitative results are displayed in the Final
result column.

The final qualitative results of samples are color-coded,
i.e., the result names are underlaid with the
corresponding color.
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»E& About final results (173)

*& About color-coding of final results for samples (149)

About the notes indicator The notes indicator is displayed in the Notes column on
the Controls tab and the Samples tab.

The notes indicator indicates if a sample or control has
notes:

No notes.

There are notes.

B[]

To add, edit, or delete notes, choose the notes indicator.

*@ Viewing, adding, editing, and deleting result notes
(263)

About the Completed batches screen

The Completed batches screen lists all batches on the
system that have complete results only.

If all results of a batch are complete, i.e., released and
sent, the batch is completed.

A batch is immediately listed on the Completed

batches screen after the diagnostic run is finished if one

of the following applies:

= The system is configured to release and send results
automatically.

= All orders of the batch were for analysis packages in
In validation status.

To display the Completed batches screen, in the
Results column on the dashboard, choose the
Completed batches tile.

To display the Results of screen of a completed batch,
on the Completed batches screen, choose the batch

and choose the View button. The screen header of the
Results of screen is color-coded.

»& About header colors (102)
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Searching on the Completed batches screen

To search for runs by batch information, enter the search
term in the Search field.

To search for runs by sample IDs that were processed in
the run, select the Search by sample ID check box and
enter the sample ID in the Search field.
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Overview of the analyzer software

You access the analyzer software and operate the
analyzer via the user interface.

The user interface of the analyzer software consists of
the following elements:

{ ] = Global information area
= Work area

A Global information B Work area
area

In this section

About the global information area of the analyzer
software (106)

About the work area of the analyzer software (110)
About the panels in the analyzer software (112)
About the file and folder browsers (123)

About the virtual keyboard (125)

About the global information area of the analyzer
software

The global information area of the analyzer software
provides functions and information that are always
available.
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Plates button

Button to open and close the nanowell plate stack
drawer

Overview of the software components

F User Assistance
G Shutdown button

C Message indicator H Connection indicator

D Logon indicator I Analyzer status indicator
E Log on button or Log off button J Screenshot button
Global information area of the analyzer software

About the Plates button

About the button to open and close the
nanowell plate stack drawer

Roche Diagnostics
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The global information area is always displayed and
contains the following elements:

= Plates button

= Button to open and close the nanowell plate stack
drawer

= Message indicator
= Logon indicator

* Log on button / Log off button
(depending on logon status)

= Shutdown button

= User Assistance

= Connection indicators

= Analyzer status indicator
= Screenshot button

To display the Plates panel and to hide it again, choose
the Plates button.

You do not need to be logged on to display the Plates
panel.

*& About the Plates panel (112)

To open or close the nanowell plate stack drawer,
choose the (&} button.

If you open the nanowell plate stack drawer, the Plates
panel is displayed automatically.

Whenever you close the nanowell plate stack drawer, the
analyzer attempts to read the barcode labels of loaded
nanowell plates and refreshes the Plates panel.

You can only open and close the drawer if the analyzer is
in Analyzer ready status.
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About the message indicator

W W 0

About the logon indicator

About the Log on button and the Log off

button

About the User Assistance

Roche Diagnostics

You do not need to be logged on to open or close the
nanowell plate stack drawer.

*& Loading the analyzer (225)
*& Unloading the analyzer (227)

To display the messages panel and to hide it again,
choose the message indicator.

The message indicator is color-coded if a user is logged
on to the analyzer software. If no user is currently logged
on, the message indicator is unavailable.

The color of the message indicator corresponds to the
unconfirmed message with the highest severity:

Red:
There is at least 1 unconfirmed error message.

Orange:
There is at least 1 unconfirmed warning message.

White:
There are only confirmed error and/or warning
messages, and/or there are only information messages.

The color of the message indicator is updated
immediately when a corresponding event occurs or when
you confirm messages.

*E& About the messages panel (121)

*& Messages in the analyzer software (509)

The logon indicator displays the full name of the
currently logged on user.

»& User management (545)

To log on to the analyzer, choose the Log on button.
To log off from the analyzer, choose the Log off button.

»@& Starting up the analyzer (235)

*@ Logging on to the analyzer software (236)
*@ Logging off from the analyzer software (439)
*@ Shutting down the analyzer (440)

To display the User Assistance and to hide it again,
choose the (7} button.
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The User Assistance is context-sensitive and displays
information about the panel you are currently using.

»& About the User Assistance (47)

About the shutdown button To shut down the analyzer and the analyzer software,
choose the () button.

The () button is only available if the nanowell plate stack
drawer is closed and the analyzer is in Analyzer not
initialized status, Analyzer ready status, or Analyzer
paused status.

»@ Shutting down the analyzer (440)

About the connection indicators If the system is connected to an LIS and/or to AVENIO
Connect, a corresponding connection indicator displays
the status and type of the connection.

The connection indicator displays the connection status:

= Connection is configured.

b
= Last communication was successful, i.e., the
connection is working.
ao = Connection is configured.
= Last communication was unsuccessful, i.e., the
connection is not working.
The connection indicator displays the connection type
next to the connection status:
= LIS
= AVENIO Connect
The connection indicators for an LIS connection and an
AVENIO Connect connection are displayed separately.
If a connection is not configured, the corresponding
connection indicator is not displayed.
»& Overview of the connections (67)
»@& Connection settings (569)
About the analyzer status indicator The analyzer status indicator displays the current status

of the analyzer:

* Analyzer not initialized
= Analyzer initializing

* Analyzer ready

= Analyzer processing

= Archiving

Roche Diagnostics
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About the screenshot button

= Backup

= Analyzer paused

= Error

= Analyzer connected

= Analyzer disconnected
= Analyzer performing maintenance
= Analyzer offline

= Analyzer starting up

= Analyzer pre-initialized
= Analyzer shutting down
= Software starting up

If the analyzer status changes, the analyzer status
indicator is updated immediately.

If the analyzer status changes to Error status, the
message indicator will turn red and a corresponding
error message will be displayed in the messages panel.
*& About the message indicator (108)

*&l About the messages panel (121)

To take a screenshot of the currently displayed panel,
choose the &3 button.

The [ button is also available on messages callouts.

The screenshots are saved automatically on the analyzer
and listed on the Manage screenshots panel. You can
export and delete the screenshots.

The screenshots are also included in custom problem
reports.

*& Managing screenshots in the analyzer software (447)
*& About the message callouts (510)

*& Problem reports on the analyzer (512)

About the work area of the analyzer software

Roche Diagnostics

The work area is the center of your activities when
working with the analyzer software.
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A Navigation bar
B Tabs

C Panel

D Software version
E Date and time

About the tabs

About the navigation bar

Roche Diagnostics

Overview of the software components

The work area contains the following elements:

Tabs

Navigation bar with back button, forward button, and
breadcrumb

Panel
Software version
Date and time

A tab groups related tasks, e.g., all administration tasks.
It depends on your user role which tasks you can access
from the tabs.

The work area contains the following tabs:

Routine
Monitoring (only available during a run)
Administration

Each tab has the navigation bar at the top and displays
the panels.

*& About the panels in the analyzer software (112)

The navigation bar contains the following navigation
elements:

Back button ¢ and forward button ::

- While navigating through the work area, each
location is stored automatically in a browse
history.

- To browse the history, choose the < button and
the » button.

Breadcrumb:

- The path from the tab to the current location is
displayed as a breadcrumb.

- The first element in the breadcrumb is the tab.
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- The blue element in the breadcrumb is the
current location.

- Choose an element of the breadcrumb to go back
to that location.

About the panels in the analyzer software

About the Plates panel

Roche Diagnostics

A panel in the analyzer software is an organizational unit
within a tab and groups information and related software
functions.

In this section

About the Plates panel (112)

About the Sample setup panel (115)
About the Edit run profile panel (117)
About the Monitoring panel (120)
About the messages panel (121)
About the Administration panel (123)

The Plates panel displays the loading status of the
analyzer and the plate status of the loaded nanowell
plates.
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/)]

A Plates button G Manual entry button
B Nanowell plate stack H Open drawer button / Close drawer button
C Color-coding of nanowell plate type I Error indicator and error description for run
prerequisites
D Status of loaded nanowell plate J  Run profile button for development runs
Error indicator for nanowell plate K Sample setup button for diagnostic runs

F Table of nanowell plates with position, nanowell plate
ID, and nanowell plate type

Plates panel

To display and to hide the Plates panel, in the global
information area of the analyzer software, choose the
Plates button.

When you open the nanowell plate stack drawer, the
Plates panel is displayed automatically in the analyzer
software.

To read the barcode labels of the loaded nanowell plates
again and refresh the Plates panel, open and close the
nanowell plate stack drawer.

After closing the nanowell plate stack drawer, the
analyzer reads the barcode labels of the loaded nanowell
plates and performs a series of consecutive checks. For
example, for flags sent from the partitioning engine.

Roche Diagnostics
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About the nanowell plate status

About run prerequisites

About the Manual entry button

About the Open drawer button and the Close
drawer button

About the Run profile button

About the Sample setup button

Roche Diagnostics

Depending on the outcome of the checks, a loaded
nanowell plate can be in the following statuses:

= Barcode scan failed
= Invalid barcode

= Duplicate barcode

= Expired

= Results already exist
* Not partitioned

= Valid

For each plate that is not in Valid status, an error
indicator is displayed. To display a callout with additional
information, choose the error indicator.

You can only start the run if all nanowell plate loading
errors are resolved so that all loaded nanowell plates are
in Valid status, and if the other prerequisites for the run
are met.

*& Nanowell plate loading errors on the analyzer (520)

If any of the run prerequisites are not met, an error
indicator and error description are displayed below the
table of nanowell plates.

*& About run prerequisites (172)

The Manual entry button is only available if the
following applies:

= A nanowell plate ID could not be read by the
analyzer.

= The nanowell plate is in Barcode scan failed status.
= The nanowell plate stack drawer is closed.

*& Resolving a nanowell plate ID reading error (521)

The Open drawer button or Close drawer button is
only available if the analyzer is in Analyzer ready status.

The Run profile button is only available if the
prerequisites for a development run are met.

*@ Prerequisites for a development run (172)

The Sample setup button is only available if the
prerequisites for a diagnostic run are met.

*& Prerequisites for a diagnostic run (172)
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The Sample setup panel displays the sample setup for a
diagnostic run that was received from the web
application.

The Sample setup panel is read-only.

A B C
D \
E \
F G

A Legend for nanowell plate order E Column footer
B Batch name / run name F Column for 1 nanowell plate
C Estimated end time G Tile for 1 nanowell plate lane
D Column header
Sample setup panel

Roche Diagnostics

The Sample setup panel in the analyzer software
displays the same information as the Sample setup
screen in the web application:

= Batch name as defined in the web application (used
as name of the diagnostic run on the analyzer)

= Estimated end time
= Sample setup in plate view:
- 1 column per nanowell plate with column header
and column footer

- 1tile per nanowell plate lane, i.e., reaction
mixture

Invalidated nanowell plate lanes or nanowell plates are
grayed out.
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-Q- The nanowell plates on the Sample setup panel
are displayed in the same order as in the sample
setup in the web application, not in the actual
loading order on the analyzer. This is to facilitate
the verification of the loaded sample setup
against the sample setup report from the web
application.

The Sample setup panel is displayed automatically after
loading the analyzer if the prerequisites for a diagnostic
run are met.

If you left the Sample setup panel, to navigate back to

it, do one of the following:

= On the Plates panel, choose the Sample setup
button.

= Choose Routine > Diagnostic run > Sample
setup.

If the analyzer is in Analyzer ready status, the Start run
button is available on the Sample setup panel.

*& About run prerequisites (172)
*& About sample setups in plate view (150)

»& About the Sample setup screen (97)

About the column headers on the Sample
setup panel

Plals order, S selsp |Stact poslon |

In the analyzer software, the column header displays the

positions of the nanowell plate in the sample setup and

in the nanowell plate stack, e.g., "1(1)":

= The first number is the position of the nanowell plate
in the sample setup (as displayed in the column
header on the Sample setup screen in the web
application).

= The second number in brackets is the position of the
nanowell plate in the stack as currently loaded on the
analyzer.

The corresponding legend

Plate order: Sample setup (Stack position)

for the displayed nanowell plate positions is displayed at
the top left of the Sample setup panel.

The positions of the nanowell plates in the stack are
numbered from bottom to top:

= Nanowell plate 1 is at the bottom of the stack
= Nanowell plate 12 is at the top of the stack

Roche Diagnostics
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If the denoted positions of a nanowell plate do not
match, the numbers in the column header differ.

If a nanowell plate was invalidated by the partitioning
engine or in the web application, and is not loaded on
the analyzer, a hyphen is displayed in the brackets
instead of the position of the nanowell plate in the stack.
(The column for the nanowell plate is still displayed on
the Sample setup panel.)

*& About the positions of nanowell plate lanes in
sample setups (153)

About the Edit run profile panel

For development runs, the Edit run profile panel
displays a visual representation of a run profile and
allows you to edit unlocked run profiles.

You cannot edit locked run profiles on the Edit run
profile panel.

Roche Diagnostics
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/7

/)

)

Temperature of the step [in °C]
Temperature curve

Duration of the step [in seconds]
Temperature chart of the run
Add program button

Name of the program

O mMmMmQooOow>»

Delete program button

Incubation program
Amplification program
Number of PCR cycles
Mandatory cooling program
Run profile name

Detection formats

Z2rxXx-=—z=x

Estimated run duration depending on number of
samples

Edit run profile panel

About incubation programs

Roche Diagnostics

Each run profile is a progression of the following
programs:

= Incubation programs
= Amplification programs
= Cooling program

»@ Editing run profiles on the Edit run profile panel in
the analyzer software (303)

A run profile can contain up to 5 incubation programs.

An incubation program has a temperature and the
duration for which the temperature is kept after it is
reached.

The default values for an incubation program are as
follows:

= Name: Incubation
=  Temperature: 95 °C
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= Duration: 120 s
About amplification programs A run profile can contain up to 5 amplification programs.

An amplification program can contain 2 or 3 steps.

A 2-step amplification program is a sequence of 2
steps with different temperatures and durations, and the
number of PCR cycles that the analyzer repeats the
sequence.

The default values for a 2-step amplification program are
as follows:

= Name: Amplification
= Number of PCR cycles: 40
= Step 1:
- Temperature: 95 °C
- Duration: 10 s
= Step 2:
- Temperature: 60 °C

- Duration: 20 s

A 3-step amplification program is a sequence of 3
steps with different temperatures and durations, and the
number of PCR cycles that the analyzer repeats the
sequence.

The default values for a 3-step amplification program are
as follows:

= Name: Amplification
= Number of PCR cycles: 40
= Step 1:
- Temperature: 95 °C
- Duration: 10 s
= Step 2:
- Temperature: 60 °C
- Duration: 15 s
= Step 3:
- Temperature: 72 °C

— Duration: 15 s

Roche Diagnostics
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About the cooling program

About the detection formats

About the Monitoring panel

Roche Diagnostics

Each run profile contains a mandatory cooling program
at the end that cannot be edited or deleted.

The values for the cooling program are as follows:
= Name: Cooling

= Temperature: 40 °C

= Duration: 30 s

The detection formats define the channels, the dye per
channel, and the integration time for the detection of
fluorescence by the analyzer.

The following applies:

= Enable the channels for all dyes that are contained in
any of the master mix reagents used in the
development run.

= Disable the channels for dyes that are not contained
in any of the master mix reagents used in the
development run. Disabling empty channels shortens
the run time, reduces the size of the raw data file, and
enhances the performance of the development
software.

= You cannot use different dyes that are detected in the
same channel in 1 development run.

During a run on the analyzer, the Monitoring panel
displays run-specific information and a progress
indicator.
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A Run type E Abort run button
B Estimated end time F Estimated remaining

run duration

()

D Button to edit run H Estimated run
name and to add run duration
notes

About the messages panel

Roche Diagnostics

Run name G Progress indicator

Overview of the software components

The Monitoring panel is displayed automatically after a
run is started on the analyzer.

The & button to edit the run name and/or to add run
notes is only displayed during a development run.

The progress indicator on the Monitoring panel is color-
coded:

Blue:
Run is processing.

Green:
Run is completed.

Red:
Run is aborted.

By default, the messages panel displays the unconfirmed
messages. If there are no unconfirmed messages, the
messages panel displays all messages.

You can also display the audit trails on the messages
panel because the system displays audit trails as
information messages.

To display and to hide the messages panel, in the global
information area of the analyzer software, choose the

message indicator.

To display the details of a message, choose the message.
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Message indicator

Icon indicating unconfirmed message
Detail panel

Sort, filter, configure columns, and export

moow>»

Messages table

F Icon indicating information message
G Icon indicating warning message

H Icon indicating error message

I Icon indicating confirmed message

Messages panel

About the severity icons

A
A
®

About the status icons

Roche Diagnostics

*&l Audit trails in the analyzer software (449)

»& Messages in the analyzer software (509)

An icon in the Severity column of the messages table
indicates the severity of the messages:

Red:
Error message

Yellow:
Warning message

Information message

The color-coding of the icons match the color-coding of
the message indicator in the global information area.

*& About the message indicator (108)

An icon in the Status column of the messages table
indicates the status of messages that need confirmation:
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Unconfirmed message

© 6

Confirmed message

If there is no icon displayed in the Status column, the
message does not need confirmation.

*@ Displaying and confirming messages in the analyzer
software (511)

About the Administration panel

The Administration panel displays the task buttons to
perform administrator tasks.

You need administrator user role to perform most
administrator tasks on the Administration panel.
However, you can change your password, manage
screenshots, and handle problem reports with any user
role on the Administration panel.

About the file and folder browsers

Whenever you choose a folder to export or save a file, a
folder browser is displayed in a dialog box in the analyzer
software. Whenever you choose a file for import from a
folder, a file browser complements the folder browser.

About the folder browsers

The folder browsers allow you to navigate the folder trees
A

to choose a folder.
/ For folder browsers, the following rules apply:
= To go down a level in the folder tree, double-click an

\ entry.
= To go up a level in the folder tree, do one of the
B following (depending on availability):

) - Double-click the first entry (starting with ".").
A Current path B First entry

- Choose the < button.

= The current path is displayed in a field.
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About the top level of the folder browser

\

B

A Network shares B External storage

devices

About the file browsers

\

D

A Folder browser C File for import

B File browser D Importable file types

Roche Diagnostics

The last selected folder is retained:

The folder you selected the last time for a function is
preselected the next time the folder browser is
displayed for the same function.

If you create a folder, the folder name can consist of 1
to 30 characters. The name must not contain the
following characters:

2*<>/\:"|’

L2 . .
-Q— Do not create folders in network shares in a

folder browser. Instead, create all necessary
folders and subfolders in the network and include
them in the UNC path for the network share.

*& Network share settings (591)

On the top level of the folder browser, the following
groups are displayed:

UNC Mappings:

Lists all network shares configured on the analyzer.
USB:

Lists all external storage devices currently connected
to the analyzer.

To go down in the folder tree, double-click an entry in a
group.

The file browsers allow you to choose a file for import
after you navigated to a folder in the folder browser.

For file browsers, the following rules apply:

The file types that can be imported are displayed in a
drop-down list.

The file browser lists the importable files that are
located in the folder that is currently selected in the
folder browser.
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About the virtual keyboard

Use the virtual keyboard for data entry.

Whenever input is required, the virtual keyboard is
displayed automatically.

To toggle between the alphanumeric and the numeric
keyboard, choose the 123 button or the Text button,
respectively.

To hide the virtual keyboard, choose the  button.

The layout of the virtual keyboard depends on the active
language package in the analyzer software.

»& User Assistance and language settings (607)

Roche Diagnostics
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Overview of the development software

The development software is a dedicated software to
plan development runs, to analyze development runs and
diagnostic runs, and to create analysis packages.

A project in the development software can contain up to
50 analyses, allowing for an iterative approach.

N

-Q’- In the development software, the language of the
user interface and the User Assistance is
determined by the Windows language settings.

The development software can be installed on a
standalone computer or on a server.

»& Computer specifications (187)

After starting the development software, the start page is
displayed.

On the start page, you can do the following:
= Create a project.
= Open afile.

After performing an action on the start page, the project

/’“ page of the development software is displayed.
The project page consists of the following elements:
= Header with file or project name
= Navigation area
= Work area
The active or selected element is highlighted in blue.

\ *@ Projects in the development software (294)
B C
A Header C Work area

B Navigation area
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In this section

About the Navigation area of the development
software (127)

About the work area of the development software (127)
Tabs in the development software (129)

Plate view and table view in the development
software (138)

About the Navigation area of the development software

About the menu commands

The Navigation area of the development software
provides menus and commands that are always available.

The Navigation area contains the following menus:
= File

* Runs

= Clustering

= Analysis

= Unassigned sample setup

= Analysis package

To hide the Navigation area, choose the &5 button at
the top left of the work area. To display the Navigation
area again, choose the = button at the top left of the
work area.

To display the menu commands, choose the n button
next to the menu name. The availability of commands
depends on the status of the project.

About the work area of the development software

Roche Diagnostics

The work area of the development software displays all
data and functions that belong to 1 project.

The work area contains the following elements:
= Tabs
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= Tab navigation buttons
= Buttons
= Cards

( )
T )

D E
A Tabs D Sample setup plate view card
B Tab navigation buttons E Run settings card
C Buttons

Work area of the development software

In the work area, several tabs of the same sort can be
displayed (e.g., several clustering tabs).

You can arrange the tabs in the work area:

= To close a tab, choose its  button.
To display the tab in the work area again, choose its
entry from the corresponding menu in the
Navigation area.

= To display the Start page tab, choose File > [ >
Start page.

= To change the order of the tabs, drag and drop the
tabs horizontally.

= To detach a tab, i.e,, to display the tab in a separate
window, drag and drop the tab vertically.
To reattach the tab, i.e., to display it in the work area
again, close the window and reopen the tab from the
Navigation area.

Roche Diagnostics
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Use the tab navigation buttons to access the tabs:

= To scroll the tabs to the right or left, choose the 4
button or the ®» button, respectively.

= To navigate to a certain tab, choose the i button.
From the drop-down list, choose the tab.

= To close all tabs, choose i > Close all tabs.

The 4 button and the ® button are only available if not
all tabs are visible.

Tabs in the development software

In the development software, the tabs are displayed in
the work area and display the buttons and cards.

In this section

About the tabs in the development software (129)
About the run tabs (130)

About the clustering tabs (131)

About the analysis tabs (134)

About the sample setup tabs (136)

About the analysis package tabs (137)

About the tabs in the development software

Roche Diagnostics

In the development software, a tab groups information
and related software functions that belong to a step of a
development workflow.

It depends on the tab which buttons and cards are
displayed.

All tabs belong to the same project. To save changes on
a tab, you must save the project.

Tabs are listed in the corresponding menu in the
Navigation area.

If the data on a tab needs to be recalculated, the tab
name and the tab entry in the Navigation area are
displayed in italics.

To trigger the recalculation, choose the tab entry from
the Navigation area. If several tabs require recalculation,
choose the tab entries in the sequence of a development
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About the tab commands

About the run tabs

Buttons for editing
Sample setup in plate view
Buttons for plate and table view

0w >

Buttons for run settings, lane settings, and
sample groups

m

Sample setup plate view card
Run settings card

Roche Diagnostics

workflow, i.e., choose the affected tab entries from top to
bottom in the Navigation area. This is because later
steps in the workflow (e.g., an analysis) may be affected
by the recalculation of an earlier step (e.g., a clustering).

To display the tab commands, in the Navigation area,
choose the [B button next to the tab entry in the
corresponding menu. The availability of commands
depends on the status of your project.

There are no tab commands for clustering tabs.

A run tab displays the sample setup after a run, i.e., after
you imported the raw data file of a development run or
diagnostic run into the development software.

By default, the run tabs are named

"RunName (DD.MM.YYYY hh:mm:ss)"

with the date and time when the run was started on the
analyzer.

You can rename the run tabs via the tab commands.

In the Navigation area, the run tabs are listed in the
Runs menu. The run tabs are ordered by run date, with
the oldest run at the top.

You can display the sample setup on the run tab either in
plate view or in table view.

To display the Run settings card, the Lane settings
card, or the Sample groups card, choose the
corresponding button.

Merged nanowell plate lanes are still processed
separately. Therefore, each merged lane is listed
individually on a run tab.

*& Sample setups in plate view (150)

»& List of naming placeholders (154)

*@ Plate view and table view in the development
software (138)
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Clustering data card
Scatter plots card
Clustering method indicator

o0 W >

Buttons for display options

Overview of the software components

*& Runs in the development software (309)

A clustering tab displays the clustering for one
combination of master mix reagent and nanowell plate
type across all runs of a project.

E Button to display the Settings combo box
F Highlighted sample
G Scatter plot from 1 nanowell plate lane

Clustering tab in the development software

Roche Diagnostics

The clustering tabs are named
"MMXx - PlateType".

In the Navigation area, the clustering tabs are listed in
the Clustering menu. The clustering tabs are listed in
the order they were added to the project, with the oldest
clustering at the top.

There are no menu commands for the Clustering menu
and no tab commands for the clustering tabs.
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About the clustering data table

About the scatter plots

About the clustering method indicator

About the display options

Wiew

Roche Diagnostics

Merged lanes are listed individually on a clustering tab
and their scatter plots are displayed separately.

»& List of naming placeholders (154)

»@ Clustering in the development software (338)

The clustering data table on the Clustering data card
displays the samples included in the clustering.

When you mouse over an entry in the clustering data
table, the entry and the corresponding scatter points in
the scatter plots are highlighted in green.

»@ List of columns on the Clustering data card (339)

The scatter plots on the Scatter plots card display the
fluorescence intensity of each nanowell as separate
scatter points. The scatter plot for each nanowell plate
lane is displayed separately in a rectangular area.

The axes of the scatter plots depend on the selected
scatter plot type (1D, 2D, or 3D).

The buttons above the scatter plots allow you to adjust
the display of the scatter plots.

*&l Changing the display options for the scatter plots in
the development software (341)

The clustering method indicator displays the currently
applied clustering method.

For the Manual clustering method, the Threshold
button, the Lasso button, and the Spider button are
displayed below the clustering method indicator.

To adjust the display, choose the buttons above the
scatter plots:

The Table button displays or hides the Clustering data
card.

Alternatively, choose the x button at the top right of
the Clustering data card.

The View buttons display the scatter plots for the
different channels in 1, 2, or 3 columns.
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The Legend buttons display or hide the dye to target
name mapping and a legend for the color-coding of the
scatter plots.

The Scale buttons display a linear or a logarithmic scale
for the fluorescence axes.

The Heatmap buttons display or hide the scatter plots
as heatmaps.

The heatmaps are color-coded according to the density
of the scatter points:

= green = low density
= red = high density
The Histogram buttons display or hide vertical

histograms of the scatter points to the left of the
corresponding scatter plots.

The histogram displays the intensity distribution of the
fluorescence of the scatter plots:

= x-axis = intensity
= y-axis = number of scatter points

The active option is highlighted in blue. Any change in
the display applies to all scatter plots.

»& Changing the display options for the scatter plots in
the development software (341)

To display the Settings combo box for the clustering
settings, choose the & button.

*& Adjusting the clustering in the development software
(342)
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About the Settings combo box

The Settings combo box displays the current clustering
settings and allows you to change them:

= Clustering method

A— .
B = Clustering parameters

= Scatter plot type

= Channels displayed in the scatter plots

= Axis ranges for the scatter plots
cC— - .

The availability of the clustering parameters depends on
D the selected clustering method.

»@ List of clustering settings in the development

E — software (342)

A Clustering method D Channels

B Clustering E Axis ranges
parameters

C Scatter plot type

About the analysis tabs

An analysis tab displays the analysis results ordered on
separate panels.

By default, the analysis tabs are named
A B ¢ "AbsQuant", "CNV", or "InDel"
C 3 as the analyses and numbered consecutively.

You can rename analysis tabs via the tab commands.

By default, each project contains an Abs Quant - All
analysis and the corresponding analysis tab that cannot
be renamed or deleted.

In the Navigation area, the analysis tabs are listed in the
Analysis menu. The analysis tabs are ordered
alphanumerically.

A Buttons for panels € Button for analysis

B Result | settings *& Analyses in the development software (358)
esults pane

About the panels The results on an analysis tab are displayed on the
following panels:

= Results
= Result overview

Roche Diagnostics
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About the bar charts

A
D
C
A Legend C Bar for target
B Error bars D Indicator for positive

control

Roche Diagnostics

Overview of the software components

= Linkage (for absolute quantification analysis only)
= Statistics

To display a panel, choose the corresponding button.

The panels only display results for samples that are
included in the analysis.

Merged lanes are analyzed together. Therefore, a set of
merged lanes has 1 entry on an analysis tab.

The sample ID in the Sample ID columns on the panels
is a link to the run tab of the run in which the sample
was processed. To display the run tab with the sample
selected, choose the link.

2= Do not choose the link to highlight a row in a
table on the panels. Choose anywhere else in the
row instead.

On the Result overview panel on an analysis tab, you
can display the final quantitative results as bar charts.

For each sample or control that is included in the
analysis, a separate bar chart is displayed.

Each bar chart displays 1 bar per target if there is a valid
final result for the target and the value is inside the range
for displaying quantitative results (if configured).

Each bar includes error bars for the 95% confidence
interval.

For negative or invalid final results, and for results that
are only displayed qualitatively, no bar is displayed.

A legend is displayed above the bar charts on the Graph
card.

Bars that represent a control are marked with the icon
and the color for controls.

To adjust the display of the bar charts, use the field and
buttons above the bar charts. The active option is
highlighted in blue.

Any change in the display applies to all bar charts.
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*& About color-coding of controls (148)
*@ Displaying the bar charts (400)

About the button for the analysis settings To display the Settings combo box for the analysis
settings, choose the #& button.

*& Analyses in the development software (358)

About the Settings combo box

The Settings combo box displays the current analysis
settings and allows you to change them. The analysis
settings are ordered on the following tabs:

=  Sample selection
= Analysis setup

= Controls

= Internal controls
= Target limits

The availability of the tabs depends on the analysis type.

The availability of settings on a tab depends on the
current settings on the other tabs.

*@ Analyses in the development software (358)

About the sample setup tabs

A sample setup tab displays an unassigned sample setup
before a development run, i.e., a sample setup that is
used to plan a development run and is not yet assigned
to the raw data of a development run.

Roche Diagnostics
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Buttons for editing

Unassigned sample setup in plate view
Buttons for plate and table view

Buttons for run settings and lane settings
Sample setup plate view card

Mmoo W >

Run settings card

About the analysis package tabs

A Breadcrumb B Panel

Roche Diagnostics

Overview of the software components

By default, the sample setup tabs are named
"Sample Setup" and numbered consecutively.

You can rename sample setup tabs via the tab
commands.

In the Navigation area, the sample setup tabs are listed
in the Unassigned sample setup menu.

You can display the unassigned sample setup on the
sample setup tab either in plate view or in table view.

To display the Run settings card or the Lane settings
card, choose the corresponding button.

*& Sample setups in plate view (150)

*@ Plate view and table view in the development
software (138)

*& Unassigned sample setups in the development
software (402)

An analysis package tab displays the current settings for
an analysis package on separate panels and allows them
to be edited.

When you create an analysis package, you must name
the analysis package. By default, the name is appended
with the version number.

You cannot rename an analysis package later.
In the Navigation area, the analysis package tabs are
listed in the Analysis package menu. The analysis

package tabs are ordered alphanumerically.

If you change an analysis package, you must update the
version of the analysis package before you can export it.

If you must update the version, an * is added to the tab
entry in the Navigation area.

*@ Analysis packages in the development software (412)
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About the breadcrumb

At the top of the panels, an analysis package tab always
displays the breadcrumb for the steps that you must
perform in the given order to create an analysis package:

= Edit

* General settings
= Test definition

= MMx settings

To display the panel for a step, choose a button from the
breadcrumb.

Plate view and table view in the development software

About plate view and table view

Roche Diagnostics

In the development software, you can toggle between
plate view and table view on run tabs and sample setup
tabs.

In this section

About plate view and table view (138)
Configuring plate view (139)

In the development software, a sample setup on a run
tab or on a sample setup tab can be displayed in plate
view or in table view.

To toggle between plate view and table view, choose the

=22 button or the || button, respectively.

You can copy and paste lane settings between sample
setups of the same project in the same view.

»& Editing lane settings via copy and paste in the
development software (335)
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About plate view

About table view

Configuring plate view

Roche Diagnostics

Overview of the software components

By default, the development software displays all sample
setups in plate view.

In plate view, 1 column per nanowell plate and 1 tile per
nanowell plate lane is displayed.

To perform an action on a selected tile, choose the tile.

To select several tiles, press Shift or Ctrl while choosing
tiles.

To select all tiles, choose the
the plate view.

button at the top left of

If available, the column footer displays the last 5 digits of
the nanowell plate ID.

By default, the tiles are color-coded according to master
mix reagents.

»& Configuring plate view (139)

In table view, a table with 1 row per nanowell plate lane
is displayed.

In table view, you can configure the visible columns,
search for table entries, and filter the table.

*@ Configuring table columns (142)
*& Working with tables (142)

*& About the positions of nanowell plate lanes in
sample setups (153)

You can configure the display of lane settings and the
color-coding of the tiles in plate view independently for
each sample setup.

The currently displayed lane settings are listed in the
Lane legend group box on the Lane settings card.
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About configuring table view In table view, you can configure which columns are
displayed.

»& Configuring table columns (142)

.

o_ O Sample setup tab or run tab in plate view

» To configure plate view

1 In the development software, in the Navigation area,
choose a run from the Runs menu or an unassigned
sample setup from the Unassigned sample setup
menu.

2 |If the sample setup is displayed in table view, choose
the 222 button.

3 On top of the tab, choose the Edit button.

- The Plate view configuration combo box is
displayed.

4 To adjust the visibility of the lane settings on the tiles,

do the following:

= To hide a lane setting, choose the lane setting
from the Visible lane settings table and choose
the <= button.

= To display a lane setting, choose the lane setting
from the Available lane settings table and
choose the = button.

® A maximum of 3 lane settings can be displayed.
You must hide a lane setting before you can
display another.

5 To adjust the order of the visible lane settings, do the
following:

= To move a lane setting up, choose the lane setting
from the Visible lane settings table and choose
the {p button.

= To move a lane setting down, choose the lane
setting from the Visible lane settings table and
choose the {1 button.

6 To change the color-coding of the tiles, choose an
option from the Lane coloring list:

= Sample ID

= MMx

= Merged lanes
= None

O If you choose the None option, all tiles are
displayed with the same color (dark gray).

7 To reset the tiles to the default layout of lane settings,
choose the Reset rows button.

Roche Diagnostics
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©® The reset does not apply to the project coloring
options.

8 Choose the Confirm button.
= The plate view is updated.
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Common software functions

Working with tables

Configuring table columns

Roche Diagnostics

In this section

Working with tables (142)
Color-coding (148)

Sample setups in plate view (150)
About callouts (154)

List of naming placeholders (154)

The analyzer software, the web application, and the
development software offer similar functions for data in
tables.

In this section

Configuring table columns (142)
Sorting, searching, and filtering tables (143)
Exporting tables as Excel files (146)

You can configure which columns are visible in tables
and in which order the columns are displayed.

You can configure the table columns in the analyzer
software and in the development software.

You cannot hide columns that are marked with an
icon.

» To place table columns via drag and
drop

1 Navigate to a table.

2 To adjust the order of the columns, do the following:
= Choose a column header.
= Drag and drop the column to its new location.

» To configure table columns

1 Navigate to a table.

2 At the top right of the table, choose the ## button.
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3 Choose the Configure columns button.
- The Configure columns callout is displayed.

4 Adjust the visibility of the table columns:

= To display a column, choose the column from the
Available columns table and choose the =
button.

= To hide a column, choose the column from the
Visible columns table and choose the <= button.

@ You cannot hide columns that are marked with an

icon.

5 Adjust the order of the visible columns:
= To move a column to the left in the table, choose
the column from the Visible columns table and
choose the it button.
= To move a column to the right in the table, choose
the column from the Visible columns table and
choose the I} button.

6 To reset the table to the default layout, choose the
Reset columns button.

7 Choose the Confirm button.

Sorting, searching, and filtering tables

About sorting

About searching

Roche Diagnostics

To find entries in a table, you can sort, search, and filter
tables.

In the analyzer software, the web application, and the
development software, you can sort and search tables.

In the analyzer software and the development software,
you can additionally filter tables.

Each table has its own default sort column and sort order
(ascending or descending).

You can custom sort tables by its columns.

Searching is the fastest way to display only the entries in
a table that contain a search term.

The search term is not case-sensitive.
Depending on the table, the search term is applied to

some or all columns that are visible in the table. Hidden
columns are not searched.
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If a search produces no matches, consider if the search
term is only contained in not searchable or hidden
columns.

You cannot search and filter a table simultaneously.
Searching a table disables any previously applied filter.

About filtering Filter a table to reduce the number of entries.

There are 2 types of filters:
= Default filters:

- The analyzer software and the development
software include predefined default filters for
each table.

- For each table, at least the All default filter is
available.

- Default filters are available from the filter drop-
down list above the table.

= Custom filters:
- Custom filters are user-defined.

- You can combine several filter criteria to a
custom filter.

- If you combine several filter criteria for the same
column, they are combined by a logical OR
operator.

- If you combine several filter criteria for different
columns, they are combined by a logical AND
operator.

- You can apply, save, and delete custom filters.
- A saved custom filter is added to the filter drop-
down list and can be applied like a default filter.

You cannot search and filter a table simultaneously.
Filtering a table disables any previously applied search.

» To sort a table

1 Navigate to a table.

2 To sort the table by a column in ascending or
descending order, choose the column header.

= To indicate the custom sorting, < Custom view >
is displayed in the filter drop-down list.

3 To toggle between ascending and descending sort
order, choose the column header again.

» To search a table

1 Navigate to a table.
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2 To display the table entries that contain a search
term, do the following:

= In the field at the top of the table, enter your
search term.

= Choose the / button.
@ If there are no matches, the search term may be

contained in not searchable or hidden columns
only.

3 To display all table entries again, do the following:
= Clear the field.

= Choose the /& button.

= Alternatively, from the filter drop-down list, choose
the All default filter.

» To filter a table

1 Navigate to the table.

2 To display the table entries that fulfill the filter criteria,
from the filter drop-down list, choose the filter.

@ You can apply the default filters or the saved
custom filters.

3 To display all table entries again, from the filter drop-
down list, choose the All default filter.

» To define a custom filter
1 Navigate to a table.

2 To start with an empty custom filter, from the filter
drop-down list, choose the All option.

@ If you choose another filter from the filter drop-
down list, the corresponding filter criteria are
already entered in the custom filter.

3 At the top right of the table, choose the ## button.

4 In the Filter by row, define the filter criterion:
= From the first drop-down list, choose the column.

= From the second drop-down list, choose the
logical condition.

= Depending on table column, from the third drop-
down list, choose the value. Alternatively, in the
field, enter the value.

5 To combine filter criteria, do the following:
= To add a criterion, choose the (%) button.
= To remove a criterion, choose the (=} button.
@ Filter criteria for the same column are combined

by a logical OR operator. Filter criteria for different
columns are combined by a logical AND operator.

6 To filter the table and to test the custom filter, choose

the Apply button.
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O If you apply a custom filter only, the filter will be
lost when you navigate to a different location in
the software. To keep a custom filter permanently,
you must save it.

7 To save the custom filter, do the following:
= Choose the Save button.

= Choose the Save view as field and enter a name
for the filter.

= Choose the Save button.

= The custom filter is added to the filter drop-down
list of the table.

» To delete a custom filter

1 Navigate to a table.

2 From the filter drop-down list, choose the custom
filter.

3 At the top right of the table, choose the ## button.

4 Choose the Delete button.

® You cannot delete a default filter.

= The custom filter is deleted from the filter drop-
down list.

Exporting tables as Excel files

In the analyzer software and the development software,
you can export tables as an XLSX file.

The XLSX file contains the data of the table that is visible
at the time of the export. If you filter a table or hide
columns, the content of the export file will change
accordingly.

In the analyzer software, you can export the XLSX file to
a network share or external storage device. You cannot
save the XLSX file on the analyzer.

It depends on the applications installed on the computer
running the development software if the XLSX file is
displayed directly or if you are asked to save it.

By default, the XLSX file is named
exportYYYYMMDD-hhmmss.xlsx
with the date and time of the export.

»@ List of naming placeholders (154)

@ O Optionally, external storage device, e.g., USB flash
drive
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&

O In the analyzer software:
Access to the panel that displays the table
(depending on user role)

» To export a table as Excel file in the
analyzer software

1 Optionally, to export to an external storage device,
connect the external storage device to the analyzer.

2 In the analyzer software, navigate to the table.

3 At the top of the table, choose the [3] button.
= The Export to Excel dialog box is displayed.

4 Optionally, enter a different file name.

5 To change the export path, choose the [ button.
= The Select folder dialog box is displayed.

6 In the folder browser, navigate to a folder.

7 Choose the Confirm button.

8 In the Export to Excel dialog box, choose the Export
to Excel button.
- The table entries are exported as an XLSX file to

the folder.

9 Optionally, disconnect the external storage device.

» To export a table as Excel file in the
development software

1 Optionally, to export to an external storage device,
connect the external storage device to the computer
running the development software.

2 In the development software, navigate to the table.

3 At the top of the table, choose the [3] button.

= If an application for XLSX files is installed on the
computer, the XLSX file is displayed directly. You
can then save the file from the application.

= If no application for XLSX files is installed on the
computer, you are asked to save the file.
4 |If the Export dialog box is displayed, do the following:
= Navigate to a folder.
= Optionally, enter a different file name.
= Choose the Save button.
= The table entries are exported as an XLSX file.

5 Optionally, disconnect the external storage device.
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Color-coding

The software components of the system share a common
color-coding concept.

If your color vision is impaired, refer to the texts and/or
icons in the software components to obtain the same
information.

In this section

About color-coding of nanowell plates (148)
About color-coding of controls (148)

About color-coding of final results for samples (149)

About color-coding of nanowell plates

About color-coding of controls

Roche Diagnostics

The nanowell plates are color-coded according to
nanowell plate types.

The web application, the partitioning engine software,
the analyzer software, and the development software
adopt the color-coding of the nanowell plate types from
the labels of the nanowell plates:

White:
Universal nanowell plate

Violet:

High resolution nanowell plate
Light-blue:

High sensitivity nanowell plate

Example:
Column footers in sample setups in plate view

*&l Sample setups in plate view (150)

In the software components of the system, controls are
color-coded and have an icon according to the control

type.

The web application, the analyzer software, and the
development software use the following color-coding
and icons for controls:
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Blue:
Negative control

Pink:
Positive control for absolute quantification analysis
Copy number control for CNV analysis

Variant control for indel analysis

Brown:
Wild type control for indel analysis

Orange:
Internal control for absolute quantification analysis

Example:
Tile header for controls in sample setups in plate view

*& Sample setups in plate view (150)

About color-coding of final results for samples

Color-coding for absolute quantification
analysis

Color-coding for CNV analysis

Roche Diagnostics

In the software components of the system, final results of
samples are color-coded.

When a final result is displayed in the web application or
the development software, the result names are
underlaid with the corresponding color.

For diagnostic workflows, the result names for valid final
results, e.g., "Positive" and "Negative", are configurable in
the analysis packages.

»E& About final results (173)

The web application and the development software use
the following color-coding for final results of an absolute
quantification analysis:

Pink:
Positive
Blue:
Negative
Gray:
Invalid

The web application and the development software use
the following color-coding for final results of a CNV
analysis:

Pink:
Low
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Color-coding for indel analysis

Sample setups in plate view

About sample setups in plate view

Roche Diagnostics

Blue:
Normal

Dark pink:
High

Gray:
Invalid

The web application and the development software use
the following color-coding for final results of an indel
analysis:

Pink:
Variant positive

Blue:

Variant negative
Gray:

Invalid

The web application, the analyzer software, and the
development software display sample setups in plate
view.

In the development software, you can also display the
sample setups in table view.

In this section

About sample setups in plate view (150)

About the positions of nanowell plate lanes in sample
setups (153)

A sample setup in plate view is a visual representation of
the compiled nanowell plates for 1 run, and the positions
of the samples and controls on the nanowell plates.
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A Nanowell plate lane D Column footer
letters (A to H)

B Column for nanowell E Tile for nanowell
plate plate lane

C Column header

About the columns of sample setups

Roche Diagnostics

Overview of the software components

A sample setup in plate view consists of the following
elements:

= Letters (A to H) on the left denoting the position of
the nanowell plate lane

= 1 column per nanowell plate with column header and
column footer

= 1 tile per nanowell plate lane, i.e., reaction mixture

A sample setup in plate view can contain up to 12
columns for the 12 nanowell plates that can be
processed in 1 run on the analyzer.

Each column contains 8 tiles for the 8 nanowell plate
lanes on a nanowell plate.

Sample setups in plate view are displayed in the
following locations in the software components:

= On the Sample setup screen in the web application.
= On the Sample setup panel in the analyzer software.

= On the sample setup tabs and on the run tabs in the
development software.

*&l About the Sample setup screen (97)
*& About the Sample setup panel (115)
*& About the run tabs (130)

*& About the sample setup tabs (136)

Each column in a sample setup represents a nanowell
plate that is part of the sample setup.
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C Tile for nanowell
plate lane

A Column header
B Column footer

About the tiles of sample setups

A B C
N
D
F
G H
A Icon for control type E Indicator for
partitioning flag
B Sample ID F Icon for merged

lanes
C Header for control G Analysis package
D Master mix reagent H Icon for notes

Roche Diagnostics

Each column has a column header and a column footer.

The column header displays the position of the nanowell
plate in the sample setup (1 to 12). In the analyzer
software, the column header additionally displays the
position of the nanowell plate in the stack in the
nanowell plate stack drawer, e.g., 1(1).

If available, the column footer displays the last 5 digits of
the nanowell plate ID and is color-coded according to
nanowell plate type.

In the web application and the analyzer software, the
columns for invalidated nanowell plates are grayed out.

»& Color-coding (148)

Each column in a sample setup contains 8 tiles. Each tile
represents a nanowell plate lane, i.e., 1 reaction mixture
that contains a sample or a control.

In the web application and the analyzer software, a tile

displays the following information (if applicable):

= Sample ID

= Tile header for controls with icon and color for control
type

= Master mix reagent

= Analysis package

= lcon for merged lanes

= |con for notes belonging to the nanowell plate lane

= Indicator for partitioning flags
To display a callout with additional information,
mouse over the indicator.

Additionally, the following applies in the web application

and the analyzer software:

= The tiles are color-coded according to master mix
reagent: All nanowell plate lanes that contain the
same master mix reagent have the same color.
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= If there are master mix reagents with the same name
from different analysis packages, they are considered
and colored differently.

= The tiles for unused nanowell plate lanes are white
and empty.

= The tiles for invalidated nanowell plate lanes are
grayed out.

*& About color-coding of controls (148)

In the development software, you can configure which
information is displayed on a tile and how the tiles are
colored.

*@ Configuring plate view (139)

About the positions of nanowell plate lanes in sample setups

The positions of the 96 nanowell plate lanes in a sample
setup are denoted as A1 to H12 in the web application,
the analyzer software, and the development software.

The letters A to H label the 8 nanowell plate lanes on a
nanowell plate. If you place a nanowell plate in front of
you with the barcode label facing to the left, lane A is at
the top of the nanowell plate.

The numbers 1 to 12 identify the positions of the
nanowell plates in a sample setup from left to right.

When combined, the nanowell plate lanes in a sample
setup are denoted in a grid-like fashion:
B = Nanowell plate lane Al is at the top left of the sample
setup.

A Position Al B Position H12 = Nanowell plate lane H12 is at the bottom right of the
sample setup.

When stacking the nanowell plates, the left-to-right
numbering of the nanowell plates in the sample setup
translates to a bottom-to-top numbering in the stack:

= Nanowell plate 1 is at the bottom of the stack.
= Nanowell plate 12 is at the top of the stack.

The position of a set of merged lanes in a sample setup
is denoted by the lowest position of the included
nanowell plate lanes.

Example:

If the nanowell plate lanes A1, B1, and C1 are merged,
the position of the set of merged lanes is denoted as

Roche Diagnostics
Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1



Common software functions

IIA-I ll.
The position is also used as name for the set of merged
lanes.

-Q— The positions of the nanowell plate lanes and sets
of merged lanes are derived from plate view.
However, the same denominations are used
whenever the position is displayed, e.g., in table
view.

About callouts

A callout is a context-specific element that provides
additional information. A callout always points to the
software element it belongs to.

In the analyzer software and the development software, if
the content of a field is missing or invalid, the field is
marked with a red border. To display a callout with
additional information, select the field.

In the web application, the analyzer software, and the
development software, an error indicator is displayed
whenever an error occurs. To display a callout with
additional information, mouse over or choose the error
indicator.

List of naming placeholders

The descriptions of names in this publication use the
following placeholders:

= YYYY = Year
= MM = Month
= DD = Day

= hh = Hours

= mm = Minutes

= ss = Seconds

= SN = Serial number of the analyzer

= BatchName = Name of the batch as given on the
Sample setup screen in the web application (used
as the run name on the analyzer)

= RunName = Name of the run on the analyzer

= PlateType = Type of nanowell plate (i.e., "Uni",
"HiRes", or "HiSens")
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= RunType = Type of the run, i.e., "Diagnostic" or
"Development”

= MMx = Name of the master mix reagent

= TypeOfReport = Type of problem report (i.e., "Basic",
"Advanced", "Extended", or "Complete")
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Consumables

Nanowell plates
\C \D \E

Nanowell plate frame
Nanowell plate lanes
Beveled corner

Label with barcode
Inlet port for lane H

Mmoo w>»

Alignment notch

Roche Diagnostics

Overview of the supplies

Consumables are for single use only. Do not reuse
consumables.

Dispose of consumables according to local regulations.

In this section

Nanowell plates (159)
Liquid waste bottles (160)

Nanowell plates hold the reaction mixtures.

All nanowell plates have the following common

characteristics:

= Nanowell plate frame with alignment notches and
beveled corner for correct stacking and orientation in
the partitioning engine and the analyzer
For handling, touch the long sides of the nanowell
plate frame only.

= 8 nanowell plate lanes with inlet ports for pipetting of
the reaction mixtures
Do not touch the nanowell plate lanes or inlet ports.

= Labels A to H for nanowell plate lanes
If the beveled corner of the nanowell plate is at the
top left, lane A is at the top of the nanowell plate.

= Color-coded nanowell plate label including the
following information:

- Nanowell plate type
- Nanowell plate ID

- Expiry date
Expired nanowell plates cannot be used.

Nanowell plates are available in 3 different types
(universal, high sensitivity, high resolution) that differ in
the number of nanowells per nanowell plate lane and the
input volume.

For the input volumes of the reaction mixtures per
nanowell plate lane, refer to the Instructions for Use of
the nanowell plates.

Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1
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Consumables

Universal nanowell plates

High resolution nanowell plates

High sensitivity nanowell plates

Liquid waste bottles

77}
Ie
=

=

-

77}

[<b)
=
v
(-

(=)

S
IQ

-

(b

>
o
©

Roche Diagnostics

To facilitate the target detection for samples with a low
concentration of target molecules, the software
components allow merged lanes to emulate nanowell
plate lanes with an even higher number of nanowells.

*& About color-coding of nanowell plates (148)

*& About merged lanes (62)

Universal nanowell plates have white labels.

High resolution nanowell plates have violet labels.

High resolution nanowell plates have a higher number of
nanowells per nanowell plate lane and therefore allow for
very accurate quantification of target concentrations.

High sensitivity nanowell plates have light-blue labels.

High sensitivity nanowell plates allow for a higher input
volume per nanowell plate lane and therefore detection
of very low target concentrations.

The liquid waste bottle holds the liquid waste in the
partitioning engine.

Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1 Draft - Do Not Distribute



Overview of the supplies

The fill status of the liquid waste bottle is displayed in the
Liquids panel in the partitioning engine software.

Empty liquid waste bottles are delivered together with the
partitioning engine. They are marked as liquid waste
bottle on the RFID tag.

When a liquid waste bottle is full, discard it together with
the liquid waste. Do not empty and reuse a liquid waste

bottle. Instead, use empty or expired partitioning fluid
bottles as liquid waste bottles.
»& About the Liquids panel (87)

*él Replacing the partitioning fluid bottle and/or the
liquid waste bottle on the partitioning engine (460)
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Reagents and controls

Reagents and controls

IVD kits

Master reagents

Roche Diagnostics

Reagents and controls enable the processing of samples,
the detection of targets, and the monitoring of the
process.

Dispose of reagents and controls according to local
regulations.

In this section

IVD kits (162)

Master reagents (162)
Partitioning fluid (163)

Primers, probes, and dyes (164)
Controls (165)

For IVD workflows, the Roche-provided IVD kits contain
the mandatory master mix reagents (with primers and
probes) and controls.

The IVD kits have a barcode label with the kit ID. You
must enter the kit ID in the sample setup in the web
application.

The IVD kits have an expiry date. You cannot use expired
IVD Kits.

For details about preparing the reaction mixtures, refer to
the Instructions for Use of the IVD kit.

For LDT workflows and development workflows, the
Roche-provided master reagents are the required bases
for the reaction mixtures.
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Overview of the supplies

A DNA master reagent and an RNA master reagent are
available for DNA and RNA applications, respectively.

The master reagents have a barcode label with the
master reagent ID. You can enter the master reagent ID
in the sample setup in the web application and the
development software.

The master reagents have an expiry date. Do not use
expired master reagents.

About preparation

To prepare the master mix reagents, add the primers and

Master reagents probes to the master reagents.
I To prepare the reaction mixtures, add the samples or
+ primers and probes controls to the master mix reagents.

For details about preparing the master mix reagents and
Master mix reagents reaction mixtures, refer to the Instructions for Use of the
| master reagents.

+ samples or controls

Ny

-Q’- The stability of the reaction mixtures between
* partitioning of a nanowell plate and processing it
on the analyzer has been tested for 90 minutes.

Reaction mixtures

Partitioning fluid

The partitioning engine uses the partitioning fluid to
partition the reaction mixtures into the nanowells and to
seal the nanowell plates.

The partitioning fluid is provided in the partitioning fluid
bottle that is loaded into the partitioning engine.

The fill status of the partitioning fluid bottle is displayed
in the Liquids panel in the partitioning engine software.

The partitioning fluid bottle has an RFID tag with the
partitioning fluid ID.

The partitioning fluid has an expiry date and an onboard
stability (60 days).
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Reagents and controls

The partitioning engine monitors the loaded partitioning
fluid for the expiry date and for the onboard stability. You
must exchange the partitioning fluid when the expiry
date or the onboard stability is exceeded (whichever
happens first). You cannot use expired partitioning fluid
on the partitioning engine.

The date when the partitioning fluid will expire is
displayed on the Liquids panel in the partitioning engine
software.

Keep empty or expired partitioning fluid bottles as liquid
waste bottles. The system marks empty and expired
partitioning fluid bottles as liquid waste bottles on the
RFID tag.

*& About the Liquids panel (87)

*& Replacing the partitioning fluid bottle and/or the
liquid waste bottle on the partitioning engine (460)

Primers, probes, and dyes

Primers, probes, and dyes enable target amplification and

detection.

About primers A pair of primers marks the start and the end of the
target nucleic acid sequence to be amplified during the
PCR.

For IVD workflows, the IVD kits contain the primers.

For LDT workflows and development workflows, you
must provide your own primers.

For details about preparing the reaction mixtures, refer to
the Instructions for Use of the IVD kits and the master
reagents.

About probes The probes enable the detection of the amplified target
nucleic acid sequences. The probes contain the dyes that
fluoresce if the target nucleic acid sequence is present.

For IVD workflows, the IVD kits contain the probes.

For LDT workflows and development workflows, you
must provide your own probes.
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Roche Diagnostics
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About dyes

Overview of the supplies

For details about preparing the reaction mixtures, refer to
the Instructions for Use of the IVD kits and the master
reagents.

The dyes are part of the probes. If the target nucleic acid
sequence is present, the dyes fluoresce and can be
detected by the system.

For IVD workflows, the IVD kits contain probes with
system-compatible dyes.

For LDT workflows and development workflows, ensure
that your probes contain system-compatible dyes only.

The following table lists the dyes that can be used with
the system:

Channel Dyes

Channel 1 = Atto425
= Coumarin
= Cyan500

Channel 2 = FAM

Channel 3 = HEX
= VIC

Channel 4 = TexRed
= LCe610
= CFR610

Channel 5 = Cy5
= LC640
= JA270

Channel 6 = Cyb5

#B  System-compatible dyes

You cannot use different dyes that are detected in the
same channel in 1 development run.

Use controls to monitor the workflows, e.g., the reaction
quality, the test and analyzer performance, for pipetting
errors, and for cross-contamination.

The system invalidates the results for samples if the
result of a corresponding control is invalid.
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Reagents and controls

About control types

Roche Diagnostics

= |VD workflows:

- Controls are mandatory.
- Controls are part of the Roche-provided IVD Kkits.
= LDT workflows:

- It depends on the settings in the analysis
packages if the sample setup contains controls.

- Itis the responsibility of the issuers of the
analysis packages to include controls.

- You must prepare your own user-defined controls
in advance.

= Development workflows:

- Itis your responsibility to add controls to the
sample setup.

- You must prepare your own user-defined controls
in advance.

For details about preparing the reaction mixtures, refer to
the Instructions for Use of the IVD kits and the master
reagents.

The supported control types depend on analysis type:
= For absolute quantification analysis:

- Internal controls

- Negative controls

- Positive controls
= For CNV analysis:

- Negative controls

- Copy number controls
= For indel analysis

- Negative controls

- Variant controls

- Wild type controls

Internal controls are measured as a separate target and
are therefore lane-specific:

If the internal control in a nanowell plate lane is invalid,
the system automatically invalidates the final results for
all targets that are tested in that nanowell plate lane.

All other controls are measured as a separate sample
and are therefore target-specific:

If a control for a target is invalid, the system
automatically invalidates the final results for that target
for all samples of the run.
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Overview of orders, run prerequisites, and results

About orders

About order status

Roche Diagnostics

For diagnostic workflows, orders tell the system which
tests to perform on which samples. There are no orders
for development workflows.

An order is the distinct combination of 1 sample ID with
1 test.

If more than 1 test is assigned to the same sample ID,
each combination of sample ID and test constitutes a
separate order.

In a diagnostic workflow, each test belongs to an
analysis package. Therefore, the system can deduce from
the order the analysis package and the nanowell plate
type that must be used.

Orders are exclusively managed in the web application.

The web application gets orders in the following ways:
= Automatically received from an LIS (LIS orders)

= Imported as an orders list

= Manually created in the web application

—‘Q’- The system can also receive orders from AVENIO
Connect as part of an integrated laboratory
workflow. However, AVENIO Connect orders are
hidden in the web application and cannot be
accessed.

The web application can manage orders from all sources
simultaneously. Orders from all sources can be assigned
to the same sample setup if the analysis packages of the
tests specify the same run profile.

On some screens of the web application, 1 row
summarizes all orders that belong to the same sample ID,
are for tests from the same analysis package, and have
the same status.

»&Z About the Orders screen (95)

*@ Ordering in the web application (250)

On the Orders screen in the web application, orders can
be in the following statuses:

* Not allocated
= Allocated

* In process

= Executed

Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1
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170 About orders

About allocation of orders

About LIS orders
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* Released
= Sent

As soon as an order is in Executed status, a result exists
for that order in the web application. An order is in
Released status if the corresponding result is released.
An order is in Sent status if the corresponding result is
sent.

»& About the Orders screen (95)

Orders that are not yet assigned to a sample setup are
called not allocated orders. You can edit and delete
not allocated orders (except LIS orders).

Orders that are assigned to a sample setup are called
allocated orders. You cannot assign allocated orders to
a different sample setup. To edit an allocated order, you
must either delete the sample setup (so that again the
orders are not allocated) or you must create a new not
allocated order.

When you assign orders to a sample setup, the web
application applies the following logic:

= The orders that are summarized by 1 row on the
Orders screen are always assigned to the same
sample setup. You cannot assign the summarized
orders to different sample setups.

= Only orders with the same run profile in the analysis
packages can be processed in 1 diagnostic run and
can be assigned to the same sample setup.

= You can only choose as many orders as can be
processed in 1 diagnostic run, i.e., on 12 nanowell
plates. The web application automatically includes
and counts the required controls.

A batch consists of the orders that are allocated to
1 sample setup. A batch is processed in 1 diagnostic run
on the analyzer.

*& Orders in the web application (250)
»& Sample setups in the web application (255)

In the web application, the following rules apply to LIS

orders:

= When there are 2 versions of the same analysis
package on the system (1 version in Enabled status
and 1 version in In validation status), always the
enabled version of the analysis package is assigned
to LIS orders.
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= On the Orders screen, LIS is displayed in the
Requester name column.

= On the Sample IDs card on the Edit orders screen,
tests from LIS orders are displayed in blue font.

= You cannot delete LIS orders, i.e., you cannot
deassign the test from an LIS order.

= You can add orders for sample IDs that are part of
LIS orders. l.e., you can assign additional tests to a
sample ID that was received as part of an LIS order
(because assigning additional tests to a sample ID
creates new orders and the LIS orders remain
unchanged).

= You must send the results to the LIS (if not done
automatically).
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About run prerequisites

About run prerequisites

Prerequisites for a diagnostic run

Prerequisites for a development run
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You can only start a diagnostic run or a development run
on the analyzer if the corresponding run prerequisites
are met.

You can use different types of nanowell plates together
in 1 run. However, you cannot start a run if nanowell
plates for a diagnostic run and nanowell plates for a
development run are loaded together on the analyzer.

You can only start a diagnostic run on the analyzer if the
following prerequisites are met:

= Preventive maintenance of the analyzer is not
overdue.

= The analyzer is in Analyzer ready status.

= The nanowell plate stack drawer is closed.

= You are logged on with diagnostic operator user role.

= All loaded nanowell plates are in Valid status.

= There is a matching sample setup in Ready to start
run status in the web application:

- All loaded nanowell plates belong to the same
sample setup.

- All nanowell plates of the sample setup except
invalidated nanowell plates are loaded.

= The maximum allowed timespan between partitioning
of the nanowell plates and starting the run on the
analyzer has not elapsed.

*& About the analyzer status indicator (109)
*& About the nanowell plate status (114)

»& Sample setups in the web application (255)

You can only start a development run on the analyzer if
the following prerequisites are met:

= The analyzer is in Analyzer ready status.
= The nanowell plate stack drawer is closed.

= You are logged on with development operator user
role.

= All loaded nanowell plates are in Valid status.

= None of the loaded nanowell plates belong to a
diagnostic sample setup in the web application.

*& About the analyzer status indicator (109)

»& About the nanowell plate status (114)
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About final results

Final results are the outcomes of your workflows.

The system displays final quantitative and final qualitative
results.

The final results for samples consider the corresponding
control results.

About final results for controls A control can have the following final results for a target:

Analysis type Possible final results for controls

Quantitative Qualitative
Absolute quantification = Target concentration [cp/pL] = Valid

= N/A = Invalid
CNV = Copy number of the target of interest = Valid

= N/A = Invalid
Indel = Percentage of variant sequence [%] = Valid

= N/A = Invalid

g8 Possible final results for controls

About final results for samples A sample can have the following final results for a target:
Analysis type Possible final results for samples
Quantitative Qualitative
Absolute quantification = Target concentration [cp/pL] = Negative
= N/A = Positive
= Invalid
CNV = Copy number of the target of interest = Low
= N/A =  Normal
= High
= Invalid
Indel = Percentage of variant sequence [%] = Variant negative
= N/A = Variant positive
= Invalid

#  Possible final results for samples
The final qualitative results for samples are color-coded,
i.e., the result denominations are underlaid with the

corresponding color.

*& About color-coding of final results for samples (149)

Roche Diagnostics
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174 About final results

About results of diagnostics workflows

After an order is processed in a diagnostic workflow, the
corresponding final results are calculated automatically
and displayed on the Results of screen in the web
application.

= If configured, the final quantitative results are
displayed in the Result column (with the
corresponding unit in the Unit column).

= The final qualitative results are displayed in the Final
result column.

The denominations of the final (qualitative) results
depend on the settings in the analysis package.
*& About the Results of screen (100)
*& Results in the web application (263)
About results of development workflows
In the development software, final results are determined

by clustering and analyzing the raw data. Final results are
displayed on the Results panel on the analysis tab.

You can configure the development software to display
the initial results additionally.

*& About the analysis tabs (134)

»& Configuring table columns (142)

*& Analyses in the development software (358)
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About maintenance

Automatic maintenance actions

Manual maintenance actions

Decontamination

Preventive maintenance

Roche Diagnostics

Maintenance overview

Maintenance ensures safe and reliable operation of the
system.

Do not carry out any maintenance actions that are not
described in this publication.

You can schedule automatic archiving and automatic
backups on the system.

*& Scheduling automatic archiving (560)
*& Scheduling automatic backups (566)

You must perform the following maintenance actions
manually:

*@ Replacing the partitioning fluid bottle and/or the
liquid waste bottle on the partitioning engine (460)

»& Cleaning up not allocated orders (466)

»& Performing manual archiving (467) (if automatic
archiving is not configured or fails)

»& Performing a manual backup (469) (if automatic
backup is not configured or fails)
»@ Cleaning the partitioning engine (473)

*& Cleaning the analyzer (476)

If the inside of the partitioning engine or the inside of the
analyzer may be contaminated, contact your Roche
Service representative.

If the nanowell plate drawer of the partitioning engine
may be contaminated, decontaminate the nanowell plate
drawer.

If the nanowell plate stack drawer of the analyzer may be
contaminated, decontaminate the nanowell plate stack

drawer.

If the aspiration needle of the partitioning engine may be
contaminated, decontaminate the aspiration needle.

»& Decontamination (478)

Your Roche Service representative performs preventive
maintenance.
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*€l About preventive maintenance (482)
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Specifications

System specifications

In this section

General specifications (181)

Electric power supply (182)

Environmental conditions for the system (183)
Dimensions and weight (183)

Required space (184)

Radio equipment specifications (185)
Supported characters in ASTM messages (185)

List of available consumables and reagents (186)

General specifications

In this section

General specifications of the system (181)
General specifications of the analyzer (181)

General specifications of the partitioning engine (182)

General specifications of the system

The system has the following general specifications:

Noise emission |< 60 db (A)

B8 General specifications of the system

General specifications of the analyzer

The analyzer has the following general specifications:

Throughput Up to 3.5 hours
for 1 to 6 nanowell plates

Up to 5 hours
for 7 to 12 nanowell plates

#8 General specifications of the analyzer

Roche Diagnostics
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System specifications

General specifications of the partitioning engine

The partitioning engine has the following general

specifications:
Throughput Up to 5 minutes

for 1 nanowell plate

Up to 60 minutes
for 12 nanowell plates

E8  General specifications of the partitioning engine

Electric power supply

In this section

Electric power supply for the analyzer (182)
Electric power supply for the partitioning engine (182)

Electric power supply for the analyzer

The electric power supply for the analyzer must fulfill the
following requirements:

International (Europe) US / Canada

Voltage 100-240 V AC % 10%

Frequency 50-60 Hz

Current 15-6.25 A

Installation Installation category Installation Category Il (IEC 61010-1)
Protection class Protection Class |

g8  Electric power supply for the analyzer

Electric power supply for the partitioning engine

The electric power supply for the partitioning engine
must fulfill the following requirements:

International US / Canada
(Europe)

Voltage 24V DC

Current 4 A

R Electric power supply for the partitioning engine
The power supply (AC adapter) of the partitioning engine

must fulfill the following requirements:

Roche Diagnostics
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Specifications

International (Europe) US / Canada

Input voltage 100-240 V AC £ 10%

Input frequency 50-60 Hz

Input current 1.6 A

Output voltage 24V DC

Output current 5A

Installation Installation category Installation Category Il (IEC 61010-1)
Protection class Protection Class |

#8  Power supply (AC adapter) of the partitioning engine

-‘Q’- Only use the power supply (AC adapter) that is
delivered together with the partitioning engine.

Environmental conditions for the system

The location must comply with the following conditions:

International (Europe) US / Canada

Ambient temperature During operation 1510 30 °C 59 to 86 °F
During storage 51040 °C 4110 104 °F
During transportation -20to 60 °C -4 10 140 °F
Ambient humidity During operation 20 to 80% (non-condensing)
During storage 15 to 85% (non-condensing)
During transportation 10 to 90% (non-condensing)
Altitude above sea level Up to 2000 m Up to 6561 ft
Pollution degree 2

ER  Environmental conditions

Never operate the system if one of the environmental
conditions is not fulfilled.

Other environmental conditions = Indoor use only
= Horizontal installation space
= Dust-free environment with adequate ventilation
= No direct sunlight
= No perceptible vibration

= No equipment generating electromagnetic waves in
the near vicinity

= No machines discharging ultrahigh frequencies (e.g.,
electric discharger)

Dimensions and weight

Roche Diagnostics
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System specifications

In this section

Dimensions and weight of the analyzer (184)

Dimensions and weight of the partitioning engine (184)

Dimensions and weight of the analyzer

The analyzer has the following dimensions and weight:

International uUs
(Europe)
Height 90 cm 35.4in
Width 100 cm 39.4in
Depth 60 cm 23.6in
(without monitor)
Weight 200 kg 440 Ibs

B8 Dimensions and weight of the analyzer

Dimensions and weight of the partitioning engine

Required space

Space required around the analyzer

Roche Diagnostics

The partitioning engine has the following dimensions and
weight:

International us
(Europe)
Height 25 cm 9.8in
Width 25cm 9.8in
Depth 30 cm 11.8in
Weight 11 kg 24 |bs

B8 Dimensions and weight of the partitioning engine

In this section

Space required around the analyzer (184)

Space required around the partitioning engine (185)

Do not operate the analyzer if there is insufficient free

space around it.
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Specifications

International us
(Europe)
Front 30 cm 12in
Back 0cm 0in
Left side 50 cm 20in
Right side 30 cm 12in
Top 50 cm 20in

BB Space required around the analyzer

Space required around the partitioning engine

Do not operate the partitioning engine if there is
insufficient free space around it.

International us
(Europe)
Front 20 cm 8in
Back 10 cm 4in
Left side 0cm 0in
Right side 30 cm 12in
Top 20 cm 8in

B Space required around the partitioning engine

Radio equipment specifications
The partitioning engine contains radio equipment:

Partitioning engine

Frequency 13.56 MHz
Maximum radio-frequency < 500 mW
power

Number of RFID readers 1 (MUX 1to2)
Number of RFID antennas 2

#8 Radio equipment specifications of the partitioning engine

Supported characters in ASTM messages

The system uses CP-1252 (code page 1252) to encode
and decode ASTM messages. Characters outside of code
page 1252 (e.g., Unicode characters) are not supported
and are replaced by a "?" (question mark) in ASTM
messages.
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System specifications

If you connect the system to an LIS via the ASTM
protocol, only use characters in the range of 0x21
(exclamation mark "!") to 0x7D (closing curly bracket "}")
of the CP-1252 character encoding for sample IDs.

List of available consumables and reagents

Below is a list of globally available consumables and
reagents. For ordering information, contact your local
sales representative.

Image of product Product name

Digital LightCycler® Universal Nanowell Plate

Digital LightCycler® High Resolution Nanowell Plate

Digital LightCycler® High Sensitivity Nanowell Plate

Digital LightCycler® Partitioning Fluid

Digital LightCycler® Waste Bottle

Digital LightCycler® 5x DNA Master

Digital LightCycler® 5x RNA Master

BB Available consumables and reagents

Roche Diagnostics
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Computer specifications

In this section

Specifications

Specifications for the development software (187)

Specifications for the web application (187)

Specifications for the development software

Computer Operating system: Windows 10
Intel i5 processor Intel i7 processor or higher
8 GB RAM 16 GB RAM or more
Monitor resolution 1366 x 768 1920 x 1080

ER Specifications for the development software

Specifications for the web application

Browser

Firefox ESR 91.1.0

Monitor resolution

1920 x 1080

#R  Specifications for the web application

Roche Diagnostics
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Overview of routine tasks

Overview of diagnostic workflow

Diagnostic workflow
_ “ o application

Get orders

Create and confirm
sample setup

= Prepare reaction Create sample setup
mixtures < report

= Pipette nanowell plates
L» H Partition nanowell plates
Load analyzer

v Verify sample setup

Start run

Unload analyzer

R

Release results

Send results

Create result report
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Overview of development workflow without unassigned sample setup

Overview of development workflow without
unassigned sample setup

Development workflow without unassigned sample setup
_ Development software Partitioning engine

= Plan development run Partition nanowell plates
= Prepare reaction

mixtures >
= Pipette nanowell plates

o

Load analyzer

= Provide run profile and
detection formats
= Start development run

= Unload analyzer
= Export raw data file

= Open or create project
= Import raw data file <
= Add lane settings

¥ - Adjust clustering
= Perform analyses

:

Review results

.ooooooooocoo.ooooooooooooocoooooooocoo.oooocoooo>

= Create or update
analysis package
= Export analysis package
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Overview of routine tasks

Overview of development workflow with
unassigned sample setup

Development workflow with unassigned sample setup
Development software Partitioning engine Analyzer
Development operator

- Open or create project

= Create unassigned
sample setup

= Create sample setup
' report

= Prepare reaction Partition nanowell plates
mixtures .

= Pipette nanowell plates ]

Load analyzer

= Provide run profile and
detection formats
= Start development run

= Import raw data file yAN - Unload analyzer
= Assign sample setup - = Export raw data file
to run

= Adjust clustering
= Perform analyses

® 0000000000000000000000000000000000000000000000000000000000000000000 ¢°

Review results

©0000000000000000000000000000000000000000000000000000 0 °

= Create or update
analysis package
= Export analysis package
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Diagnostic workflow (quick reference)

Diagnostic workflow (quick reference)

To create and import an orders list, do the
following:

1 Web application
If orders are not exclusively
received from an LIS:
Create and import the orders
list and/or create the orders.

1.
2.

5.

Create a CSV file for the orders.

In the Orders column on the dashboard,
choose the View orders tile.

On the Orders screen, choose the Import
order list button.

Navigate to the orders list and choose the
Open button.

In the dialog box, choose the Confirm button.

To create the orders manually, do the following:

1.

6.

In the Orders column on the dashboard,
choose the Create sample setup tile.

On the Orders screen in assignment mode,
choose the Add/edit order button.

On the Add sample ID card on the Edit
orders screen, choose the Sample ID field.
Scan or enter the sample ID and choose the
Add button.

On the Sample IDs card, select the sample
ID.

On the Analysis package and test card,
assign complete analysis packages, or expand
the analysis packages and assign selected
tests only.

Choose the Save button.

»& Ordering in the web application (250)

2 Web application
Create the sample setup.

1.

4.

In the Orders column on the dashboard,
choose the Create sample setup tile.

On the Orders screen in assignment mode,
select the first row of orders for the sample
setup.

Select the other rows of orders for the sample
setup.

Choose the Assign to sample setup button.

»& Creating sample setups in the web

application (255)

g Diagnostic workflow (quick reference)
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Overview of routine tasks 197

Step Description

3 Web application @ On the Sample setup screen, do the
Erterl%r scan the nanowell - following for each nanowell plate:
plate IDs.
1. To display the Plate: combo box, choose the
column header twice.
2. Inthe Plate ID field, scan or enter the
T nanowell plate ID.
Sy 3. Choose the Confirm button.
=
4 Web application | e & If required, on the Sample setup screen, do the

If required, enter or scan the e
kit IDs and/or enter sample o

following for each nanowell plate lane:

1. To display the Sample settings: combo box,

notes. P
. . choose the tile twice.
— 2. Optionally, in the Notes field, enter sample
O notes.
- 3. If required, in the Kit No. field, scan or enter
R the kit ID.
= 4. Choose the Confirm button.
5  Web application o — " 1. On the Sample setup screen, choose the #*
Optionally, change the batch button.

name and/or enter run notes.
2. In the Run information dialog box, change

the batch name and/or enter run notes.

3. Choose the Confirm button.

Confirm the sample setup.

6 Web application 1. On the Sample setup screen, choose the

Confirm button.

Web application
Create the sample setup
report.

In the Sample setups column on the
dashboard, choose the batch tile.

2. On the Sample setup screen, choose the
Generate report button.

3. Choose to open or to save the file, and choose
the Confirm button. If required, navigate to a
folder and choose the Save button.

4. On the Sample setup screen, choose the
Confirm button.

5. Print the sample setup report as a guide for

pipetting.

'@ Creating sample setup reports in the web
application (259)

g8 Diagnostic workflow (quick reference)
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Diagnostic workflow (quick reference)

Step Description

8 Prepare the reaction mixtures. 1. Prepare the reaction mixtures.

2. Refer to the sample setup report to identify
the nanowell plates and to allocate the
reaction mixtures to the nanowell plate lanes.

For details about preparing the reaction mixtures
and pipetting, refer to the Instructions for Use of
the reagents and controls.

9 Partitioning engine 1. Pipette the reaction mixtures into the inlet
Pipette and partition the ports of the first nanowell plate.

nanowell plates.

P 2. Choose the Load button.

3. Place the nanowell plate in the nanowell plate
drawer.

4. Choose the Start button.

5. When the nanowell plate drawer opens, check
that all nanowell plate lanes that contain
reaction mixtures are partitioned.

6. Remove the nanowell plate.

7. Place the nanowell plate on a flat and clean
surface.

8. Pipette and partition the other nanowell
plates.

9. Stack the partitioned nanowell plates.

*@ Partitioning the nanowell plates (221)

10 Analyzer 1. In the global information area, choose the (£}
Load the analyzer. button.

2. Place the nanowell plate stack in the nanowell
plate stack drawer.

3. Choose the [Z) button.
»@l Loading the analyzer (225)

11  Analyzer 1. On the Sample setup panel, verify the
Verify the sample setup and displayed sample setup against the sample
start the run. setup report.

2. Choose the Start run button.

12 Web application 1. In the Run in progress column on the
Optionally, enter run notes. dashboard, choose the # button on the
batch tile.

2. Enter the run notes.
3. Choose the Confirm button.

*@ Entering run information for a diagnostic run
in the web application (261)

g8 Diagnostic workflow (quick reference)
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Overview of routine tasks

Step Description

13 Analyzer 1. When the run is finished, in the global
Unload the analyzer. information area, choose the (2] button.

2. Remove the nanowell plate stack from the
nanowell plate stack drawer.

3. Choose the (£} button.

4. Dispose of the nanowell plates according to
local regulations.

*& Unloading the analyzer (227)

14 Web application If the analyzer is not configured for

If reéluti]md- rellease and/or automatic release of results, release the
send the results. reSUItS:

1. In the Results column on the dashboard,
choose the batch tile.

2. On the Results of screen, review the results.

3. Choose the Samples column.

4. Choose the results from the list and choose
the Release button.

5. In the Confirmation dialog box, enter your
password and choose the Release button.

*@l Releasing results manually in the web
application (265)

If the analyzer is not configured for
automatic sending of results, with diagnostic
approver user role, send the results:

1. In the Results column on the dashboard,
choose the batch tile.

2. On the Results of screen, choose the
released results from the list and choose the
Send button.

3. In the Confirmation dialog box, enter your
password and choose the Send button.

»@ Sending results manually in the web
application (267)

15 Web application 1. In the Results column on the dashboard,
Optionally, create the result choose the Completed batches tile.
report.

2. Choose the batch from the list and choose the
View button.

3. On the Results of screen, choose the Report
button.

»& Creating result reports in the web application
(268)

g8 Diagnostic workflow (quick reference)

& Related topics

= Performing a diagnostic workflow (243)
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Development workflow without unassigned sample setup (quick reference)

Development workflow without unassigned
sample setup (quick reference)

The following table provides you with a quick reference
of how to perform a development workflow without
unassigned sample setup.

*@ For a quick reference for a development workflow
with unassigned sample setup, refer to Development
workflow with unassigned sample setup (quick
reference) (208).

Step Description

1 Prepare the reaction mixtures. 1. Prepare the reaction mixtures.

For details about preparing the reaction mixtures
and pipetting, refer to the Instructions for Use of
the reagents and controls.

2 Partitioning engine 1. Pipette the reaction mixtures into the inlet
Pipette and partition the ports of the first nanowell plate.

nanowell plates.

P 2. Choose the Load button.

3. Place the nanowell plate in the nanowell plate
drawer.

4. Choose the Start button.

5. When the nanowell plate drawer opens, check
that all nanowell plate lanes that contain
reaction mixtures are partitioned.

6. Remove the nanowell plate.

7. Place the nanowell plate on a flat and clean
surface.

8. Pipette and partition the other nanowell
plates.

9. Stack the partitioned nanowell plates.

»@ Partitioning the nanowell plates (221)

3 Analyzer 1. In the global information area, choose the (&)
Load the analyzer. button.

2. Place the nanowell plate stack in the nanowell
plate stack drawer.

3. Choose the [Z) button.
*& Loading the analyzer (225)

4 Analyzer
Verify the nanowell plates and

the sample setup. 1. On the Plates panel, verify that all nanowell

plates have status Valid.

2. Verify the displayed nanowell plates against
the planned sample setup.

3. Choose the Run profile button.

#8 Development workflow without unassigned sample setup (quick reference)
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Overview of routine tasks

Step Description

5  Analyzer To duplicate a run profile, do the following:
Optionally, duplicate or import .
P Yy, Gup P 1. On the Manage run profiles panel, choose a
a run profile. )
run profile.

2. Choose the Duplicate button.

3. In the Edit run profile name dialog box,
enter a name for the run profile.

4. Choose the Save button.

To import a run profile, do the following:

1. On the Manage run profiles panel, choose
the Import button.

2. In the folder browser in the Import run
profiles dialog box, navigate to the folder.

3. In the file browser, choose the run profile.

4. Choose the Import button.

»& Working with run profiles on the Manage run
profiles panel in the analyzer software (299)
6 Analyzer 1. On the Manage run profiles panel, choose
Edit the run profile. an unlocked run profile.

2. Choose the Open button.

3. Optionally, on the Edit run profile panel, edit
the programs.

4. Choose the Detection formats button.

5. In the Detection format combo box, disable
the channels for dyes that are not contained
in any of the master mix reagents. For each
enabled channel, choose the dye from the
drop-down list. Optionally, edit the integration
time. Choose the Save button.

6. Choose the Save button.

»@ Editing run profiles on the Edit run profile
panel in the analyzer software (303)
7  Analyzer To start the run on the Manage run
Start the run. profiles panel, do the following:

1. Choose the run profile

2. Choose the Run button.

To start the run on the Edit run profile
panel:

1. Choose the Run button.

#8 Development workflow without unassigned sample setup (quick reference)
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Development workflow without unassigned sample setup (quick reference)

Step Description

8 Analyzer 1. In the middle of the Monitoring panel, next to

Optionally, change the run the run name, choose the # button.
name and/or enter run notes.
2. In the dialog box, in the Run name field,

enter a new run name.
3. In the Edit notes field, enter run notes.
4. Choose the Confirm button.

»@ Entering run information for a development
run in the analyzer software (307)

9 Analyzer 1. When the run is finished, in the global
Unload the analyzer. information area, choose the (£] button.

2. Remove the nanowell plate stack from the
nanowell plate stack drawer.

3. Choose the (=) button.

4. Dispose of the nanowell plates according to
local regulations.

*& Unloading the analyzer (227)

10 Analyzer If the analyzer is not configured for
I(]; rqul'fed- export the raw automatic export, export the raw data file of
ata file.

the development run:

1. Optionally, to export to an external storage
device, connect the external storage device to
the analyzer.

2. Choose Routine > Development run >
Development results.

3. Choose the run and choose the Export
button.

4. Navigate to a folder and choose the Export
button

5. Optionally, disconnect the external storage
device.

*él Managing raw data files of development runs
in the analyzer software (312)

#8 Development workflow without unassigned sample setup (quick reference)
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Overview of routine tasks

Step Description

11 Development software To open a project:
Create a project or open a
project pro) P 1. On the Start page tab, choose the Open file

button.

2. Navigate to the dpcrPrj file and choose the
Open button.

To create a project:

1. If you exported the raw data file to an external
storage device, connect the external storage
device to the computer running the
development software.

2. In the Windows Explorer, double-click the raw
data file of the development run.

3. To save the project, choose File > i > Save
as. Navigate to a folder, enter a project name,
and choose the Save button.

4. Optionally, disconnect the external storage
device.

»& Working with projects in the development
software (295)

12 Development software If you opened a project, import the raw data
If required, import the raw file of the development run:
data file of the development ]
run. 1. If you exported the raw data file to an external

storage device, connect the external storage
device to the computer running the
development software.

2. From the Navigation area, choose Runs >
B > Import.

3. Navigate to the raw data file and choose the
Open button.

4. Save the project.

5. Optionally, disconnect the external storage
device.

*& Working with raw data files and runs in the
development software (317)

13 Development software 1. Optionally, in the Additional run notes: field,
Optionally, enter run notes. enter run notes.

2. Save the project.

#8 Development workflow without unassigned sample setup (quick reference)
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Development workflow without unassigned sample setup (quick reference)

Step Description

14 Development software 1. On the run tab, choose the Lane settings
Add the lane settings. button.

2. Choose one or several tiles (in plate view) or
rows (in table view).

3. On the Lane settings card, choose the
Sample ID field. Scan or enter the sample ID.
If required, press Enter.

4. Optionally, edit the dilution factor for the
sample.

5. In the MMix field, enter the name of the
master mix reagent.

6. Optionally, enter the ID, the expiry date, and/
or the lot number of the master reagent or the
master mix reagent.

7. Optionally, enter notes and/or sample
preparation notes.

8. Save the project.

*él Adding and editing lane settings of a run in
the development software (325)

15 Development software For each master mix reagent, do the
Edit the target and dye following:
settings.

1. Choose a tile (in plate view) or a row (in table
view).

2. Inthe Target and dye settings table, disable
the dyes that are not contained in the master
mix reagent.

3. Optionally, rename the targets.

4. Save the project.

16 Development software 1. Choose one or several tiles (in plate view) or
Optionally, enter notes. rows (in table view).

2. Choose the Edit notes button or the Edit
sample preparation notes button.

3. In the dialog box, enter the notes.
4. Choose the Save button.

5. Save the project.

#8 Development workflow without unassigned sample setup (quick reference)
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Overview of routine tasks

Step Description

17 Development software 1. On the run tab, choose the Sample groups
Optionally, work with sample button.
groups.

2. Add and/or edit sample groups.
3. Save the project.

*& Working with sample groups in the
development software (328)

18 Development software 1. Choose the clustering from the Clustering
Check and adjust the menu.
clustering.

2. Choose the 2 button.

3. Inthe Settings combo box, adjust the
clustering settings.

4. Choose the £ button.

5. If required, adjust the thresholds. Choose the
Calculate button.

6. Save the project.

*@ Adjusting the clustering in the development
software (342)

#8 Development workflow without unassigned sample setup (quick reference)
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Development workflow without unassigned sample setup (quick reference)

Step Description

19 Development software To add an analysis, do the following:

Perform the analyses.
y 1. From the Navigation area, choose Analysis

> B Choose the analysis type.

2. In the Settings combo box, choose the
samples and choose the Update analysis
button.

3. Optionally, add and/or edit sample groups.

4. On the other tabs in the Settings combo box,
enter the settings required for the analysis

type.
5. Choose the £ button.

6. Save the project.

To edit an analysis, do the following:
1. Choose the analysis from the Analysis menu.
2. Choose the 2 button.

3. In the Settings combo box, edit the analysis
settings.

4. Choose the £ button.
5. Save the project.

*& Analyses in the development software (358)

#8 Development workflow without unassigned sample setup (quick reference)
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Overview of routine tasks

Step Description

20 Development software To create an analysis package:
Optionally, create or update

an analysis package. 1. From the Navigation area, choose Analysis

package > u > Create analysis package.

2. In the Create analysis package dialog box,
enter a name for the analysis package and the
type of nanowell plate. Choose the Confirm
button.

3. On the panels of the analysis package tab,
enter the required information.

4. Choose the analysis package from the
Analysis package menu.

5. Choose H > Update version.

6. In the Increment version number dialog
box, choose the version number and choose
the Update button.

7. Save the project.

To update an analysis package:

1. Choose the analysis package from the
Analysis package menu.

2. On the panels of the analysis package tab,
edit the information.

3. Choose the analysis package from the
Analysis package menu.

4. Choose n > Update version.

5. In the Increment version number dialog
box, choose the version number and choose
the Update button.

6. Save the project.

»él Working with analysis packages (429)

21 Development software 1. Choose the analysis package from the
Optionally, export the analysis Analysis package menu.
package.

2. Choose B > Export.

3. Navigate to a folder that is accessible from the
analyzer and choose the Save button.

»& Working with analysis packages (429)

# Development workflow without unassigned sample setup (quick reference)

& Related topics

= Performing a development workflow without
unassigned sample setup (275)
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Development workflow with unassigned sample setup (quick reference)

Development workflow with unassigned
sample setup (quick reference)

The following table provides you with a quick reference
of how to perform a development workflow with
unassigned sample setup.

*@ For a quick reference for a development workflow
without unassigned sample setup, refer to
Development workflow without unassigned sample
setup (quick reference) (200).

Step Description

1 Development software To open a project:
Create a project or open a
. pro) P 1. On the Start page tab, choose the Open file
project. button

2. Navigate to the dpcrPrj file and choose the
Open button.

To create a project:

1. On the Start page tab, choose the Create
new project button.

2. To save the project, choose File > H > Save
as. Navigate to a folder, enter a project name,
and choose the Save button.

»& Working with projects in the development
software (295)
2  Development software If you opened a project, add an unassigned
If required, create an sample setup to the project:

unassigned sample setup.
1. In the Navigation area, choose Unassigned

sample setup > n > Create new.
2. Save the project.

If you created a project, an unassigned sample
setup is added automatically.

»& Working with unassigned sample setups in
the development software (405)

# Development workflow with unassigned sample setup (quick reference)
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Overview of routine tasks

Step Description

3 Development software 1. On the sample setup tab, from the Plate type
Add the nanowell plates. drop-down list, choose the nanowell plate
type.

2. Optionally, scan or enter the nanowell plate
ID. If required, press Enter.

3. Save the project.

*& Adding run settings and lane settings to
unassigned sample setups in the
development software (406)

4 Development software 1. Choose the Detection formats button.

Set the detection formats. .
2. Disable the channels for dyes that are not

contained in any of the master mix reagents.

3. For each enabled channel, choose the dye
from the drop-down list.

4. To edit the integration times, choose the
Advanced Settings check box and edit the
values in the Integration time (ms) fields.

5. Choose the Save button.
6. Save the project.

*é Adding run settings and lane settings to
unassigned sample setups in the
development software (406)

5 Development software 1. Optionally, in the Additional run notes: field,
Optionally, enter run notes. enter run notes.

2. Save the project.

g8 Development workflow with unassigned sample setup (quick reference)
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Step Description

6 Development software 1. On the sample setup tab, choose the Lane
Add the lane settings. settings button.

2. Choose one or several tiles (in plate view) or
rows (in table view).

3. On the Lane settings card, choose the
Sample ID field. Scan or enter the sample ID.
If required, press Enter.

4. Optionally, edit the dilution factor for the
sample.

5. In the MIMx field, enter the name of the
master mix reagent.

6. Optionally, enter the ID, the expiry date, and/
or the lot number of the master reagent or the
master mix reagent.

7. Optionally, enter notes and/or sample
preparation notes.

8. Save the project.

*é Adding run settings and lane settings to
unassigned sample setups in the
development software (406)

7  Development software For each master mix reagent, do the
Edit the target and dye following:
settings.

1. Choose a tile (in plate view) or a row (in table
view).

2. Inthe Target and dye settings table, disable
the dyes that are not contained in the master
mix reagent.

3. Optionally, rename the targets.

4. Save the project.

8 Development software 1. Choose one or several tiles (in plate view) or
Optionally, enter notes. rows (in table view).

2. Choose the Edit notes button or the Edit
sample preparation notes button.

3. In the dialog box, enter the notes.
4. Choose the Save button.
5. Save the project.
9 Development software 1. In the Navigation area, from the unassigned
Create a sample setup report. sample setup in the Unassigned sample

setup menu, choose [f > Create a sample
setup report.

2. Navigate to a folder. Enter a name for the
sample setup report and choose the Save
button.

»& Creating a sample setup report of an
unassigned sample setup in the development
software (410)
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Overview of routine tasks

Step Description

10 Prepare the reaction mixtures. 1. Prepare the reaction mixtures.

2. Refer to the sample setup report to identify
the nanowell plates and to allocate the
reaction mixtures to the nanowell plate lanes.

For details about preparing the reaction mixtures
and pipetting, refer to the Instructions for Use of
the reagents and controls.

11 Partitioning engine 1. Pipette the reaction mixtures into the inlet
Pipette and partition the ports of the first nanowell plate.

nanowell plates.

P 2. Choose the Load button.

3. Place the nanowell plate in the nanowell plate
drawer.

4. Choose the Start button.

5. When the nanowell plate drawer opens, check
that all nanowell plate lanes that contain
reaction mixtures are partitioned.

6. Remove the nanowell plate.

7. Place the nanowell plate on a flat and clean
surface.

8. Pipette and partition the other nanowell
plates.

9. Stack the partitioned nanowell plates.

*@ Partitioning the nanowell plates (221)

12  Analyzer 1. In the global information area, choose the (£}
Load the analyzer. button.

2. Place the nanowell plate stack in the nanowell
plate stack drawer.

3. Choose the [Z) button.
»@l Loading the analyzer (225)

13  Analyzer 1. On the Plates panel, verify that all nanowell
Verify the nanowell plates and plates are in Valid status.

th le setup.
¢ sample setup 2. Verify the displayed nanowell plates against

the sample setup report.

3. Choose the Run profile button.

#8 Development workflow with unassigned sample setup (quick reference)
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Step Description

14  Analyzer To duplicate a run profile, do the following:
Optionally, duplicate or import .
P y, dup P 1. On the Manage run profiles panel, choose a
a run profile. )
run profile.

2. Choose the Duplicate button.

3. In the Edit run profile name dialog box,
enter a name for the run profile.

4. Choose the Save button.

To import a run profile, do the following:

1. On the Manage run profiles panel, choose
the Import button.

2. In the folder browser in the Import run
profiles dialog box, navigate to the folder.

3. In the file browser, choose the run profile.

4. Choose the Import button.

»& Working with run profiles on the Manage run
profiles panel in the analyzer software (299)
15 Analyzer 1. On the Manage run profiles panel, choose
Edit the run profile. an unlocked run profile.

2. Choose the Open button.

3. Optionally, on the Edit run profile panel, edit
the programs.

4. Choose the Detection formats button.

5. In the Detection format combo box, disable
the channels for dyes that are not contained
in any of the master mix reagents. For each
enabled channel, choose the dye from the
drop-down list. Optionally, edit the integration
time. Choose the Save button.

6. Choose the Save button.

»@ Editing run profiles on the Edit run profile
panel in the analyzer software (303)
16 Analyzer To start the run on the Manage run
Start the run. profiles panel, do the following:

1. Choose the run profile

2. Choose the Run button.

To start the run on the Edit run profile
panel:

1. Choose the Run button.

# Development workflow with unassigned sample setup (quick reference)
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Overview of routine tasks

Step Description

17 Analyzer 1. In the middle of the Monitoring panel, next to

Optionally, change the run the run name, choose the # button.
name and/or enter run notes.
2. In the dialog box, in the Run name field,

enter a new run name.
3. In the Edit notes field, enter run notes.
4. Choose the Confirm button.

»@ Entering run information for a development
run in the analyzer software (307)

18 Analyzer 1. When the run is finished, in the global
Unload the analyzer. information area, choose the (£] button.

2. Remove the nanowell plate stack from the
nanowell plate stack drawer.

3. Choose the (=) button.

4. Dispose of the nanowell plates according to
local regulations.

*& Unloading the analyzer (227)

19 Analyzer If the analyzer is not configured for
I(]; req;fl'red- export the raw automatic export, export the raw data file of
ata file.

the development run:

1. Optionally, to export to an external storage
device, connect the external storage device to
the analyzer.

2. Choose Routine > Development run >
Development results.

3. Choose the run and choose the Export
button.

4. Navigate to a folder and choose the Export
button

5. Optionally, disconnect the external storage
device.

*él Managing raw data files of development runs
in the analyzer software (312)

# Development workflow with unassigned sample setup (quick reference)
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Step Description

20 Development software 1. If the raw data file was exported to an external
Import the raw data file of the storage device, connect the external storage
development run. device to the computer running the

development software.
2. From the Navigation area, choose Runs >
B > Import.

3. Navigate to the raw data file and choose the
Open button.

4. If a match is found, to confirm the assignment
of the unassigned sample setup to the run,
choose the Confirm button.

5. Save the project.

6. Optionally, disconnect the external storage
device.

*& Working with raw data files and runs in the
development software (317)

21 Development software If the unassigned sample setup was not
If required, assign the assigned to the run automatically, assign it
unassigned sample setup to manually:
the run. '

1. Choose the run from the Runs menu.

2. Choose [l > Assign existing sample
setup.

3. Choose the unassigned sample setup and
choose the Confirm button.

4. Save the project.

»& Assigning partially matching unassigned
sample setups to development runs in the
development software (321)

22 Development software 1. On the run tab, choose the Lane settings
Optionally, edit the lane button.
settings.

2. Choose one or several tiles (in plate view) or
rows (in table view).

3. Edit the sample IDs, the dilution factor, the
master mix reagent, and/or the additional
information for the master mix reagent or
master reagent.

4. Edit the target and dye settings.
5. Add notes.
6. Save the project.

*& Adding and editing lane settings of a run in
the development software (325)
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Overview of routine tasks

Step Description

23 Development software 1. On the run tab, choose the Sample groups
Optionally, work with sample button.
groups.

2. Add and/or edit sample groups.
3. Save the project.

*& Working with sample groups in the
development software (328)

24 Development software 1. Choose the clustering from the Clustering
Check and adjust the menu.
clustering.

2. Choose the 2 button.

3. Inthe Settings combo box, adjust the
clustering settings.

4. Choose the £ button.

5. If required, adjust the thresholds. Choose the
Calculate button.

6. Save the project.

*@ Adjusting the clustering in the development
software (342)

#8 Development workflow with unassigned sample setup (quick reference)
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Development workflow with unassigned sample setup (quick reference)

Step Description

25 Development software To add an analysis, do the following:

Perform the analyses.
y 1. From the Navigation area, choose Analysis

> B Choose the analysis type.

2. In the Settings combo box, choose the
samples and choose the Update analysis
button.

3. Optionally, add and/or edit sample groups.

4. On the other tabs in the Settings combo box,
enter the settings required for the analysis

type.
5. Choose the £ button.

6. Save the project.

To edit an analysis, do the following:
1. Choose the analysis from the Analysis menu.
2. Choose the 2 button.

3. In the Settings combo box, edit the analysis
settings.

4. Choose the £ button.
5. Save the project.

*& Analyses in the development software (358)

# Development workflow with unassigned sample setup (quick reference)
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Overview of routine tasks

Step Description

26 Development software To create an analysis package:
Optionally, create or update

an analysis package. 1. From the Navigation area, choose Analysis

package > u > Create analysis package.

2. In the Create analysis package dialog box,
enter a name for the analysis package and the
type of nanowell plate. Choose the Confirm
button.

3. On the panels of the analysis package tab,
enter the required information.

4. Choose the analysis package from the
Analysis package menu.

5. Choose H > Update version.

6. In the Increment version number dialog
box, choose the version number and choose
the Update button.

7. Save the project.

To update an analysis package:

1. Choose the analysis package from the
Analysis package menu.

2. On the panels of the analysis package tab,
edit the information.

3. Choose the analysis package from the
Analysis package menu.

4. Choose n > Update version.

5. In the Increment version number dialog
box, choose the version number and choose
the Update button.

6. Save the project.

»él Working with analysis packages (429)

27 Development software 1. Choose the analysis package from the
Optionally, export the analysis Analysis package menu.
package.

2. Choose B > Export.

3. Navigate to a folder that is accessible from the
analyzer and choose the Save button.

»& Working with analysis packages (429)

# Development workflow with unassigned sample setup (quick reference)

& Related topics

= Performing a development workflow with unassigned
sample setup (283)
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Frequently performed tasks

Partitioning the nanowell plates

Roche Diagnostics

About partitioning information

You must partition the pipetted nanowell plates in the
partitioning engine before you can process them on the
analyzer.

N

-g— The stability of the reaction mixtures between
partitioning of a nanowell plate and processing it
on the analyzer has been tested for 90 minutes.

The design of the drawer of the partitioning engine and
the beveled corner of the nanowell plates ensure the
correct orientation of the nanowell plate in the drawer.

£ CAUTION!

Moving drawer

The nanowell plate drawer of the partitioning engine
opens and closes during operation. An opening drawer
may strike you. A closing drawer may pinch your fingers.

» Keep away from the nanowell plate drawer during
operation.

» Do not try to close the nanowell plate drawer
manually by pushing against it.

» Leave sufficient free space around the partitioning
engine to allow for unobstructed movement of the
nanowell plate drawer.

£ CAUTION!

Improper handling of nanowell plates

Scratches, finger prints, dust, or other artifacts on the
nanowell plate lanes compromise the image integrity,
which may cause incorrect, invalid, or delayed results.

» Do not leave the nanowell plates in the open for any
length of time.

» Do not touch the nanowell plate lanes.

» Handle the nanowell plates by the long sides of their
nanowell plate frames only.

» Wear lab gloves when handling the nanowell plates.
Regularly change the lab gloves.

Directly after partitioning, the partitioning engine sends
the following information to the analyzer it is assigned to
(if the connection is working):

= Nanowell plate ID
= Timestamp
= Serial number of the partitioning engine

Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1 Draft - Do Not Distribute
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Partitioning the nanowell plates

About invalid nanowell plate lanes

)
X
&
S
wd
-
Q
£
T
o
=
O
=
>
wd
=
O
S
=3
O
|
s
F
F

Roche Diagnostics

= Information about the partitioning fluid
= Invalid nanowell plate lanes
= Partitioning flags

Without this information, the validation of the nanowell
plate fails during loading on the analyzer and the
nanowell plate cannot be processed.

In a diagnostic workflow, the information is also sent to
the web application.

In a development workflow, the analyzer includes the
information in the raw data file of the run.

The partitioning engine flags invalid nanowell plate lanes.

If an invalid nanowell plate lane contains a sample, the
final results for all targets will be invalid.

If an invalid nanowell plate lane contains a control, the
final results for all associated targets or samples will be
invalid.

If all partitioned nanowell plate lanes of a nanowell plate
are invalid, the whole nanowell plate is invalid. Do not
load invalid nanowell plates on the analyzer. You cannot
start a run on the analyzer while invalid nanowell plates
are loaded.

For a development run, consider pipetting new nanowell
plates to replace invalid ones.

For a diagnostic run, you cannot replace invalid nanowell
plates.

Dispose of pipetted nanowell plates according to local
regulations.

O Pipetted nanowell plates

O For diagnostic workflow:
Sample setup report from the web application

O For development workflow:
Sample setup report from the development software
(if available) or other planning of development run

O Partitioning engine started, initialized, and primed

»@ Starting up the partitioning engine (231)
»@ Initializing the partitioning engine (505)
*@ Priming the partitioning engine (232)
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Frequently performed tasks

» To partition a nanowell plate

1 Ensure that the connection indicator in the global
information area indicates that the partitioning engine
is connected to the analyzer.

2 On the Plate Setup panel, choose the Load button.
= The nanowell plate drawer opens.

3 Place a pipetted nanowell plate in the nanowell plate
drawer with the beveled corner at the back right.

4 Choose the Start button.

©® Do not try to close the nanowell plate drawer
manually by pushing against it.
- The nanowell plate drawer closes.

- The nanowell plate ID and type are displayed on
the Plate Setup panel.

- The nanowell plate is partitioned.
- The partitioning indicators display the partitioning
status of the nanowell plate lanes.

5 Wait until partitioning of the nanowell plate is finished
and the nanowell plate drawer opens.
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Partitioning the nanowell plates

6 Check the partitioning status of the nanowell plate
lanes by means of the color of the partitioning
indicators:

= Check that the partitioning indicators for all
nanowell plate lanes that contain reaction
mixtures are green or red.

= If partitioning indicators of nanowell plate lanes
that contain reaction mixtures remain gray,
discard the nanowell plate according to local
regulations.

@ The partitioning indicators of nanowell plate lanes
that do not contain reaction mixtures will always
remain gray. You do not need to consider such
nanowell plate lanes.

7 Remove the nanowell plate from the nanowell plate
drawer.

8 Choose the Close button.
- The nanowell plate drawer closes.

9 Do the following with the nanowell plates for a run:
= Place the first partitioned nanowell plate on a flat
and clean surface.

= Stack the partitioned nanowell plates on top of
each other.

Roche Diagnostics
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Loading the analyzer

You must load the partitioned nanowell plates on the
analyzer.

Ny

-g— The stability of the reaction mixtures between
partitioning of a nanowell plate and processing it
on the analyzer has been tested for 90 minutes.

For diagnostic runs, do not load nanowell plates on the
analyzer that you invalidated in the web application. You
cannot start the diagnostic run while invalidated
nanowell plates are loaded.

£ CAUTION!

Moving drawer

The nanowell plate stack drawer of the analyzer opens
and closes during operation. An opening drawer may
strike you. A closing drawer may pinch your fingers.

» Keep away from the nanowell plate stack drawer
during operation.

» Do not try to close the nanowell plate stack drawer
manually by pushing against it.

v

Leave sufficient free space around the analyzer to
allow for unobstructed movement of the nanowell
plate stack drawer.

|‘§| O Partitioned nanowell plates
B .
o— O Analyzer in Analyzer ready status

» To load the analyzer

1 In the analyzer software, choose the (£} button.
= The nanowell plate stack drawer opens.

2 CAUTION! Risk of incorrect, invalid, or delayed
results.
Do not load nanowell plates with unpartitioned
nanowell plate lanes that contain reaction mixtures.
Avoid scratches, finger prints, dust, or other artifacts
on the nanowell plate lanes.

Place the nanowell plate stack in the nanowell plate
stack drawer with the barcode labels facing to the
front of the analyzer.
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©® For diagnostic runs, do not load invalid nanowell
plates on the analyzer.
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Loading the analyzer

3 To close the nanowell plate stack drawer, choose the
(®) button.

@ Do not try to close the nanowell plate stack
drawer manually by pushing against it.

4 Wait until the automatic scanning of the barcode
labels of the nanowell plates is finished.
- The nanowell plates are displayed on the Plates
panel.

n
X
n
@
wd
-
Q
£
1
©
=
O
=
=
wd
=
O
S
=3
O
1
B
F
F

Roche Diagnostics
Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1 Draft - Do Not Distribute




Frequently performed tasks

Unloading the analyzer

Roche Diagnostics

Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1

Unload the analyzer when a run is finished.

Always unload the analyzer before you shut down the
analyzer.

£ CAUTION!

Moving drawer

The nanowell plate stack drawer of the analyzer opens
and closes during operation. An opening drawer may
strike you. A closing drawer may pinch your fingers.

» Keep away from the nanowell plate stack drawer
during operation.

» Do not try to close the nanowell plate stack drawer
manually by pushing against it.

v

Leave sufficient free space around the analyzer to
allow for unobstructed movement of the nanowell
plate stack drawer.

O Run finished (completed or aborted)

O Awaiting plate removal displayed on Monitoring
panel

O Analyzer in Analyzer ready status

» To unload the analyzer

1 When the run is finished, in the global information
area of the analyzer software, choose the (£] button.

= The nanowell plate stack drawer opens.

2 Remove the nanowell plate stack from the nanowell
plate stack drawer.

3 To close the nanowell plate stack drawer, choose the
(=) button.

4 CAUTION! Risk of contamination of the laboratory.
Do not leave nanowell plates in the open for any
length of time.

Pack the used nanowell plates in a resealable plastic
bag.

5 Dispose of the plastic bag containing the used
nanowell plates according to local regulations.

Draft - Do Not Distribute
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Unloading the analyzer
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Before routine operation

Starting up the partitioning engine
You must start up the partitioning engine before use.

@ 5 minutes

» To start up the partitioning engine

1 At the back of the partitioning engine, press the
power switch.

2 Wait until the partitioning engine is initialized and
primed and is in Ready status.

3 Ensure that the connection indicator in the global
information area indicates that the partitioning engine
is connected to the analyzer.
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Priming the partitioning engine

Priming the partitioning engine

You can prime the partitioning engine when required or
on demand.

Priming flushes the fluid system inside the partitioning
engine with partitioning fluid to ensure it is free of air
bubbles.

The partitioning engine primes automatically directly
after startup.

The partitioning engine requires priming after 24 hours
without activity or after shutdown.

When priming is required, the Prime button is available
on the Plate Setup panel.

*&l Overview of the partitioning engine software (83)

At least when required, i.e., when the Prime button is
available
%: O To prime when required:

Prime button available on the Plate Setup panel

O To prime on demand:
Partitioning engine in Ready status

» To prime the partitioning engine

1 To prime the partitioning engine when required, on
the Plate Setup panel, choose the Prime button.
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Before routine operation

2 To prime the partitioning engine on demand, in the
global information area, choose = > Prime
Instrument.

3 Wait until priming is complete and the partitioning
engine is in Ready status.
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Logging on to the web application

Logging on to the web application

You must log on to the web application before use.

To log on to the web application, you need diagnostic
operator user role or diagnostic approver user role.

User accounts are managed in the analyzer software.
You log on to the web application with the same user
account that you use in the analyzer software.

El O User name and password

1 . . . .

o_ O Diagnostic operator user role or diagnostic approver
user role

» To log on to the web application

1 In the Firefox browser, in the Logon dialog box, enter
your user name and password.

O Use the same user account as for the analyzer
software.

2 Choose the Logon button.
= The dashboard of the web application is displayed.
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Before routine operation

Starting up the analyzer

You must start up the analyzer and log on before use.
During startup, the analyzer transfers all loaded nanowell
plates to the nanowell plate stack drawer and displays
the Plates panel. In this case, you must unload the

analyzer before further use.

*él Unloading the analyzer (227)

@ 10 minutes

O User name and password

» To start up the analyzer

1 On the right side of the analyzer, press the power
button.

2 Wait until the analyzer is initialized and is in Analyzer
ready status.

3 Inthe global information area, choose the Logon
button.

4 In the Logon dialog box, enter your user name and
password.

5 Choose the Confirm button.
= The Routine panel is displayed.
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Logging on to the analyzer software

Logging on to the analyzer software

If you logged off from the analyzer software or if you
were logged off automatically, you must log on again
before you can use the analyzer.

E] O User name and password

» To log on to the analyzer software

1 In the global information area of the analyzer
software, choose the Logon button.

2 In the Logon dialog box, enter your user name and
password.

3 Choose the Confirm button.
- The Routine panel is displayed.
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Before routine operation

Change password

In the Change password dialog box, you change your
password.

All users, regardless of their user roles, can change their
own passwords.

The new password applies to the analyzer software and
the web application.

£ CAUTION!

Weak passwords

Weak passwords may allow unauthorized access to the
system, data manipulation or loss, or unauthorized
access to personal information, which may cause
incorrect, invalid, or delayed results.

» Use strong passwords.
» Do not share passwords.
» Do not write down passwords.

» Do not share user accounts.

You can change your password at any time. Alternatively,
the analyzer software or the web application may prompt
you at logon to change your password (depending on
which software component you log on to first).

The new password must conform to the global password
policy configured in Administration > Password
settings. Passwords are case-sensitive.

= Optional:
Anytime
= Mandatory:
When prompted at logon by the analyzer software or
the web application

» To change my password in the
analyzer software

1 In the analyzer software, choose Administration >
Change password.
- The Change password dialog box is displayed.
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Change password

2 Enter your current password. Enter the new password
twice.

@ Passwords are case-sensitive.

3 Choose the Confirm button.

=> The new password applies to the analyzer
software and the web application.

» To change my password at logon in
the analyzer software

1 In the global information area of the analyzer
software, choose the Logon button.

2 In the Logon dialog box, enter your user name and
password.

3 Choose the Logon button.
= The Change password dialog box is displayed.

4 Enter your current password. Enter your new
password twice.

© Passwords are case-sensitive.

5 Choose the Confirm button.

= The new password applies to the analyzer
software and the web application.

» To change my password at logon in
the web application

1 In your Firefox browser, enter the URL of the analyzer
you want to connect to.
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Before routine operation

2 In the Logon dialog box, enter your user name and
password.

@ Use the same user account as for the analyzer
software.

3 Choose the Logon button.
- The Change password dialog box is displayed.

4 Enter your new password twice.

© Passwords are case-sensitive.

5 Choose the Confirm button.

= The new password applies to the analyzer
software and the web application.
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Starting the development software

Starting the development software

You must start the development software before use.

On the start page of the development software, the last
5 projects or raw data files that you worked with are
listed in the Open a recently used file list. The project
or file that you worked with last is listed at the top.

When you open a raw data file from the start page, a new
project for that file is created automatically.

*& Projects in the development software (294)

» To start the development software

1 To start the development software, double-click the
icon on the desktop.

@ Alternatively, start the development software from
the Windows menu.

= The start page of the development software is
displayed.

2 On the start page, do one of the following:

= To create a project, choose the Create new
project button.

= To open a project or raw data file, choose the
Open file button. Navigate to the project or file
and choose the Open button.

= To open a project or raw data file that you recently
worked with, choose the entry from the Open a
recently used file list.

= To open the demonstration project, choose it from
the Demo projects list.

©® When you open a raw data file, a new project for
that file is created automatically.

- The project page of the development software is
displayed.
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Routine operation of diagnostic workflow

Performing a diagnostic workflow

Perform a diagnostic workflow for diagnostic purposes.

In diagnostic workflows, you work with the following
system components:

= Web application
= Partitioning engine
= Analyzer

For diagnostic workflows, you need diagnostic operator
user role, except for sending results you need diagnostic
approver user role.

-‘Q’— Before you can perform a diagnostic workflow, a
user with administrator user role must import and
enable suitable analysis packages in the analyzer
software that include the tests and the nanowell
plate types you want to use for your diagnostic
workflow.

—Q- The procedure below gives an overview of the
steps you must perform in a diagnostic workflow.
For more details, refer to the individual
procedures that are referenced in the steps.

£ CAUTION!

Delayed processing of partitioned nanowell plates

Delayed processing of partitioned nanowell plates on
the analyzer may cause degradation of biological
material and/or invalidation of the nanowell plates,
which may cause incorrect, invalid, or delayed results.

» Only pipette and partition nanowell plates if you can
directly run them on the analyzer afterwards

» Ensure that you start the run directly after loading the
analyzer.

» Observe that there may be a time limit configured in
the analysis packages between partitioning and
processing of a nanowell plate. If the time limit is
exceeded, the nanowell plate is invalidated and
cannot be processed anymore.

El O Nanowell plates (plate types matching the analysis
packages assigned in the orders)
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Performing a diagnostic workflow

&

O Diagnostic operator user role

O To send results manually:
Diagnostic approver user role

O Analysis packages imported and enabled in analyzer
software

» To perform a diagnostic workflow

1 If orders are not exclusively received from an LIS, in

the web application, create and import an orders list

as described in Ordering in the web application (250):

= Create a CSV file for the orders.

= In the Orders column on the dashboard, choose
the View orders tile.

= On the Orders screen in assignment mode,
choose the Import order list button.

= Navigate to the orders list and choose the Open
button.

= In the dialog box, choose the Confirm button.

2 Alternatively, in the web application, create orders
manually as described in Ordering in the web
application (250):
= In the Orders column on the dashboard, choose
the Create sample setup tile.

= On the Orders screen in assignment mode,
choose the Add/edit order button.

= Onthe Add sample ID card on the Edit orders
screen, choose the Sample ID field. Scan or enter
the sample ID and choose the Add button.

= On the Sample IDs card, select the sample ID.

= On the Analysis package and test card, assign
complete analysis packages, or expand the
analysis packages and assign selected tests only.

= Choose the Save button.

©® The web application can manage orders from all
sources simultaneously.

3 In the web application, create a sample setup as
described in Creating sample setups in the web
application (255):
= In the Orders column on the dashboard, choose
the Create sample setup tile.

= On the Orders screen in assignment mode, select
the first row of orders for the sample setup.

= Select the other rows of orders for the sample
setup.

= Choose the Assign to sample setup button.
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- On the Sample setup screen, the unconfirmed
sample setup is displayed in plate view.
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Routine operation of diagnostic workflow

- The column footers are color-coded according to
nanowell plate type.

4 On the Sample setup screen, for each nanowell
plate, assign the nanowell plate IDs:

= To display the Plate: combo box, choose the
column header twice.

= |n the Plate ID field, scan or enter the nanowell
plate ID.

= Choose the Confirm button.

= The column footers display the last 5 digits of the
nanowell plate IDs.

5 If required, on the Sample setup screen, for each

nanowell plate lane, do the following:

= To display the Sample settings: combo box,
choose the tile twice.

= Optionally, in the Notes field, enter sample notes.

= If required, in the Kit No. field, scan or enter the
IVD kit ID.

= Choose the Confirm button.

@ For IVD workflows, ensure that the IVD kits match
the tests in the orders.
For LDT workflows, the Kit No. field is a free text
field, e.g., to track the master mix reagents.

- ® 6 Optionally, on the Sample setup screen, change the
S _ETIET batch name and/or enter run notes as described in
o Entering run information for a diagnostic run in the

web application (261):

e = In the top center of the screen, choose the #

- ' button.

= In the Run information dialog box, change the
batch name and/or enter run notes.

= Choose the Confirm button.
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Performing a diagnostic workflow

7 On the Sample setup screen, choose the Confirm
button.

@ Ensure that you confirm the sample setup.
Otherwise the sample setup is lost when you
leave the Sample setup screen.

= The sample setup is confirmed.

= In the Sample setups column on the dashboard,
the batch tile of the sample setup is displayed in
Pending partitioning status.

8 In the web application, create a sample setup report
as described in Creating sample setup reports in the
web application (259):
= In the Sample setups column on the dashboard,
choose the batch tile.

= On the Sample setup screen, choose the
Generate report button.

= Open or save the sample setup report.

= On the Sample setup screen, choose the
Confirm button.

@ Use the sample setup report as a guide for
pipetting and for verification of the sample setup
in the analyzer software.

9 Prepare the reaction mixtures.

@ For details about preparing the reaction mixtures
and pipetting, refer to the Instructions for Use of
the reagents and controls.

10 Refer to the sample setup report to identify the
nanowell plates and to allocate the reaction mixtures
to the nanowell plate lanes.

@ Ensure that you use the correct nanowell plates.
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Routine operation of diagnostic workflow W1/

11 CAUTION! Risk of incorrect results.
Take care to avoid pipetting errors. If a pipetting error
may have occurred, invalidate the affected nanowell
plate lane in the web application.

Pipette and partition the nanowell plates on the
partitioning engine as described in Partitioning the
nanowell plates (221):

= Pipette the reaction mixtures into the inlet ports of
the first nanowell plate.

= Choose the Load button.

= Place the nanowell plate in the nanowell plate
drawer.

= Choose the Start button.

= When the nanowell plate drawer opens, check

that all nanowell plate lanes that contain reaction
mixtures are partitioned.

= Remove the nanowell plate.

= Place the nanowell plate on a flat and clean
surface.

= Pipette and partition the other nanowell plates.
= Stack the partitioned nanowell plates.

@ The stability of the reaction mixtures between
partitioning of a nanowell plate and processing it
on the analyzer has been tested for 90 minutes.

= In the web application, in the Sample setups
column on the dashboard, the batch tile of the
sample setup is displayed in Ready to start run
status.

12 CAUTION! Risk of incorrect, invalid, or delayed
results.
Do not load nanowell plates with unpartitioned
nanowell plate lanes that contain reaction mixtures.
Avoid scratches, finger prints, dust, or other artifacts
on the nanowell plate lanes.

Load the analyzer as described in Loading the

analyzer (225):
= In the global information area, choose the (&)
button.

= Place the nanowell plate stack in the drawer.
= Choose the (&} button.

©® Do not load invalid nanowell plates on the
analyzer.

= In the analyzer software, the Sample setup panel
is displayed.
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Performing a diagnostic workflow
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13 Verify the displayed sample setup against the sample
setup report from the web application.

14 To start the run, choose the Start run button.

= In the analyzer software, the Monitoring panel is
displayed.

- In the web application, in the Run in progress
column on the dashboard, the batch tile is
displayed in Processing status.

- The expected run duration is displayed in the
analyzer software and in the web application.

15 Optionally, in the web application, enter run notes as
described in Entering run information for a diagnostic
run in the web application (261):
= In the Run in progress column on the dashboard,

choose the # button on the batch tile.
= Enter run notes.
= Choose the Confirm button.

16 CAUTION! Risk of contamination of the laboratory.
Pack the used nanowell plates in a resealable plastic
bag.

When the run is finished, unload the analyzer as
described in Unloading the analyzer (227):

= In the global information area, choose the (&)
button.

= Remove the nanowell plate stack from the drawer.
= Choose the () button.

0 Dispose of the nanowell plates according to local
regulations.

= In the web application, if results must be manually
released and/or sent, the batch tile is displayed in
the Results column on the dashboard.

= In the web application, if results are automatically
released and sent, the batch is automatically listed
on the Completed batches screen. On the
dashboard, no separate batch tile is displayed
anymore.

17 If required, release the results in the web application
as described in Releasing results manually in the web
application (265):
= In the Results column on the dashboard, choose

the batch tile.
= On the Results of screen, navigate to the results.

= Review the results and the corresponding run
information.
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Routine operation of diagnostic workflow

= Select the results from the list and choose the
Release button.

= In the Confirmation dialog box, enter your
password and choose the Release button.

= The results are released.

18 If required, a user with diagnostic approver user role
must send the results in the web application as
described in Sending results manually in the web
application (267):
= In the Results column on the dashboard, choose

the batch tile.

= On the Results of screen, select the released
results and choose the Send button.

= In the Confirmation dialog box, enter your
password and choose the Send button.

- The results are sent.

- If all results are released and sent, the batch is
listed on the Completed batches screen. On the

dashboard, no separate batch tile is displayed
anymore.

19 Optionally, in the web application, create a result
report as described in Creating result reports in the
web application (268):
= In the Results column on the dashboard, choose

the Completed batches tile.

= Choose the batch from the list and choose the
View button.

= On the Results of screen, choose the Report
button.

@ Alternatively, you can create a result report before
you release and/or send the results.

& Related topics
= Diagnostic workflow (quick reference) (196)
= Partitioning the nanowell plates (221)
= Loading the analyzer (225)
= Unloading the analyzer (227)
= Orders in the web application (250)
= Sample setups in the web application (255)

= Entering run information for a diagnostic run in the
web application (261)

= Results in the web application (263)
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Orders in the web application

Orders in the web application

For diagnostic workflows, orders tell the system which
tests to perform on which samples.

In this section

Ordering in the web application (250)
Editing not allocated orders in the web application (252)

Ordering in the web application

About orders lists

Roche Diagnostics

If orders are not exclusively received from an LIS, you
must import an orders list and/or create orders manually
in the web application.

To import an orders list, the file must conform to the
following specifications:

= CSVfile
= Separator: comma
= Header row with following content:

- "SamplelD"
- "AssayName" (the test name)
- "AnalysisPackageName"
- "AnalysisPackageVersion"
= 1 separate row per order (i.e., per combination of
sample ID and test, regardless of analysis package)

= The sample ID can consist of 1 to 25 characters
= The test name can consist of 1 to 30 characters

Importing an orders list fails in the following cases:

= If any row in the orders list is incomplete or contains
errors, e.g., spelling errors in the names of tests or
analysis packages.

= |If there is a problem with the referenced analysis
packages:

- Avrreferenced analysis package does not exist on
the system or is in Disabled status.

- The version of a referenced analysis package
does not match the version of the analysis
package on the system.

- An ordered test is not contained in the referenced
analysis package.

Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1 Draft - Do Not Distribute



Routine operation of diagnostic workflow

= If the orders list contains duplicate orders.

= |If there is already a not allocated order in the web
application that matches an order in the orders list.

If the import fails for 1 order of the orders list, no order is
imported from the orders list.

El O Suitable analysis package in Enabled status (or in In
validation status)

O To import orders list:
CSV file with required content

o— O Diagnostic operator user role

» To import an orders list into the web
application

1 Create a CSV file for the orders. Save the file in a
folder that is accessible from the web application.

2 In the web application, in the Orders column on the
dashboard, choose the View all orders tile.

- The Orders screen is displayed with assignment
mode disabled.

3 Choose the Import order list button.

4 Navigate to the orders list and choose the Open
button.

5 In the dialog box, choose the Confirm button.

@ If the import fails for 1 order from the orders list,
the import fails for all orders. No orders are
imported.

= 1 order is created for each distinct combination of
sample ID and test.

- The orders are displayed as summarized entries
on the Orders screen.

- On the dashboard, the Create sample setup tile
lists the number of not allocated orders.

» To create orders manually in the web
application

1 In the web application, in the Orders column on the
dashboard, choose the Create sample setup tile.

- The Orders screen in assignment mode is
displayed.

=
Qo
=
=L
} &5
=)
S
Q
I:
(/7]
)
s
(o))
3
5=
-
(@)
c
=)
I;
©
| S
Q
=
(@)
[<b)
c
I;
-
Q
(o'
™
F

Roche Diagnostics
Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1 Draft - Do Not Distribute




Orders in the web application

2 Choose the Add/edit order button.
- The Edit orders screen is displayed.

3 To add the sample IDs, do the following:

= On the Add sample ID card, choose the Sample
ID field.

= Scan or enter the sample ID.
= Choose the Add button.

©® The sample ID can consist of 1 to 25 characters.
Do not press Enter after entering the sample ID.
The Enter key does not work.

= The sample ID is added to the Sample IDs card.

- If there are already not allocated orders for the
same sample ID, all already assigned tests and
analysis packages are displayed on the Sample
IDs card. Tests of LIS orders are displayed in blue
font.

4 To assign the tests to the samples IDs, do the

following:

= On the Sample IDs card, select the sample ID.

= On the Analysis package and test card, assign
complete analysis packages, i.e., all tests of the
analysis packages. Alternatively, expand the
analysis packages and assign selected tests only
(if possible).

® You can assign the same tests to multiple sample
IDs at the same time. Alternatively, you can assign
the tests individually to each sample ID.

5 Choose the Save button.

= 1 order is created for each distinct combination of
sample ID and test.

= The orders are displayed as summarized entries
on the Orders screen.

= On the dashboard, the Create sample setup tile
lists the number of not allocated orders.

Editing not allocated orders in the web application
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In the web application, you can edit not allocated orders
except LIS order, i.e., orders that are not yet assigned to a
sample setup.
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Routine operation of diagnostic workflow

You edit orders by assigning and/or deassigning tests
from sample IDs.

Because an order is the combination of a sample ID and
a single test, editing orders results in the following:

= If you assign an additional test to a sample ID, you
create an additional order for the same sample ID.

= If you deassign a test from a sample ID, you delete
the order.

For LIS orders, the following applies:

= You cannot delete LIS orders in the web application.
To delete LIS orders, contact your LIS administrator.

= You can assign additional tests to sample IDs that
were received with an LIS order (because assigning
additional tests creates new orders and the LIS orders
remain unchanged).

To edit already allocated orders, you must delete the
sample setup in the web application so that the orders
are not allocated again.

*@ Deleting sample setups in the web application (445)
E— O Not allocated, editable orders in the web application
O Diagnostic operator user role

» To edit not allocated orders

1 In the web application, in the Orders column on the
dashboard, choose the Create sample setup tile.
= The Orders screen in assignment mode is

displayed.
- The table lists all not allocated orders.

2 From the table, select the row of orders that you want
to edit.

@ A row can summarize several orders.

3 Choose the Add/edit order button.
- The Edit orders screen is displayed.

= The sample IDs and their assigned tests are
displayed on the Sample IDs card.
Tests of LIS orders are displayed in blue font.

4 To create additional orders for a sample ID, assign
additional tests to the sample ID:

= Onthe Sample IDs card, select the check box of
the sample ID and clear the check boxes of all
other sample IDs.
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Orders in the web application

= On the Analysis package and test card, assign
complete analysis packages, i.e., all tests of the
analysis packages. Alternatively, expand the
analysis packages and assign selected tests only
(if possible).

@ You can create orders for sample IDs that were
received as part of an LIS order.

5 To delete orders for a sample ID, deassign tests from
that sample ID:

= Onthe Sample IDs card, select the check box of
the sample ID and clear the check boxes of all
other sample IDs.

= On the Analysis package and test card,
deassign complete analysis packages, i.e., all tests
of the analysis packages. Alternatively, expand the
analysis packages and deassign selected tests
only (if possible).

@ You cannot delete LIS orders.

6 Choose the Save button.

= The orders are added to and/or deleted from the
rows on the Orders screen.

- |If all orders for a sample ID were deleted, there is
no row for that sample ID on the Orders screen
anymore.

- On the dashboard, the Create sample setup tile
lists the number of not allocated orders.
& Related topics
= Sample setups in the web application (255)
= Results in the web application (263)
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Routine operation of diagnostic workflow

Sample setups in the web application

A sample setup in the web application comprises the
orders that are processed together in a diagnostic run on
the analyzer.

In this section

Creating sample setups in the web application (255)
Editing sample setups in the web application (258)

Creating sample setup reports in the web
application (259)

Creating sample setups in the web application

To determine which orders are processed in 1 diagnostic
run on the analyzer, you must create a sample setup in
the web application.

You create a sample setup by assigning orders and
nanowell plates to the sample setup. The web application
automatically includes the required controls in the
sample setup.

The orders that are allocated to a confirmed sample
setup comprise 1 batch, are in Allocated status, and are
processed in 1 diagnostic run on the analyzer.

When a sample setup is confirmed, a corresponding
batch tile is automatically created in the Sample setups
column on the dashboard. If a sample setup is deleted
again, the corresponding batch tile is deleted as well.

By default, a sample setup and its batch tile are named
"Batch_YYMMDDhhmmss"
with the date and time the sample setup was created.

The name of the sample setup is later used as the run
name on the analyzer.

You can combine different analysis packages and
different nanowell plate types in 1 sample setup if the
analysis packages use the same run profile.

You can only start a diagnostic run on the analyzer if a
sample setup exists for the loaded nanowell plates.

S
Qo
=
=
} &5
=)
S
Q
I;
(/7]
)
s
(=)
3
=]
-
(@)
c
)
=
«
}
Q
=
(@)
[<b)
c
=
-
Q
o'
™
F

»E About the batch tiles (93)
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Sample setups in the web application

*@ List of naming placeholders (154)
»& Prerequisites for a diagnostic run (172)

E] O Orders in the web application (received from LIS,
imported as orders list, and/or added manually)

o— O Diagnostic operator user role

» To create a sample setup in the web
application
1 In the web application, in the Orders column on the
dashboard, choose the Create sample setup tile.
- The Orders screen in assignment mode is
displayed.
- The table lists all not allocated orders.

2 From the table, select a row of orders that you want to
assign to the sample setup.

- The table is filtered automatically for orders that
can be processed in the same diagnostic run.

3 Select the other rows of orders that you want to
assign to the sample setup.

@ You can only choose as many orders as can be
processed on 12 nanowell plates. The web
application automatically counts the required

controls.
| et o i e | 4 Optionally, for an overview of the selected orders, do
the following:
: :: _"_'_ ) -: = To display the Selected orders dialog box,
B S S choose the Selection overview button at the
- bottom right of the table.
' = To return to the Orders screen, choose the Back
button.

5 Choose the Assign to sample setup button.

- The unconfirmed sample setup is created and
displayed in plate view on the Sample setup
screen.

- The web application automatically includes the
required controls in the sample setup.
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Routine operation of diagnostic workflow

6 CAUTION! Risk of compromised image integrity.
Avoid scratches, finger prints, dust, or other artifacts
on the nanowell plate lanes.

For each nanowell plate of the sample setup, do the

following:

= To display the Plate: combo box, choose the
column header twice.

= In the Plate ID field, scan or enter the nanowell
plate ID.

= Choose the Confirm button.

@ You cannot enter a nanowell plate ID of a
nanowell plate that is expired, has the wrong type,
is already part of a sample setup, and/or is
already partitioned.

7 Optionally, for each nanowell plate lane, do the
following:
= To display the Sample settings: combo box,
choose the tile twice.

= In the Notes field, enter sample notes.

= If required, in the Kit No. field, scan or enter the
kit ID.

= Choose the Confirm button.

@ For IVD workflows, it is mandatory to enter the kit
IDs. For LDT workflows, the Kit No. field is a free-
text field, e.g., for the ID of your master mix
reagent.

You can select several tiles and enter the same
sample settings for all of them.

< R o 8 Optionally, to change the batch name and/or enter
Seprms 7 S AT run notes, do the following:

= In the top center of the Sample setup screen,
choose the & button.

= In the Run information dialog box, change the
batch name and/or enter run notes.

= Choose the Confirm button.

@ The batch name can consist of 1 to 25 characters.
The batch name must not contain the following
characters:

X< >/\:"|’
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9 On the Sample setup screen, choose the Confirm
button.
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Sample setups in the web application

©® You cannot generate a sample setup report
before the sample setup is confirmed.

=> The sample setup is confirmed.
The dashboard is displayed.

vy

A batch tile in Pending partitioning status is
created and displayed in the Sample setups
column.

= The assigned orders are in Allocated status.

Editing sample setups in the web application

You can edit sample setups in the web application.

The editing options depend on the status of the sample

setup.
@ O Sample setup in the web application
_ . .
o— O Diagnostic operator user role

» To edit a sample setup in the web
application

1 In the web application, in the Sample setups column
on the dashboard, choose the batch tile.
- The Sample setup screen is displayed.

2 To edit the plate settings for a nanowell plate, do the
following:

= To display the Plate: combo box, choose the
column header twice.

= Edit the plate settings.
= Choose the Confirm button.

@ You cannot change the nanowell plate ID if the
nanowell plate is already partitioned.
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Routine operation of diagnostic workflow

3 To edit the sample settings for a nanowell plate lane,
do the following:

= To display the Sample settings: combo box,
choose the tile twice.

= Edit the sample settings.
= Choose the Confirm button.

©® You can select several tiles and enter the same
sample settings for all of them.

S i o 4 To change the batch name and/or enter run notes, do
ST ST the following:

= In the top center of the Sample setup screen,
choose the ¢ button.

= In the Run information dialog box, change the
batch name and/or enter run notes.

= Choose the Confirm button.

@ The batch name can consist of 1 to 25 characters.
The batch name must not contain the following
characters:
2*<>/\:"|”

You cannot enter run notes later during the run
on the analyzer.

5 On the Sample setup screen, choose the Confirm
button.

= The changes to the sample setup are confirmed.
- The dashboard is displayed.

Creating sample setup reports in the web application

Create a sample setup report in the web application as a
guide for pipetting and for verification of the sample
setup in the analyzer software.

A sample setup report is a PDF that contains the
following information:

= Run notes
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= Nanowell plates
= Samples that are invalid and/or have sample notes
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Sample setups in the web application

Roche Diagnostics

Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1

Plate view of the sample setup as on the Sample
setup screen (plus the dilution)

By default, sample setup reports are named
Diagnostic Sample Setup Report - BatchName.pdf

*@ List of naming placeholders (154)

*& About the Sample setup screen (97)

O
O

7

Sample setup in the web application

Optionally, external storage device, e.g., USB flash
drive

Diagnostic operator user role

To create a sample setup report

Optionally, to save the sample setup report to an
external storage device, connect the external storage
device to the computer running the web application.

In the web application, in the Sample setups column
on the dashboard, choose a batch tile.

- The Sample setup screen is displayed.
Choose the Generate report button.
- A dialog box is displayed.

Select to open or save the report. Choose the OK
button.

@ The available options and details depend on your
browser and computer configuration.

On the Sample setup screen, choose the Confirm
button.

Print the sample setup report as a guide for pipetting
and for verification of the sample setup in the
analyzer software.

Optionally, disconnect the external storage device.

& Related topics

= Orders in the web application (250)

= Results in the web application (263)

Draft - Do Not Distribute



Routine operation of diagnostic workflow

Entering run information for a diagnostic
run in the web application

Before and during a diagnostic run, you can enter run
information in the web application.

Run information comprises the following:

= Run name:
The name of the sample setup that is used as run
name on the analyzer.
The run name can consist of 1 to 25 characters.
The run name must not contain the following
characters:
X< >/\:"|’

= Run notes:
Additional information that is listed on the Run notes
tab on the Results of screen.

The allowed actions depend on the status of the

diagnostic run:

= Before you start the diagnostic run on the analyzer
(i.e., batch tile in the Sample setups column in the
web application), you can add run notes and change
the batch name on the Sample setup screen in the
web application.

= During the diagnostic run (i.e., batch tile in the Run
in progress column in the web application), you can
only enter run notes. You cannot change the run
name anymore.

= When the diagnostic run is finished, you can only
view run information. If you need to enter additional
information, you must add notes to individual results.

*@ Viewing, adding, editing, and deleting result notes
(263)

o— O Diagnostic operator user role

» To enter run information before the
diagnostic run is started

1 In the web application, in the Sample setups column
on the dashboard, choose a batch tile.
= The Sample setup screen is displayed.
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Entering run information for a diagnostic run in the web application
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In the top center of the Sample setup screen,
choose the # button.

- The Run information dialog box is displayed.

Change the run name and/or enter run notes.

@ The run name can consist of 1 to 25 characters.
The run name must not contain the following
characters:

X< >/\:"|’

Choose the Confirm button.

To add run notes in the web
application during the diagnostic run

In the web application, in the Run in progress
column on the dashboard, choose the # button on
the batch tile.

= The Run information dialog box is displayed.
Enter run notes.

@ You cannot change the run name after the run
was started on the analyzer.

Choose the Confirm button.
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Routine operation of diagnostic workflow

Results in the web application

Results are the outcome of your diagnostic workflows.

It depends on the configuration of your system if you
must release and/or send results manually to the LIS.

In this section

Viewing, adding, editing, and deleting result notes (263)
Releasing results manually in the web application (265)
Sending results manually in the web application (267)

Creating result reports in the web application (268)

Viewing, adding, editing, and deleting result notes

You can view, add, edit, or delete result notes.

You can only add, edit, or delete result notes before a
result is sent.

You can view result notes with any user role that allows
access to the web application.

To add, edit, or delete result notes, you need diagnostic
operator user role.

.

o— O To add, edit, or delete result notes:
Diagnostic operator user role

» To view result notes

1 In the web application, in the Results column on the
dashboard, choose a batch tile.

- The Results of screen is displayed.
2 Alternatively, for completed batches, choose the

Completed batches tile. Choose the batch and
choose the View button.

= The Results of screen is displayed.
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Results in the web application

3 Choose the Controls tab or the Samples tab.

4 In the Notes column, choose the Il indicator of the
result.

- The Sample notes dialog box is displayed.

5 To close the Sample notes dialog box again, choose
the Cancel button.

@ Only choose the Confirm button if you are logged
on with diagnostic operator user role.

» To add result notes

1 In the web application, in the Results column on the
dashboard, choose a batch tile.

= The Results of screen is displayed.

2 Choose the Controls tab or the Samples tab.

In the Notes column, choose the ] indicator or Il
indicator of the result.

- The Sample notes dialog box is displayed.

4 Enter your result notes and choose the Confirm
button.

» To edit result notes

1 In the web application, in the Results column on the
dashboard, choose a batch tile.

- The Results of screen is displayed.

13 Routine operation of diagnostic workflow
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Routine operation of diagnostic workflow

2 Choose the Controls tab or the Samples tab.

3 In the Notes column, choose the Il indicator of the
result.

- The Sample notes dialog box is displayed.

4 Edit the result notes and choose the Confirm button.

» To delete result notes

1 In the web application, in the Results column on the
dashboard, choose a batch tile.

- The Results of screen is displayed.

2 Choose the Controls tab or the Samples tab.

3 In the Notes column, choose the Il indicator of the
result.

- The Sample notes dialog box is displayed.

4 Delete the result notes and choose the Confirm
button.

Releasing results manually in the web application
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If results are not released automatically, you must release
the results manually in the web application.
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Results in the web application

To release results manually, you need diagnostic
operator user role.

To complete the batch, the results must be sent
additionally.

Results for orders with analysis packages in In
validation status are complete immediately after the
diagnostic run finishes. You cannot release such results
or send them to the LIS.

o— O Results in Pending release status available in the
web application

O Diagnostic operator user role

» To release results manually in the
web application

1 In the web application, in the Results column on the
dashboard, choose a batch tile that lists results in
{count} pending to be released status.

- The Results of screen is displayed.

2 Navigate to the results in Pending release status
that you want to release:

= From the drop-down list, choose the analysis
package.

= Choose the Samples tab.

= Alternatively, use the search function.

@ Results in Pending release status are marked
with an < icon in the Status column.

3 Select 1 or several results in Pending release status.

©® You can release several results at the same time.

To release the result, choose the Release button.
- The Confirmation dialog box is displayed.

5 Enter your password and choose the Release button.
- The result status changes to Pending send,
marked with an @ icon in the Status column.

= Your user name is added to the Released by
column.

13 Routine operation of diagnostic workflow
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Routine operation of diagnostic workflow

Sending results manually in the web application

If results are not sent automatically, you must send the
results manually to the LIS.

You can only send results that are already released,
either automatically or manually by a user with
diagnostic operator user role (depending on system
configuration).

To send results, you need diagnostic approver user role.

If the system is not connected to an LIS, sending results
still changes the result status from Pending send to
Send queued or Sent, and completes the batch.

Results for orders with analysis packages in In
validation status are complete immediately after the
diagnostic run finishes. You cannot release such results
or send them to the LIS.

It depends on the system configuration if the control
results are sent to the LIS.

»& Diagnostic results settings (604)
o— O Results in Pending send status available in the web
application
O Diagnostic approver user role

» To send results manually in the web
application
1 In the web application, in the Results column on the

dashboard, choose a batch tile that lists results in
{count} pending to be sent status.

- The Results of screen is displayed.

2 Navigate to the results in Pending send status that
you want to send:

= From the drop-down list, choose the analysis
package.

= Choose the Samples tab.
= Alternatively, use the search function.

0 Results in Pending send status are marked with
the @ icon in the Status column.

3 Select 1 or several results in Pending send status.
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@ You can send several results at the same time.
If you choose results that are not released yet, the
Send button is unavailable.
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Results in the web application

4 To send the results, choose the Send button.
- The Confirmation dialog box is displayed.

5 Enter your password and choose the Send button.

- The result status changes to Send queued or
Sent, respectively, marked with an = icon or an
= icon in the Status column (depending on LIS
connection status).

- Your user name is added to the Send by column.

= If all results of the batch are in Send queued
status or Sent status, the batch is complete, the
header color of the Results of screen changes to
light-brown, the batch tile is deleted from the
Results column on the dashboard, and the batch
is listed on the Completed batches tile.

Creating result reports in the web application
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Roche Diagnostics

You can create result reports on the Results of screen.

A result report is a PDF that contains the same
information as the Results of screen.

By default, a result report is named
Diagnostic Result Report - BatchName.pdf

You can create result reports independent from the
result status.

»Z About the Results of screen (100)
*& About the Completed batches screen (104)

*@ List of naming placeholders (154)

O Optionally, external storage device, e.g., USB flash
drive

O Diagnostic operator user role or diagnostic approver
user role

» To create a result report in the web
application
1 Optionally, to save the result report to an external

storage device, connect the external storage device to
the computer running the web application.

2 In the web application, in the Results column on the

dashboard, do one of the following:
= Choose a batch tile.

Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1 Draft - Do Not Distribute



Routine operation of diagnostic workflow

= For completed batches, choose the {count}
completed batches tile. Choose a batch and
choose the View button.

- The Results of screen of the batch is displayed.

3 Choose the Report button.
- A dialog box is displayed.

4 Select to open or save the report. Choose the OK
button.

@ The available options and details depend on your
browser and computer configuration.

5 Optionally, disconnect the external storage device.

& Related topics
= Orders in the web application (250)
= Sample setups in the web application (255)
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7/l Results in the web application
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Routine operation of development workflow

Performing a development workflow
without unassigned sample setup

In a development workflow without unassigned sample
setup, you plan the sample setup outside of the
development software. After the development run, you
import the raw data file of the run into the development
software and then add the sample setup information to
the run.

In a development workflow, you work with the following
system components:

= Development software
= Partitioning engine
= Analyzer

For a development workflow, you need development
operator user role on the analyzer.

—Q- The procedure below gives an overview of the
steps you must perform in a development
workflow. For more details, refer to the individual
procedures that are referenced in the steps.

£ CAUTION!

Delayed processing of partitioned nanowell plates

Delayed processing of partitioned nanowell plates on
the analyzer may cause degradation of biological
material, which may cause incorrect, invalid, or delayed
results.

» Only pipette and partition nanowell plates if you can
directly run them on the analyzer afterwards.

» Ensure that you start the run directly after loading the
analyzer.

*& Overview of development workflow without
unassigned sample setup (194)

*&l Development workflow without unassigned sample
setup (quick reference) (200)
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El O Nanowell plates
O Optionally, external storage device, e.g., USB flash
drive
%: O Development operator user role in the analyzer
software
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77/ Performing a development workflow without unassigned sample setup

» To perform a development workflow
without unassigned sample setup

1 Prepare the reaction mixtures.

@ For details about preparing the reaction mixtures
and pipetting, refer to the Instructions for Use of
the reagents and controls.

2 CAUTION! Risk of incorrect results.
Take care to avoid pipetting errors. If a pipetting error
may have occurred, take note of the affected
nanowell plate lane to exclude it from analysis.

Pipette and partition the nanowell plates on the
partitioning engine as described in Partitioning the
nanowell plates (221):

= Pipette the reaction mixtures into the inlet ports of
the first nanowell plate.

= Choose the Load button.

= Place the nanowell plate in the drawer.

= Choose the Start button.

= When the nanowell plate drawer opens, check
that all nanowell plate lanes that contain reaction
mixtures are partitioned.

= Remove the nanowell plate.

= Place the nanowell plate on a flat and clean
surface.

= Pipette and partition the other nanowell plates.
= Stack the partitioned nanowell plates.
O The stability of the reaction mixtures between

partitioning of a nanowell plate and processing it
on the analyzer has been tested for 90 minutes.

CAUTION! Risk of incorrect, invalid, or delayed
results.

Do not load nanowell plates with unpartitioned
nanowell plate lanes that contain reaction mixtures.
Avoid scratches, finger prints, dust, or other artifacts
on the nanowell plate lanes.

Load the analyzer as described in Loading the
analyzer (225):

= In the global information area, choose the (%]
button.

= Place the nanowell plate stack in the drawer.

= Choose the (&} button.

® Do not load invalid nanowell plates on the

analyzer. You cannot start the run while invalid
nanowell plates are loaded.

14 Routine operation of development workflow

= In the analyzer software, the Plates panel is
displayed.
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Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1 Draft - Do Not Distribute




Routine operation of development workflow

4 In the analyzer software, on the Plates panel, do the
following:

= Verify that all nanowell plates have status Valid.
= Verify the displayed nanowell plates against the
planned sample setup.
5 Choose the Run profile button.
= The Manage run profiles panel is displayed.

6 Optionally, on the Manage run profiles panel,
duplicate or import a run profile as described in
Working with run profiles on the Manage run profiles
panel in the analyzer software (299):

= To duplicate a run profile, choose a run profile
and choose the Duplicate button. Enter a name
for the run profile and choose the Save button.

= To import a run profile, choose the Import
button. Navigate to the folder. Choose the run
profile and choose the Import button.

7 Edit an unlocked run profile as described in Editing
run profiles on the Edit run profile panel in the
analyzer software (303):

= On the Manage run profiles panel, choose the
run profile and choose the Open button.

= Optionally, on the Edit run profile panel, edit the
programs.

= Choose the Detection formats button.

= In the Detection format combo box, disable the
channels for dyes that are not contained in any of
the master mix reagents. For each enabled
channel, choose the dye from the drop-down list.
Optionally, edit the integration time. Choose the
Save button.

= Choose the Save button.

@ Ensure that you disable empty channels.

8 To start the run, do one of the following:

= On the Manage run profiles panel, choose the
run profile. Choose the Run button.

= On the Edit run profile panel, choose the Run
button.

- The Monitoring panel is displayed.
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Performing a development workflow without unassigned sample setup

9 Optionally, change the name of the development run
and/or add run notes as described in Entering run
information for a development run in the analyzer
software (307):
= On the Monitoring panel, next to the run name,
choose the # button.

= In the dialog box, in the Run name field, enter a
new run name.

= In the Edit notes field, enter run notes.

= Choose the Confirm button.

@ You can also change the run name on the
Development results panel after the run is
finished.

10 CAUTION! Risk of contamination of the laboratory.
Pack the used nanowell plates in a resealable plastic
bag.

When the run is finished, unload the analyzer as
described in Unloading the analyzer (227):

= In the global information area, choose the (&)

button.

= Remove the nanowell plate stack from the drawer.

= Choose the (&} button.

@ Dispose of the nanowell plates according to local
regulations.

11 If the analyzer is not configured for automatic export,
export the raw data file of the development run as
described in Managing raw data files of development
runs in the analyzer software (312):

= Optionally, to export to an external storage device,
connect the external storage device to the
analyzer.

Choose Routine > Development run >
Development results.

= Choose the run and choose the Export button.

= Navigate to a folder and choose the Export
button.

= Optionally, disconnect the external storage device.

12 In the development software, open a project as
described in Working with projects in the
development software (295):

= On the Start page tab, choose the Open file
button.

= Navigate to the dpcrPij file of the project and
choose the Open button.

14 Routine operation of development workflow

13 Alternatively, in the development software, create a
project as described in Working with projects in the
development software (295):
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Routine operation of development workflow BWwyt:]

= If the raw data file was exported to an external
storage device, connect the external storage
device to the computer running the development
software.

= In the Windows Explorer, double-click the raw
data file of the development run.

= Save the project as described in To save a project
in the development software (296).

= Optionally, disconnect the external storage device.
= The run tab is displayed.

14 If you opened a project in the development software,
import the raw data file of the development run as
described in Working with raw data files and runs in
the development software (317):

= If the raw data file was exported to an external
storage device, connect the external storage
device to the computer running the development
software.

= From the Navigation area, choose Runs > [ >
Import.

= Navigate to the raw data file and choose the
Open button.

= Save the project.
= Optionally, disconnect the external storage device.
= The run tab is displayed.
15 Optionally, in the Additional run notes: field on the
Run settings card, enter run notes. Save the project.
16 On the run tab, choose the Lane settings button.
= The Lane settings card is displayed.

17 Add the lane settings as described in Adding run
settings and lane settings to unassigned sample
setups in the development software (406):
= On the sample setup tab, choose one or several

tiles (in plate view) or rows (in table view).

= On the Lane settings card, choose the Sample
ID field. Scan or enter the sample ID. If required,
press Enter.

= Optionally, edit the dilution factor.

= In the MMx field, enter the name of the master
mix reagent or choose a master mix reagent from
the drop-down list.

= Optionally, enter the ID, the expiry date, and the
lot number of the master reagent or the master
mix reagent.

= Save the project.

O If you enter the same lane settings for multiple

tiles or rows, the nanowell plate lanes are
automatically merged.
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Performing a development workflow without unassigned sample setup
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18 For each master mix reagent, in the Target and dye
settings table, do the following:

= Choose atile (in plate view) or a row (in table
view).

= Disable the dyes that are not contained in the
master mix reagent.

= Optionally, rename the targets.

= Save the project.

@ A change applies to all tiles that use the same
master mix reagent.

19 Optionally, add notes and/or sample preparation
notes:

= Choose one or several tiles (in plate view) or rows
(in table view).

= Choose the Edit notes button or the Edit sample
preparation notes button.

= In the dialog box, enter the notes.
= Choose the Save button.
= Save the project.

@ The notes or sample preparation notes apply to all
selected tiles.

20 Optionally, work with sample groups for statistical
purposes as described in Working with sample
groups in the development software (328):

= Choose the Sample groups button.
= Add and/or edit the sample groups.
= Save the project.
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21 Check and adjust the clustering, as described in
Adjusting the clustering in the development software
(342):
= From the Clustering menu, choose the clustering.
= Choose the £k button.

= In the Settings combo box, adjust the clustering
settings.

= Choose the £} button.

= If required, adjust the thresholds in the scatter
plots. Choose the Calculate button.

= Save the project.

22 Add analyses as described in Analyses in the
development software (358):

* From the Navigation area, choose Analysis > [
. Choose the analysis type.

= In the Settings combo box, choose the samples
and choose the Update analysis button.

= Optionally, add and/or edit sample groups.

= On the other tabs in the Settings combo box,
enter the settings required for the analysis type.

= Choose the £} button.
= Save the project.

23 Alternatively, edit analyses as described in Analyses
in the development software (358):

= From the Analysis menu, choose the analysis.
= Choose the 3 button.

= In the Settings combo box, edit the analysis
settings.

* Choose the £¥ button.
= Save the project.

24 Optionally, create an analysis package as described in

Working with analysis packages (429):

= From the Navigation area, choose Analysis
package > u > Create analysis package.

= In the Create analysis package dialog box,
enter a name for the analysis package and the
type of nanowell plate. Choose the Confirm
button.

= On the panels of the analysis package tab, enter
the required information.

= From the Analysis package menu, choose the
analysis package.

= Choose [ > Update version.

= In the Increment version number dialog box,
choose the version number and choose the
Update button.
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Performing a development workflow without unassigned sample setup

= Save the project.
25 Optionally, update an analysis package as described
in Working with analysis packages (429):
= From the Analysis package menu, choose the
analysis package.
= On the panels of the analysis package tab, edit the
information.

= From the Analysis package menu, choose the
analysis package.
* Choose [ > Update version.

= In the Increment version number dialog box,
choose the version number and choose the
Update button.

= Save the project.

26 Optionally, export the analysis package as described
in Working with analysis packages (429):
= From the Analysis package menu, choose the
analysis package.
= Choose [ > Export.

= Navigate to a folder that is accessible from the
analyzer and choose the Save button.

27 Save the project.

& Related topics

= Development workflow without unassigned sample
setup (quick reference) (200)

= Partitioning the nanowell plates (221)

= Loading the analyzer (225)

= Unloading the analyzer (227)

= Projects in the development software (294)
= Run profiles in the analyzer software (298)

= Entering run information for a development run in
the analyzer software (307)

= Runs in the development software (309)

= Editing lane settings via copy and paste in the
development software (335)

= Clustering in the development software (338)
= Analyses in the development software (358)

= Analysis packages in the development software (412)

=
Q
=
=
=
(=]
S
)
o
Q
e
=1
L=
Q
>
Q
=)
-
(=)
c
=]
=
©
| &
Q
=
o
(<b)
c
=
-
Q
(o'
J
F

Roche Diagnostics
Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1 Draft - Do Not Distribute




Routine operation of development workflow

Performing a development workflow with
unassigned sample setup

In a development workflow with unassigned sample
setup, you plan the sample setup in the development
software. After the development run, you import the raw
data file of the run into the development software and
then assign the sample setup information to the run.

In a development workflow, you work with the following
system components:

= Development software
= Partitioning engine
= Analyzer

For a development workflow, you need development
operator user role on the analyzer.

-‘Q’- The procedure below gives an overview of the
steps you must perform in a development
workflow. For more details, refer to the individual
procedures that are referenced in the steps.

/ CAUTION!

Delayed processing of partitioned nanowell plates

Delayed processing of partitioned nanowell plates on
the analyzer may cause degradation of biological
material, which may cause incorrect, invalid, or delayed
results.

» Only pipette and partition nanowell plates if you can
directly run them on the analyzer afterwards.

» Ensure that you start the run directly after loading the
analyzer.

»& Overview of development workflow with unassigned
sample setup (195)

*& Development workflow with unassigned sample
setup (quick reference) (208)

El O Nanowell plates
O Optionally, external storage device, e.g., USB flash
drive

&

O Development operator user role in the analyzer
software
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Performing a development workflow with unassigned sample setup

» To perform a development workflow
with unassigned sample setup

1 In the development software, open a project as
described in Working with projects in the
development software (295):
= On the Start page tab, choose the Open file

button.

= Navigate to the dpcrPrj file of the project and
choose the Open button.

2 Alternatively, in the development software, create a
project as described in Working with projects in the
development software (295):

= On the Start page tab, choose the Create new
project button.

= Save the project under a new name as described
in To save a project in the development software
(296).

- An unassigned sample setup is automatically
added to the project.

- The sample setup tab of the unassigned sample
setup is displayed.

3 If you opened a project, add an unassigned sample

setup to the project as described in Working with

unassigned sample setups in the development

software (405):

= In the Navigation area, choose Unassigned
sample setup > [l > Create new.

= Save the project.

- The sample setup tab of the unassigned sample
setup is displayed.

On the Run settings card on the sample setup tab,
add the nanowell plates to the unassigned sample
setup as described in Adding run settings and lane
settings to unassigned sample setups in the
development software (406):

= From the Plate type drop-down list, choose the
nanowell plate type.

= Optionally, choose the Plate ID field. Scan or
enter the nanowell plate ID. If required, press
Enter.

= Save the project.

14 Routine operation of development workflow

Roche Diagnostics
Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1 Draft - Do Not Distribute




Routine operation of development workflow

©® You can use different types of nanowell plates in
1 development run.
The unassigned sample setup can later be
assigned to the run only if the nanowell plate
types and IDs in the unassigned sample setup
and in the actual development run match.
The unassigned sample setup can only be
assigned automatically if it contains the nanowell
plate IDs.

5 On the Run settings card, set the detection formats
for the development run:

= Choose the Detection formats button.

= In the Detection format combo box, disable the
channels for dyes that are not contained in any of
the master mix reagents used in the development
run.

= For each enabled channel, choose the dye from
the drop-down list.

= To edit the integration times, choose the
Advanced Settings check box. In the
Integration time (ms) fields, edit the values.

= Choose the Save button.

= Save the project.

@ Ensure that you disable empty channels.
Only the enabled dyes can be assigned in the lane
settings.
The unassigned sample setup can later be
assigned to the run only if the detection formats
in the unassigned sample setup and in the actual
development run match.

6 Optionally, in the Additional run notes: field, enter
run notes. Save the project.

7 On the sample setup tab, choose the Lane settings
button.

= The Lane settings card is displayed.

8 Add the lane settings as described in Adding run
settings and lane settings to unassigned sample
setups in the development software (406):
= On the sample setup tab, choose one or several
tiles (in plate view) or rows (in table view).

= On the Lane settings card, choose the Sample
ID field. Scan or enter the sample ID. If required,
press Enter.

= Optionally, edit the dilution factor.

= In the MMx field, enter the name of the master
mix reagent or choose a master mix reagent from
the drop-down list.

= Optionally, enter the ID, the expiry date, and the
lot number of the master reagent or the master
mix reagent.
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= Save the project.

@ If you enter the same lane settings for multiple
tiles or rows, the nanowell plate lanes are
automatically merged.

9 For each master mix reagent, in the Target and dye

settings table, do the following:

= Choose a tile (in plate view) or a row (in table
view).

= Disable the dyes that are not contained in the
master mix reagent.

= Optionally, rename the targets.

= Save the project.

@® A change applies to all tiles that use the same
master mix reagent.

10 Optionally, add notes and/or sample preparation
notes:
= Choose one or several tiles (in plate view) or rows
(in table view).
= Choose the Edit notes button or the Edit sample
preparation notes button.

= In the dialog box, enter the notes.
= Choose the Save button.
= Save the project.

©® The notes or sample preparation notes apply to all
selected tiles.

11 From the unassigned sample setup, create a sample
setup report as described in Creating a sample setup
report of an unassigned sample setup in the
development software (410):

= In the Navigation area, from the unassigned
sample setup in the Unassigned sample setup
menu, choose B > Create a sample setup
report.

= Navigate to a folder. Enter a name for the report
and choose the Save button.

©® Use the sample setup report as a guide for
pipetting.

12 Prepare the reaction mixtures.

@ For details about preparing the reaction mixtures
and pipetting, refer to the Instructions for Use of
the reagents and controls.

13 Refer to the sample setup report to identify the
nanowell plates and to allocate the reaction mixtures
to the nanowell plate lanes.

©® Ensure that you use the correct nanowell plates.
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14 CAUTION! Risk of incorrect results.
Take care to avoid pipetting errors. If a pipetting error
may have occurred, take note of the affected
nanowell plate lane to exclude it from analysis.

Pipette and partition the nanowell plates on the
partitioning engine as described in Partitioning the
nanowell plates (221):

= Pipette the reaction mixtures into the inlet ports of
the first nanowell plate.

= Choose the Load button.

= Place the nanowell plate in the drawer.

= Choose the Start button.

= When the nanowell plate drawer opens, check

that all nanowell plate lanes that contain reaction
mixtures are partitioned.

= Remove the nanowell plate.

= Place the nanowell plate on a flat and clean
surface.

= Pipette and partition the other nanowell plates.
= Stack the partitioned nanowell plates.
@ The stability of the reaction mixtures between

partitioning of a nanowell plate and processing it
on the analyzer has been tested for 90 minutes.

15 CAUTION! Risk of incorrect, invalid, or delayed
results.
Do not load nanowell plates with unpartitioned
nanowell plate lanes that contain reaction mixtures.
Avoid scratches, finger prints, dust, or other artifacts
on the nanowell plate lanes.

Load the analyzer as described in Loading the

analyzer (225):
= In the global information area, choose the (&)
button.

= Place the nanowell plate stack in the drawer.

= Choose the (&} button.

©® Do not load invalid nanowell plates on the
analyzer. You cannot start the run while invalid
nanowell plates are loaded.

= In the analyzer software, the Plates panel is
displayed.

16 In the analyzer software, on the Plates panel, do the
following:
= Verify that all nanowell plates are in Valid status.
= Verify the displayed nanowell plates against the
sample setup report from the development
software.
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17 Choose the Run profile button.

= The Manage run profiles panel is displayed.
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v  Performing a development workflow with unassigned sample setup

18 Optionally, on the Manage run profiles panel,
duplicate or import a run profile as described in
Working with run profiles on the Manage run profiles
panel in the analyzer software (299):

= To duplicate a run profile, choose a run profile
and choose the Duplicate button. Enter a name
for the run profile and choose the Save button.

= To import a run profile, choose the Import
button. Navigate to the folder. Choose the run
profile and choose the Import button.

19 Edit an unlocked run profile as described in Editing
run profiles on the Edit run profile panel in the
analyzer software (303):
= On the Manage run profiles panel, choose the

run profile and choose the Open button.
= Optionally, on the Edit run profile panel, edit the
programs.

= Choose the Detection formats button.

= In the Detection format combo box, disable the
channels for dyes that are not contained in any of
the master mix reagents. For each enabled
channel, choose the dye from the drop-down list.
Optionally, edit the integration time. Choose the
Save button.

= Choose the Save button.

@ Ensure that you disable empty channels.

20 To start the run, do one of the following:

= On the Manage run profiles panel, choose the
run profile. Choose the Run button.

= On the Edit run profile panel, choose the Run
button.

= The Monitoring panel is displayed.

21 Optionally, change the name of the development run
and/or add run notes as described in Entering run
information for a development run in the analyzer
software (307):
= On the Monitoring panel, next to the run name,
choose the # button.

= In the dialog box, in the Run name field, enter a
new run name.

= In the Edit notes field, enter run notes.

= Choose the Confirm button.

@ You can also change the run name on the
Development results panel after the run is
finished.
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Routine operation of development workflow

22 CAUTION! Risk of contamination of the laboratory.
Pack the used nanowell plates in a resealable plastic
bag.

When the run is finished, unload the analyzer as
described in Unloading the analyzer (227):

= In the global information area, choose the (%]
button.

= Remove the nanowell plate stack from the drawer.
= Choose the (=] button.

0 Dispose of the nanowell plates according to local
regulations.

23 If the analyzer is not configured for automatic export,
export the raw data file of the development run as
described in Managing raw data files of development
runs in the analyzer software (312):
= Optionally, to export to an external storage device,

connect the external storage device to the
analyzer.

= Choose Routine > Development run >

Development results.
= Choose the run and choose the Export button.

= Navigate to a folder and choose the Export
button.

= Optionally, disconnect the external storage device.

24 In the development software, import the raw data file
of the development run into the project as described
in Working with raw data files and runs in the
development software (317):

= If the raw data file was exported to an external
storage device, connect the external storage
device to the computer running the development
software.

= From the Navigation area, choose Runs > [ >
Import.

= Navigate to the raw data file and choose the
Open button.

= To confirm the automatic assignment of the
unassigned sample setup to the run if a match is
found, in the Matching unassigned sample
setup was found. dialog box, choose the
Confirm button.

= Save the project.

= Optionally, disconnect the external storage device.

= The run tab is displayed.

25 If required, assign a partially matching unassigned
sample setup to the run as described in Assigning
partially matching unassigned sample setups to
development runs in the development software (321):

S
Q
=
=L
=
(=]
S
=)
c
(5]
(S
Q.
L=
(5]
>
Q
E=]
(-
(@)
c
=)
=]
o
| S
5]
.
(@)
Q
c
I;
-
Q
o'
q
F

Roche Diagnostics
Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1 Draft - Do Not Distribute




Performing a development workflow with unassigned sample setup

= From the Runs menu, choose the run.
» Choose [ > Assign existing sample setup.

= Choose the unassigned sample setup and choose
the Confirm button.

= Save the project.

@ If no unassigned sample setup can be assigned,
you must add the lane settings directly to the run.

26 Optionally, edit the lane settings of the run as
described in Adding and editing lane settings of a run
in the development software (325):
= On the run tab, choose the Lane settings button.
= Choose one or several tiles (in plate view) or rows
(in table view).

= Edit the sample IDs, the dilution factor, the master
mix reagent, and/or the additional information for
the master mix reagent or master reagent.

= Edit the target and dye settings.

= Save the project.

@ If you enter the same lane settings for multiple

tiles or rows, the nanowell plate lanes are
automatically merged.
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Routine operation of development workflow

27 Optionally, work with sample groups for statistical
purposes as described in Working with sample
groups in the development software (328):

= Choose the Sample groups button.
= Add and/or edit the sample groups.
= Save the project.

28 Check and adjust the clustering, as described in
Adjusting the clustering in the development software
(342):
= From the Clustering menu, choose the clustering.
= Choose the &k button.

= In the Settings combo box, adjust the clustering
settings.

= Choose the £¥ button.

= If required, adjust the thresholds in the scatter
plots. Choose the Calculate button.

= Save the project.

29 Add analyses as described in Analyses in the
development software (358):

* From the Navigation area, choose Analysis > [
. Choose the analysis type.

= In the Settings combo box, choose the samples
and choose the Update analysis button.

= Optionally, add and/or edit sample groups.

= On the other tabs in the Settings combo box,
enter the settings required for the analysis type.

= Choose the £} button.
= Save the project.
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Performing a development workflow with unassigned sample setup

30 Alternatively, edit analyses as described in Analyses
in the development software (358):

From the Analysis menu, choose the analysis.
Choose the 3 button.

In the Settings combo box, edit the analysis
settings.

Choose the £¥ button.
Save the project.

31 Optionally, create an analysis package as described in
Working with analysis packages (429):

From the Navigation area, choose Analysis
package > [l > Create analysis package.
In the Create analysis package dialog box,
enter a name for the analysis package and the
type of nanowell plate. Choose the Confirm
button.

On the panels of the analysis package tab, enter
the required information.

From the Analysis package menu, choose the
analysis package.

Choose [l > Update version.

In the Increment version number dialog box,
choose the version number and choose the
Update button.

Save the project.

32 Optionally, update an analysis package as described
in Working with analysis packages (429):

From the Analysis package menu, choose the
analysis package.

On the panels of the analysis package tab, edit the
information.

From the Analysis package menu, choose the
analysis package.

Choose [i > Update version.

In the Increment version number dialog box,
choose the version number and choose the
Update button.

Save the project.

33 Optionally, export the analysis package as described
in Working with analysis packages (429):

From the Analysis package menu, choose the
analysis package.
Choose [ > Export.

Navigate to a folder that is accessible from the
analyzer and choose the Save button.

34 Save the project.
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Routine operation of development workflow

& Related topics

= Development workflow with unassigned sample
setup (quick reference) (208)

= Partitioning the nanowell plates (221)

= Loading the analyzer (225)

= Unloading the analyzer (227)

= Projects in the development software (294)
= Run profiles in the analyzer software (298)

= Entering run information for a development run in
the analyzer software (307)

= Runs in the development software (309)

= Editing lane settings via copy and paste in the
development software (335)

= Clustering in the development software (338)
= Analyses in the development software (358)

= Unassigned sample setups in the development
software (402)

= Analysis packages in the development software (412)
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Projects in the development software

Projects in the development software

In the development software, a project comprises
associated data, for example, data belonging to the same
research topic.

In this section

About projects in the development software (294)

Working with projects in the development software (295)

About projects in the development software

In the development software, a project is the container
for all data that is collected in 1 or several development
workflows. For example, a project can be used to collect
and analyze the data belonging to the development of a
test or to a research topic.

A project can contain the following data, corresponding
to the steps of a development workflow:

= Runs (raw data files)

= Clustering

= Analyses

= Unassigned sample setups

= Analysis packages

You must save the project to save associated data. You
cannot save any data separately.

A project in the development software can contain and
process up to 672 samples and 50 analyses.

Some settings apply across the whole project. For
example, if you change the name of a master mix
reagent, the master mix reagent is renamed everywhere
in the project.

The master mix reagents across a project must be
unambiguous in regard to name and detection formats. A
project cannot contain master mix reagents with the
same name but different detection formats.

A project is always opened in its own instance of the
development software. You cannot open 2 projects in the
same software instance.
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Routine operation of development workflow

By default, projects are named "Project" and numbered
consecutively.

A project has a .dpcrPij file extension.

Working with projects in the development software

You can create, open, save, and close a project.

Always save your projects before closing.

» To create a project in the
development software

1 In the development software, do one of the following:

= On the Start page tab, choose the Create new
project button.

* In the Navigation area, choose File > [ > New
project.

- For each project, a separate instance of the
development software is opened.

- A new unassigned sample setup with 1 universal
nanowell plate is added to the project
automatically.

2 To save the project, choose File > B > Save as.

3 Navigate to a folder, enter a project name, and
choose the Save button.
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Projects in the development software

Roche Diagnostics

Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1

To open a project in the development
software

In the development software, do one of the following:

= On the Start page tab, choose the project from
the list of recent items.

= On the Start page tab, choose the Open file
button.

* In the Navigation area, choose File > [ >
Open.

= In the Windows Explorer, double-click the dpcrPrj
file.

If required, navigate to a dpcrPj file and choose the
Open button.

- A separate instance of the development software
may be opened.

- All tabs of the project are displayed that were
displayed when you last saved the project.

To save a project in the development
software

To save a new project, or to save a project under a
different name or in a different folder, do the
following:

* In the Navigation area, choose File > [ > Save
as.

= Navigate to a folder.
= Enter a name for the project.
= Choose the Save button.

To save an existing project with the same name and
in the same folder, do one of the following:

* In the Navigation area, choose File > [ >
Save.

= Press Ctrl+S.

@ You must save the project to save associated
data. You cannot save any data separately.
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Routine operation of development workflow

» To close a project in the development
software

1 To close a project, do one of the following:
* In the Navigation area, choose File > [ >
Close.
= In the top right of the software window, choose
the » button.

2 In the Close dialog box, choose the Exit button.

= The project and the instance of the development
software are closed.

&l Related topics

Runs in the development software (309)

Clustering in the development software (338)
= Analyses in the development software (358)

= Unassigned sample setups in the development
software (402)

= Analysis packages in the development software (412)
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Run profiles in the analyzer software

Run profiles in the analyzer software

For development runs, run profiles contain the run
parameters for the analyzer.

The run profiles are listed on the Manage run profiles
panel.

You can edit the run profiles on the Edit run profile
panel.

*& About the Edit run profile panel (117)

In this section

About run profiles in the analyzer software (298)

Working with run profiles on the Manage run profiles
panel in the analyzer software (299)

Editing run profiles on the Edit run profile panel in the
analyzer software (303)

About run profiles in the analyzer software

For development runs, a run profile provides the run
parameters for the analyzer.

A run profile contains the following run parameters:
= Temperatures

= Durations

= Number of cycles

= Detection formats

About the default run profiles A default DNA run profile and a default RNA profile are
contained in the analyzer software.

Default DNA run profile:

Detection formats Program Temperature Duration Number of cycles
Channel 2 / FAM UNG 50 °C 120 s 1
Channel 3 / HEX Denaturation 95 °C 120 s 1
Amplification Step 1: 95 °C Step1:15s 40
Step 2: 58 °C Step 2:30's
Cooling 40 °C 30s 1
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#8 Default DNA run profile

Default RNA profile:
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Routine operation of development workflow

Detection formats Program Temperature Duration Number of cycles
Channel 2 / FAM UNG 50 °C 120's 1
Channel 3 / HEX Denaturation 95 °C 20s 1

RT Step 1 55°C 180 s 1

RT Step 2 65 °C 720 s 1

RT Inactivation 95 °C 15s 1

Amplification Step 1: 95 °C Step1:15s 40

Step 2: 58 °C Step 2:30's
Cooling 40 °C 30s 1

g8 Default RNA run profile

About run profile status A run profile can be locked or unlocked, which is
indicated in the Manage run profiles panel by a symbol
in the Run profile name column:

& = Locked run profile
= Cannot be renamed or deleted

= Can be open and viewed but not edited

= Duplicate as starting point for your own run profiles
@ = Unlocked run profile

= All duplicated run profiles are unlocked

= Can be renamed and deleted

= Can be edited

You cannot change the status of a run profile.

Working with run profiles on the Manage run profiles
panel in the analyzer software

On the Manage run profiles panel in the analyzer
software, you can open, rename, duplicate, delete, export,
and import run profiles and start a development run.

-Q- You cannot create a run profile. If you need a
new run profile, you must duplicate an existing
run profile and edit it.

»@ Editing run profiles on the Edit run profile
panel in the analyzer software (303)

You cannot rename or delete a locked run profile.

You can only rename a run profile in the analyzer
software. Even if you change the file name of an exported
run profile in the Windows Explorer, the name of the run
profile itself will remain unchanged.
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Run profiles in the analyzer software

You can export run profiles to and import from a network
share or external storage device.

You can only start a run from the Manage run profiles
panel if the prerequisites for a development run are met.

*& Prerequisites for a development run (172)

IE] O To import a run profile:
Run profile (.dpcrPrfl file) saved in network share or
on external storage device

O To export a run profile:
Optionally external storage device, e.g., USB flash
drive

Development operator user role

» To open a run profile in the analyzer
software

1 In the analyzer software, choose Routine >
Development run > Manage run profiles.
= The Manage run profiles panel is displayed.

2 From the Run profiles table, choose a run profile.

3 Choose the Open button.

=> The run profile is displayed on the Edit run
profile panel.

» To rename a run profile in the
analyzer software

1 In the analyzer software, choose Routine >
Development run > Manage run profiles.
- The Manage run profiles panel is displayed.

2 From the Run profiles table, choose a run profile.

©® You can only rename unlocked run profiles.

3 Choose the Rename button.
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Routine operation of development workflow

4 In the Edit run profile name dialog box, enter a new
name for the run profile.

@ The name can consist of 1 to 20 characters.
The name must not contain the following
characters:

2 > /\ : " | ’

5 Choose the Save button.

- The run profile is displayed with the changed
name in the Run profiles table.

» To duplicate a run profile in the
analyzer software

1 In the analyzer software, choose Routine >
Development run > Manage run profiles.
- The Manage run profiles panel is displayed.

2 From the Run profiles table, choose a run profile.

3 Choose the Duplicate button.

4 In the Edit run profile name dialog box, enter a
name for the new run profile.

©® The name can consist of 1 to 20 characters.

5 Choose the Save button.

= The unlocked run profile is displayed in the Run
profiles table.

- Your user name is added to the Author column.

» To start a development run from the
Manage run profiles panel in the
analyzer software

1 In the analyzer software, choose Routine >
Development run > Manage run profiles.

- The Manage run profiles panel is displayed.

2 From the Run profiles table, choose a run profile.

@ You can only start a run if the analyzer is loaded
and ready for a development run.
Alternatively, you can open the run profile and
start the run from the Edit run profile panel.

3 Choose the Run button.
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@ You can only start the run if the prerequisites for
a development run are met.

- The development run is started.
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Run profiles in the analyzer software
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= The Monitoring panel is displayed.

To delete a run profile in the analyzer
software

In the analyzer software, choose Routine >
Development run > Manage run profiles.

= The Manage run profiles panel is displayed.

From the Run profiles table, choose a run profile.

@ You can only delete unlocked run profiles.
You can delete several run profiles
simultaneously.

Choose the Delete button.

In the Delete run profiles dialog box, choose the
Confirm button.

= The run profile is deleted from the Run profiles
table.

To export a run profile in the analyzer
software

Optionally, to export to an external storage device,
connect the external storage device to the analyzer.

In the analyzer software, choose Routine >
Development run > Manage run profiles.

= The Manage run profiles panel is displayed.
From the Run profiles table, choose a run profile.

@ You can export several run profiles
simultaneously.

Choose the Export button.
In the folder browser, navigate to a folder.

Choose the Export button.

Optionally, if a run profile with the same name already
exists in the folder, to overwrite the existing run
profile, choose the Confirm button.

= The run profile is exported as .dpcrPrfl file to the
folder.

Optionally, disconnect the external storage device.

To import a run profile in the analyzer
software

Optionally, to import from an external storage device,
connect the external storage device to the analyzer.
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Routine operation of development workflow

2 In the analyzer software, choose Routine >
Development run > Manage run profiles.

= The Manage run profiles panel is displayed.

3 Choose the Import button.
- The Import run profiles dialog box is displayed.

4 In the folder browser, navigate to the folder of the run
profile.

5 In the file browser, choose the run profile.

©® You can import several run profiles
simultaneously.

6 Choose the Import button.

7 Optionally, if a run profile with the same name already
exists in the analyzer software, in the Action denied
dialog box, do one of the following:
= To keep the existing run profile, choose the

Rename button. A number is appended to the
name of the imported run profile.

= To replace the existing run profile, choose the
Overwrite button.

= The run profile is displayed in the Run profiles
table.

8 Optionally, disconnect the external storage device.

Editing run profiles on the Edit run profile panel in the
analyzer software

On the Edit run profile panel, you can add, edit, and
delete programs from run profiles, edit the detection
formats, and start a development run.

If you edit the run profile, the temperature chart of the
run and the estimated run duration are updated
immediately.

-“Q'— You cannot delete the mandatory cooling
program at the end of a run.

You cannot edit locked run profiles.

It depends on the location in the run profile which
programs you can add.
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*& About the Edit run profile panel (117)
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Run profiles in the analyzer software

You can only start a run from the Edit run profile panel
if all changes to the run profile are saved and if the
prerequisites for a development run are met.

*@ Prerequisites for a development run (172)

About the detection formats The detection formats define the channels, the dye per
channel, and the integration time for the detection of
fluorescence by the analyzer.

The following applies:

= Enable the channels for all dyes that are contained in
any of the master mix reagents used in the
development run.

= Disable the channels for dyes that are not contained
in any of the master mix reagents used in the
development run. Disabling empty channels shortens
the run time, reduces the size of the raw data file, and
enhances the performance of the development
software.

= You cannot use different dyes that are detected in the
same channel in 1 development run.

o— O Development operator user role

» To edit a run profile in the analyzer
software

1 In the analyzer software, choose Routine >
Development run > Manage run profiles.
= The Manage run profiles panel is displayed.

2 Open an unlocked run profile:

= From the Run profiles table, choose the run
profile.

= Choose the Open button.

= The run profile is displayed on the Edit run
profile panel.

3 To edit a field value (i.e., program name, number of
cycles, step temperature, or step duration), do the
following:

= Choose the entry in the field.
= Enter the new value.
= Close the virtual keyboard.

4 Alternatively, to edit the step temperature, drag and
drop the plateau segment of the temperature curve.
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@ You cannot edit the gradient of the temperature
change.
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Routine operation of development workflow

5 To add a program, choose the + button. From the
drop-down menu, choose the program.

@ It depends on the location in the run profile which
programs you can add.

- The new program is added to the left.
6 To delete a program, choose the = button.

@ You cannot delete the cooling program at the end
of the run profile.

7 Choose the Detection formats button.
= The Detection format combo box is displayed.

8 To edit the detection formats, do the following:

= To disable a channel, clear the Enabled check
box.

= To enable a channel, select the Enabled check
box.

= For each enabled channel, choose the dye from
the Dye drop-down list.

= Optionally, to edit the integration time for a
channel, select the Advanced Settings check
box. Choose the Integration time (ms) field and
enter the new value.

= Choose the Save button.
@ Ensure that you disable empty channels.
9 Choose the Save button.

10 On the Edit run profile panel, choose the Save
button.

» To start a development run from the
Edit run profile panel in the analyzer
software

1 In the analyzer software, choose Routine >
Development run > Manage run profiles.

- The Manage run profiles panel is displayed.

2 Open a run profile:

= From the Run profiles table, choose the run
profile.

= Choose the Open button.

= The run profile is displayed on the Edit run
profile panel.
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Run profiles in the analyzer software

3 Choose the Run button.

@ The Run button is only available if there are no
unsaved changes in the run profile and if the
prerequisites for a development run are met.
Alternatively, you can start the development run
from the Manage run profiles panel.

- The development run is started.
= The Monitoring panel is displayed.
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Routine operation of development workflow

Entering run information for a development
run in the analyzer software

During a development run, you can enter run information
on the Monitoring panel of the analyzer software.

Run information comprises the run name and run notes.

By default, a development run is named
"Batch_YYYYMMDDhhmmss"

with the date and time the development run was started
on the analyzer.

The run name can consist of 1 to 25 characters.
The run name must not contain the following characters:
2*<>/\:"|’

Alternatively, you can rename the development run in the
analyzer software after the run is finished or in the
development software after import of the raw data file.

»& List of naming placeholders (154)

*& Managing raw data files of development runs in the
analyzer software (312)

*& Working with raw data files and runs in the
development software (317)

O

- Development run processing on the analyzer

O Monitoring panel displayed in the analyzer software
O Development operator user role

» To enter run information for a
development run

1 On the Monitoring panel in the analyzer software,
choose the # button next to the run name.

= A dialog box is displayed.

= Previously added run notes are displayed with
user name and timestamp.
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Entering run information for a development run in the analyzer software

2 Change the run name and/or enter run notes.

@ The run name can consist of 1 to 25 characters.
The run name must not contain the following
characters:
2*<>/\:"|”’

3 Choose the Confirm button.
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Routine operation of development workflow

Runs in the development software

At the end of each run, a raw data file is generated that
contains the run parameters and fluorescence values.
You import the raw data files as runs into the
development software for data analysis.

You can import the raw data files of up to 600 samples
into the development software.

Merged nanowell plate lanes are still processed

separately. Therefore, each merged lane is listed
individually on a run tab.

In this section

About raw data files and runs (309)

Managing raw data files of development runs in the
analyzer software (312)

Exporting raw data files of diagnostic runs from the web
application (315)

Working with raw data files and runs in the development
software (317)

Assigning partially matching unassigned sample setups
to development runs in the development software (321)

List of columns on the Sample setup table view
card (323)

Adding and editing lane settings of a run in the
development software (325)

Working with sample groups in the development
software (328)

About raw data files and runs

The raw data of a run consists of the run parameters and
a list of the valid nanowells and their fluorescence
values. The raw data is compiled into a single raw data
file at the end of the run.

Raw data files can be exported:
= Automatically from the analyzer at the end of the run
(if configured).

= Manually from the analyzer software (for development
runs) or the web application (for diagnostic runs).
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Runs in the development software

Raw data files are then imported as runs into the
development software and are listed in the Runs menu.
The raw data is the basis for clustering and analyses.

*& Automatic export of raw data files (602)

*& Managing raw data files of development runs in the
analyzer software (312)

*@ Exporting raw data files of diagnostic runs from the
web application (315)

Content of raw data files A raw data file always contains the following information
(regardless of run type):

= Run details:
- Run name

- Date and time the run was started and finished
on the analyzer

- User ID of the user that started the run on the
analyzer

- Serial number of the analyzer

- Run flags

- Partitioning information and flags
= Run profile on the analyzer:

- Programs (temperatures, durations, number of
cycles)

- Detection formats
= Run settings:
- Number of nanowell plates
- Nanowell plate IDs and types
- Run notes (optional)

= Fluorescence values for valid nanowells
(The system may invalidate some nanowells, e.g.,
nanowells that cannot be imaged properly due to
dust particles.)

For a diagnostic run, the raw data file contains the
following additional information:

= Lane settings (editable in the development software):

- Sample IDs

- Merged lanes

- Dilution factors

- Master mix reagents

- Target and dye settings
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= Clustering settings (import optional)
= Analysis settings (import optional)
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Routine operation of development workflow

For a development run, the lane settings are not
contained in the raw data file. The lane settings can
either be assigned to the run from an unassigned sample
setup or they can be added directly to the run.

*& Working with raw data files and runs in the
development software (317)

*& Assigning partially matching unassigned sample
setups to development runs in the development
software (321)

*& Adding and editing lane settings of a run in the
development software (325)

About target and dye settings The raw data file contains the detection formats of the
run in the run settings, i.e., the channels, the dyes, and
the integration time for the detection of fluorescence by
the analyzer.

In the lane settings, in the Target and dye settings
table, you define which subset of the detected dyes is
contained in the individual master mix reagents and you
map the targets to the dyes.

The following applies:

= Only dyes that are enabled in the run settings are
available in the lane settings.
= You can only reuse a master mix reagent across a

project if the runs or unassigned sample setups use
the same detection formats.

If you enable or disable targets for a master mix reagent
in the lane settings, any clustering for that master mix
reagent is updated accordingly.

About merged lanes Merged lanes emulate the partitioning of a larger sample
volume into a higher number of nanowells. The system
treats the nanowells of a set of merged lanes as if they
belong to 1 nanowell plate lane. Merged lanes therefore
facilitate detection of very low target concentrations.

Up to 8 nanowell plate lanes can be merged.

A set of merged lanes has the following characteristics:

= The same reaction mixture is pipetted into the
merged lanes.

= The merged lanes are analyzed together. A set of
merged lanes gets 1 final result.
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In the development software, nanowell plate lanes with
identical lane settings are merged automatically. Empty
lane settings are considered as identical.
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Runs in the development software

Naming of raw data files

The position of a set of merged lanes in a sample setup
is denoted by the lowest position of the included
nanowell plate lanes.

Example:

If the nanowell plate lanes A1, B1, and C1 are merged,
the position of the set of merged lanes is denoted as
"AT"

The position is also used as name for the set of merged
lanes.

*& About the positions of nanowell plate lanes in
sample setups (153)

Before export, raw data files are identified by the run
name in the analyzer software and the web application.

By default, after export, a raw data file is named
RunType_RunName_SN_YYYYMMDDhhmmss.dpcrRaw
with the date and time the run was started on the
analyzer.

A raw data file has a .dpcrRaw file extension.

2O-If you change the name of a development run in
the analyzer software before export, the run name
is used as name of the export file.

After import into the development software, the raw data
files are listed in the Runs menu as
"RunName (DD/MM/YYYY hh:mm:ss)".

»& List of naming placeholders (154)

Managing raw data files of development runs in the

analyzer software

About renaming

Roche Diagnostics

For development runs, you can rename, export, and
delete the raw data files in the analyzer software.

Renaming the raw data file in the analyzer software
changes the file name as well as the run name that is
contained in the raw data file.

The name can consist of 1 to 20 characters.
The name must not contain the following characters:
X< >/\:" |’

Do not change the file name in the Windows Explorer.
Changing the file name does not change the run name.
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Routine operation of development workflow

Alternatively, you can change the run name in the
development software after import of the raw data file.

*& Working with raw data files and runs in the
development software (317)

About export Even if automatic export of the raw data files is
configured, manual export of the raw data files is always
possible.

If no automatic export of the raw data files is configured
or if automatic export fails, you must export the raw data
files manually.

After export, you can open or import the raw data file in
the development software.

»& Working with raw data files and runs in the
development software (317)

E] O Optionally, external storage device, e.g., USB flash
drive
%: O Raw data available in analyzer software (development

run finished on the analyzer)

O Enough memory in the network share or on the
external storage device

O Development operator user role

» To rename the raw data of a
development run in the analyzer
software

1 In the analyzer software, choose Routine >
Development run > Development results.

- The Development results panel is displayed.

2 Choose the run.

3 Choose the Rename button.
- The Rename dialog box is displayed.
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Runs in the development software

Roche Diagnostics

Enter a new name for the run and choose the Save
button.

@ The name can consist of 1 to 20 characters.
The name must not contain the following
characters:

2 > /\ : " | ’

- The new name is displayed on the Development
results panel.

To export the raw data of a
development run manually from the
analyzer software

Optionally, to export to an external storage device,
connect the external storage device to the analyzer.

In the analyzer software, choose Routine >
Development run > Development results.

- The Development results panel is displayed.
Choose the run.

Choose the Export button.
= The Export dialog box is displayed.

To change the export path, choose the ++- button.
- The Select folder dialog box is displayed.

In the folder browser, navigate to a folder.
Choose the Confirm button.

In the Export dialog box, choose the Export button.
= The results are exported as dpcrRaw file.

To delete the raw data of a
development run in the analyzer
software

In the analyzer software, choose Routine >
Development run > Development results.

- The Development results panel is displayed.
Choose the run.

Choose the Delete button.
= The Delete dialog box is displayed.
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Routine operation of development workflow

4 Choose the Confirm button.

- The run is deleted from the table on the
Development results panel.

Exporting raw data files of diagnostic runs from the web
application

For diagnostic runs, you can export the raw data files
from the web application if the export conditions are met.

Even if automatic export of the raw data files is
configured, manual export of the raw data files is always
possible if the export conditions are met.

If no automatic export of the raw data files is configured
or if automatic export fails, you must export the raw data
files manually.

After export, you can open or import the raw data file in
the development software.

»& Working with raw data files and runs in the
development software (317)

About export conditions For a diagnostic run, the export of the raw data file is
only possible if the following conditions are met:
= All results of the diagnostic run must be complete,
i.e., released and sent. The run must be listed on the
Completed batches screen.
= The export of the raw data file must be enabled in the
analysis packages used for the diagnostic run.

-“Q'— If a diagnostic run uses 2 or more analysis
packages with different export settings, the most
restrictive option is applied to the raw data file of
that run.

*& Analysis packages in the development software (412)

About export options There are the following export options depending on the
browser and computer configuration:

= If you access the web application from the computer
running the development software, you can export the
raw data file and directly open it as a new project in
the development software.
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Runs in the development software

Roche Diagnostics

Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1

Alternatively, you can export and save the raw data
file for later import into the development software.

Optionally, external storage device, e.g., USB flash
drive

Raw data ready for export in the web application
(diagnostic run listed on the Completed batches
screen)

Export of raw data allowed in the analysis packages
of the diagnostic run

Enough memory in the network share or on the
external storage device

Diagnostic operator user role or diagnostic approver
user role

To export and open the raw data file
of a diagnostic run from the web
application

In the web application, in the Results column on the

dashboard, choose the {count} completed batches
tile.

- The Completed batches screen is displayed.

Choose the run and choose the Export button.
= Adialog box is displayed.

Select to open the raw data file and choose the OK
button.

@ The available options and details depend on your
browser and computer configuration.
You can only open the raw data file if the
development software is installed on the same
computer.

= The development software is started.

= The Import diagnostic run data dialog box is
displayed.

In the development software, do one of the following:

= To include the analysis and clustering settings in
the import, choose the Yes button.

= To exclude the analysis and clustering settings
from the import, choose the No button.

= The diagnostic run is imported into the
development software and listed in the Runs
menu.
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Routine operation of development workflow

» To export and save the raw data file
of a diagnostic run from the web
application

1 Optionally, to export to an external storage device,

connect the external storage device to the computer
running the web application.

2 In the web application, in the Results column on the
dashboard, choose the {count} completed batches
tile.

- The Completed batches screen is displayed.

3 Choose the run and choose the Export button.
- A dialog box is displayed.

4 Select to save the raw data file and choose the OK
button.

©® The available options and details depend on your
browser and computer configuration.

- The raw data file is exported and saved in the
export location.

5 Optionally, disconnect the external storage device.

Working with raw data files and runs in the development
software

You can open or import the exported raw data files in the
development software. Then, you can rename the runs,
view the run details and the run profiles, export the run
profiles and the run data, delete the runs, or create
sample setup reports.

About matching unassigned sample setups During import of the raw data file of a development run,
the development software checks the project for a
matching unassigned sample setup:
= A matching unassigned sample setup is assigned

automatically during import.

= A partially matching unassigned sample setup can
be assigned manually after import.

The assignment transfers the lane settings from the
unassigned sample setup to the development run.

An unassigned sample setup is matching if the
following parameters match between the unassigned
sample setup and the development run:
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= Number of nanowell plates (different order is
allowed)
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Runs in the development software

= Nanowell plate IDs
= Detection formats

An unassigned sample setup is partially matching, if
the following parameters match between the unassigned
sample setup and the development run:

= Number of nanowell plates
= Nanowell plate types

= Order of the nanowell plates
= Detection formats

After an unassigned sample setup is assigned to a

development run, the following applies:

= The unassigned sample setup is deleted from the
Unassigned sample setup menu in the Navigation
area.

= You cannot assign a different unassigned sample
setup to the same development run. Instead, you
must edit the lanes settings of the run directly.

*@ Unassigned sample setups in the development
software (402)

= O Optionally, external storage device with exported raw
data file, e.g., USB flash drive

O Raw data file exported and available in network share
or on external storage device

» To open the raw data file in the
development software as a new
project

1 Optionally, if the raw data file was exported to an
external storage device, connect the external storage

device to the computer running the development
software.

2 Do one of the following:
= In the development software, on the Start page
tab, choose the Open file button.
= In the development software, in the Navigation
area, choose File > [ > Open.
= In the Windows Explorer, double-click the
dpcrRaw file.

©® The Open commands always open a new
instance of the development software.

3 If required, navigate to the dpcrRaw file and choose
the Open button.
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- A project is created and displayed in a separate
instance of the development software. By default,
the project is named as the run.
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Routine operation of development workflow

= The run tab is displayed in the work area.

= In the Navigation area, the run is listed in the
Runs menu.

- 1 default clustering per combination of master mix
reagent and plate type is added to the project and
listed in the Clustering menu.

4 Save the project.

» To import the raw data file into a
project in the development software
1 In the development software, open the project as

described in Working with projects in the
development software (295).

@ You can import several runs into the same project.
2 In the Navigation area, choose Runs > B >
Import.

©® The Import command imports the raw data file
into the same instance of the development
software.

3 Navigate to the dpcrRaw file and choose the Open
button.

4 If a matching unassigned sample setup is found, the
Matching unassigned sample setup was found.
dialog box is displayed. Choose the Confirm button.

= The run tab is displayed in the work area.

= In the Navigation area, the run is listed in the
Runs menu.

- Any affected clustering is updated according to
the rules for clustering.

5 If the project contains a partially matching
unassigned sample setup, assign it manually as
described in Assigning partially matching unassigned
sample setups to development runs in the
development software (321).

6 Save the project.
» To rename a run in the development
software

1 In the Navigation area, choose the run from the
Runs menu. Choose B > Rename.

2 In the Edit run name dialog box, enter the new
name.

3 Choose the Save button.
- The run tab is renamed.
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= The run listed in the Runs menu is renamed.

4 Save the project.
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Runs in the development software

To view the run profile of a run in the
development software

In the Navigation area, choose the run from the
Runs menu. Choose [ > View run profile.

= The run profile is displayed in the same format as
on the Edit run profile panel in the analyzer
software.

= The run profile is view only. You cannot edit the
run profile.

To display the channel, dye, and integration time
settings, choose the Detection formats button.

To close the Detection format combo box, choose
the Cancel button.

To close the run profile, choose the * button.

To view the run details of a run in the
development software

In the Navigation area, choose the run from the
Runs menu. Choose B > View run details.

- The Run details dialog box is displayed.

Roche Diagnostics

To close the run details, choose the Close button.

To export the run profile of a run from
the development software

In the Navigation area, choose the run from the
Runs menu. Choose n > Export run profile.

Navigate to a folder. Enter a name for the export file
and choose the Save button.

= The run profile is exported as dpcrPfrl file.
To export the run data of a run to CSV
from the development software

In the Navigation area, choose the run from the
Runs menu. Choose B > Export run data to CSV.
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Routine operation of development workflow

2 Navigate to a folder and choose the OK button.

= A CSV file per nanowell plate lane is exported to
the folder.

- The first row in the CSV files contains the column
headers, i.e., the legend.

» To delete a run from a project in the
development software

1 In the Navigation area, choose the run from the
Runs menu. Choose [l > Remove.

2 In the Warning dialog box, choose the Confirm
button.

©® You cannot restore the run, but you can open or
import the run again.

= The run is deleted from the project.

- The samples of the run are deleted from any
affected clustering. An empty clustering is deleted
from the project.

= The samples of the run are deleted from the
analyses. Empty analyses are kept in the project.

- Any analysis package that was created based on
the run is not affected, but kept unchanged in the
project.

3 Save the project.

» To create a sample setup report of a
run in the development software
1 In the Navigation area, choose the run from the

Runs menu. Choose B > Create a sample setup
report.

2 Navigate to a folder. Enter a name for the report and
choose the Save button.

@ A printout of the sample setup report may be
helpful when performing analysis.

- The sample setup report is saved as a PDF file.

Assigning partially matching unassigned sample setups
to development runs in the development software

To transfer the lane settings from a partially matching
unassigned sample setup to the corresponding imported
development run, assign the unassigned sample setup to
the run.
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Runs in the development software

Roche Diagnostics

Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1

An unassigned sample setup is partially matching, if
the following parameters match between the unassigned
sample setup and the development run:

= Number of nanowell plates

= Nanowell plate types

= Order of the nanowell plates

= Detection formats

After an unassigned sample setup is assigned to a
development run, the following applies:

= The unassigned sample setup is deleted from the
Unassigned sample setup menu in the Navigation
area.

= You cannot assign a different unassigned sample
setup to the same development run. Instead, you
must edit the lanes settings of the run directly.

Unassigned sample setups that are not at least partially
matching cannot be assigned to an imported
development run.

You cannot assign an unassigned sample setup to a
diagnostic run.

»& Working with raw data files and runs in the
development software (317)

O

Development run imported into project

O Project contains partially matching unassigned
sample setup

» To assign a partially matching
unassigned sample setup to a
development run in the development
software

1 In the development software, in the Navigation area,
choose the run from the Runs menu.

2 Choose [B > Assign existing sample setup.
= Alist of partially matching unassigned sample

setups is displayed as submenu.

3 Choose the sample setup.

4 Choose the Confirm button.

- The lane settings of the run are transferred from
the unassigned sample setup to the run.

- The unassigned sample setup is deleted from the
project.

= Any affected clustering is updated according to
the rules for clustering.

Draft - Do Not Distribute



Routine operation of development workflow

5 Save the project.

List of columns on the Sample setup table view card

On run tabs and sample setup tabs, the columns on the
Sample setup table view card (and the entries on the
tiles on the Sample setup plate view card) display the
lane settings as entered on the Lane settings card.

-‘Q’- The entry in the MIMx ID field on the Lane
settings card is not displayed on the Sample
setup table view card.

If you change a lane setting on the Lane settings card,
the corresponding column on the Sample setup table
view card (and the entry on the tile in plate view) is
updated accordingly. If the update is delayed, close the
tab and reopen it from the Navigation area.

In plate view, a combination of 3 selected lane settings
can be displayed on the tiles.
»@ Configuring plate view (139)

*& Adding and editing lane settings of a run in the
development software (325)

*& Adding run settings and lane settings to unassigned
sample setups in the development software (406)

Lane ID column The position of the sample in the sample setup.

Sample ID column The ID of the sample as entered in the Sample ID field
on the Lane settings card.

The sample ID can be displayed on the tiles in plate view.
Dilution factor column The dilution factor for the sample in the reaction mixture

as entered in the Dilution factor field on the Lane
settings card.
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Runs in the development software

MMx column

Target names column

Dyes column

Notes column

Sample preparation notes column

Flags column

Roche Diagnostics

Example:
A dilution factor of 2 (i.e., a dilution of 1:2) means half of
the reaction mixture consists of sample.

By default (dilution of 1:1), the development software
calculates the quantitative results in relation to the
volume of the reaction mixture.

If you enter a dilution factor, the development software
automatically uses it as a multiplication factor to
calculate the quantitative results in relation to the sample
volume.

Precision = 4 decimal places

The dilution factor can be displayed on the tiles in plate
view.

The name of the master mix reagent as entered in the
MMx field on the Lane settings card.

The name of the master mix reagent can be displayed on
the tiles in plate view.

The name of the targets as entered and enabled for the
master mix reagent in the Target and dye settings
table on the Lane settings card.

By default, the targets are named as the dyes.

The name of the targets can be displayed on the tiles in
plate view.

The dyes that are enabled for the master mix reagent in
the Target and dye settings table on the Lane
settings card.

The notes as entered via the Edit notes button on the
Lane settings card.

The sample preparation notes as entered via the Edit
sample preparation notes button on the Lane
settings card.

The flags associated with the sample.

Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1 Draft - Do Not Distribute



Routine operation of development workflow

MMx lot number column Additional identifying information, e.g., the lot number of
the master reagent or master mix reagent, as entered in
the MIMx lot number field on the Lane settings card.

MMx expiry date column The expiry date, e.g., of the master reagent or the master
mix reagent, as entered in the MIVIx expiry date field on
the Lane settings card.

Merging column Indicates if the nanowell plate lane belongs to a set of
merged lanes.

For unmerged nanowell plate lanes, "None" is displayed.

For merged nanowell plate lanes, "Merged" is displayed.

Merged lanes name column The name of the set of merged lanes that is derived from
the lowest position of the merged lanes.

*& About the positions of nanowell plate lanes in
sample setups (153)

Adding and editing lane settings of a run in the
development software

After import of the raw data file into the development
software, add and/or edit the lane settings to prepare for
clustering.

If an unassigned sample setup was assigned to a
development run or if the raw data originates from a
diagnostic run, the lane settings will be prefilled but can
be edited.

You can also copy and paste lane settings between
unassigned sample setups and/or runs of the same
project.

*@ Editing lane settings via copy and paste in the
development software (335)

About lane settings Lane settings comprise the following information that
applies to individual nanowell plate lanes, i.e., samples:

= Sample ID
= Dilution factor of sample
= Name of master mix reagent
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Runs in the development software

ID of master mix reagent or master reagent

Expiry date of master mix reagent or master reagent
Lot number of master mix reagent or master reagent
Target and dye settings

Notes and sample preparation notes

The following applies to lane settings:

Changes to a master mix reagent, e.g., a name
change or changed target and dye settings, are
applied across the project wherever the same master
mix reagent is used.

If you enter the same lane settings for multiple
nanowell plate lanes, the nanowell plate lanes are
merged automatically.

For merged lanes, empty lane settings are considered
as identical.

Changes to 1 merged lane are applied automatically
to all other merged lanes of the same set.

It is recommended to use the fields for the ID, expiry
date, and lot number to track your own master mix
reagents.

*@ List of columns on the Sample setup table view card

M— O

Roche Diagnostics

(323)

Run imported into development software

To add and edit lane settings of a run
in the development software

In the development software, in the Navigation area,
choose the run from the Runs menu.

On the run tab, choose the Lane settings button.
- The Lane settings card is displayed.

Choose one or several tiles (in plate view) or rows (in
table view).

To enter the sample ID for the selected tiles or rows,
do the following:

= Choose the Sample ID field.
= Scan or enter the sample ID.
= If required, press Enter.

= The sample ID is displayed on the selected tiles or
in the selected rows.

Optionally, to enter a dilution factor for the selected
tiles or rows, do the following:

= Choose the Dilution factor field.
= Enter the dilution factor.
= Press Enter.

Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1 Draft - Do Not Distribute



Routine operation of development workflow BEy¥/

6 To add a new master mix reagent to the project and
assign it to the selected tiles or rows, do the
following:

= Choose the MVIx field.
= Enter the name of the master mix reagent.
= Press Enter.

= The master mix reagent is displayed on the
selected tiles or in the selected rows.

- By default, in plate view, all tiles with the same
master mix reagent are displayed with the same
color.

7 To assign a master mix reagent that exists in the
project to the selected tiles or rows, do the following:

= Next to the MIMx field, choose the = button.

= From the drop-down list, choose the master mix
reagent.

® You can only assign an existing master mix
reagent if the dyes that are enabled in the run
settings match.

If you assign an existing master mix reagent, the
target and dye settings are taken over from the
master mix reagent.

- The master mix reagent is displayed on the
selected tiles or in the selected rows.

- By default, in plate view, all tiles with the same
master mix reagent are displayed with the same
color.

8 Optionally, to rename the assigned master mix
reagent across the project, do the following:

= Next to the next to the MIIVIx field, choose the &
button.

= In the Edit MIMx name dialog box, enter a new
name.

= Choose the Save button.

- The master mix reagent is renamed across the
project.

9 Optionally, for the selected tiles or rows, choose the
following fields and scan or enter the additional
information for the master mix reagent or master
reagent:
= MMxID
= MMx expiry date
=  MMx lot number

10 Optionally, in the Target and dye settings table,
disable targets for the selected tiles or rows.
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Runs in the development software

©® Only the dyes for channels that were enabled in
the run settings are displayed.
At least 1 target must be enabled for each master
mix reagent.
Disabled targets are excluded from clustering and
analysis later in the development workflow.
Ensure that you disable empty channels.

11 To map the targets to the dyes, rename the targets:
= Choose the Target field.
= Enter the name of the target.
= Press Enter.

@ You can display the mappings on the clustering
tabs later in the development workflow.

12 Optionally, add notes and/or sample preparation
notes.

13 Repeat steps 3 to 12 for all other tiles or rows.

14 Optionally, to undo or redo changes, choose the
buttons above the tiles (in plate view) or rows (in
table view):

= To undo a change, choose the Undo button.

= Toredo a change, choose the Redo button.

= Toreset all lane settings to default values, choose
the Reset button.

©® The last 15 steps are retained and can be undone
or redone, including a reset to default.

15 Save the project.

Working with sample groups in the development software

Roche Diagnostics

Sample groups allow you to perform statistics on
selected samples.

Sample groups are effective across all runs and analyses
of a project. Sample groups are displayed in the Sample
groups cards on all run tabs and analysis tabs. Any
action on a sample group is synchronized across all run
tabs and analysis tabs of a project.

If you import a diagnostic run into the development
software, a sample group per performed test is created
automatically. All samples of the run that have orders for
the corresponding test are added to the corresponding
sample group.

Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1 Draft - Do Not Distribute



Routine operation of development workflow

Sample groups and merged lanes If merged lanes belong to a sample group, always all
lanes of the set of merged lanes belong to the sample
group because the merged lanes contain the same
sample.

If you add a merged lane to a sample group, all other
merged lanes of the same set are added automatically to
the sample group.

If you merge a lane that is part of a sample group, all
other merged lanes of the same set are added
automatically to the sample group.

» To create a sample group in the
development software

1 In the development software, to navigate to the
Sample groups card from the Navigation area, do
one of the following:

= Choose the run from the Runs menu. On the run
tab, choose the Sample groups button.

= Choose the analysis from the Analysis menu. On
the analysis tab, choose the i button. In the
Settings combo box, choose the Sample
selection tab.

2 Select the samples for the sample group.

@ To add samples across runs and/or analyses,
create the sample group from 1 run or analysis,
and then update the sample group with the
samples from the other runs and/or analyses.
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Runs in the development software

3 On the Sample groups card, choose the New
button.

- A sample group is created that contains the
selected samples and is listed on the Sample
groups card.

- Sample groups are numbered consecutively.

4 Save the project.

» To add samples to a sample group in
the development software

1 In the development software, to navigate to the
Sample groups card from the Navigation area, do
one of the following:

= Choose the run from the Runs menu. On the run
tab, choose the Sample groups button.

Choose the analysis from the Analysis menu. On
the analysis tab, choose the & button. In the
Settings combo box, choose the Sample
selection tab.

2 Select the samples that you want to add to a sample
group.

14 Routine operation of development workflow

Roche Diagnostics

®
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Routine operation of development workflow

3 On the Sample groups card, choose the + button
of the sample group you want to add the samples to.

- The new samples and the samples already
belonging to the sample group are selected.

4 On the Sample groups card, choose the Update
button.

@ Without this step, the samples are not added to
the sample group!

= The sample group contains both the old and the
newly added samples.

5 Save the project.

» To update a sample group in the
development software

1 In the development software, to navigate to the
Sample groups card from the Navigation area, do
one of the following:
= Choose the run from the Runs menu. On the run

tab, choose the Sample groups button.

= Choose the analysis from the Analysis menu. On
the analysis tab, choose the & button. In the
Settings combo box, choose the Sample
selection tab.
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Runs in the development software

2 On the Sample groups card, choose the sample
group.
- The samples belonging to the sample group are
selected.

3 Press and hold Ctrl. Select and/or deselect samples
for the sample group.

@ Pressing Ctrl keeps the selected samples. If you
just select a sample without pressing Ctrl, all
other samples are deselected.

4 On the Sample groups card, choose the Update
button.

@ Instead of updating a sample group, consider
deleting it and creating a new one.

- The selected samples are added to the sample
group.

- The deselected samples are removed from the
sample group.

5 Save the project.

» To rename a sample group in the
development software

1 In the development software, to navigate to the
Sample groups card from the Navigation area, do
one of the following:

= Choose the run from the Runs menu. On the run
tab, choose the Sample groups button.

Choose the analysis from the Analysis menu. On
the analysis tab, choose the &k button. In the
Settings combo box, choose the Sample
selection tab.

14 Routine operation of development workflow
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Routine operation of development workflow

2 On the Sample groups card, choose the sample
group.
3 Choose the Rename button.
= The Edit sample group name dialog box is
displayed.
4 Enter the new name and choose the Save button.
- The new name of the sample group is displayed
on the Sample groups card.

5 Save the project.

» To delete a sample group in the
development software

1 In the development software, to navigate to the
Sample groups card from the Navigation area, do
one of the following:
= Choose the run from the Runs menu. On the run

tab, choose the Sample groups button.

= Choose the analysis from the Analysis menu. On
the analysis tab, choose the & button. In the
Settings combo box, choose the Sample
selection tab.
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Runs in the development software

2 On the Sample groups card, choose the sample
group.

3 Choose the Delete button.
= The Warning dialog box is displayed.

4 Choose the Confirm button.

@ You cannot restore deleted sample groups.

= The sample group is deleted from the Sample
groups card.

5 Save the project.

& Related topics
= Projects in the development software (294)
= Clustering in the development software (338)
= Analyses in the development software (358)

= Unassigned sample setups in the development
software (402)

= Analysis packages in the development software (412)
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Routine operation of development workflow

Editing lane settings via copy and paste in
the development software

Instead of adding and/or editing lane settings manually,
you can copy and paste them between unassigned
sample setups and/or runs of the same project in the
development software.

*& Adding and editing lane settings of a run in the
development software (325)

*& Adding run settings and lane settings to unassigned
sample setups in the development software (406)

About rules The following rules apply for copy and paste:

= You can only copy and paste between setups of the
same project, not across projects.

= The source setup is the unassigned sample setup or
run that you copy lane settings from.

= The target setup is the unassigned sample setup or
run that you paste lane settings to.

= Both source setup and target setup can be an
unassigned sample setup or a run.

= Source and target setup can be the same, i.e., you
can copy and paste within the same setup or between
different setups.

= Both source setup and target setup must be in plate
view or table view.

= If you copy a single nanowell plate lane in the source
setup, you can paste it to any nanowell plate lane in
the target setup.

= The copied nanowell plate lanes are highlighted.

= You can paste repeatedly. The copied lane settings
are retained on the clipboard until you clear the
clipboard or copy different lane settings.

In table view, you can copy 1 row only. However, you
can paste to several rows at the same time (resulting in
merged lanes).

In plate view, the following additional rules apply:

= You can copy and paste several tiles at the same time
(not necessarily resulting in merged lanes).

* You can only copy and paste adjacent tiles, i.e., there
can be not gaps between the tiles.

= You can copy and paste several tiles if you choose
the same number and distribution of tiles across
nanowell plates in the source setup and the target
setup.
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Editing lane settings via copy and paste in the development software

= You can copy several tiles from the same nanowell
plate and choose 1 tile only in the target setup if
there are enough tiles below the selected tile in the
target setup. The tiles are pasted starting from the
selected tile towards the end of the nanowell plate.

» To edit lane settings via copy and
paste in the development software

1 In the development software, choose the target setup:
= From the Runs menu, choose a run.

= Alternatively, from the Unassigned sample
setup menu, choose an unassigned sample setup.

= The sample setup tab or run tab is displayed in the
work area.

2 Choose the source setup:
= From the Runs menu, choose a run.

= Alternatively, from the Unassigned sample
setup menu, choose an unassigned sample setup.

= The sample setup tab or run tab is displayed in the
work area.

3 Ensure that both the source setup and the target
setup are displayed in the same view (plate view or
table view).

4 To copy the lane settings in plate view, do the
following:

= Choose the tab of the source setup.

= On the Sample setup plate view card, choose
one or several tiles.

= Choose the Copy button.

= Optionally, to clear the clipboard, choose the
Cancel copy button.

@ To deselect the tiles, press Esc.

- The source tiles are highlighted.

5 To copy the lane settings in table view, do the
following:

= Choose the tab of the source setup.

= On the Sample setup table view card, choose a
row.

= Choose the Copy button.

= Optionally, to clear the clipboard, choose the
Cancel copy button.

= The source row is highlighted in red.

6 Paste the lane settings:
= Choose the tab of the target setup.

= Choose one or several tiles (in plate view) or rows
(in table view).

= Choose the Paste button.
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Routine operation of development workflow

= Optionally, to undo the paste operation, choose
the Undo button.

7 Save the project.

S
L=
[
=L

| S

(=)

S
o]

o

(5]

=

Q.
L=

(5]

>

Q
§=]
-

(=)

c
S
)
o
| &
Q
(=
(@)
Q
c
I;
-
Q
(2’
3
F

Roche Diagnostics
Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1 Draft - Do Not Distribute




Clustering in the development software

Clustering in the development software

Clustering differentiates between positive and negative
nanowells.

In this section

About clustering in the development software (338)
List of columns on the Clustering data card (339)

Changing the display options for the scatter plots in the
development software (341)

Adjusting the clustering in the development
software (342)

Exporting custom clustering parameters as seed data

files (356)

= About clustering in the development software

(=}
E Clustering differentiates between positive nanowells that
rum are counted as containing the target and negative

=) nanowells that are counted as not containing the target.
; Clustering provides the data basis for the followin

gp 9

v analyses.

e

(«b)

E For clustering, the following applies:

o = The development software automatically performs
(=] initial clustering when you choose the clustering from
Q the Navigation area. You can then adjust the

> clustering.

% = Clustering is done across all runs of a project,

(. regardless of the run type (development run or

(=) diagnostic run).

S = All samples that were processed with the same

p p

,9 combination of master mix reagent and nanowell

= late type are clustered together

c p yp g -

3 = Consequently, a project in the development software
o always contains 1 clustering per combination of

(=) master mix reagent and nanowell plate type that is
b used in any of its runs.

.E = Aslong as the master mix reagents are not specified
'5' (e.g., by editing the lane settings), the development
o software assigns a default master mix reagent to all
o samples that were processed with the same

< combination of nanowell plate type and detection

formats.
F

= Merged lanes are listed individually on a clustering
tab and their scatter plots are displayed separately.
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Routine operation of development workflow

The development software adds, updates, and/or deletes
the clustering tabs when you do one of the following:

= Open a raw data file as a new project:

- Clustering tabs are added.

= Import a raw data file into an existing project:

- All samples with a combination of master mix
reagent and nanowell plate type that matches an
existing clustering are added to that clustering
tab.

- For all other samples, clustering tabs are added.
= Change the master mix reagent for samples:

- If the new combination of master mix reagent and
nanowell plate type matches an existing
clustering, the samples are moved to that
clustering tab.

- If the new combination of master mix reagent and
plate type does not match an existing clustering,
a clustering tab is added.

- Clustering tabs without samples are deleted.

= Delete a run from a project:

- The samples of that run are deleted from the
affected clustering tabs.

- Clustering tabs without samples are deleted.

List of columns on the Clustering data card

On clustering tabs, the columns on the Clustering data
card display the sample and clustering information.

Sample ID column The sample ID of the sample as entered in the lane
settings on the run tab.

Merged lanes are always clustered and listed separately.
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»@ List of columns on the Sample setup table view card
(323)
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Clustering in the development software

Lane column

Columns for number of positive nanowells

Total valid nanowells column

Quality indicator column

Roche Diagnostics

Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1

The position of the sample in the sample setup.

The Pos. NWs {0}-{1} columns display the number of
positive nanowells of the sample determined from the
current clustering settings.

The Clustering data card contains a separate Pos.
NWs {0}-{1} column per dye that is enabled in the lane
settings on the run tab.

The placeholders in the curly brackets are replaced as
follows:

= {0} is replaced with the dye name.

= {1} is replaced with the target name as entered in the
lane settings on the run tab.

»@ List of columns on the Sample setup table view card
(323)

The total number of valid nanowells of the sample, i.e.,
the sum of positive and negative nanowells.

The system may invalidate some nanowells, e.g.,
nanowells that cannot be imaged properly due to dust
particles.

For the automatic clustering methods, the quality
indicator (Ql) evaluates the actual clustering for a
nanowell plate lane. If applicable, the number of clusters,
the separation and size of the positive and negative
clusters, the relative fluorescence intensities of the
clusters, and the cluster tightness are considered for Ql
calculation.

Consequently, the quality indicator is not reliable for
negative controls (1 cluster only) or indel tests (3 clusters
in 2 channels).

The quality indicator is only suitable for comparison of
similar reaction mixtures, e.g., during test optimization.

In the Quality indicator column, the numerical value of
the quality indicator and the derived classification are
displayed:

= Low forQl < 0.33

= Medium for 0.33 < Ql < 0.67

= High for Ql > 0.67

For the manual clustering method, Undefined is
displayed.

Draft - Do Not Distribute



Routine operation of development workflow

The quality indicator does not distinguish between the
channels, but is calculated across all channels of a
nanowell plate lane.

*@ List of clustering settings in the development
software (342)

Flags column The flags associated with the sample.

Changing the display options for the scatter plots in the
development software

On the clustering tabs, you can change the display
options for the scatter plots.

By default, all samples that are listed on the Clustering
data card on a clustering tab are displayed in the scatter
plots.

*& About the display options (132)

» To change the display options for the
scatter plots in the development
software

1 In the development software, in the Navigation area,
choose a clustering from the Clustering menu.

- The clustering tab is displayed.

2 To highlight a sample in the scatter plots in green,
mouse over the corresponding row on the Clustering
data card.

3 To display the scatter plots for specific samples only,
select the check boxes of the samples on the
Clustering data card.

0 Clearing the check boxes of samples on the
Clustering data card does not exclude such
sample from clustering. Even if they are not
displayed in the scatter plots, they are still
included in the clustering.

4 To display all samples in the scatter plots again, do
one of the following:

= Select the check boxes of all samples in the table.
= Clear the check boxes of all samples in the table.
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5 To adjust the available screen space for the scatter
plots, do the following:
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Clustering in the development software

* To hide the Navigation area, choose the 5
button.

= To hide or display the Clustering data card,
choose the Table button above the scatter plots.

6 To display the scatter plots for different channels next
to each other, choose the View buttons.

7 To hide or display the dye to target name mapping
and a legend for the color-coding of the scatter plots,
choose the Legend buttons.

8 To toggle between a linear and a logarithmic scale for
the fluorescence axes, choose the Scale buttons.

9 To display or hide a heatmap, choose the Heatmap
buttons.

10 To display or hide a histogram, choose the
Histogram buttons.

11 Save the project.

Adjusting the clustering in the development software

To change the differentiation between positive and
negative nanowells that is automatically done by the
development software, adjust the clustering.

By itself, you cannot exclude samples from clustering.
However, you can assign a separate master mix reagent
to such samples. This will move these samples to a
separate clustering for the resulting combination of
nanowell plate type and master mix reagent.

In this section

List of clustering settings in the development
software (342)

Adjusting the clustering settings for the automatic
clustering methods (347)

Adjusting the clustering settings and thresholds for
manual clustering (350)

List of clustering settings in the development software

Roche Diagnostics

Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1

The clustering settings allow you to select the clustering
method, the plot type, the channels, and the axis ranges.

The choice of clustering settings influences the
availability of other clustering settings.

Draft - Do Not Distribute



Routine operation of development workflow

To display the clustering settings, in the top right corner
on the clustering tab, choose the & button.

Clustering drop-down list

Determines the clustering method:

= Automatic
The clustering is calculated as if all scatter points
originated from one nanowell plate lane.

= Automatic (individual)

The clustering is calculated separately for each
nanowell plate lane.
= Automatic - External seed data
The clustering uses the exported clustering settings
from a previous automatic clustering for calculation.
= Manual
The user adjusts the clustering thresholds.

Default value = Automatic

For the automatic clustering methods, the development
software differentiates automatically between positive
and negative nanowells using built-in algorithms. In the
clustering data table, a quality indicator is displayed that
classifies the reliability of the clustering.

For the manual clustering method, the quality indicator is
not available.

Clustering parameters drop-down list

For the Automatic clustering method and the
Automatic (individual) clustering method only:
Predefined balances for the sensitivity specificity
parameter and the competition cross-reactivity
parameter that are optimized for specific applications:
= Standard

= Rare event detection

= Genotyping
= Indel
= Custom

Default value = Custom

The Custom option of the clustering parameters allows
you to set the balances manually in the Sensitivity
specificity field and the Competition cross-reactivity
field.
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Clustering in the development software

Sensitivity specificity field

A B C

A 0.0000 B 0.5000 C 1.0000

Competition cross-reactivity field

Roche Diagnostics

Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1

For the Custom option of the clustering parameters only:
Editable value between 0.0000 and 1.0000 that
determines the balance between sensitivity and
specificity:

= 0.0000 = maximum sensitivity

= 1.0000 = maximum specificity

The lower the value, the closer the threshold is set to the
negative cluster.

Default value = 1.0000

Precision = 4 decimal places

The figure illustrates for 1 nanowell plate lane how a
change in the value affects the very small number of
scatter points between the negative and the positive
clusters:

= Left = 0.0000 (maximum sensitivity):

- Higher sensitivity increases the number of
nanowells that are counted as positive.

- Maximum sensitivity sets the lowest possible
threshold for a nanowell to be counted as
positive.

= Middle = 0.5000
= Right = 1.0000 (maximum specificity):
- Higher specificity increases the number of

nanowells that are considered as outliers and are
counted as negative.

- Maximum specificity sets the highest possible
threshold for a nanowell to be counted as
positive.

For the Custom option of the clustering parameters only:
Editable value between 0.0000 and 1.0000 that accounts
for competition and cross-reactivity:

= 0.0000 = no competition, no cross-reactivity
= 1.0000 = maximum competition and cross-reactivity

The higher the value, the more the reaction artifacts from
competition and cross-reactivity are taken into account
for clustering.

Default value = 0.0000

Precision = 4 decimal places

Draft - Do Not Distribute



Routine operation of development workflow

If 2 targets compete for reaction components, the
fluorescence of nanowells that contain both targets is
lower in both channels than the fluorescence of
nanowells that contain 1 of the targets only.

If 2 targets cross-react, a positive reaction in 1 channel
raises the baseline for the negative nanowells in the
other channel.

The figure illustrates the effects of such reaction artifacts
in a 2D scatter plot:

= Competition:

- Without competition, the double-positive cluster
(green) has the same fluorescence intensities as
the single-positive clusters (yellow and blue).

- With competition, the green cluster would be
below the yellow cluster and left from the blue
cluster.

= Cross-reactivity:

- Without cross-reactivity, the single-positive
clusters (yellow and blue) lie on the same
baseline as the double-negative cluster (brown).

- With cross-reactivity, the yellow cluster would be
to the right of the brown cluster and/or the blue
cluster would be above the brown cluster.

Export seed data button and Import seed data
button

Allows you to transfer the custom clustering parameters
to another automatic clustering and to use the custom
clustering parameters in analysis packages.

The Export seed data button is only available for the
Automatic clustering method with the Custom option
of the clustering parameters.

The Import seed data button is only available for the
Automatic - External seed data clustering method.

A seed data file has a .sdxml/ file extension.
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Clustering in the development software

Graph drop-down list

Determines the type of scatter plots used to visualize the
fluorescence intensities:

= 1D scatter plot
= 2D scatter plot
= 3D scatter plot

Default value = 1D scatter plot

In a 1D scatter plot, the fluorescence intensity of a
channel is plotted against the nanowell index that is
randomized for visualization purposes only.

In a 2D scatter plot or a 3D scatter plot, the nanowell
fluorescence intensities of 2 or 3 channels, respectively,
are plotted against each other.

The scatter plots that use the same channels are linked:
changes in 1 of the scatter plots are automatically taken
over into the other scatter plots.

The 2D and 3D scatter plots are only available if enough
channels are available.

2= To facilitate the clustering for indel analysis, use
the 2D scatter plot type.

For 2D scatter plots, the following applies:

= For the Manual clustering method, the Threshold
button, the Lasso button, and the Spider button are
displayed below the clustering method indicator.

= However, the Lasso button and the Spider button
are only available if exactly 2 targets are enabled for
the master mix reagent in the lane settings.

= A manual clustering via the Lasso button or the
Spider button cannot be used in the clustering
settings of an analysis package.

For 3D scatter plots, the following applies:

= For a 3D scatter plot, you must enable exactly 3
channels in the Select channels table.

= The 3D scatter plot is for visualization purposes only.
You cannot adjust the thresholds in a 3D scatter plot.
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Routine operation of development workflow

Select channels table

Allows you to include or exclude channels from the
scatter plots.

For the 2D scatter plot plot type or the 3D scatter plot
plot type, you must enable the corresponding number of
channels.

Axis ranges group box

In the Min. field and the Max. field, enter the start and
end values for the intensity-axes of the scatter plots (e.g.,
the y-axis of the 1D scatter plot).

By default, the maximums of the axis ranges are set to
display all scatter points.

To reset the axis ranges, choose the Reset button.

Adjusting the clustering settings for the automatic clustering methods

For the automatic clustering methods, you can adjust
clustering parameters, the plot type, the enabled
channels, and the axis ranges.

To import the custom clustering parameters from an
automatic clustering, use the Automatic - External
seed data clustering method.

About compatibility of seed data files A seed data file can only be imported if the following
prerequisites are met:

= The seed data file was not modified, i.e., the signature
can be verified.

= The nanowell plate type in the seed data file is the
same as in the clustering.

= The detection formats match.

2O)-  Ensure that you use a seed data file that is
compatible with the master mix reagent.

O For Automatic - External seed data clustering
method:
Seed data file (SDXMIL file)
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*& Exporting custom clustering parameters as seed data
files (356)
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Clustering in the development software

» To adjust the clustering settings for
the Automatic clustering method or
the Automatic (individual) clustering
method

1 In the development software, in the Navigation area,
choose the clustering from the Clustering menu.

- The clustering tab is displayed.

2 In the top right corner, choose the 3 button.
- The Settings combo box is displayed.

3 From the Clustering drop-down list, choose the
Automatic option or the Automatic (individual)
option.

4 To set the clustering parameters, from the Clustering
parameters drop-down list, choose an option:
= Standard
= Rare event detection
= Genotyping
* Indel
* Custom

5 For the Custom option, to shift the balance between
sensitivity and specificity, enter a value between
0.0000 and 1.0000 in the Sensitivity specificity field:

= 0.000 = maximum sensitivity
= 1.0000 = maximum specificity

6 For the Custom option, to shift the balance between
competition and cross-reactivity, enter a value

between 0.0000 and 1.0000 in the Competition
cross-reactivity field:

= 0.0000 = maximum competition
= 1.0000 = maximum cross-reactivity

7 From the Graph drop-down list, choose an option:
= 1D scatter plot
= 2D scatter plot

@ The 3D scatter plot is for visualization purposes
only. You cannot adjust the thresholds in a 3D
scatter plot.

8 In the Select channels table, enable the channels
that you want to plot.

9 Optionally, in the Axis ranges fields, enter the
minimum and maximum values for the intensity axes
of the scatter plots. To reset the axis ranges, choose
the Reset button.

=
Q
=
=
=
(@)
S
)
c
Q
e
=1
L=
Q
>
Q
E=]
-
(=)
c
=]
-
©
P S
Q
=
o
(<b)
c
-
-
Q
(o'
J
F

10 Click outside the Settings combo box. Alternatively,
choose the £¥ button.

Roche Diagnostics
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Routine operation of development workflow

- The scatter plots and the values on the
Clustering data card are recalculated and
displayed.

11 Save the project.

» To adjust the clustering settings for
Automatic - External seed data
clustering method

1 Optionally, if the seed data file is stored on an
external storage device, connect the external storage
device to the computer running the development
software.

2 In the development software, in the Navigation area,
choose the clustering from the Clustering menu.

- The clustering tab is displayed.

3 In the top right corner, choose the &} button.
- The Settings combo box is displayed.

4 From the Clustering drop-down list, choose the
Automatic - External seed data option.

5 Choose the Import seed data button.

6 Navigate to the seed data file (SDXML file) and
choose the Open button.

7 From the Graph drop-down list, choose an option:
= 1D scatter plot
* 2D scatter plot
@ The 3D scatter plot is for visualization purposes

only. You cannot adjust the thresholds in a 3D
scatter plot.

8 In the Select channels table, enable the channels
that you want to plot.

9 Optionally, in the Axis ranges fields, enter the
minimum and maximum values for the intensity axes
of the scatter plots. To reset the axis ranges, choose
the Reset button.

10 Click outside the Settings combo box. Alternatively,
choose the £} button.

= The scatter plots and the values on the
Clustering data card are recalculated and
displayed.

11 Save the project.

12 Optionally, disconnect the external storage device.
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Clustering in the development software

Adjusting the clustering settings and thresholds for manual clustering

For the manual clustering method, you can adjust the
plot type, the enabled channels, and the axis ranges in
the clustering settings. In the scatter plots, you must
adjust the thresholds manually.

With the Manual clustering method, you can adjust the
thresholds manually in 1D scatter plots and 2D scatter
plots only.

A manual clustering via the Lasso button or the Spider
button cannot be used in the clustering settings of an
analysis package.

» To adjust the clustering settings for
the Manual clustering method

1 In the development software, in the Navigation area,

choose the clustering from the Clustering menu.

- The clustering tab is displayed.

2 In the top right corner, choose the # button.
- The Settings combo box is displayed.

3 From the Clustering drop-down list, choose the
Manual option.

4 From the Graph drop-down list, choose an option:
* 1D scatter plot
= 2D scatter plot
©® The 3D scatter plot is for visualization purposes

only. You cannot adjust the thresholds in a 3D
scatter plot.

In the Select channels table, enable the channels
that you want to plot.

6 Optionally, in the Axis ranges fields, enter the
minimum and maximum values for the intensity axes
of the scatter plots. To reset the axis ranges, choose
the Reset button.

7 Click outside the Settings combo box. Alternatively,
choose the £} button.

- The values on the Clustering data card are
deleted.

= The scatter plots are displayed.
8 Save the project.

9 Depending on the selected plot type, continue with

adjusting the thresholds in the scatter plots as

described in:

* To adjust the threshold in a 1D scatter plot
(manual clustering) (351)

14 Routine operation of development workflow
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Routine operation of development workflow

= To adjust the thresholds in a 2D scatter plot with
the Threshold button (manual clustering) (352)

* To adjust the thresholds in a 2D scatter plot with
the Lasso button (manual clustering) (353)

= To adjust the thresholds in a 2D scatter plot with
the Spider button (manual clustering) (354)

* To calculate the values in the clustering data table
for a 3D scatter plot (manual clustering) (355)

» To adjust the threshold ina 1D
scatter plot (manual clustering)

1 Adjust the clustering settings as described in To
adjust the clustering settings for the Manual
clustering method (350). Choose the 1D scatter plot
option.
= The values on the Clustering data card are

deleted.
= The scatter plots including threshold indicators
(dashed lines) are displayed.

=> The scatter points are color-coded.

= The threshold values are displayed above the
scatter plots.

2 To adjust a threshold, do the following:

= Mouse over a threshold indicator (dashed line)
until the cursor changes to a double arrow.

= Move the threshold indicator via drag and drop.
- The coloring of the scatter points is updated.

3 Choose the Calculate button.

- The values on the Clustering data card are
calculated and displayed.

4 Save the project.
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Clustering in the development software

Roche Diagnostics

To adjust the thresholds in a 2D
scatter plot with the Threshold button
(manual clustering)

Adjust the clustering settings as described in To

adjust the clustering settings for the Manual

clustering method (350). Choose the 2D scatter plot

option.

= The values on the Clustering data card are
deleted.

= The scatter plots including threshold indicators
(dashed lines) are displayed.

- The Threshold button for the manual clustering is
selected.

=> The scatter points are color-coded according to
quadrant.

= The threshold values are displayed above the
scatter plots.

To adjust a threshold in the x-direction or y-direction
only, do the following:

= Mouse over a threshold indicator (dashed line)
until the cursor changes to a double arrow.

= Move the threshold indicator via drag and drop.
= The coloring of the scatter points is updated.

To adjust the thresholds in both x- and y-direction
simultaneously, do the following:

= Mouse over the intercept indicator (gray circle)
until the cursor changes to a quad arrow.

= Move the interception indicator via drag and drop.
=> The coloring of the scatter points is updated.

Choose the Calculate button.

- The values on the Clustering data card are
calculated and displayed.

Save the project.
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Routine operation of development workflow

» To adjust the thresholds in a 2D
scatter plot with the Lasso button
(manual clustering)

1 Adjust the clustering settings as described in To
adjust the clustering settings for the Manual
clustering method (350). Choose the 2D scatter plot
option.

- The values on the Clustering data card are
deleted.

= The scatter plots including threshold indicators
(dashed lines) are displayed.

- The Threshold button for the manual clustering is
selected.

=> The scatter points are color-coded according to
quadrant.

= The threshold values are displayed above the
scatter plots.

2 Choose the Lasso button.

@ The Lasso button is only available if exactly

2 targets are enabled for the master mix reagent
in the lane settings.

= The threshold indicators and the threshold values
are deleted from the scatter plots.
= The coloring of the scatter points is updated.

= A box to select the cluster positions (positive-
negative, negative-positive, double-negative,
double-positive) is displayed.

3 To mark the scatter points that belong to a cluster

position, do the following:

= In the box, choose a cluster position. To achieve a
helpful update of the color-coding of the scatter
points, choose the cluster positions in the
following order:
double-positive, positive-negative and negative-
positive, double-negative.

= Click in the scatter plot to set the start point.

= Click in the scatter plot repeatedly to circle the
scatter points for the selected cluster position. The
clicks are joined by straight lines.

= To close the selection area, mouse over the start
point until the cursor changes to a red square and
click.

= To remove the lines and start again, press Esc.

= The coloring of the scatter points is updated.
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4 Choose the Calculate button.
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Clustering in the development software

= The values on the Clustering data card are
calculated and displayed.

5 Save the project.

» To adjust the thresholds in a 2D
scatter plot with the Spider button
(manual clustering)

1 Adjust the clustering settings as described in To
adjust the clustering settings for the Manual
clustering method (350). Choose the 2D scatter plot
option.
= The values on the Clustering data card are

deleted.

= The scatter plots including threshold indicators
(dashed lines) are displayed.

= The Threshold button for the manual clustering is
selected.

- The scatter points are color-coded according to
quadrant.

= The threshold values are displayed above the
scatter plots.

2 Choose the Spider button.

O The Spider button is only available if exactly
2 targets are enabled for the master mix reagent
in the lane settings.

- An intercept indicator (gray circle) and endpoint
indicators (gray rectangles) are added to the
threshold indicators (dashed lines).

- The color-coding of the scatter points is updated.

3 To adjust the intercept of the thresholds, do the
following:

= Mouse over the intercept indicator (gray circle)
until the cursor changes to a quad arrow.

= Move the intercept indicator via drag and drop.
- The coloring of the scatter points is updated.

4 To adjust the endpoint of a threshold, do the
following:

= Mouse over an endpoint indicator until the cursor
changes to a quad arrow.

= Move the endpoint indicator via drag and drop.
= The coloring of the scatter points is updated.

5 Choose the Calculate button.

= The values on the Clustering data card are
calculated and displayed.
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6 Save the project.
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Routine operation of development workflow

» To calculate the values in the
clustering data table for a 3D scatter
plot (manual clustering)

1 Adjust the clustering settings as described in To
adjust the clustering settings for the Manual
clustering method (350). Choose the 3D scatter plot
option.
= The values on the Clustering data card are
deleted.

= The scatter plot is displayed.

= The scatter points are color-coded.

= The threshold values and a color legend are
displayed above the scatter plot.

2 To turn the 3D-view, click in the scatter plot. Drag
and drop the view.

@ The 3D scatter plot is for visualization purposes
only. You cannot adjust the thresholds in a 3D
scatter plot.

3 Choose the Calculate button.

= The values on the Clustering data card are
calculated and displayed.

4 Save the project.
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Clustering in the development software

Exporting custom clustering parameters as seed data
files

You can export the custom clustering parameters from
an automatic clustering as a seed data file to transfer the
clustering parameters to another automatic clustering
and to use them in analysis packages.

A seed data file is specific for the nanowell plate type.

A seed data file is exported as signed XML file and is
named
PlateType_SeedData_YYYYMMDDhhmmss.sdxml
with the date and time of the export.

A seed data file has a .sdxml/ file extension.

*@ List of naming placeholders (154)

= O Optionally, external storage device, e.g., USB flash
drive

&

O Custom clustering parameters adjusted in automatic
clustering

» To export custom clustering
parameters as seed data file

1 Optionally, to export to an external storage device,
connect the external storage device to the computer
running the development software.

2 In the development software, choose an automatic
clustering with custom clustering parameters from
the Clustering menu.

- The clustering tab is displayed in the work area.

3 In the top right corner, choose the i button.
- The Settings combo box is displayed.
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Routine operation of development workflow

4 Choose the Export seed data button.

@ You can only export a seed data file from an
automatic clustering with custom clustering
parameters.

5 Navigate to a folder. Optionally, enter a different
name for the seed data file. Choose the Save button.

- The SDXML file is exported.

6 Optionally, disconnect the external storage device.

& Related topics
= Projects in the development software (294)
= Runs in the development software (309)
= Analyses in the development software (358)

= Unassigned sample setups in the development
software (402)

= Analysis packages in the development software (412)
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Analyses in the development software

Analyses in the development software

Analyses determine the final qualitative and quantitative
results.

-‘Q’- Merged lanes are analyzed together. Therefore, a
set of merged lanes has 1 entry on an analysis
tab.

In this section

Working with analyses (358)
Absolute quantification analysis (359)
CNV analysis (376)

Indel analysis (388)

Displaying the bar charts (400)

Working with analyses

In the development software, you can duplicate, rename,
and delete analyses.

In the development software, analyses are displayed as
follows:

= Listed in the Analysis menu in the Navigation area
= Displayed as analysis tabs in the work area

By default, the analysis tabs are named as the analysis
and numbered consecutively.

You cannot rename or delete the default Abs Quant -
All analysis.

» To duplicate an analysis

1 In the Navigation area, choose the analysis from the

Analysis menu. Choose [ > Duplicate.

= The analysis tab of the duplicate analysis is
displayed in the work area.

= The duplicate analysis is listed in the Analysis
menu in the Navigation area.

= The duplicate analysis is named as the original
analysis plus the suffix " - copy x" (x =
consecutive number).
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Routine operation of development workflow

» To delete an analysis

1 In the Navigation area, choose the analysis from the
Analysis menu. Choose [i] > Delete.

2 In the Warning dialog box, choose the Confirm
button.

= The analysis is deleted from the project.

» To rename an analysis

1 In the Navigation area, choose the analysis from the
Analysis menu. Choose [i] > Rename.

2 |In the dialog box, enter the new name.

3 Choose the Save button.
- The analysis tab is renamed.

- The analysis listed in the Analysis menu is
renamed.

Absolute quantification analysis

Absolute quantification (Abs Quant) analysis determines
the presence and the concentration of known targets in
samples.

By default, each project in the development software
contains an Abs Quant - All analysis that includes all
samples and controls of the project.

You can either edit the Abs Quant - All analysis or

perform a new absolute quantification analysis on a
specified subset of samples and controls.

In this section

List of tabs and settings for absolute quantification
analysis (359)

List of result columns for absolute quantification
analysis (363)

Editing the default Abs Quant - All analysis (371)

Performing absolute quantification analysis (373)

List of tabs and settings for absolute quantification analysis
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The settings provide all parameters necessary for
absolute quantification analysis.
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Analyses in the development software

Sample selection tab

Controls tab

Roche Diagnostics

- Navigation > Analysis > [l > Abs Quant > £}

The settings are ordered on tabs in the Settings combo
box.

The availability of settings on a tab depends on the
current settings on the other tabs.

On the Sample selection tab, choose the samples for
the analysis.

The table lists all samples of the project with the sample
IDs as entered in the lane settings on the run tabs.

By default, no samples are selected for analysis.

To perform statistics, you can work with sample groups.
The Sample groups card lists all sample groups of the
project.

»& Working with sample groups in the development
software (328)

On the Controls tab, mark the positions of controls in
the sample setups and enter the valid ranges for the
controls.

If you choose a merged lane, the whole set of merged
lanes is selected automatically.

The table on the left of the tab lists the combinations of

master mix reagent and target that match the following

criteria:

= A sample with that combination was selected on the
Sample selection tab.

= The combination is not set as internal control on the
Internal controls tab.

The Run: drop-down list lists all runs that contain
samples that were selected on the Sample selection
tab.

For a diagnostic run that was imported with clustering
and analysis settings, assumed control positions are
striped if the corresponding channels were measured on
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Routine operation of development workflow

the analyzer but the tests were not included in the
analysis package. By default, such positions are analyzed
as samples, not as controls.

The table on the right of the tab lists the defined controls
for the selected combination of master mix reagent and
target.

Controls are target-specific:

If the control for a target is invalid, the system
automatically invalidates the final results for that target

for all samples of the same run.

»& Controls (165)

Lower limit field and Upper limit field The fields define the valid range for a control.
The lower limit must be lower than the upper limit.

For negative controls, the lower limit is always 0 and
cannot be changed.

Default values for positive controls:
= Lower limit = 1.0000 cp/pl
= Upper limit = 1000.0000 cp/pl

Default value for negative controls:
= Upper limit = 0.0000 cp/pl

Internal controls tab

On the Internal controls tab, choose the combination of
master mix reagent and target used as internal control
and enter the valid concentration range for the internal
control.

From the Target drop-down lists, only those targets are
available for which no controls were defined on the
Controls tab.

If a master mix reagent only contains 1 target, it is not
available as internal control.

Internal controls are measured as a separate target and
are therefore lane-specific:

If the internal control in a nanowell plate lane is invalid,
the system automatically invalidates the final results for
all targets that are tested in that nanowell plate lane.
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»Z Controls (165)
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Analyses in the development software

Lower limit field and Upper limit field

Target limits tab

Lower limit of detection field

Limits of quantification check box, Lower
limit of quantification field, and Upper limit of
quantification field

Roche Diagnostics

The fields define the valid concentration range for the
internal control.

The lower limit must be lower than the upper limit.

Default values:
= Lower limit = 1.0000 cp/pl
= Upper limit = 1000.0000 cp/pl

On the Target limits tab, optionally enter the limit of
detection and/or the limits of quantification.

A limit of detection > 0 accounts for noise in the data,
i.e., if there are positive nanowells even if the nanowell
plate lane contains no target molecules.

The initial result and the final result for a target are
negative if the calculated raw concentration of the target
is below the limit of detection.

You can see the indication to set a limit of detection in
the clustering for a target.

The concentration value to be entered as the limit of
detection can be derived from the value in the
Concentration [copies/pL] column or the Raw
concentration [copies/pL] column on the Results
panel.

The lower limit of detection must be lower than the lower
limit of quantification (if enabled).

Default value:
= Lower limit of detection = 0.0000 cp/pl

If the limit of quantification is enabled, the calculation of
the target concentration is suppressed outside of the
entered quantification range. This is to account for the
increase in uncertainty for very low or very high target
concentrations.

On the Results panel, final results outside the
quantification range are flagged. Instead of the
calculated target concentration, the quantification limit
that is not met is displayed as final quantitative result.

Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1 Draft - Do Not Distribute



Routine operation of development workflow

The lower limit of quantification must be lower than the
upper limit of quantification.

The lower limit of quantification must be higher than the
lower limit of detection.

Default values:

= Limit of quantification = disabled

= Lower limit of quantification = 0.0000 cp/pl

= Upper limit of quantification = 50000.0000 cp/pl

List of result columns for absolute quantification analysis

An absolute quantification tab displays the results of an
absolute quantification analysis on the Results panel,
the Result overview panel, the Linkage panel, and the
Statistics panel.

- Navigation > Analysis > [l > Abs Quant
The panels only display results for samples that were
selected on the Sample selection tab in the Settings

combo box.

Merged lanes are analyzed together. Therefore, a set of
merged lanes has 1 entry on an analysis tab.

Results panel

The Results panel displays the results per target
separately for each sample and control.

By default, not all available columns are visible on the
Results panel.

*é Configuring table columns (142)

Sample ID column The sample ID of the sample or control as entered in the
lane settings on the run tab.

»@ List of columns on the Sample setup table view card
(323)
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Target column The tested target as enabled in the lane settings on the
run tab.
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Analyses in the development software

MMx column

Lane column

Concentration [copies/pL] column

Final result column

Conc. 95% CI min. column and Conc. 95% CI
max. column

Flags column
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Roche Diagnostics

*@ List of columns on the Sample setup table view card
(323)

The used master mix reagent as entered in the lane
settings on the run tab.

»@ List of columns on the Sample setup table view card
(323)

The position of the sample or control in the run. Merged
lanes are indicated by the O} icon.

*& About the positions of nanowell plate lanes in
sample setups (153)

The calculated final concentration of the target in the
sample or control (final quantitative result).

"N/A" is displayed if one of the following applies:
= The final result for the target is negative.
= The final result for the target is invalid.

If the target concentration falls outside a configured limit
of quantification, the quantification limit that is not met is
displayed as final quantitative result.

*& About color-coding of final results for samples (149)

Final (qualitative) result for the sample or control. For
samples, final results consider the corresponding control
results.

The final results for samples are color-coded, i.e., the
result names are underlaid with the corresponding color.

*& About color-coding of final results for samples (149)

»& About final results (173)

The values specify the confidence interval for the 95%
confidence level (based on the applied Poisson
distribution and not accounting for other error sources):
The probability is 95% that the concentration of the
target in the sample or control lies within the specified
range.

The flags associated with the sample or control.

Critical flags that invalidate the final result are displayed
in bold.
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Routine operation of development workflow

»@ List of flags (489)

Sample type column Color-coding and icon for the control type.

*& About color-coding of controls (148)

Merged lanes column Name of the set of merged lanes as displayed in the lane
settings on the run tab.

»& About the positions of nanowell plate lanes in
sample setups (153)

Total copies column Absolute number of target molecules in the sample or
control.

Initial result column Initial (qualitative) result for the target. For samples,
initial results are regardless of the corresponding control
results.

Both samples and controls can have the following initial
results for a target:

= Negative
= Positive
= |nvalid

A sample or control has an invalid initial result if it was
invalidated at any point during the workflow, e.g., during
partitioning. A corresponding critical flag is displayed in
the Flags column.

Plate type column Nanowell plate type used for processing the sample.

»& Nanowell plates (159)

No. of positive nanowells column Number of positive nanowells for the sample or control
as determined in the clustering.

»@ List of columns on the Clustering data card (339)

Total valid nanowells column Number of valid nanowells for the sample or control as
displayed in the clustering.

The number of valid nanowells is the total of the positive
and the negative nanowells.
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»@ List of columns on the Clustering data card (339)
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Analyses in the development software

Dilution factor column

Run name column

Conc. 68% CI min. column and Conc. 68% CI
max. column

Copies per nanowell column

Relative confidence column

Negative nanowells column

Clustering method column

Raw concentration [copies/pL] column

=
Q
=
=
=
=)
S
)
c
QO
e
=1
L=
(b
>
(b
E=]
-
(=)
c
=)
-
(1)
P S
Q
=
(@)
(<b)
c
-
-
Q
(o'
J
F

Roche Diagnostics

Dilution factor as entered in the lane settings on the run
tab.

*@ List of columns on the Sample setup table view card
(323)

Run name on the analyzer in which the sample or control
was processed.

The run name is used as name of the run tab in the
development software.

The values specify the confidence interval for the 68%
confidence level (based on the applied Poisson
distribution and not accounting for other error sources):
The probability is 68% that the concentration of the
target in the sample or control lies within the specified
range.

The probability is lower because the specified range is

smaller than the range specified by the Conc. 95% CI
min. column and the Conc. 95% CI max. column.

Average number of target molecules per valid nanowell
for the sample or control.

The confidence interval normalized by the final
quantitative result (based on the applied Poisson
distribution and not accounting for other error sources).

The relative confidence is a measure for the accuracy of
the calculations.

Number of negative nanowells for the sample or the
control as determined in the clustering.

»@ List of columns on the Clustering data card (339)

Clustering method as set on the clustering tab.

*@ List of clustering settings in the development
software (342)

The calculated initial concentration of the target in the
sample or control (initial quantitative result).

Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1 Draft - Do Not Distribute



Routine operation of development workflow

Raw values are regardless of applied limits. For samples,
raw values are also regardless of the corresponding
control results.

Result overview panel

The Result overview panel summarizes the results per
target for each sample or control for the selected master
mix reagent.

Run column Run name on the analyzer in which the sample or control
was processed.

The run name is used as name of the run tab in the
development software.

Lane column The position of the sample or control in the run. Merged
lanes are indicated by the O icon.

*& About the positions of nanowell plate lanes in
sample setups (153)

Sample ID column The sample ID of the sample or control as entered in the
lane settings on the run tab.

»@ List of columns on the Sample setup table view card
(323)

Columns for targets For each tested target, the final quantitative and
qualitative results are displayed in 1 column:

= Concentration
= Final result

The tested targets are displayed as the column headers.

*& Concentration [copies/pL] column (364)

»& Final result column (364)
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Analyses in the development software

Linkage panel

Linkage is the occurrence of different targets that are
located on the same target molecule and therefore in the
same nanowell:

= If 2 targets are unlinked, the targets are all located on
different target molecules.
The fraction of double-positive nanowells is the
product of the fraction of nanowells positive for target
1 and the fraction of nanowells positive for target 2.

= If 2 targets are perfectly linked, the targets are always
located on the same target molecules.
All positive nanowells are double-positive.

Linkage may occur due to incomplete target separation
during sample preparation.

The Linkage panel displays the p-value of a chi-square
test with a null hypothesis that the considered targets are
not linked. Due to the high number of nanowells, the p-
value changes significantly with only small changes in
the percentage of linked targets.

Examples for 100000 nanowells and 25000 positive
nanowells for each target 1 and target 2:

Percentage of linked targets p-value

0.01% 0.9811
0.1% 0.8125
0.5% 0.2351
0.8% 0.0573
1% 0.0174
1.5% 0.0004
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#8 Examples for linkage
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Routine operation of development workflow

Linkage may negatively affect target quantification.
Therefore, the displayed p-value can be used as a quality
control for multiplex tests.

If the selected master mix reagent contains 1 target only,
no linkage can be determined.

Sample ID column The sample ID of the sample or control as entered in the
lane settings on the run tab.

*@ List of columns on the Sample setup table view card
(323)

Run column Run name on the analyzer in which the sample or control
was processed.

The run name is used as name of the run tab in the
development software.

Lane column The position of the sample or control in the run. Merged
lanes are indicated by the O icon.

*&l About the positions of nanowell plate lanes in
sample setups (153)

Columns for target combinations The p-value of a chi-square test with a null hypothesis
that the considered targets are not linked.

The linkage of the targets is classified as follows:

* Linked
= Weakly linked
*  Unlinked

For linked and weakly linked, a numerical value is
displayed. For unlinked, "UL" is displayed.

The thresholds between linked, weakly linked, and
unlinked can be edited in the legend above the table.

The following applies:
= Default values:

Linked < 0.0100 < Weakly linked < 0.0500
= Possible values:

Linked < 0.0001 < Weakly linked < 0.9999
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Analyses in the development software

Statistics panel

Group column

Target column

MMx column

Concentration mean [copies/pL]

Concentration SD [copies/pL] column

Roche Diagnostics

The Statistics panel displays statistical information for
the sample groups that contain samples that were
selected for the analysis.

The name of the sample group as entered on the run tab
or in the Settings combo box.

If not all samples of a sample group are included in the
analysis, the sample group name is appended with the
number of included samples in brackets, e.g., "(3 out of
4)". Merged lanes are counted separately.

*& Working with sample groups in the development
software (328)

The tested target as enabled in the lane settings on the
run tab.

*@ List of columns on the Sample setup table view card
(323)

The used master mix reagent as entered in the lane
settings on the run tab.

*@ List of columns on the Sample setup table view card
(323)

The mean of the concentrations (final quantitative
results) across the samples of the sample group.

If not all samples of a sample group are included in the
analysis, the mean is calculated from the included
samples only.

"N/A" is displayed if the sample group contains a sample
for which no final quantitative result is available.

The standard deviation of the concentration mean.

"N/A" is displayed if the concentration mean cannot be
calculated.
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Editing the default Abs Quant - All analysis

By default, each project contains an Abs Quant - All
analysis that includes all samples of the project. You can
edit the analysis settings for the Abs Quant - All
analysis, except you cannot exclude samples.

If you want to perform an absolute quantification analysis
on a subset of samples only, you must add a new
absolute quantification analysis to the project.

»& Performing absolute quantification analysis (373)

a_ O Previous steps of the development workflow
completed

*@ Overview of development workflow with unassigned
sample setup (195)

*&l Overview of development workflow without
unassigned sample setup (194)

» To display the Abs Quant - All
analysis

1 In the development software, in the Navigation area,
choose Analysis > B > Abs Quant - All.

= The Abs Quant - All tab is displayed in the work
area.

- The Abs Quant - All analysis is calculated.

- The Results panel is displayed on the Abs Quant
- All tab.

= The Results panel displays 1 entry for each
sample or control.

2 To display a summary of the results, do the following:
= Choose the Result overview button.
= From the drop-down list, choose the master mix
reagent.
3 To display the bar charts as described in Displaying
the bar charts (400), do the following:

= At the top right of the Result overview panel,
choose the Li. button.

= Optionally, adjust the display of the bar charts.

4 To display the calculated linkage between the targets,

do the following.

= Choose the Linkage button.

= From the drop-down list, choose the master mix
reagent.

= Optionally, edit the thresholds between linked,
weakly linked, and/or unlinked in the legend
above the table.
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=y#28 Analyses in the development software

5 To display the statistics for the sample groups,
choose the Statistics button.

» To edit the Abs Quant - All analysis

1 In the development software, in the Navigation area,
choose Analysis > B > Abs Quant - All.

- The Abs Quant - All tab is displayed in the work
area.

- The Abs Quant - All analysis is calculated.

= The Results panel is displayed on the Abs Quant
- All tab.

- The Results panel displays 1 entry for each
sample or control.

2 To edit the Abs Quant - All analysis, choose the 3
button.
- The Sample selection tab in the Settings combo
box is displayed.

3 Optionally, you can work with sample groups as
described in Working with sample groups in the
development software (328).

4 In the Settings combo box, choose the Controls tab.

5 For each nanowell plate lane (i.e., position on a
nanowell plate) that contains a control, do the
following:

= From the table, choose the combination of master
mix reagent and target.

= If the same combination is used in several runs,
from the Run drop-down list, choose the run.

= In the graphical representation of the sample
setup of the selected run, choose the nanowell
plate lane that contains a control.

= For a positive control, choose the Positive option.
In the Lower limit field and the Upper limit field,
enter the concentration range.

= For a negative control, choose the Negative
option. In the Upper limit field, enter the
concentration value. (For a negative control, the
lower limit of the concentration range is always 0.)

©® The lower and upper limits determine the valid
ranges for the controls.

= The nanowell plate lanes are color-coded
according to control types.

= The controls are listed in the table.

6 In the Settings combo box, choose the Internal
controls tab.
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7 For each master mix reagent that contains an internal
control, do the following:
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Routine operation of development workflow By

= From the Target drop-down list, choose the target
that was used as internal control.

= In the Lower limit field and the Upper limit field,
enter the valid concentration range for the internal
control.

0 In the Target drop-down lists, only the targets are
available for which no controls were defined on
the Controls tab.

For each master mix reagent, you can set 1 target
as an internal control.

If a master mix reagent only contains 1 target, it is
not available as an internal control.

8 Optionally, in the Settings combo box, choose the
Target limits tab.

9 For each combination of master mix reagent and
target, you can do the following:
= From the table, choose the combination of master
mix reagent and target.

= To account for noise in the data (if there are
positive nanowells even if the nanowell plate lane
contains no target molecules), enter a value > 0 in
the Lower limit of detection field.

= To suppress the calculation of the concentration
for very low or very high target concentrations,
select the Limits of quantification check box. In
the Lower limit of quantification field and the
Upper limit of quantification field, enter the
quantification range.

@ Results outside the quantification ranges are
displayed qualitatively only on the Results panel.

- The table is updated.

10 Click outside the Settings combo box. Alternatively,
choose the £¥ button.

- The Abs Quant - All analysis is recalculated.

- The Results panel is displayed on the Abs Quant
- All tab.

Performing absolute quantification analysis

Perform absolute quantification analysis to determine the
absolute concentrations of targets in specified samples.

o— O Previous steps of the development workflow
completed

»& Overview of development workflow with unassigned
sample setup (195)
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=¥/ Analyses in the development software

*&l Overview of development workflow without
unassigned sample setup (194)

» To add an absolute quantification
analysis

1 In the development software, in the Navigation area,
choose Analysis > B > Abs Quant.

= A new absolute quantification tab is displayed in
the work area and listed in the Analysis menu.

- The Settings combo box is displayed.

2 Onthe Sample selection tab, select the samples for
the analysis.

O The table lists all samples of the project.
The Sample groups card lists all sample groups
of the project.

3 Optionally, you can work with sample groups as
described in Working with sample groups in the
development software (328).

4 Choose the Update analysis button.

5 Optionally, to return to the selection of samples
before the last time you chose the Update analysis
button, choose the Reset selection button.

6 In the Settings combo box, choose the Controls tab.

7 For each nanowell plate lane (i.e., position on a
nanowell plate) that contains a control, do the
following:

= From the table, choose the combination of master
mix reagent and target.

= If the same combination is used in several runs,
from the Run drop-down list, choose the run.

In the graphical representation of the sample
setup of the selected run, choose the nanowell
plate lane that contains a control.

= For a positive control, choose the Positive option.
In the Lower limit field and the Upper limit field,
enter the concentration range.

= For a negative control, choose the Negative
option. In the Upper limit field, enter the
concentration value. (For a negative control, the
lower limit of the concentration range is always 0.)

©® The lower and upper limits determine the valid
ranges for the controls.

= The nanowell plate lanes are color-coded
according to control types.

- The controls are listed in the table.

14 Routine operation of development workflow

8 In the Settings combo box, choose the Internal
controls tab.
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Routine operation of development workflow

9 For each master mix reagent that contains an internal
control, do the following:

= From the Target drop-down list, choose the target

that was used as internal control.

= In the Lower limit field and the Upper limit field,
enter the valid concentration range for the internal
control.

@ In the Target drop-down lists, only the targets are
available for which no controls were defined on
the Controls tab.

For each master mix reagent, you can set 1 target
as an internal control.

If a master mix reagent only contains 1 target, it is
not available as an internal control.

10 Optionally, in the Settings combo box, choose the
Target limits tab.

11 For each combination of master mix reagent and
target, you can do the following:
= From the table, choose the combination of master
mix reagent and target.

= To account for noise in the data (if there are
positive nanowells even if the nanowell plate lane
contains no target molecules), enter a value > 0 in
the Lower limit of detection field.

= To suppress the calculation of the concentration
for very low or very high target concentrations,
select the Limits of quantification check box. In
the Lower limit of quantification field and the
Upper limit of quantification field, enter the
quantification range.

O Results outside the quantification ranges are
displayed qualitatively only on the Results panel.

= The table is updated.

12 Click outside the Settings combo box. Alternatively,
choose the £} button.

= The absolute quantification analysis is calculated.
= The Results panel is displayed on the absolute
quantification tab.

13 Save the project.

14 To display a summary of the results, do the following:
= Choose the Result overview button.

= From the drop-down list, choose the master mix
reagent.

15 To display the bar charts as described in Displaying

the bar charts (400), do the following:

= At the top right of the Result overview panel,
choose the ki button.

= Optionally, adjust the display of the bar charts.
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=¥/ Analyses in the development software

16 To display the calculated linkage between the targets,
do the following.

= Choose the Linkage button.

= From the drop-down list, choose the master mix
reagent.

= Optionally, edit the thresholds between linked,
weakly linked, and/or unlinked in the legend
above the table.

17 To display the statistics for the sample groups,
choose the Statistics button.

» To edit an absolute quantification
analysis
1 In the development software, in the Navigation area,

choose the absolute quantification analysis from the
Analysis menu.

- The absolute quantification tab is displayed in the
work area.

2 To display the Settings combo box, choose the o
button.

3 To include and/or exclude samples from the analysis,
do the following:

= Choose the Sample selection tab.

= Select the samples you want to include in the
analysis.

= Choose the Update analysis button.
4 To edit the parameters of the analysis, do the
following:

= Choose the Controls tab, the Internal controls
tab, and/or the Target limits tab, respectively.

= Enter the changes.

Click outside the Settings combo box. Alternatively,
choose the £¥ button.

= The absolute quantification analysis is
recalculated.

6 Save the project.

CNV analysis

CNV (copy number variation) analysis determines the
copy number of a known target of interest by comparison
with the copy numbers of known reference targets.

In this section

14 Routine operation of development workflow

List of tabs and settings for CNV analysis (377)

List of result columns for CNV analysis (380)
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Routine operation of development workflow

Performing CNV analysis (386)

List of tabs and settings for CNV analysis

The settings provide all parameters necessary for CNV
analysis.

> Navigation > Analysis > [l > CNV > &

The settings are ordered on tabs in the Settings combo
box.

The availability of settings on a tab depends on the
current settings on the other tabs.

Sample selection tab

On the Sample selection tab, choose the samples for
the analysis.

The table lists all samples of the project with the sample
IDs as entered in the lane settings on the run tabs.

By default, no samples are selected for analysis.

To perform statistics, you can work with sample groups.
The Sample groups card lists all sample groups of the
project.

*&l Working with sample groups in the development
software (328)

Analysis setup tab

On the Analysis setup tab, select the targets of interest
and the reference targets.

The table lists all combinations of master mix reagent
and target of the samples that were selected on the
Sample selection tab.

If you select several reference targets, the development
software takes the mean of their copy numbers for
analysis.

If the current selection causes problems with the
calculation of results, a warning is displayed on the right
of the tab. For result calculation, at least 1 target of
interest and 1 reference target must be selected.
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¥4 38 Analyses in the development software

Controls tab

On the Controls tab, mark the positions of controls in
the sample setups and enter the valid ranges for the
controls.

If you choose a merged lane, the whole set of merged
lanes is selected automatically.

The table on the left lists the combinations of master mix
reagent and target of interest for which a sample was
selected on the Sample selection tab.

The Run: drop-down list lists all runs that contain
samples that were selected on the Sample selection
tab.

For a diagnostic run that was imported with clustering
and analysis settings, assumed control positions are
striped if the corresponding channels were measured on
the analyzer but the tests were not included in the
analysis package. By default, such positions are analyzed
as samples, not as controls.

The table on the right lists the defined controls for the
selected combination of master mix reagent and target of
interest.

Controls are target-specific:

If the control for a target is invalid, the system
automatically invalidates the final results for that target
for all samples of the same run.

Lower limit field and Upper limit field for The fields define the valid concentration range for a
negative controls negative control.

For negative controls, the lower limit is always 0 and
cannot be changed.

Default value for negative controls:
= Upper limit = 0.0000 cp/pl

Min. copy number field and Max. copy The fields define the valid copy number range for copy
number field for copy number controls number controls.

The lower limit must be lower than the upper limit.

Default values for copy number controls:
= Min. copy number = 1.8000 copies
= Max. copy number = 2.2000 copies
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Routine operation of development workflow BEEyA:]

Target limits tab

On the Target limits tab, optionally enter the limits of
validity for targets of interest and reference targets.

For targets of interest, enter the reference target copy
number and the limits of the normal copy number.

Limit of validity check box, Lower limit of If the limit of validity is enabled, the measured
validity field, and Upper limit of validity field concentration of the target molecules in the reference
target and/or the target of interest must fall within the
configured range.

If a concentration is outside the configured range, the
corresponding final (qualitative) result is invalid.

The lower limit of validity must be lower than the upper
limit of validity.

Default values:

= Limit of validity = disabled

= Lower limit of validity = 0.0000 cp/pl

= Upper limit of validity = 50000.0000 cp/pl

Reference target copy number field The expected copy number of the reference target.

The reference target copy number is used to normalize
the ratio of the copy numbers of the reference target and
the target of interest to allow for comparison with the
configured range for normal copy number.

Default value:
= Reference target copy number = 2.0000

Lower limit of copy number field and Upper The expected normal range of the copy number of the
limit of copy number field for normal copy target of interest.
number

The configured range sets the thresholds for the final

(qualitative) results for the targets of interest:

= The final result is low if the calculated copy number is
lower than the configured lower limit of copy number.

= The final result is normal if the calculated copy
number lies within the configured range of copy
number.
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Analyses in the development software

= The final result is high if the calculated copy number
is higher than the configured upper limit of copy
number.

Default values:
= Lower limit of copy number = 1.8000
= Upper limit of copy number = 2.2000

List of result columns for CNV analysis
A CNV tab displays the results of a CNV analysis on the

Results panel, the Result overview panel, and the
Statistics panel.

- Navigation > Analysis > [ > CNV
The panels only display results for samples that were
selected on the Sample selection tab in the Settings

combo box.

Merged lanes are analyzed together. Therefore, a set of
merged lanes has 1 entry on an analysis tab.

Results panel

The Results panel displays the results per target of
interest separately for each sample and control.

By default, not all available columns are visible on the
Results panel.

»& Configuring table columns (142)

Sample ID column The sample ID of the sample or control as entered in the
lane settings on the run tab.

*@ List of columns on the Sample setup table view card
(323)

TOI column The tested target of interest as selected on the Analysis
setup tab.

*&l Analysis setup tab (377)

MMx (TOI) column The master mix reagent used with the target of interest
as entered in the lane settings on the run tab.
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*@ List of columns on the Sample setup table view card
(323)
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Routine operation of development workflow

Lane column The position of the sample or control in the run. Merged
lanes are indicated by the 54 icon.

*& About the positions of nanowell plate lanes in
sample setups (153)

Copy number column The calculated final copy number of the target of interest
in the sample or control (final quantitative result).

"N/A" is displayed if one of the following applies:
= The final result for the target of interest is invalid.

= The nanowell plate lane contains no target molecules
(e.g., valid negative control).

Final result column Final (qualitative) result for the sample or control. For
samples, final results consider the corresponding control
results.

The final results for samples are color-coded, i.e., the
result names are underlaid with the corresponding color.

*&l About color-coding of final results for samples (149)

»& About final results (173)

CN 95% CI min. column and CN 95% CI max. The values specify the confidence interval for the 95%
column confidence level (based on the applied Poisson
distribution and not accounting for other error sources):
The probability is 95% that the copy number of the target
of interest in the sample or control lies within the
specified range.

Flags column The flags associated with the sample or control.

Critical flags that invalidate the final result are displayed
in bold.

»@ List of flags (489)

Sample type column Color-coding and icon for the control type.

*& About color-coding of controls (148)

Merged lanes column Name of the set of merged lanes as displayed in the lane
settings on the run tab.
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*&l About the positions of nanowell plate lanes in
sample setups (153)
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Analyses in the development software

Ratio column The final ratio of the copy numbers of the reference
target and the target of interest.

If the analysis contains several reference targets, the
development software takes the mean of their copy
numbers for analysis.

Ratio 95% CI min. column and Ratio 95% CI The values specify the confidence interval for the 95%
max. column confidence level (based on the applied Poisson
distribution and not accounting for other error sources):
The probability is 95% that the ratio of the copy numbers
of the reference target and the target of interest lies
within the specified range.

Initial result column Initial (qualitative) result for the target of interest. For
samples, initial results are regardless of the
corresponding control results.

Both samples and controls can have the following initial
results for the target of interest:

= Low

= Normal
= High

= Invalid

A sample or control has an invalid initial result if it was
invalidated at any point during the workflow, e.g., during
partitioning. A corresponding critical flag is displayed in
the Flags column.

Run name column Run name on the analyzer in which the sample or control
was processed.

The run name is used as name of the run tab in the
development software.

CN 68% CI min. column and CN 68% CI max. The values specify the confidence interval for the 68%
column confidence level (based on the applied Poisson
distribution and not accounting for other error sources):
The probability is 68% that the copy number of the target
of interest in the sample or control lies within the
specified range.

The probability is lower because the specified range is
smaller than the range specified by the CN 95% CI min.
column and the CN 95% CI max. column.
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Routine operation of development workflow

Ratio 68% CI min. column and Ratio 68% CI The values specify the confidence interval for the 68%
max. column confidence level (based on the applied Poisson
distribution and not accounting for other error sources):
The probability is 68% that the ratio of the copy numbers
of the reference target and the target of interest lies
within the specified range.

The probability is lower because the specified range is
smaller than the range specified by the Ratio 95% CI
min. column and the Ratio 95% CI max. column.

Copy number relative confidence column The confidence interval normalized by the final
quantitative result (based on the applied Poisson
distribution and not accounting for other error sources).

The relative confidence is a measure for the accuracy of
the calculations.

Raw copy number column The calculated initial copy number of the target of
interest in the sample or control (initial quantitative
result).

Raw values are regardless of applied limits. For samples,
raw values are also regardless of the corresponding
control results.

Raw ratio column The initial ratio of the copy numbers of the reference
target and the target of interest.

If the analysis contains several reference targets, the
development software takes the mean of their copy
numbers for analysis.

Raw values are regardless of applied limits. For samples,
raw values are also regardless of the corresponding
control results.
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Analyses in the development software

Result overview panel

The Result overview panel summarizes the results per
sample or control.

Run name column Run name on the analyzer in which the sample or control
was processed.

The run name is used as name of the run tab in the
development software.

Lane column The position of the sample or control in the run. Merged
lanes are indicated by the O icon.

*&l About the positions of nanowell plate lanes in
sample setups (153)

Sample ID column The sample ID of the sample or control as entered in the
lane settings on the run tab.

»@ List of columns on the Sample setup table view card

(323)
Columns for combinations of target of For each combination of target of interest and master
interest and master mix reagent mix reagent, the final quantitative and qualitative results

are displayed in 1 column:
= Copy number
= Final result

The combinations of target of interests and master mix
reagents are displayed as the column headers.

*& Copy number column (381)

»@ Final result column (381)
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Routine operation of development workflow

Statistics panel

The Statistics panel displays statistical information for
the sample groups that contain samples that were
selected for the analysis.

Group column The name of the sample group as entered on the run tab
or in the Settings combo box.

If not all samples of a sample group are included in the
analysis, the sample group name is appended with the
number of included samples in brackets, e.g., "(3 out of
4)". Merged lanes are counted separately.

»& Working with sample groups in the development
software (328)

TOI column The tested target of interest as selected on the Analysis
setup tab.

»@ List of columns on the Sample setup table view card
(323)

MMx (TOI) column The master mix reagent used with the target of interest
as entered in the lane settings on the run tab.

»@ List of columns on the Sample setup table view card
(323)

Copy number mean [copies] column The mean of the copy numbers for the targets of interest
(final quantitative results) across the samples of the
sample group.

If not all samples of a sample group are included in the
analysis, the mean is calculated from the included
samples only.

"N/A" is displayed if the sample group contains a sample
for which no final quantitative result is available.

Copy number SD [copies] column The standard deviation of the copy number mean.

"N/A" is displayed if the copy number mean cannot be
calculated.
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Analyses in the development software

Performing CNV analysis

Perform CNV analysis to determine the differences of the
number of copies of genomic segments between
samples and reference standards.

o— O Previous steps of the development workflow
completed

*& Overview of development workflow with unassigned
sample setup (195)

*& Overview of development workflow without
unassigned sample setup (194)

» To add a CNV analysis

1 In the development software, in the Navigation area,
choose Analysis > [l > CNV.

- A new CNV tab is displayed in the work area and
listed in the Analysis menu.

= The Settings combo box is displayed.

2 On the Sample selection tab, select the samples for
the analysis.

@ The table lists all samples of the project.
The Sample groups card lists all sample groups
of the project.

3 Optionally, you can work with sample groups as
described in Working with sample groups in the
development software (328).

4 Choose the Update analysis button.

5 Optionally, to return to the selection of samples
before the last time you chose the Update analysis
button, choose the Reset selection button.

6 In the Settings combo box, choose the Analysis
setup tab.

7 For each combination of master mix reagent and
target, do the following:
= To set a combination as a target of interest,
choose the Target of interest option.

= To set a combination as a reference target, choose
the Reference target option.

= To exclude a combination from the analysis, keep
the Exclude option.

© If results cannot be calculated from the selection,
a warning is displayed.
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8 In the Settings combo box, choose the Controls tab.
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Routine operation of development workflow

9 For each nanowell plate lane (i.e., position on a
nanowell plate) that contains a control, do the
following:
= From the table, choose the combination of master

mix reagent and target of interest.
= If the same combination is used in several runs,
from the Run: drop-down list, choose the run.
= In the graphical representation of the sample
setup, choose the nanowell plate lane that
contains a control.

= For a negative control, choose the Negative
option. In the Upper limit field, enter the
concentration value. (For a negative control, the
lower limit of the concentration range is always 0.)

= For a copy number control, choose the Copy
number option. In the Min. copy number field
and the Max. copy number field, enter the range
for the number of copies.

©® The limits determine the valid ranges for the
controls.

= The nanowell plate lanes are color-coded
according to control types.

- The controls are listed in the table.

10 In the Settings combo box, choose the Target limits
tab.

11 For each combination of master mix reagent and

target of interest, do the following:

= From the table, choose the combination of master
mix reagent and target of interest.

= Enter the expected copy number for the reference
target in the Reference target copy number
field.

= Enter the expected normal range for the copy
number of the target of interest in the Lower limit
of copy number field and the Upper limit of
copy number field.

= The table is updated.

12 For each combination of master mix reagent and

reference target, you can do the following:

= From the table, choose the combination of master
mix reagent and reference target.

= To ensure the concentration of target molecules
falls within the validity range, select the Limit of
validity check box.

= In the Lower limit of validity field and the Upper
limit of validity field, enter the validity range.

- The validity range is displayed in the table.
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13 Click outside the Settings combo box. Alternatively,
choose the £} button.
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<1:1:38 Analyses in the development software

- The CNV analysis is calculated.
- The Results panel is displayed on the CNV tab.

14 Save the project.

15 To display a summary of the results, choose the
Result overview button.

16 To display the bar charts as described in Displaying
the bar charts (400), do the following:

= At the top right of the Result overview panel,
choose the Li. button.

= Optionally, adjust the display of the bar charts.

17 To display the statistics for the sample groups,
choose the Statistics button.

» To edit a CNV analysis

1 In the development software, in the Navigation area,
choose the CNV analysis from the Analysis menu.

- The CNV tab is displayed in the work area.

2 To display the Settings combo box, choose the o
button.

3 To include and/or exclude samples from the analysis,
do the following:

= Choose the Sample selection tab.

= Select the samples you want to include in the
analysis.

= Choose the Update analysis button.
4 To edit the parameters of the analysis, do the
following:

= Choose the Analysis setup tab, the Controls tab,
and/or the Target limits tab, respectively.

= Enter the changes.

5 Click outside the Settings combo box. Alternatively,
choose the ¥ button again.

= The CNV analysis is recalculated.

6 Save the project.

Indel analysis

Indel (insertion - deletion) analysis determines the
presence of unknown mutations in a variant target by
simultaneously detecting the variant target and an
adjacent reference target.

If both the reference target and the variant target are
detected (i.e., there are double-positive nanowells), the
sequence of the variant target is unchanged. This is the
so-called wild-type sequence.
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Routine operation of development workflow

If the reference target is detected but the variant target is
not detected (i.e., there are positive-negative nanowells),

the sequence of the variant target is changed. This is the

so-called variant sequence.

2Ot To facilitate the clustering for indel analysis, use
the 2D scatter plot type.

In this section

List of tabs and settings for indel analysis (389)
List of result columns for indel analysis (392)

Performing indel analysis (398)

List of tabs and settings for indel analysis

The settings provide all parameters necessary for indel
analysis.

> Navigation > Analysis > [ > Indel > £}

The settings are ordered on tabs in the Settings combo
box.

The availability of settings on a tab depends on the
current settings on the other tabs.

Sample selection tab

On the Sample selection tab, choose the samples for
the analysis.

The table lists all samples of the project with the sample
IDs as entered in the lane settings on the run tabs.

By default, no samples are selected for analysis.

To perform statistics, you can work with sample groups.
The Sample groups card lists all sample groups of the
project.

*&l Working with sample groups in the development
software (328)
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Analyses in the development software

Analysis setup tab

On the Analysis setup tab, create the analysis setups:

= Choose the combinations of master mix reagent,
variant target, and reference target.

= Enter the minimum percentage of the variant
sequence.

= Optionally, enter the limits of validity.

MMx drop-down list Lists the master mix reagents for which a sample was
included in the analysis on the Sample selection tab.

Variant drop-down list and Reference target List the targets for which a sample was included in the
drop-down list analysis on the Sample selection tab.

Variant target and reference target must be different:
If you choose a target from one of the drop-down lists, it
is not available anymore from the other drop-down list.

Min. variant [%] field Defines the minimum percentage of the variant
sequence that must be present in the sample for it to be
variant positive.

Default value:
= Minimum percentage of the variant = 1.0000 %

Limit of validity (for the total concentration of If the limit of validity is enabled, the sum of the measured
the variant and the wild type) check box, concentrations of the variant sequence and the wild-type
Lower limit of validity field, and Upper limit of sequence must fall within the configured range.
validity field

If the concentration is outside the configured range, the
corresponding final (qualitative) result is invalid.

The lower limit of validity must be lower than the upper
limit of validity.

Default values:

= Limit of validity = enabled

= Lower limit of validity = 200.0000 cp/pl

= Upper limit of validity = 500000.0000 cp/pl
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Routine operation of development workflow

Controls tab

On the Controls tab, mark the positions of controls in
the sample setups and enter the valid ranges for the
controls.

If you choose a merged lane, the whole set of merged
lanes is selected automatically.

The table on the left lists the combinations of master mix
reagent, variant target, and reference target for which a
sample was included in the analysis on the Sample
selection tab.

The Run: drop-down list lists all runs that contain
samples that were selected on the Sample selection
tab.

For a diagnostic run that was imported with clustering
and analysis settings, assumed control positions are
striped if the corresponding channels were measured on
the analyzer but the tests were not included in the
analysis package. By default, such positions are analyzed
as samples, not as controls.

The table on the right lists the defined controls for the
selected combination of master mix reagent, variant
target, and reference target.

Controls are target-specific:

If the control for a target is invalid, the system
automatically invalidates the final results for that target
for all samples of the same run.

»& Controls (165)

Lower limit field and Upper limit field The fields define the valid range for a control.
The lower limit must be lower than the upper limit.

For negative controls, the lower limit is always 0 and
cannot be changed.

Default values for variant controls:
= Lower limit = 1.0000 %
= Upper limit = 100.0000 %

Default values for wild type controls:
= Lower limit = 1.0000 cp/pl
= Upper limit = 1000.0000 cp/pl
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Analyses in the development software

Default value for negative controls:
= Upper limit = 0.0000 cp/pl

List of result columns for indel analysis
An indel tab displays the results of an indel analysis on

the Results panel, the Result overview panel, and the
Statistics panel.

- Navigation > Analysis > [ > Indel
The panels only display results for samples that were
selected on the Sample selection tab in the Settings

combo box.

Merged lanes are analyzed together. Therefore, a set of
merged lanes has 1 entry on an analysis tab.

Results panel

The Results panel displays the results per variant
separately for each sample and control.

By default, not all available columns are visible on the
Results panel.

»& Configuring table columns (142)

Sample ID column The sample ID of the sample or control as entered in the
lane settings on the run tab.

*@ List of columns on the Sample setup table view card
(323)

Variant column The tested variant target as selected on the Analysis
setup tab.
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*@l Analysis setup tab (390)
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Routine operation of development workflow

Reference column The tested reference target as selected on the Analysis
setup tab.

*él Analysis setup tab (390)

MMx column The used master mix reagent as entered in the lane
settings on the run tab.

»@ List of columns on the Sample setup table view card
(323)

Lane column The position of the sample or control in the run. Merged
lanes are indicated by the 54 icon.

*& About the positions of nanowell plate lanes in
sample setups (153)

Variant [%] column Percentage of the variant sequence in the sample or
control (final quantitative result).

Variant [copies/pl] column Concentration of the variant sequence in the sample or
control.

Wild type [copies/pl] column Concentration of the wild-type sequence in the sample
or control.

Final result column Final (qualitative) result for the sample or control. For
samples, final results consider the corresponding control
results.

The final results for samples are color-coded, i.e., the
result names are underlaid with the corresponding color.

*& About color-coding of final results for samples (149)

»& About final results (173)

Variant [%] 95% CI min. column and Variant The values specify the confidence interval for the 95%
[%] 95% CIl max. column confidence level (based on the applied Poisson
distribution and not accounting for other error sources):
The probability is 95% that the percentage of the variant
sequence in the sample or control lies within the
specified range.
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Flags column The flags associated with the sample or control.
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Analyses in the development software

Critical flags that invalidate the final result are displayed
in bold.

»& List of flags (489)

Sample type column Color-coding and icon for the control type.

*& About color-coding of controls (148)

Merged lanes column Name of the set of merged lanes as displayed in the lane
settings on the run tab.

*& About the positions of nanowell plate lanes in
sample setups (153)

Variant [copies] column Absolute number of copies of the variant sequence in the
sample or control.

Wild type copies column Absolute number of copies of the wild-type sequence in
the sample or control.

Initial result column Initial (qualitative) result for the variant sequence. For
samples, initial results are regardless of the
corresponding control results.

Both samples and controls can have the following initial
results for the variant sequence:

= Negative
= Positive
= |nvalid

A sample or control has an invalid initial result if it was
invalidated at any point during the workflow, e.g., during
partitioning. A corresponding critical flag is displayed in
the Flags column.

Plate type column Nanowell plate type used for processing the sample.

»& Nanowell plates (159)

No. of positive nanowells column Number of positive nanowells for the sample or control
as determined in the clustering.

»@ List of columns on the Clustering data card (339)
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Total valid nanowells column Number of valid nanowells for the sample or control as
displayed in the clustering.
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Routine operation of development workflow

The number of valid nanowells is the total of the positive
and the negative nanowells.

»@ List of columns on the Clustering data card (339)

Dilution factor column Dilution factor as entered in the lane settings on the run
tab.

*@ List of columns on the Sample setup table view card
(323)

Run name column Run name on the analyzer in which the sample or control
was processed.

The run name is used as name of the run tab in the
development software.

Variant [%] 68% CI min. column and Variant The values specify the confidence interval for the 68%
[%] 68% CI max. column confidence level (based on the applied Poisson
distribution and not accounting for other error sources):
The probability is 68% that the percentage of the variant
sequence in the sample or control lies within the
specified range.

The probability is lower because the specified range is
smaller than the range specified by the Variant [%]

95% CI min. column and the Variant [%] 95% CI
max. column.

Variant [copies/nanowell] column The average number of copies of the variant sequence
per valid nanowell for the sample or control.

Wild type [copies/nanowell] column The average number of copies of the wild-type sequence
per valid nanowell for the sample or control.

Negative nanowells column Number of negative nanowells for the sample or the
control as determined in the clustering.

»@ List of columns on the Clustering data card (339)

Clustering method column Clustering method as set on the clustering tab.

*@ List of clustering settings in the development
software (342)
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Raw variant [%] column The calculated initial percentage of the variant sequence
in the sample or control (initial quantitative result).
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Analyses in the development software

Result overview panel

Run name column

Lane column

Sample ID column

Columns for combinations of variant target
and reference target

=
Q
=
=
=
(@)
S
)
c
Q
e
=1
L=
Q
>
Q
E=]
-
(=)
c
=]
=
©
P S
Q
=
o
(<b)
c
=
-
Q
(o'
J
F

Roche Diagnostics

Raw values are regardless of applied limits. For samples,
raw values are also regardless of the corresponding
control results.

The Result overview panel summarizes the results per
sample or control for the selected master mix reagent.

Run name on the analyzer in which the sample or control
was processed.

The run name is used as name of the run tab in the
development software.

The position of the sample or control in the run. Merged
lanes are indicated by the 54 icon.

*& About the positions of nanowell plate lanes in
sample setups (153)

The sample ID of the sample or control as entered in the
lane settings on the run tab.

*@ List of columns on the Sample setup table view card
(323)

For each combination of variant target and reference
target, the final quantitative and qualitative results are
displayed in 1 column:

= Percentage of variant sequence
= Final result

The combinations of variant targets and reference targets
are displayed as the column headers.

»& Variant [%] column (393)

»& Final result column (393)
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Routine operation of development workflow

Statistics panel

The Statistics panel displays statistical information for
the sample groups that contain samples that were
selected for the analysis.

Group column The name of the sample group as entered on the run tab
or in the Settings combo box.

If not all samples of a sample group are included in the
analysis, the sample group name is appended with the
number of included samples in brackets, e.g., "(3 out of
4)". Merged lanes are counted separately.

*& Working with sample groups in the development
software (328)

Variant column The tested variant target as selected on the Analysis
setup tab.

*& Analysis setup tab (390)

MMx column The used master mix reagent as entered in the lane
settings on the run tab.

»@ List of columns on the Sample setup table view card
(323)

Variant [%] column The mean of the percentages of the variant sequence
(final quantitative results) across the samples of the
sample group.

If not all samples of a sample group are included in the
analysis, the mean is calculated from the included

samples only.

"N/A" is displayed if the sample group contains a sample
for which no final quantitative result is available.

Variant SD [%] column The standard deviation of the percentage mean.
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"N/A" is displayed if the percentage mean cannot be
calculated.
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Analyses in the development software

Performing indel analysis

Perform indel analysis to determine the presence
(insertion) or absence (deletion) of bases in a genomic
sequence.

o— O Previous steps of the development workflow
completed

*& Overview of development workflow with unassigned
sample setup (195)

*& Overview of development workflow without
unassigned sample setup (194)

» To add an indel analysis

1 In the development software, in the Navigation area,
choose Analysis > [l > Indel.

- A new indel tab is displayed in the work area and
listed in the Analysis menu.

= The Settings combo box is displayed.

2 On the Sample selection tab, select the samples for
the analysis.

@ The table lists all samples of the project.
The Sample groups card lists all sample groups
of the project.

3 Optionally, you can work with sample groups as
described in Working with sample groups in the
development software (328).

4 Choose the Update analysis button.

5 Optionally, to return to the selection of samples
before the last time you chose the Update analysis
button, choose the Reset selection button.

6 In the Settings combo box, choose the Analysis
setup tab.

7 Add at least 1 analysis setup:
= Choose the New button.

= From the MIMx drop-down list, choose the master
mix reagent.

= From the Variant drop-down list, choose the
variant target.

= From the Reference target drop-down list,
choose the reference target.

= |n the Min. variant [%] field, enter the minimum
required percentage of the variant sequence.
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= Optionally, in the Lower limit of validity field and
the Upper limit of validity field, edit the validity
range.
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Routine operation of development workflow

= Optionally, clear the Limit of validity (for the
total concentration of the variant and the wild
type) check box.

8 In the Settings combo box, choose the Controls tab.

9 For each nanowell plate lane (i.e., position on a
nanowell plate) that contains a control, do the
following:
= From the table, choose the combination of master

mix reagent, variant, and reference.
= |If the same combination is used in several runs,
from the Run: drop-down list, choose the run.
= In the graphical representation of the sample
setup, choose the nanowell plate lane that
contains a control.

= For a variant control, choose the Variant option.
In the Lower limit field and the Upper limit field,
enter the percentage range.

= For a wild type control, choose the Wild type
option. In the Lower limit field and the Upper
limit field, enter the concentration range.

= For a negative control, choose the Negative
option. In the Upper limit field, enter the
concentration value. (For a negative control, the
lower limit of the concentration range is always 0.)

©® The lower and upper limits determine the valid
ranges for the controls.

- The nanowell plate lanes are color-coded
according to control types.
= The controls are listed in the table.

10 Click outside the Settings combo box. Alternatively,
choose the £¥ button.

= The indel analysis is calculated.
= The Results panel is displayed on the indel tab.

11 Save the project.

12 To display a summary of the results, do the following:
= Choose the Result overview button.

= From the drop-down list, choose the master mix
reagent.

13 To display the bar charts as described in Displaying
the bar charts (400), do the following:

= At the top right of the Result overview panel,
choose the Li. button.

= Optionally, adjust the display of the bar charts.

14 To display the statistics for the sample groups,
choose the Statistics button.
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Analyses in the development software

» To edit an indel analysis

1 In the development software, in the Navigation area,
choose the indel analysis from the Analysis menu.

= The indel tab is displayed in the work area.

2 To display the Settings combo box, choose the i
button.

3 To include and/or exclude samples from the analysis,
do the following:

= Choose the Sample selection tab.

= Select the samples you want to include in the
analysis.

= Choose the Update analysis button.
4 To edit the parameters of the analysis, do the
following:

= Choose the Analysis setup tab and/or the
Controls tab, respectively.

= Enter the changes.

5 Click outside the Settings combo box. Alternatively,
choose the €¥ button.

= The indel analysis is recalculated.

6 Save the project.

Displaying the bar charts

For each analysis, you can display the final quantitative
results as bar charts on the Result overview panel.

»& About the bar charts (135)

o— O Analysis performed

» To display the bar charts

1 In the development software, in the Navigation area,
choose the analysis from the Analysis menu.

= The analysis tab is displayed in the work area.

2 Choose the Result overview button.
- The Result overview panel is displayed.

3 To display the bar charts, at the top right of the
Result overview panel, choose the Lak button.
- On the right of the Result overview panel, a bar
chart per sample or control is displayed.
- Above the bar charts, the field and buttons for the
display options of the bar charts are displayed.
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Routine operation of development workflow

4 To change the maximum value for the concentration
axes, do the following:
= To change the maximum value, enter the value in
the Range field. Press Enter.

= To return to the default value, choose the Reset
button.

@ The Reset button is only displayed after you
entered a different value.

5 To change the scale of the concentration axes, do the
following:

= To display a logarithmic scale, choose Scale >
Log..
= To display a linear scale, choose Scale > Lin..

6 To change the display of the error bars, do the
following:

= To hide the error bars, choose Error bar > Off.
= To display the error bars, choose Error bar > On.

7 To hide the bar charts, choose the [l button.

& Related topics
= Projects in the development software (294)
= Runs in the development software (309)
= Clustering in the development software (338)

= Unassigned sample setups in the development
software (402)

= Analysis packages in the development software (412)
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Unassigned sample setups in the development software

Unassigned sample setups in the
development software

You can use unassigned sample setups in your project to
plan development runs.

It is not required to use unassigned sample setups in
your project. You can directly add the same information
later to the raw data file (run) of the development run.

In this section

About unassigned sample setups in the development
software (402)

Working with unassigned sample setups in the
development software (405)

Adding run settings and lane settings to unassigned
sample setups in the development software (406)

Creating a sample setup report of an unassigned sample
setup in the development software (410)

About unassigned sample setups in the development
software

Unassigned sample setups are a planning tool for
development runs. It allows you to use an unassigned
sample setup report as a help for pipetting.

You can add run settings and lane settings to
unassigned sample setups.

About run settings Run settings comprise the following information that
applies to the complete sample setup and the
subsequent development run:

= Nanowell plate IDs and types

= Detection formats (channels, dyes, and integration
times)

= Run notes

By default, all channels are enabled.
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About lane settings Lane settings comprise the following information that
applies to individual nanowell plate lanes, i.e., samples:

= Sample ID
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Routine operation of development workflow

= Dilution factor of sample

= Name of master mix reagent

= ID of master mix reagent or master reagent

= Expiry date of master mix reagent or master reagent
= Lot number of master mix reagent or master reagent
= Target and dye settings

= Notes and sample preparation notes

By default, the targets are named as the dyes.

The following applies to lane settings:

= Changes to a master mix reagent, e.g., a name
change or changed target and dye settings, are
applied across the project wherever the same master
mix reagent is used.

= If you enter the same lane settings for multiple
nanowell plate lanes, the nanowell plate lanes are
merged automatically.

= For merged lanes, empty lane settings are considered
as identical.

= Changes to 1 merged lane are applied automatically
to all other merged lanes of the same set.

= Itis recommended to use the fields for the ID, expiry
date, and lot number to track your own master mix
reagents.

*@ List of columns on the Sample setup table view card
(323)

About detection formats The detection formats define the channels, the dye per
channel, and the integration time for the detection of
fluorescence by the analyzer.

The following applies:

= In the run settings, in the Detection format combo
box, enable the channels for all dyes that are
contained in any of the master mix reagents used in
the development run.

= You cannot use different dyes that are detected in the
same channel in 1 development run.

= In the lane settings, in the Target and dye settings
table, you define which subset of the detected dyes is
contained in the individual master mix reagents and
you map the targets to the dyes.

= Only dyes that are enabled in the run settings are
available in the lane settings.

= You can only reuse a master mix reagent across a
project if the runs or unassigned sample setups use
the same detection formats.
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Unassigned sample setups in the development software

To use the planned configuration of the detection
formats for the development run, you must configure the
run profile on the analyzer accordingly.

»@ Editing run profiles on the Edit run profile panel in
the analyzer software (303)

About merged lanes Merged lanes emulate the partitioning of a larger sample
volume into a higher number of nanowells. The system
treats the nanowells of a set of merged lanes as if they
belong to 1 nanowell plate lane. Merged lanes therefore
facilitate detection of very low target concentrations.

Up to 8 nanowell plate lanes can be merged.

A set of merged lanes has the following characteristics:

= The same reaction mixture is pipetted into the
merged lanes.

= The merged lanes are analyzed together. A set of
merged lanes gets 1 final result.

In the development software, nanowell plate lanes with
identical lane settings are merged automatically. Empty
lane settings are considered as identical.

The position of a set of merged lanes in a sample setup
is denoted by the lowest position of the included
nanowell plate lanes.

Example:

If the nanowell plate lanes A1, B1, and C1 are merged,
the position of the set of merged lanes is denoted as
"AT"

The position is also used as name for the set of merged
lanes.

*&l About the positions of nanowell plate lanes in
sample setups (153)

Display of unassigned sample setups In the development software, unassigned sample setups
are displayed as follows:

= Listed in the Unassigned sample setup menu in the
Navigation area

= Displayed as sample setup tabs in the work area

By default, the unassigned sample setups are named
"Sample setup" and numbered consecutively.

*& About the sample setup tabs (136)
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Working with unassigned sample setups in the
development software

To facilitate the use of unassigned sample setups, you
can create, duplicate, rename, and delete unassigned
sample setups.

If you create a project, an unassigned sample setup with
1 universal nanowell plate is added automatically.

*@ For adding information to unassigned sample setups
(i.e., run settings and lane settings), refer to Adding
run settings and lane settings to unassigned sample
setups in the development software (406).

o— O Project in the development software

» To add an unassigned sample setup
to a project in the development
software

1 In the development software, open or create a project
as described in Working with projects in the
development software (295).

2 In the Navigation area, choose Unassigned sample
setup > [l > Create new.

=> An unassigned sample setup with 1 universal
nanowell plate is added to your project and listed
in the Unassigned sample setup menu.

- The sample setup tab of the unassigned sample
setup is displayed in the work area.

3 Save the project.

» To rename an unassigned sample
setup in the development software
1 In the development software, in the Navigation area,

choose the unassigned sample setup from the
Unassigned sample setup menu.

2 Choose [l > Rename.

3 In the Rename sample setup dialog box, enter the
new name. Choose the Save button.

- The sample setup tab is renamed.

=> The unassigned sample setup listed in the
Unassigned sample setup menu is renamed.
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4 Save the project.

Roche Diagnostics
Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1 Draft - Do Not Distribute




Unassigned sample setups in the development software

» To delete an unassigned sample
setup in the development software
1 In the development software, in the Navigation area,

choose the unassigned sample setup from the
Unassigned sample setup menu.

2 Choose [l > Delete.

3 In the Warning dialog box, choose the Confirm
button.

= The sample setup tab is closed.

= The unassigned sample setup is deleted from the
Unassigned sample setup menu.

4 Save the project.

» To duplicate an unassigned sample
setup in the development software

1 In the development software, in the Navigation area,
choose the unassigned sample setup from the
Unassigned sample setup menu.

2 Choose [l > Duplicate.

- The duplicated unassigned sample setup is
created and named as "copy" and numbered
consecutively.

- The duplicated unassigned sample setup is listed
in the Unassigned sample setup menu.

= The sample setup tab of the duplicated
unassigned sample setup is displayed in the work
area.

3 Save the project.

Adding run settings and lane settings to unassigned
sample setups in the development software

You can add run settings and lane settings to
unassigned sample setups.

It is not required to add all information to the unassigned
sample setup. You can add some information and
directly add the rest of the information to the
development run after import of the raw data file.

To transfer the information from the unassigned sample
setup to the development run, the unassigned sample
setup can be assigned to the run if the unassigned
sample setup is matching or partially matching.
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Routine operation of development workflow

*&l Working with raw data files and runs in the
development software (317)

» To add run settings to an unassigned
sample setup in the development
software

1 In the development software, in the Navigation area,
choose the unassigned sample setup from the
Unassigned sample setup menu.

2 On the sample setup tab, choose the Run settings
button.
= The Run settings card is displayed on the sample
setup tab.

3 CAUTION! Risk of compromised image integrity.
Avoid scratches, finger prints, dust, or other artifacts
on the nanowell plate lanes.

On the Run settings card, for each nanowell plate,
do the following:

= From the Plate type drop-down list, choose the
nanowell plate type.

= Optionally, choose the Plate ID field. Scan or
enter the nanowell plate ID. If required, press
Enter.

@ You can use different types of nanowell plates in
1 development run.
The unassigned sample setup can later be
assigned to the run only if the nanowell plate
types and IDs in the unassigned sample setup
and in the actual development run match.
The unassigned sample setup can only be
assigned automatically if it contains the nanowell
plate IDs.

- The nanowell plates are added to the unassigned
sample setup.

= In plate view, the column footer is color-coded
according to nanowell plate type. If you entered
the nanowell plate IDs, the last 5 digits of the
nanowell plate ID are displayed in the column
footer.

4 Choose the Detection formats button.
- The Detection format combo box is displayed.

Roche Diagnostics
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Unassigned sample setups in the development software

To edit the detection formats, do the following:

= To disable a channel, choose the Disabled
button.

= To enable a channel, select the Enabled check
box.

= For each enabled channel, choose the dye from
the Dye drop-down list.

©® Ensure that you disable empty channels.
Only the enabled dyes can be assigned in the lane
settings.
The unassigned sample setup can later be
assigned to the run only if the detection formats
in the unassigned sample setup and in the actual
development run match.

Disable the channels for dyes that are not contained
in the master mix reagents.

Optionally, to change the integration time, select the
Advanced Settings check box. Enter the integration
time in the corresponding fields.

Choose the Save button.

Optionally, on the Run settings card, enter a
comment in the Additional run notes: field.

10 Save the project.

>

Roche Diagnostics

To add lane settings to an
unassigned sample setup in the
development software

In the development software, in the Navigation area,
choose the unassigned sample setup from the
Unassigned sample setup menu.

On the sample setup tab, choose the Lane settings
button.
- The Lane settings card is displayed.

Choose one or several tiles (in plate view) or rows (in
table view).

To enter the sample ID for the selected tiles or rows,
do the following:

= Choose the Sample ID field.
= Scan or enter the sample ID.
= If required, press Enter.

- The sample ID is displayed on the selected tiles or
in the selected rows.

Optionally, to enter a dilution factor for the selected
tiles or rows, do the following:

= Choose the Dilution factor field.
= Enter the dilution factor.
= Press Enter.
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Routine operation of development workflow

6 To add a new master mix reagent to the project and
assign it to the selected tiles or rows, do the
following:

= Choose the MVIx field.
= Enter the name of the master mix reagent.
= Press Enter.

= The master mix reagent is displayed on the
selected tiles or in the selected rows.

- By default, in plate view, all tiles with the same
master mix reagent are displayed with the same
color.

7 To assign a master mix reagent that exists in the
project to the selected tiles or rows, do the following:

= Next to the MIMx field, choose the = button.

= From the drop-down list, choose the master mix
reagent.

® You can only assign an existing master mix
reagent if the dyes that are enabled in the run
settings match.

If you assign an existing master mix reagent, the
target and dye settings are taken over from the
master mix reagent.

- The master mix reagent is displayed on the
selected tiles or in the selected rows.

- By default, in plate view, all tiles with the same
master mix reagent are displayed with the same
color.

8 Optionally, to rename the assigned master mix
reagent across the project, do the following:

= Next to the next to the MIIVIx field, choose the &
button.

= In the Edit MIMx name dialog box, enter a new
name.

= Choose the Save button.

- The master mix reagent is renamed across the
project.

9 Optionally, for the selected tiles or rows, choose the
following fields and scan or enter the additional
information for the master mix reagent or master
reagent:
= MMxID
= MMx expiry date
=  MMx lot number

10 Optionally, in the Target and dye settings table,
disable targets for the selected tiles or rows.
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Unassigned sample setups in the development software

©® Only the dyes for channels that were enabled in
the run settings are displayed.
At least 1 target must be enabled for each master
mix reagent.
Disabled targets are excluded from clustering and
analysis later in the development workflow.
Ensure that you disable empty channels.

11 To map the targets to the dyes, rename the targets:
= Choose the Target field.
= Enter the name of the target.
= Press Enter.

@ You can display the mappings on the clustering
tabs later in the development workflow.

12 Optionally, add notes and/or sample preparation
notes.

13 Repeat steps 3 to 12 for all other tiles or rows.

14 Optionally, to undo or redo changes, choose the
buttons above the tiles (in plate view) or rows (in
table view):

= To undo a change, choose the Undo button.
= Toredo a change, choose the Redo button.

= To reset all lane settings to default values, choose
the Reset button.

©® The last 15 steps are retained and can be undone
or redone, including a reset to default.

15 Save the project.

Creating a sample setup report of an unassigned sample
setup in the development software

After you planned your development run in an
unassigned sample setup, create (and print) the sample
setup report as a help for pipetting.

o_ O Unassigned sample setup completed

» To create a sample setup report of an
unassigned sample setup in the
development software

1 In the development software, in the Navigation area,

choose the unassigned sample setup from the
Unassigned sample setup menu.
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2 Choose [l > Create a sample setup report.
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Routine operation of development workflow

Navigate to a folder. Enter a name for the report and
choose the Save button.

- The sample setup report is saved as PDF file.

= If a program for viewing PDF files is installed on
your computer, the PDF is displayed.

Print the sample setup report as a guide for pipetting.

Related topics

Projects in the development software (294)
Runs in the development software (309)
Clustering in the development software (338)
Analyses in the development software (358)

Analysis packages in the development software (412)
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Analysis packages in the development software

Analysis packages in the development

software

Analysis packages provide all parameters necessary to
plan and to perform diagnostic runs and to generate
diagnostic results as part of diagnostic workflows.

An analysis package is based upon a development
workflow:

In an analysis package, you can only include tests from
analyses that are part of the project.

By default, each project contains an Abs Quant - All
analysis. If you do not add further analyses to the project,
you can only use the tests from the Abs Quant - All
analysis for the analysis packages.

In this section

List of settings for analysis packages (412)
Working with analysis packages (429)

List of settings for analysis packages

Create analysis package dialog box

Roche Diagnostics

Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1

You must enter the settings for an analysis package to
create it.

In this section

Create analysis package dialog box (412)
Edit panel (414)
General settings panel (414)

Test definition panel for absolute quantification
tests (416)

Test definition panel for CNV tests (420)
Test definition panel for indel tests (424)
MMx settings panel (427)

In the Create analysis package dialog box, you enter
the name for the analysis package and you choose the
nanowell plate type.

Draft - Do Not Distribute



Routine operation of development workflow

- Navigation > Analysis package > ] > Create
analysis package

-“Q'— Ensure that you enter the information correctly.
You cannot change it later.

Analysis package name field Field to enter the name that identifies the analysis
package in the development software, the analyzer
software, and the web application.

The name is automatically appended with the version
number "(V0.0)".

—‘Q’- Ensure that you enter a unique and meaningful
name for the analysis package. You cannot
change the name of the analysis package later.

Analysis packages are additionally identified by Version,
Name GUID, and Version GUID.

*él Manage analysis packages (579)

Plate type drop-down list Drop-down list to choose the nanowell plate type
compatible with the analysis package, i.e., the nanowell
plate type you must use to perform the tests of the
analysis package on a sample.

It is not required to choose a nanowell plate type used in
a run of the project that is used to create the analysis
package.

-‘Q’- Ensure that you choose the correct nanowell
plate type. You cannot change the nanowell plate
type later. If you choose the wrong nanowell plate
type, you must delete the analysis package and
create a new one.
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Analysis packages in the development software

Edit panel

On the Edit panel, you choose the tests for the analysis
package and enter the issuer name of the analysis
package.

> Navigation > Analysis package > [ > Create
analysis package > Edit

Creator field Field to enter the creator of the analysis package.

In the analyzer software, the creator is displayed on the
Manage analysis packages panel.

Select table The Select table lists all analyses of the project and their
tests.
Manage table The Manage table lists all tests that are selected for the

analysis package.

General settings panel

On the General settings panel, you set the global
parameters that apply to all tests of the analysis package
and you can document the history of the analysis
package.

- Navigation > Analysis package > ] > Create
analysis package > General settings
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Routine operation of development workflow

The General settings panel comprises the following
cards:

= General settings
= History

General settings card

On the General settings card, you set the global
parameters that apply to all tests of the analysis package.

Number of merged lanes drop-down list Drop-down list to choose the number of nanowell plate
lanes to be merged in the sample setup (1 to 8).

The number applies to both samples and controls in the
sample setup.

Default value = 1 (no merged nanowell plate lanes)

Run profile drop-down list Drop-down list to choose the run profile for the analysis
package.

All runs of the project and the run profiles used on the
analyzer are listed chronologically with the latest run on

top.
Time limit between plate filling and starting a Check box and field to set a maximum duration between
run check box and minutes field partitioning of the nanowell plates and the start of the

diagnostic run.

Default value (check box) = cleared
Default value (field) = 360 minutes

Result export restrictions options Enable or disable the export of raw data files and
analyses of diagnostic runs from the web application:

= Unable to export
= Export raw data
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= Export raw data and analyses
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Analysis packages in the development software

Default value = Export raw data

Report label field Free text field to enter the text used on the analysis
package report.

*&l To create an analysis package report (433)

History card

On the History card, you can document the change
history of the analysis package.

Comment field Free text field.

For example, enter a change description whenever you
create a new version of an analysis package.

Test definition panel for absolute quantification tests

On the Test definition panel, you set the parameters
that apply to the individual tests of the analysis package.

- Navigation > Analysis package > ] > Create
analysis package > Test definition
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The required parameters depend on the test type
(absolute quantification, CNV, indel).
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Routine operation of development workflow B/

The values are pre-entered from the analyses that are
used to create the analysis package.

The Test definition panel comprises the following cards:
* Test list

= Test details

= Test settings

= Result names

= Controls

= Internal controls

Test list card

Card that lists all tests of the analysis package, i.e., the
tests that you chose on the Edit panel for the analysis
package.

To display the other test-specific cards, choose a test
from the table on the Test list card.

Test details card

Card that lists the name of the master mix reagent, the
target name, and the dye name.

The Test details card is read-only.

Test settings card

Card to enter the limits of detection and quantification,
and to configure the display of final quantitative results.

S
Q
=
=
=
(=)
S
e
o
Q
S
Q.
L=
(5]
>
Q
E=
-
(@)
c
=)
=
©
| &
Q
=
(@)
[<b)
c
I;
-
Q
(o'
3
F

Roche Diagnostics
Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1 Draft - Do Not Distribute




S
Q
=
=
-
=)
S
)
c
QO
=
=1
L=
(b
>
(b
E=]
-
(=)
c
=)
-
(1)
| &
Q
=
(@)
(<b)
c
-
-
Q
(o'
J
F

Analysis packages in the development software

Lower limit of detection [copies/pL] field

Limits of quantification check box, Lower
limit of quantification [copies/pL] field, and
Upper limit of quantification [copies/pL] field

Show quantitative result check box

Result names card

Roche Diagnostics

A limit of detection > 0 accounts for noise in the data,
i.e., if there are positive nanowells even if the nanowell
plate lane contains no target molecules.

The initial result and the final result for a target are
negative if the calculated raw concentration of the target
is below the limit of detection.

The lower limit of detection must be lower than the lower
limit of quantification (if enabled).

Precision = 4 decimal places

If the limit of quantification is enabled, the calculation of
the target concentration is suppressed outside of the
entered quantification range. This is to account for the
increase in uncertainty for very low or very high target
concentrations.

On the Results panel, final results outside the
quantification range are flagged. Instead of the
calculated target concentration, the quantification limit
that is not met is displayed as final quantitative result.

The lower limit of quantification must be lower than the
upper limit of quantification.

The lower limit of quantification must be higher than the
lower limit of detection.

Precision = 4 decimal places

Enable or disable the calculation and display of the
concentrations (final quantitative results).

If the check box is cleared, all final results are only
displayed qualitatively.

Default value = enabled

Card to enter the names that are displayed for valid final
qualitative results.

Default values:
= "Positive"
= "Negative"
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Routine operation of development workflow

Controls card

Card that lists the controls defined for the test and their
settings.

You can edit and delete the pre-defined controls, and
add new controls.

The controls that are defined here are automatically
added to the diagnostic sample setup.

Controls table Lists the controls that were defined in the analyses that
are used to create the analysis package.

To add a control, choose the New button.

To delete a control, choose the Delete button.

ID field Field to enter the name of a control. The entry is
displayed as the sample ID in the diagnostic sample
setup.

Lower limit field and Upper limit field The fields define the valid range for a control.

The lower limit must be lower than the upper limit.

For negative controls, the lower limit is always 0 and
cannot be changed.

Precision = 4 decimal places

Positive option and Negative option Options to define the type of control.

Internal controls card

Card to configure the internal control.

Internal control drop-down list Lists the targets that are available as internal controls.
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The internal control that is defined here is automatically
added to the diagnostic sample setup.
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Analysis packages in the development software

To exclude the use of an internal control, choose the
None option.

Lower limit field and Upper limit field The fields define the valid concentration range for the
internal control.

The lower limit must be lower than the upper limit.

Precision = 4 decimal places

Test definition panel for CNV tests

On the Test definition panel, you set the parameters
that apply to the individual tests of the analysis package.

- Navigation > Analysis package > ] > Create
analysis package > Test definition

The required parameters depend on the test type
(absolute quantification, CNV, indel).

The values are pre-entered from the analyses that are
used to create the analysis package.
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The Test definition panel comprises the following cards:
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Routine operation of development workflow

= Test list

* Test details

= Test settings
= Controls

* Result names

Test list card

Card that lists all tests of the analysis package, i.e., the
tests that you chose on the Edit panel for the analysis
package.

To display the other test-specific cards, choose a test
from the table on the Test list card.

Test details card

Card that lists the defined reference targets and the

target of interest and that allows you to enter limits of ;
validity. o
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corresponding final (qualitative) result is invalid.
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Test settings card

Reference target copy number field

Lower limit of copy number field and Upper
limit of copy number field for normal copy
number

Show quantitative result check box
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Roche Diagnostics

Analysis packages in the development software

The lower limit of validity must be lower than the upper
limit of validity.

Precision = 4 decimal places

Card to enter the reference target copy number and the
limits of normal copy number, and to configure the
display of final quantitative results

The expected copy number of the reference target.

The reference target copy number is used to normalize
the ratio of the copy numbers of the reference target and
the target of interest to allow for comparison with the
configured range for normal copy number.

Precision = 4 decimal places

The expected normal range of the copy number of the
target of interest.

The configured range sets the thresholds for the final

(qualitative) results for the targets of interest:

= The final result is low if the calculated copy number is
lower than the configured lower limit of copy number.

= The final result is normal if the calculated copy
number lies within the configured range of copy
number.

= The final result is high if the calculated copy number
is higher than the configured upper limit of copy
number.

Precision = 4 decimal places
Enable or disable the calculation and display of the
concentration of the target of interest (final quantitative

results).

If the check box is cleared, all final results are only
displayed qualitatively.

Default value = enabled
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Routine operation of development workflow

Controls card

Card that lists the controls defined for the test and their
settings.

You can edit and delete the pre-defined controls, and
add new controls.

The controls that are defined here are automatically
added to the diagnostic sample setup.

Controls table Lists the controls that were defined in the analyses that
are used to create the analysis package.

To add a control, choose the New button.

To delete a control, choose the Delete button.

ID field Field to enter the name of a control. The entry is
displayed as the sample ID in the diagnostic sample
setup.

Lower limit field and Upper limit field The fields define the valid range for a control.

The lower limit must be lower than the upper limit.

For negative controls, the lower limit is always 0 and
cannot be changed.

Precision = 4 decimal places

Copy number option and Negative option Options to define the type of control.

Result names card

Card to enter the names that are displayed for valid final
qualitative results.

Default values:

. llLOW"
= "Normal"
. llHighll
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Analysis packages in the development software

Test definition panel for indel tests

On the Test definition panel, you set the parameters
that apply to the individual tests of the analysis package.

> Navigation > Analysis package > [ > Create
analysis package > Test definition

The required parameters depend on the test type
(absolute quantification, CNV, indel).

The values are pre-entered from the analyses that are
used to create the analysis package.

The Test definition panel comprises the following cards:

Test list card

Roche Diagnostics

®

Test list

Test details
Test settings
Result names
Controls

Card that lists all tests of the analysis package, i.e., the
tests that you chose on the Edit panel for the analysis
package.

To display the other test-specific cards, choose a test
from the table on the Test list card.
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Routine operation of development workflow

Test details card

Card that lists the name of the master mix reagent, the
name of the variant target, and the name of the reference
target.

The Test details card is read-only.

Test settings card

Card to enter the minimum percentage of the variant
sequence, the limits of validity, and to configure the
display of final quantitative results.

Min. variant [%] field Defines the minimum percentage of the variant
sequence that must be present in the sample for it to be
variant positive.

Precision = 4 decimal places

Limit of validity (for the total concentration of If the limit of validity is enabled, the sum of the measured
the variant and the wild type) check box, concentrations of the variant sequence and the wild-type
Lower limit of validity field, and Upper limit of sequence must fall within the configured range.
validity field

If the concentration is outside the configured range, the
corresponding final (qualitative) result is invalid.

The lower limit of validity must be lower than the upper
limit of validity.

Precision = 4 decimal places

Show quantitative result check box Enable or disable the calculation and display of the
percentage of the variant sequence (final quantitative
results).

If the check box is cleared, all final results are only
displayed qualitatively.
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Default value = enabled
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Result names card

Controls card
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Roche Diagnostics

Controls table

ID field

Lower limit field and Upper limit field

Variant option, Negative option, and Wild type

option

Analysis packages in the development software

Card to enter the names that are displayed for valid final
qualitative results.

Default values:
= '"Variant Positive"
= "Variant Negative"

Card that lists the controls defined for the test and their
settings.

You can edit and delete the pre-defined controls, and
add new controls.

The controls that are defined here are automatically
added to the diagnostic sample setup.

Lists the controls that were defined in the analyses that
are used to create the analysis package.

To add a control, choose the New button.

To delete a control, choose the Delete button.

Field to enter the name of a control. The entry is
displayed as the sample ID in the diagnostic sample
setup.

The fields define the valid range for a control.
The lower limit must be lower than the upper limit.

For negative controls, the lower limit is always 0 and
cannot be changed.

Precision = 4 decimal places

Options to define the type of control.
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Routine operation of development workflow B¥¥/

MMx settings panel

On the MIMx settings panel, you set the dilution factors
and the clustering settings for each test.

> Navigation > Analysis package > [ > Create
analysis package > MMx settings

The MIMx settings panel comprises the following cards:
= MMx overview
= Clustering settings of "{0}"

MMx overview card

Card that lists the settings for the master mix reagents
for each test of the analysis package.

Dilution factor column For each test, enter the dilution factor.
Default value = 1.0000
Precision = 4 decimal places

Example:
A dilution factor of 2 (i.e., a dilution of 1:2) means half of
the reaction mixture consists of sample.

By default (dilution of 1:1), the development software
calculates the quantitative results in relation to the
volume of the reaction mixture.

If you enter a dilution factor, the development software
automatically uses it as a multiplication factor to
calculate the quantitative results in relation to the sample
volume.
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Analysis packages in the development software

Card for clustering settings of master mix reagent

Thresholds button and Minimum positive
threshold fields

Automatic - External seed data button and
Import seed data button

Roche Diagnostics

The Clustering settings of "{0}" card lists the clustering
settings for the master mix reagent of the analysis
package that is selected on the IMIVIx overview card.

The placeholder {0} is replaced with the name of the
master mix reagent, e.g., Clustering settings of "MIMX1".

By default, the clustering settings are taken over from the
clustering tabs for the analyses that are used to create
the analysis package, as indicated by the Project entry
in the Source column of the MIMx overview card:

= A manual clustering method of the project is taken
over as the Thresholds clustering method for the
analysis package.
Exception: If the clustering was determined via the
Lasso button or the Spider button in a 2D scatter
plot, you must enter the threshold values manually or
import a seed data file. A manual clustering via the
Lasso button or the Spider button cannot be used in
the clustering settings of an analysis package.

= Any automatic clustering method is taken over as the
Automatic - External seed data clustering method
for the analysis package.

When you change the clustering settings, this is
indicated by the Manual entry in the Source column of
the MMx overview card.

-Q- You cannot reset the clustering settings to the
values that were initially taken over from the
project.

When you make any changes on the card for the
clustering settings, the clustering settings taken
over from the project are lost.

If you want to enter thresholds values manually for each
dye, choose the Thresholds button. In the Minimum
positive threshold fields, enter the threshold values.

If you want to use an external seed data file as source for
the clustering, choose the Automatic - External seed
data button.

-‘Q’- Ensure that you use a seed data file that is
compatible with the master mix reagent.
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Routine operation of development workflow

Working with analysis packages

You can create, update, export, and delete analysis
packages, and create analysis package reports.

An analysis package has a .dpcrAp file extension.

When creating an analysis package, you must follow the
order of the breadcrumb (Edit > General settings >
Test definition > MIVIx settings) that is displayed
above the cards.

If there are changes on an analysis package tab and you
must update the version, an * is added to the tab entry in
the Navigation area.

-‘Q’- Do not change previous steps in the project while
you create or update an analysis package. For
example, do not change the clustering settings
for tests included in the analysis package. Such
changes will not be taken over into the analysis
package automatically.

Instead, complete the analysis package first. Then
apply the changes in the project and update the
analysis package accordingly.

You can export your own analysis package from the
development software and then import it in the analyzer
software for LDT runs.

& Manage analysis packages (579)

o— O Previous steps of the development workflow
completed

» To create an analysis package

1 In the development software, open a project as
described in Working with projects in the
development software (295).

2 In the Navigation area, choose Analysis package >
B > Create analysis package.
- The Create analysis package dialog box is
displayed.
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Analysis packages in the development software

3 In the Create analysis package dialog box, do the
following:

= In the Analysis package name field, enter a
name for the analysis package.

= From the Plate type drop-down list, choose the
nanowell plate type.

= Choose the Confirm button.

@ Ensure that you choose the correct plate type.
You cannot change the plate type later.

- The analysis package is created.

- The tab of the analysis package is displayed in the
work area.

= In the Navigation area, the analysis package is
listed in the Analysis package menu with version
number "(V0.0)".

4 On the Edit analysis package card on the analysis
package tab, do the following:
= Optionally, in the Creator field, enter the name of
the issuer of the analysis package.

= To add a test to the analysis package, choose a
combination of analysis type, master mix reagent,
and target from the Select table. Choose the
Copy button.

= To remove a test from the analysis package,
choose the test from the Manage table. Choose
the (x) button.

= Optionally, in the Test name field, enter a name
for the test.

5 In the breadcrumb, choose the General settings
button.

6 On the General settings card, do the following:

= Optionally, from the Number of merged lanes
drop-down list, choose the number of nanowell
plate lanes to be merged in the sample setup (1 =
no merged nanowell plate lanes).

= Optionally, to set a maximum duration between
partitioning of the nanowell plates and the start of
the diagnostic run, select the Time limit between
plate filling and starting a run check box. Enter
the duration value in the minutes field.

= From the Run profile drop-down list, choose the
run profile to be used (all run profiles from runs of
the project are listed).

= Choose a Result export restrictions option.

= Optionally, in the Report label field, enter a label
text for the analysis package report.
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7 Optionally, on the History card, enter a comment.
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Routine operation of development workflow

@ Enter a change description on the History card
whenever you create a new version of an analysis
package.

8 In the breadcrumb, choose the Test definition
button.

9 On the Test list card, choose a test.
= The cards for the test details and settings are
displayed.
10 Check, enter, and/or edit the information in the
following cards (if applicable):
= Test details
= Test settings
= Controls
* Internal controls

* Result names

11 Repeat steps 9 to 10 for all tests listed on the Test
list card.

12 In the breadcrumb, choose the MIMx settings
button.

13 On the MIMIx overview card, choose a master mix
reagent. Optionally, change the dilution factor.

= The card for the clustering settings is displayed.

= The clustering settings are taken over from the
project.

14 Optionally, on the Clustering settings of "{0}" card,
edit the clustering method and/or the clustering
settings:
= To cluster with a threshold value > 0, choose the

Thresholds button. For each dye, enter the
minimum positive threshold value.

= To cluster with seed data, choose the Automatic
- External seed data button. Choose the Import
seed data button. Navigate to the SDXML file
and choose the Open button.

@ This step is required if the clustering in the project
was determined via the Lasso button or the
Spider button and therefore cannot be used in
the clustering settings.

15 In the Navigation area, choose the analysis package
from the Analysis package menu. Choose [ >
Update version.
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Analysis packages in the development software

16 In the Increment version number dialog box, do
one of the following:

= To update the version number to "1.0", choose the
Major button.

= To update the version number to "0.1", choose the
Minor button.

= Choose the Update button.

@ You cannot save changes to an analysis package
without updating the version.

- The version of the analysis package is updated in
the Analysis package menu.

17 Save the project.

» To update an analysis package

1 In the development software, open the project as
described in To open a project in the development
software (296).

2 In the Navigation area, choose the analysis package
from the Analysis package menu.

- The tab of the analysis package is displayed in the
work area.

3 To navigate in the analysis package, choose the
buttons in the breadcrumb.

4 Enter the changes in the analysis package settings as
described in To create an analysis package (429).

@ An *is added to the tab entry in the Navigation
area, indicating that there are changes.

5 Enter a change description in General settings >
History.

6 Optionally, to discard all changes, in the Navigation
area, choose the analysis package from the Analysis
package menu. Choose B > Discard changes.
= All entered changes are deleted from the analysis

package again.

7 To save the changes, in the Navigation area, choose
the analysis package from the Analysis package
menu. Choose [ > Update version.

@ You can only update the version if you entered at
least 1 change.

8 In the Increment version number dialog box, do on
of the following:

= For a major update, e.g., to "2.0", choose the
Major button.

= For a minor update, e.g., to "1.1", choose the
Minor button.

= Choose the Update button.
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Routine operation of development workflow

@ You cannot go back to an earlier version of an
analysis package.

= The version of the analysis package is updated in
the Analysis package menu.

9 Save the project.

» To create an analysis package report

1 In the development software, open the project as
described in To open a project in the development
software (296).

2 In the Navigation area, choose the analysis package
from the Analysis package menu. Choose [ >
Generate report.

3 Navigate to a folder. Enter a name for the report and
choose the Save button.

= The analysis package report is saved as PDF file.

» To export an analysis package from
the development software

1 In the development software, open the project as
described in To open a project in the development
software (296).

2 In the Navigation area, choose the analysis package
from the Analysis package menu. Choose [ >
Export.

3 Navigate to a network folder that is accessible from
the analyzer. Enter a name for the analysis package
and choose the Save button.

= The analysis package is exported as dpcrAp file.

» To delete an analysis package

1 In the development software, open the project as
described in To open a project in the development
software (296).

2 In the Navigation area, choose the analysis package
from the Analysis package menu. Choose [ >
Remove.

3 In the Warning dialog box, choose the Confirm
button.

@ You cannot restore a deleted analysis package.

- The analysis package is deleted.

& Related topics

= Projects in the development software (294)

S
Q
=
=L
=
(=]
S
=)
c
(5]
(S
Q.
o
(5]
>
Q
=)
(-
(@)
c
=)
=]
o
| S
5]
.
(@)
Q
c
I;
-
Q
(o'
q
F

= Runs in the development software (309)

= Clustering in the development software (338)
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Analysis packages in the development software

= Analyses in the development software (358)

= Unassigned sample setups in the development
software (402)
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After routine operation

Shutting down the partitioning engine

Shut down the partitioning engine if you do not work
with it for any length of time, e.g., over night.

—‘Q’- For routine shutdown of the partitioning engine,
do not simply press the power switch. Instead,
follow the shutdown procedure and only press
the power switch when prompted to do so.

Only press the power switch outside of the
shutdown procedure if immediate shutdown is
required, e.g., in case of system failure or
emergency shutdown.

*& Restarting an unresponsive partitioning
engine (506)

Always unload the partitioning engine before you shut it
down.

»@ Partitioning the nanowell plates (221)
&_

O Partitioning engine unloaded
O Nanowell plate drawer closed
O Partitioning engine in Ready status

» To shut down the partitioning engine

1 In the global information area, choose = > Shut
Down Instrument.

—
= Error
—

(I} Initialize Instrurment . . . .
! 2 Wait until the shutdown is complete and the ! icon
' is displayed on the screen.

iy Copy Logs to USB 1

= Event Viewer

(i) Information !

('} Shut Down Instrument

3 At the back of the partitioning engine, press the
power switch.
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Logging off from the web application

Logging off from the web application

Log off from the web application after use.

Save all changes before logoff.

L2

-0O- If you close the browser window or browser tab
directly, you lose all unsaved changes.

If configured in the password settings, the current user is
logged off automatically after the inactivity time has
elapsed.

*&l Password settings (599)

» To log off from the web application

1 In the global information area, choose the logon
indicator.

- The Logoff dialog box is displayed.

2 Choose the Yes button.

= If there are unsaved changes, the Unsaved
changes dialog box is displayed.

3 Optionally, to log off and discard all unsaved changes,
choose the Yes button.

i o reaslly wosrd o Jemee e poge vathou

RN 18 CHNT - You are logged off from the web application.
e - The Logon dialog box is displayed.
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Logging off from the analyzer software

Log off from the analyzer software if you leave the
analyzer unattended for any length of time.

If configured in the password settings, the current user is
logged off automatically after the inactivity time has
elapsed.

»& Password settings (599)

a_ O Logged on to the analyzer software

» To log off from the analyzer software

1 In the global information area, choose the Logoff
button.

2 Optionally, if there are pending changes, in the
Confirmation dialog box, do one of the following:

= To abort the logoff and return to the analyzer
software, choose the Cancel button.

= To discard the changes and continue with the
logoff, choose the Discard changes button.

= To save the changes and continue with the logoff,
choose the Save button.

3 Tolog off, in the Logoff dialog box, choose the
Confirm button.

- You are logged off from the analyzer software.
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Shutting down the analyzer

Shut down the analyzer if you do not work with it for any
length of time, e.g., over night.

The (') button to shut down the analyzer is only available
in the analyzer software if the nanowell plate stack
drawer is closed and the analyzer is in Analyzer not
initialized status, Analyzer ready status, or Analyzer
paused status.

—Q- For routine shutdown of the analyzer, do not
simply press the power button. Instead, follow the
shutdown procedure and only press the power
button after the touch screen turns dark.

Only press the power button outside of the
shutdown procedure if immediate shutdown is
required, e.g., in case of system failure or
emergency failure.

*& Restarting an unresponsive analyzer (519)

Unload the analyzer before you shut it down.

*& Unloading the analyzer (227)

@ 3 minutes

&

O

Nanowell plate stack drawer closed

O Analyzer in Analyzer not initialized status,
Analyzer ready status, or Analyzer paused status

» To shut down the analyzer

1 In the global information area, choose the (!} button.
= The Shutdown dialog box is displayed.

2 To unload the analyzer if there are still nanowell

plates loaded, do the following:

= To open the nanowell plate stack drawer, choose
the Unload plates button.

= Unload the nanowell plates as described in
Unloading the analyzer (227).

= To close the nanowell plate stack drawer, in the
global information area, choose the (2} button.

= In the global information area, choose the (!}
button again.
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After routine operation

3 To shut down the analyzer, in the Shutdown dialog
box, choose the Confirm button.

4 Wait until the touch screen turns dark.

5 On the right side of the analyzer, press the power
button.
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Closing the development software

Closing the development software

Close the development software after use.

Save all changes before closing.

» To close the development software

1 To close the development software, do one of the

following:
* In the Navigation area, choose File > [ >
Close.

= In the top right corner of the software window,
choose the  button.

- The Close dialog box is displayed.

2 Do one of the following:
= To close the development software without saving
the current project, choose the Exit button. (All
unsaved changes to the project are lost.)
= To save the current project and then to close the
development software, choose the Save and exit
button.

- The development software is closed.
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Non-routine operation

Non-routine operation in the web

application

Deleting sample setups in the web application

Roche Diagnostics

You can delete sample setups in the web application
before the run is started on the analyzer.

In the web application, the batch tiles of not yet
processed sample setups are displayed in the Sample
setups column on the dashboard. The batch tiles are in
Incomplete setup status, Pending partitioning status,
Ready to start run status, or Ready to start run
(loaded) status.

When you delete a sample setup, the orders are not
allocated again and are displayed again on the Orders
screen in assignment mode. To process the orders, you
must create a new sample setup.

»& Creating sample setups in the web application (255)

O Not yet processed sample setup in the web
application

O Diagnostic operator user role

» To delete a sample setup

1 In the web application, in the Sample setups column
on the dashboard, choose a batch tile.

= The Sample setup screen is displayed.

2 To delete the sample setup, choose the Delete
button.
= The Delete sample setup dialog box is
displayed.
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Non-routine operation in the web application

3 Choose the Confirm button.
- The sample setup is deleted.

= The corresponding batch tile is deleted from the
dashboard.

- The orders of the deleted sample setup are not
allocated again and are displayed again on the
Orders screen in assignment mode.
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Non-routine operation in the analyzer
software

In this section

Managing screenshots in the analyzer software (447)
Audit trails in the analyzer software (449)

Aborting a run on the analyzer (450)

Restarting the analyzer (451)

Managing screenshots in the analyzer software

On the Manage screenshots panel in the analyzer
software, you view, export, and delete the screenshots
that were taken of the analyzer software.

The Manage screenshots panel lists all screenshots
taken by any user, not only the screenshots taken by the
currently logged on user.

You can export the screenshots to a network share or
external storage device.

You can access the Manage screenshots panel with
any user role.

About screenshooting To take a screenshot of the currently displayed panel of
the analyzer software or of a message callout, choose the

@ button.

The screenshots are saved automatically on the analyzer
and listed on the Manage screenshots panel.

By default, the screenshots are saved as PNG files and
are named:

SRC YYYY MM _DD _hhmmss.png

with the date and the time the screenshot was created.

*& About the global information area of the analyzer
software (106)

»& List of naming placeholders (154)

= O Optionally, external storage device, e.g., USB flash
drive
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Non-routine operation in the analyzer software

8
9

To export screenshots

Optionally, to export to an external storage device,
connect the external storage device to the analyzer.

In the analyzer software, choose Administration >
Manage screenshots.

- The Manage screenshots panel is displayed.

= The table lists all screenshots that are currently
stored on the analyzer.

Optionally, sort, search, or filter the table.

To display a preview of a screenshot, choose the
screenshot.

@ If you choose several screenshots, the preview of
the last chosen screenshot is displayed.

From the table, choose the screenshot.

©® You can export several screenshots at once.

Choose the Export button.

- The Export dialog box is displayed.

To change the export path, choose the -+ button.
In the folder browser, navigate to a folder.

Choose the Confirm button.

10 In the Export dialog box, choose the Export button.

- The screenshots are exported to the folder.

11 Optionally, disconnect the external storage device.

>
1

Roche Diagnostics

To delete screenshots

In the analyzer software, choose Administration >
Manage screenshots.

= The Manage screenshots panel is displayed.

= The table lists all screenshots that are currently
stored on the analyzer.

Optionally, sort, search, or filter the table.

To display a preview of a screenshot, choose the
screenshot.

@ If you choose several screenshots, the preview of
the last chosen screenshot is displayed.

From the table, choose the screenshot.

@ You can delete several screenshots at once.

Choose the Delete button.
- The Confirmation dialog box is displayed.
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6 Choose the Confirm button.
- The screenshots are deleted from the analyzer.

Audit trails in the analyzer software

System and user actions are logged as audit trails.

*&l About the message indicator (108)

*& About the messages panel (121)

In this section

About audit trails in the analyzer software (449)

Creating audit trails reports in the analyzer
software (450)

About audit trails in the analyzer software

About audit trails reports

About archiving of audit trails

Roche Diagnostics

The system logs system and user actions as audit trails
with user information and time stamp.

The system displays and handles audit trails as
information messages on the messages panel.

An audit trails report contains all audit trails currently
stored on the analyzer. Creating an audit trails report
does not change any data on the analyzer.

Audit trails reports are saved as CSV files.

Audit trails reports are named:
Audit Trail_SN_YYYYMMDD-hhmmss.csv
with the date and time the audit trails report was created.

You can only save audit trails reports in a network share
or on an external storage device. You cannot save an
audit trails report on the analyzer.

»@ List of naming placeholders (154)

Archiving includes the audit trails that are older than the
number of days configured for archiving. The
compressed archive file contains a CSV file of the
archived audit trails (AuditTrails.csv).
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After archiving is completed successfully, the archived
audit trails are deleted from the analyzer.

Creating audit trails reports in the analyzer software

You can create audit trails reports from the audit trails.

=] O

&

Aborting a run on the analyzer

Optionally, external storage device, e.g., USB flash
drive

Enough memory in the network share or on the
external storage device

To create an audit trails report in the
analyzer software

Optionally, to save to an external storage device,
connect the external storage device to the analyzer.

To display the messages panel, in the global
information area of the analyzer software, choose the
message indicator.

Optionally, to display the audit trail entries only, from
the filter drop-down list, choose the Audit trail
option.

Optionally, sort, search, or filter the table.

Choose the Export audit trail report button.
- The Select folder dialog box is displayed.

In the folder browser, navigate to a folder.

Choose the Confirm button.
= The audit trails report is saved in the folder.

Optionally, disconnect the external storage device.

You can abort the run on the analyzer.

All results from an aborted run are invalid.

[

O
O
O

Roche Diagnostics

Run processing on the analyzer
Monitoring panel displayed in the analyzer software

Diagnostic operator user role or development
operator user role
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» To abort a run on the analyzer

1 On the Monitoring panel in the analyzer software,
choose the Abort run button.

- The Confirmation dialog box is displayed.

2 Choose the Confirm button.
= The run is aborted.
= All results are invalid.

3 Wait until Awaiting plate removal is displayed on
the Monitoring panel.

4 Unload the analyzer as described in Unloading the
analyzer (227).

Restarting the analyzer

After some configuration tasks, you must restart the
analyzer for the changes to take effect.

The following configuration tasks require a restart of the
analyzer:

= Entering or changing the external IP address

= Importing a new version of the currently active
language package
= Changing the system language

Unload the analyzer before you restart it.

*@ Unloading the analyzer (227)

o— O Nanowell plate stack drawer closed

O Analyzer in Analyzer not initialized status,
Analyzer ready status, or Analyzer paused status

» To restart the analyzer

1 Shut down the analyzer as described in Shutting
down the analyzer (440).

2 Wait a few seconds.

3 Start up the analyzer as described in Starting up the
analyzer (235).
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Displaying system information

Displaying system information

—
= Error
—

d} Initialize Instrurment

i Copy Logs to USB
= Ewent Viewer
(i) Information

(!} Shut Down Instrument

Roche Diagnostics

You can access the system information in the
partitioning engine software, the analyzer software, and
the development software.

O To download the license information from the

partitioning engine:
External storage device, e.g., USB flash drive

To display the system information in
the partitioning engine software

In the partitioning engine software, in the global
information area, choose = > Information.

= The Information panel is displayed.

- The Information panel lists the software version,
system version, serial number, and network
address.

To close the Information panel, choose the Close
button.

To download the license information, do the

following:

= Connect the external storage device to the
partitioning engine.

= Choose the Copy Licence button.

= Wait until the download is completed.

= Disconnect the external storage device.

To display the system information in
the analyzer software

In the analyzer software, choose the Administration
tab.

- The Administration panel is displayed.

If required, choose the Administration element of
the breadcrumb.
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Non-routine operation

In the top right corner, choose the (i} button.
- The About dialog box is displayed.

- The About tab displays general information about
the analyzer and the analyzer software.

To display application information about the analyzer
software, choose the Application tab.

To display license information, choose the Legal
notice tab.

To display information about the intended use,
choose the Intended use tab.

To close the About dialog box, choose the x button.

To display system information in the
development software

In the development software, in the Navigation area,
choose File > [i > Help > About.

= The About dialog box is displayed.

= The About tab displays general information about
the development software.

To display application information about the
development software, choose the Application tab.

To display license information, choose the Legal
notice tab.

To display information about the intended use,
choose the Intended use tab.

To close the About dialog box, choose the Close
button.
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Maintenance schedule

Maintenance action

Replacing the partitioning fluid bottle
and/or the liquid waste bottle.

Maintenance

The table lists all maintenance actions and their

schedule.

Frequency

When the partitioning fluid bottle is
empty or expired, or the waste bottle is
full.

Procedure

»@ Replacing the partitioning fluid bottle
and/or the liquid waste bottle on the
partitioning engine (460)

Cleaning up not allocated orders.

On demand or before performing manual
archiving.

»@ Cleaning up not allocated orders
(466)

Performing manual archiving.

When automatic archiving is not
configured (or fails), or if disk space is
low.

»& Performing manual archiving (467)

Performing manual backup.

When automatic backup is not
configured (or fails).

»& Performing a manual backup (469)

Cleaning the outside of the partitioning ~ Weekly. »@ Cleaning the outside of the

engine. partitioning engine (473)

Cleaning the nanowell plate drawer of Monthly »& Cleaning the nanowell plate drawer

the partitioning engine. of the partitioning engine (474)

Cleaning the outside of the analyzer. Weekly. »& Cleaning the outside of the analyzer
(476)

Cleaning the nanowell plate stack drawer Half-yearly »& Cleaning the nanowell plate stack

of the analyzer.

drawer of the analyzer (477)

Decontaminating the nanowell plate
drawer of the partitioning engine.

On demand if the nanowell plate drawer
may be contaminated.

»@ Cleaning the nanowell plate drawer
of the partitioning engine (474)

Decontaminating the nanowell plate
stack drawer of the analyzer.

On demand if the nanowell plate stack
drawer may be contaminated.

»@ Cleaning the nanowell plate stack
drawer of the analyzer (477)

Decontaminating the aspiration needle of
the partitioning engine.

When a liquid waste bottle was loaded in
the position of the partitioning fluid
bottle.

»& Decontaminating the aspiration
needle of the partitioning engine
(479)

Preventive maintenance.

Yearly.

»& About preventive maintenance (482)

FR  Maintenance schedule
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Replacing the partitioning fluid bottle and/or the liquid waste bottle on the partitioning engine

Replacing the partitioning fluid bottle and/
or the liquid waste bottle on the
partitioning engine

When the partitioning fluid bottle is empty or expired, or
when the liquid waste bottle is full, replace the
partitioning fluid bottle and/or the liquid waste bottle.

/ CAUTION!

Sharp aspiration needle

The aspiration needle in the partitioning engine is sharp.
Contact with the aspiration needle may result in
personal injury.

» Carefully follow the instructions in this publication for
replacing the bottles on the partitioning engine and
for decontaminating the aspiration needle.

» When replacing the bottles on the partitioning engine
or when decontaminating the aspiration needle, pay
extra attention to the aspiration needle.

NOTICE!

Incorrect loading of the partitioning engine

The partitioning fluid bottles and the liquid waste bottles
are indistinguishable by their overall appearance.
Loading a bottle in the wrong position may contaminate
the partitioning engine, and/or the partitioning fluid and
the partitioning fluid bottle.

» Store partitioning fluid bottles and liquid waste bottles
in a way to allow for proper distinction.

» Mark all waste bottles with a permanent marker as
waste bottles. Mark empty or expired partitioning
fluid bottles as waste bottles immediately after
unloading them from the partitioning engine.

» Dispose of liquid waste bottles according to local
regulations directly after unloading them from the
partitioning engine.

» If you inadvertently loaded a bottle in the wrong
position, immediately unload it again and dispose of it
according to local regulations.

» Before loading a partitioning fluid bottle and using
the partitioning engine again after incorrect loading,
decontaminate the aspiration needle.

» If you suspect a contamination of the aspiration
needle, decontaminate the aspiration needle before
using the partitioning engine again.
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If the partitioning fluid bottle is empty, always replace
both the liquid waste bottle and the empty partitioning
fluid bottle.

If the partitioning fluid is expired, consider the fill levels
of the partitioning fluid bottle and the liquid waste bottle
for the replacement of the liquid waste bottle.

If the liquid waste bottle is full, replace the liquid waste
bottle.

(L2

Follow laboratory best practices and change your
lab gloves following any handling of waste
materials.

When the partitioning fluid bottle is empty or the liquid
waste bottle is full, the corresponding fill status in the
Liquids panel of the partitioning engine software turns
red. Additionally, a message is displayed in the global
information area.

*& About the global information area of the partitioning
engine software (83)

*&l About the Liquids panel (87)

= If the partitioning fluid bottle is empty or expired
= If the liquid waste bottle is full

@ 5 minutes per bottle

E] O New partitioning fluid bottle
O Liquid waste bottle
O Screw caps

o— O Replacement indicated in user interface

» To replace the partitioning fluid
bottle and the liquid waste bottle

1 To open the fluids door on the right side of the
partitioning engine, do the following:
= Push the front edge inside until the fluids door
disengages.
= Open the fluids door completely.
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Replacing the partitioning fluid bottle and/or the liquid waste bottle on the partitioning engine

2 Lift the aspiration and dispensing arm completely
until the aspiration needle is clear of the bottle
opening and the aspiration and dispensing arm locks
into place in the upper position.

3 Unload the liquid waste bottle. Close the liquid waste
bottle with a screw cap. Dispose of the full liquid
waste bottle according to local regulations.

©® Do not empty and reuse the liquid waste bottle.
Use empty or expired partitioning fluid bottles as
liquid waste bottles instead.

4 Unload the partitioning fluid bottle. Mark it as waste
bottle using a permanent marker. Load it as liquid
waste bottle in the fluids door with the label facing to
the front.

5 Unscrew the screw cap of the new partitioning fluid
bottle. Keep the screw cap for later use.

6 CAUTION! Risk of contamination.
Ensure that you do not load a liquid waste bottle in
the position of the partitioning fluid bottle.

Load the partitioning fluid bottle in the fluids door
with the label facing to the front.

7 Lower the aspiration and dispensing arm completely.
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8 Close the fluids door until it engages with an audible
click.

9 Prime the partitioning engine on demand as
described in Priming the partitioning engine (232):
= In the global information area of the partitioning
engine software, choose = > Prime Instrument.
= Wait until priming is complete.

» To replace the partitioning fluid
bottle

1 To open the fluids door on the right side of the
partitioning engine, do the following:
= Push the front edge inside until the fluids door
disengages.
= Open the fluids door completely.

2 Lift the aspiration and dispensing arm completely
until the aspiration needle is clear of the bottle
opening and the aspiration and dispensing arm locks
into place in the upper position.

3 Unload the partitioning fluid bottle. Close the bottle
with a screw cap.

@ Depending on fill level, keep the partitioning fluid
bottle as liquid waste bottle.

4 If you keep the unloaded partitioning fluid bottle as a
waste bottle, immediately mark it as waste bottle
using a permanent marker. Store partitioning fluid
bottles and waste bottles in a way to allow for proper
distinction.

5 Unscrew the screw cap of the new partitioning fluid
bottle. Keep the screw cap for later use.

6 CAUTION! Risk of contamination.
Ensure that you do not load a liquid waste bottle in
the position of the partitioning fluid bottle.

Load the partitioning fluid bottle in the fluids door
with the label facing to the front.
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Replacing the partitioning fluid bottle and/or the liquid waste bottle on the partitioning engine

7 Lower the aspiration and dispensing arm completely.

8 Close the fluids door until it engages with an audible
click.

9 Prime the partitioning engine on demand as
described in Priming the partitioning engine (232):
= In the global information area of the partitioning
engine software, choose = > Prime Instrument.
= Wait until priming is complete.

» To replace the liquid waste bottle

1 To open the fluids door on the right side of the
partitioning engine, do the following:
= Push the front edge inside until the fluids door
disengages.
= Open the fluids door completely.

2 Lift the aspiration and dispensing arm completely
until the aspiration needle is clear of the bottle
opening and the aspiration and dispensing arm locks
into place in the upper position.

3 Unload the liquid waste bottle. Close the liquid waste
bottle with a screw cap. Dispose of the full liquid
waste bottle according to local regulations.

©® Do not empty and reuse the liquid waste bottle.
Use empty or expired partitioning fluid bottles as
liquid waste bottles instead.
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4 Unscrew the screw cap of a liquid waste bottle. Keep
the screw cap for later use.

5 Load a liquid waste bottle in the fluids door with the
label facing to the front.

6 Lower the aspiration and dispensing arm completely.

7 Close the fluids door until it engages with an audible
click.

8 Prime the partitioning engine on demand as
described in Priming the partitioning engine (232):
= In the global information area of the partitioning
engine software, choose = > Prime Instrument.

= Wait until priming is complete.
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Data maintenance on the analyzer

Data maintenance on the analyzer

Data maintenance comprises the cleanup of not
allocated orders, archiving, and backup.

Archiving and backup are maintenance actions that can
be scheduled to be performed automatically at a

predefined time.

If necessary, e.g., if automatic execution is not configured
or fails, perform archiving and backup manually.

*& Scheduling automatic archiving (560)
*&l Scheduling automatic backups (566)

In this section

Cleaning up not allocated orders (466)
Performing manual archiving (467)

Performing a manual backup (469)

Cleaning up not allocated orders

M_

Roche Diagnostics

On the Archiving panel, to delete outdated orders from
the system, clean up the not allocated orders.

For cleaning up not allocated orders, the Archive data
older than (in days) setting of automatic archiving also
applies. For example, if you automatically archive data
older than 30 days, only not allocated orders that are
older than 30 days are deleted.

Clean up the not allocated orders regularly. Clean up the
not allocated orders before manual archiving.

*@ Performing manual archiving (467)
On demand

O Analyzer in Analyzer ready status
O Administrator user role

» To clean up not allocated orders

1 In the analyzer software, choose Administration >
Archiving.
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= The Archiving panel is displayed.

2 Optionally, to change how far back not allocated
orders are deleted, do the following:

* In the Archive data older than (in days) field,
change the value.

= Choose the Save button.

@ The time period also applies to automatic and
manual archiving.

3 Choose the Clean up not allocated orders button.

- The Clean up not allocated orders dialog box is
displayed.

4 Choose the Confirm button.

= All not allocated orders that are older than the
value configured in the Archive data older than
(in days) field are deleted from the system.

5 Optionally, if you changed the time period in step 2,
change it back:

= In the Archive data older than (in days) field,
change the value.

= Choose the Save button.

Performing manual archiving

On the Archiving panel, to free up disk space on the
analyzer on demand, perform manual archiving.

Reasons to perform manual archiving include the
following:

= Automatic archiving is not configured.
= Automatic archiving fails.
= A message is displayed that disk space is low.
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/ CAUTION!

Unprotected archive files

Insecure transfer or storage of archive files may allow
for data manipulation, which may cause incorrect,
invalid, or delayed results, and/or unauthorized access
to personal information.

» Ensure that archive files are transferred securely, are
stored in a secure location, and are protected from
any unauthorized access and disaster.

» Ensure that any external storage devices (such as
USB flash drives) that contain archive files are
protected against unauthorized access.

For manual archiving, the Archive data older than (in
days) setting of automatic archiving also applies. For
example, if you automatically archive data older than 30
days, a manual archiving also includes only data that is
older than 30 days.

As archiving can take a long time and you cannot work
with the system during archiving, perform manual
archiving at a time when the system is not needed.

To exclude not allocated orders from archiving, clean up
the not allocated orders before manual archiving.

*@ Cleaning up not allocated orders (466)

On demand

Depending on the amount of data, archiving may take a
long time.

O Optionally, external storage device, e.g., USB flash
drive

O Enough memory in the network share or on the
external storage device

O Analyzer in Analyzer ready status
O Administrator user role

» To perform manual archiving

1 Optionally, to archive to an external storage device,
connect the external storage device to the analyzer.

2 In the analyzer software, choose Administration >
Archiving.
= The Archiving panel is displayed.
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3 Optionally, to change how far back the data is
cleaned up and archived, do the following:

* In the Archive data older than (in days) field,
change the value.

= Choose the Save button.

@ The value also applies to automatic archiving.

4 QOptionally, to clean up not allocated orders before
archiving, choose the Cleanup not allocated orders
button.

5 Choose the Manual archiving button.
- The Manual archiving dialog box is displayed.

6 Optionally, to change the export path, choose the -+
button.

©® The folder configured for automatic archiving is
automatically pre-entered in the Export path
field.

- The Select folder dialog box is displayed.
7 In the folder browser, navigate to a folder.
8 Choose the Confirm button.

9 In the Manual archiving dialog box, choose the
Export button.

- The archive is saved as ZIP file in the folder.
10 Optionally, disconnect the external storage device.
11 Optionally, if you changed the time period in step 3,

change it back:

* In the Archive data older than (in days) field,
change the value.

= Choose the Save button.

Performing a manual backup

On the Backup panel, to save the system status on
demand, e.g., when automatic backup is not configured
or failed, perform a manual backup.

As a backup can take a long time and you cannot work
with the system during the backup, perform a manual
backup at a time when the system is not needed.

Roche Diagnostics
Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1



Data maintenance on the analyzer

M.

Oo—

Roche Diagnostics

/ CAUTION!

Unprotected backup files

Insecure transfer or storage of backup files may allow
for data manipulation, which may cause incorrect,
invalid, or delayed results, and/or unauthorized access
to personal information.

» Ensure that backup files are transferred securely, are
stored in a secure location, and are protected from
any unauthorized access and disaster.

» Ensure that any external storage devices (such as
USB flash drives) that contain backup files are
protected against unauthorized access.

On demand

Depending on the amount of data, a backup may take a
long time.

O Optionally, external storage device, e.g., USB flash
drive

O Enough memory in the network share or on the
external storage device

O Analyzer in Analyzer ready status
O Administrator user role

» To perform a manual backup

1 Optionally, to save the backup to an external storage
device, connect the external storage device to the
analyzer.

2 In the analyzer software, choose Administration >
Backup.

= The Backup panel is displayed.

3 Choose the Perform manual backup button.
= The Manual backup dialog box is displayed.
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Optionally, to change the export path, choose the +-
button.

@ The folder configured for automatic backups is
automatically pre-entered in the Export path
field.

- The Select folder dialog box is displayed.
In the folder browser, navigate to a folder.
Choose the Confirm button.

In the Manual backup dialog box, choose the
Backup button.

- The backup is saved as ZIP file in the folder.

Optionally, disconnect the external storage device.
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Cleaning and decontamination

Cleaning and decontamination

Do not perform any cleaning or decontamination that is
not described in this publication.

For cleaning and/or decontamination, always consider

the following:

= Use only the allowed cleaning and/or
decontamination solutions. Refer to the individual
cleaning and decontamination procedures for the
specified cleaning and decontamination solutions.

= Do not use technical or denatured ethanol or
isopropanol.

= Instead of deionized water you can use distilled or
otherwise purified water.

= Do not spray liquid directly on any part of the
instruments.

= Moisten the lint-free cloths away from the
instruments and wipe the surfaces and parts as
described in the procedures only.

= Take care when applying liquid to a lint-free cloth.
The cloth should be damp, not saturated, to prevent
drops of liquid from falling onto the system.

= Use decontamination solutions where indicated only.

= Before using decontamination solutions, carefully
read the precautions on the bottle labels or on the
safety data sheet of the manufacturers.

= Change lab gloves after each cleaning step.

= Dispose of the material as potentially infective
material.

In this section

Allowed cleaning and decontamination solutions (472)
Cleaning the partitioning engine (473)
Cleaning the analyzer (476)

Decontamination (478)

Allowed cleaning and decontamination solutions

Use only the cleaning and decontamination solutions for
the system that are listed below.

When cleaning and/or decontaminating the instruments,
use the following cleaning and decontamination
solutions only:

= Deionized or distilled water
= 70% ethanol p.a.
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= 70% isopropanol p.a.
= DNA AWAY™ Surface Decontaminant (Molecular
BioProducts, Inc.)

-‘Q’- Refer to the individual cleaning and
decontamination procedures for the cleaning and
decontamination solutions specified for them.

Cleaning the partitioning engine

Regularly clean the outside and the nanowell plate
drawer of the partitioning engine.

In this section

Cleaning the outside of the partitioning engine (473)

Cleaning the nanowell plate drawer of the partitioning
engine (474)

Cleaning the outside of the partitioning engine

Roche Diagnostics

.
§:
i

Regularly clean the outside of the partitioning engine
(housing and touch-screen monitor).

Risk of fire and burns

Alcohol is a flammable substance.

» Keep all sources of ignition (such as sparks, flames,
or heat) away from the partitioning engine when you
perform maintenance.

» When you use alcohol on or around the partitioning
engine, use no more than 20 mL at a time.

Weekly

Powder-free lab gloves

Eye protection

Personal protective equipment
Lint-free cloths

Oo0Oo0ooao

70% ethanol p.a.
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» To clean the outside of the
partitioning engine

1 Moisten a lint-free cloth with 70% ethanol p.a. and
clean the housing of the partitioning engine.

2 Moisten a lint-free cloth with 70% ethanol p.a. and
clean the touch-screen monitor of the partitioning
engine.

Cleaning the nanowell plate drawer of the partitioning engine

Regularly clean the nanowell plate drawer of the
partitioning engine.

Risk of fire and burns

Alcohol is a flammable substance.

» Keep all sources of ignition (such as sparks, flames,
or heat) away from the partitioning engine when you
perform maintenance.

» When you use alcohol on or around the partitioning
engine, use no more than 20 mL at a time.
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/ CAUTION!

Moving drawer

The nanowell plate drawer of the partitioning engine
opens and closes during operation. An opening drawer
may strike you. A closing drawer may pinch your fingers.

» Keep away from the nanowell plate drawer during
operation.

» Do not try to close the nanowell plate drawer
manually by pushing against it.

» Leave sufficient free space around the partitioning
engine to allow for unobstructed movement of the
nanowell plate drawer.

Decontaminating the nanowell plate drawer Perform the cleaning procedure below also to
decontaminate the nanowell plate drawer of the
partitioning engine if it may be contaminated, e.g., in
case of accidental contact with sample material.

.
N
.

Monthly

Powder-free lab gloves

Eye protection

Personal protective equipment
Lint-free cloths

70% isopropanol p.a.

DNA AWAY™ Surface Decontaminant
Deionized or distilled water

Ooo0Oo0ooooao

» To clean the nanowell plate drawer
of the partitioning engine

1 On the Plate Setup panel in the partitioning engine
software, choose the Load button.

- The nanowell plate drawer opens.

2 If a nanowell plate is loaded, unload it from the
nanowell plate drawer.

3 Moisten a lint-free cloth with 70% isopropanol and
wipe the nanowell plate drawer.
©® Do not use excessive force while wiping.

4 Wait until the isopropanol has evaporated and the
nanowell plate drawer is dry.

5 Moisten a lint-free cloth with DNA AWAY™ Surface
Decontaminant and wipe the nanowell plate drawer.

©® Do not use excessive force while wiping.

Roche Diagnostics
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Cleaning and decontamination

Cleaning the analyzer

Cleaning the outside of the analyzer

Checking around the analyzer

.
N
i
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6 Moisten a lint-free cloth with deionized water and
wipe the nanowell plate drawer.

©® Do not use excessive force while wiping.

7 Wait until the nanowell plate drawer is dry.

8 To close the nanowell plate drawer, on the Plate
Setup panel in the partitioning engine software,
choose the Close button.

Regularly clean the outside and the nanowell plate stack
drawer of the analyzer.

In this section

Cleaning the outside of the analyzer (476)

Cleaning the nanowell plate stack drawer of the
analyzer (477)

Regularly clean the outside of the analyzer (housing and
touch-screen monitor).

Risk of fire and burns

Alcohol is a flammable substance.

» Keep all sources of ignition (such as sparks, flames,
or heat) away from the analyzer when you perform
maintenance.

» When you use alcohol on or around the analyzer, use
no more than 20 mL at a time.

You must check the area around the analyzer regularly to
ensure that the air flow is unrestricted and that books,
papers, or other supplies are not interfering with the free
air flow.

Weekly

Powder-free lab gloves

Eye protection

Personal protective equipment
Lint-free cloths

O0Oo0ooad

70% ethanol p.a.

Draft - Do Not Distribute



Maintenance

%: O Analyzer is unloaded

O Analyzer is shut down
»& Shutting down the analyzer (440)

» To clean the outside of the analyzer

1 Moisten a lint-free cloth with 70% ethanol p.a. and
clean the housing of the analyzer.

2 Moisten a lint-free cloth with 70% ethanol p.a. and
clean the touch-screen monitor of the analyzer.

Cleaning the nanowell plate stack drawer of the analyzer

Regularly clean the nanowell plate stack drawer of the
analyzer.

/ CAUTION!

Moving drawer

The nanowell plate stack drawer of the analyzer opens
and closes during operation. An opening drawer may
strike you. A closing drawer may pinch your fingers.

» Keep away from the nanowell plate stack drawer
during operation.

» Do not try to close the nanowell plate stack drawer
manually by pushing against it.

» Leave sufficient free space around the analyzer to
allow for unobstructed movement of the nanowell
plate stack drawer.

Decontaminating the nanowell plate stack Perform the cleaning procedure below also to
drawer decontaminate the nanowell plate stack drawer of the
analyzer if it may be contaminated, e.g., in case of
nanowell plate loss due to hardware defects.

Roche Diagnostics
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Cleaning and decontamination

7 Half-yearly

Powder-free lab gloves

Eye protection

Personal protective equipment
Lint-free cloths

DNA AWAY™ Surface Decontaminant (Molecular
BioProducts, Inc.)

Oo0Oo0ooao

O

Deionized or distilled water

» To clean the nanowell plate stack
drawer of the analyzer

1 To open the nanowell plate stack drawer, in the
global information area of the analyzer software,
choose the (£} button.

= The nanowell plate stack drawer opens.
2 |If any nanowell plates are loaded, unload the

nanowell plate stack from the nanowell plate stack
drawer.

3 Moisten a lint-free cloth with DNA AWAY™ Surface
Decontaminant and wipe the nanowell plate stack
drawer.

@ Do not use excessive force while wiping.
4 Moisten a lint-free cloth with deionized water and
wipe the nanowell plate stack drawer.

©® Do not use excessive force while wiping.

5 Wait until the nanowell plate stack drawer is dry.

6 To close the nanowell plate stack drawer, in the
global information area of the analyzer software,
choose the (=) button.

- The nanowell plate stack drawer closes.

Decontamination

If the nanowell plate drawer or the aspiration needle of
the partitioning engine, or the nanowell plate stack
drawer of the analyzer may be contaminated, you must
decontaminate them.

N

-0~ If the inside of the partitioning engine or the
inside of the analyzer may be contaminated,
contact your Roche Service representative.

Roche Diagnostics
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Maintenance

Decontaminating the nanowell plate drawer If the nanowell plate drawer of the partitioning engine
of the partitioning engine may be contaminated, e.g., in case of accidental contact
with sample material, decontaminate it by performing the
cleaning procedure for the nanowell plate drawer.

*@ Cleaning the nanowell plate drawer of the
partitioning engine (474)

Decontamination the nanowell plate stack If the nanowell plate stack drawer of the analyzer may be
drawer of the analyzer contaminated, e.g., in case of nanowell plate loss due to
hardware defects, decontaminate it by performing the
cleaning procedure for the nanowell plate stack drawer.

*@ Cleaning the nanowell plate stack drawer of the
analyzer (477)

Decontaminating the aspiration needle of the partitioning engine

If you load a liquid waste bottle in the position of the
partitioning fluid bottle, the aspiration needle may
become contaminated and you must decontaminate it.

After closing the fluids door, the incorrect loading of a
liquid waste bottle is indicated in the global information
area of the partitioning engine software.

You cannot start partitioning if a liquid waste bottle is
loaded in the position of the partitioning fluid bottle.
Therefore, the inside of the partitioning engine will not be
contaminated.

-‘Q’— Mark all waste bottles with a permanent marker
as waste bottles. Mark empty or expired
partitioning fluid bottles as waste bottles
immediately after unloading them from the
partitioning engine.

Risk of fire and burns

Alcohol is a flammable substance.

» Keep all sources of ignition (such as sparks, flames,
or heat) away from the partitioning engine when you
perform maintenance.

» When you use alcohol on or around the partitioning
engine, use no more than 20 mL at a time.

Roche Diagnostics
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Cleaning and decontamination

Roche Diagnostics

/ CAUTION!

Sharp aspiration needle

The aspiration needle in the partitioning engine is sharp.
Contact with the aspiration needle may result in
personal injury.

» Carefully follow the instructions in this publication for

replacing the bottles on the partitioning engine and
for decontaminating the aspiration needle.

» When replacing the bottles on the partitioning engine

or when decontaminating the aspiration needle, pay
extra attention to the aspiration needle.

Ooo0Oooooad

Powder-free lab gloves

Eye protection

Personal protective equipment
Lint-free cloths

70% isopropanol p.a.

New partitioning fluid bottle
Screw cap

To decontaminate the aspiration
needle of the partitioning engine

To open the fluids door on the right side of the

partitioning engine, do the following:

= Push the front edge inside until the fluids door
disengages.

= Open the fluids door completely.

Lift the aspiration and dispensing arm completely
until the aspiration needle is clear of the bottle
opening and the aspiration and dispensing arm locks
into place in the upper position.

Remove the bottle from the partitioning fluid bottle
position. Close the bottle with a screw cap. Dispose of
the bottle according to local regulations.

Moisten a lint-free cloth with 70% isopropanol.

Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1



Maintenance

5 Wipe the aspiration needle with the moistened cloth.

6 Wait until the isopropanol has evaporated and the
aspiration needle is dry.

7 Unscrew the screw cap of the new partitioning fluid
bottle. Keep the screw cap for later use.

8 Place the new partitioning fluid bottle in the fluids
door with the label facing to the front.

9 Lower the aspiration and dispensing arm completely.

10 Close the fluids door until it engages with an audible
click.

11 Prime the partitioning engine twice as described in
Priming the partitioning engine (232).

Roche Diagnostics
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About preventive maintenance

About preventive maintenance

Preventive maintenance settings

System behavior

& Warning =
Message code 286.000.00013
Message title Preventive maintenance
Category Software
Severity Warning
Message detail Preventive maintenance is due on: {0}. Diagnostic runs cannot be started if preventive
maintenance is not done.
Number of occurences 1
Troubleshooting Contact your RSR.

Roche Diagnostics

On the Preventive maintenance panel, you view the
preventive maintenance settings.

You need administrator user role to view the preventive
maintenance settings.

2)-  Preventive maintenance is performed by your
Roche Service representative.

The following preventive maintenance settings are
displayed on the Preventive maintenance panel:
* Repeat every (in days):
Number of days between scheduled preventive
maintenance.
* Prior warning message (in weeks):
Number of weeks before next due preventive
maintenance that a warning message is displayed.

* Next maintenance due at:
Due date of next preventive maintenance.

The preventive maintenance settings are configured
upon system installation.

The preventive maintenance settings are read-only. To
change the preventive maintenance settings, contact
your Roche Service representative.

When the configured warning period starts before the
due date of the next preventive maintenance, a warning
message is displayed.

On the message callout, you must decide when the
warning message is displayed again:

= To display the warning again the next day, choose the

Show tomorrow button.

= To display the warning again next week, choose the
Show next week button.

-Q- When the warning message is displayed, contact
your Roche Service representative. Preventive
maintenance is performed by your Roche Service
representative.

Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1



& Warning

Message code
Message title
Category

Severity

Message detail
Number of occurences

Troubleshooting

Roche Diagnostics

286.000.00014
Preventive maintenance

Software

Warning

Preventive maintenance is overdue. Diagnostic run cannot be started.
1

Contact your RSR.

Maintenance

When preventive maintenance is completed, the counter
is reset, and the next due date is recalculated and
displayed on the Preventive maintenance panel.

If the preventive maintenance is not performed before
the due date, the preventive maintenance becomes
overdue.

If preventive maintenance is overdue, the following
applies:

On the Preventive maintenance panel, preventive
maintenance is displayed as overdue.

You cannot perform diagnostic runs on the analyzer.
For diagnostic operator user role, diagnostic approver
user role, and administrator user role, an error
message is displayed in the analyzer software and the
web application.

You can still perform development runs on the
analyzer.

For development operator user role, a warning
message is displayed in the analyzer software.

Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1
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Flags

List of flags

Flags are assigned to samples and controls and inform
you about issues or user actions that have occurred
during the workflow.

Flags are listed in the web application, the analyzer
software, and/or the development software, depending
on the workflow.

For additional information about a flag, you can display a
flag callout in the software components of the system.

»& Displaying the flag callouts (494)

About flag severity Flags are raised in the following severity, resulting in
different consequences for the sample or control:
= Critical:
All initial and final results for this sample or control
are invalidated.
= Informational:
The flag provides additional information only.

Flags are sorted according to their severity. The most
severe flags are listed first.

Table of flags
Flag code  Severity Description Actions
1001 Critical Analyzer: Internal system temperature is Check the following:

out of range. o )
= The air inlet underneath the analyzer is

not blocked.

= The air outlet at the back of the analyzer
is not blocked.

= The ambient temperature in the laboratory
lies within the range specified for
operation.

»€l Environmental conditions for the system

(183)

IP001 Critical Image processing: Focus position may be Restart the analyzer. If the flag occurs
suboptimal due to missing focus image. repeatedly, contact your Roche Service
representative.

»& Restarting the analyzer (451)

IP002 Critical Image Processing: LED-check failed. Restart the analyzer. If the flag occurs
repeatedly, contact your Roche Service
representative.

»& Restarting the analyzer (451)
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List of flags

Flag code

Severity

Description

Actions

IP003 Informational No nanowell columns detected within the Restart the analyzer. If the flag occurs
expected overlap area during stitching repeatedly, contact your Roche Service
representative.
»&l Restarting the analyzer (451)

IP004 Critical Data integrity check failed Restart the analyzer. If the flag occurs
repeatedly, contact your Roche Service
representative.

»& Restarting the analyzer (451)
PE0O1 Critical Partitioning engine: Lane partitioning Restart the partitioning engine. If the flag
failed occurs repeatedly, contact your Roche Service
representative.
»& Restarting the analyzer (451)
PE002 Informational Partitioning engine: Lane partitioning Restart the partitioning engine. If the flag
data missing occurs repeatedly, contact your Roche Service
representative.
»& Restarting the analyzer (451)
PE003 Critical Partitioning engine: Empty lane
RA000 Critical Unhandled exception in results Restart the analyzer. If the flag occurs
interpretation. repeatedly, contact your Roche Service
representative.
»&l Restarting the analyzer (451)

RA001 Informational Upper limit of quantification not met.

RA002 Informational Lower limit of quantification not met.

RA003 Critical Positive control concentration is too high.

RA004 Critical Positive control concentration is too low.

RA005 Critical Negative control concentration is too

high.

RA006 Critical Internal control concentration is too high.

RA007 Critical Internal control concentration is too low.

RA008 Critical Too many invalid nanowells If the flag occurs repeatedly, contact your
Roche Service representative.

RA009 Critical Integrity check failed. If the flag occurs repeatedly, contact your
Roche Service representative.

RA011 Critical Too many artifact nanowells Ensure there are no scratches, finger prints,
dust, or other artifacts on the nanowell plate
lanes that compromise the image integrity.
If the flag occurs repeatedly, contact your
Roche Service representative.

RA012 Critical Merging verification failed. If the flag occurs repeatedly, contact your
Roche Service representative.

RA013 Critical Copy number control value is too high.

RA014 Critical Copy number control value is too low.

RA015 Critical TOI concentration is above upper limit of

validity.
RA016 Critical TOI concentration is below upper limit of

validity.

ER Table of flags
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Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1

Draft - Do Not Distribute



Flags

Flag code  Severity Description Actions
RA017 Critical Reference target concentration is above
upper limit of validity.
RA018 Critical Reference target concentration is below
upper limit of validity.
RAO019 Critical Wild type control concentration is too
high.
RA020 Critical Wild type control concentration is too
low.

RA021 Critical Percentage of variant control is too high.

RA022 Critical Percentage of variant control is too low.

RA023 Critical Total concentration is above upper limit

of validity.

RA024 Critical Total concentration is below lower limit

of validity.

RA025 Critical Internal control channel has no negative Result calculation is not possible if the

nanowells. number of negative nanowells is zero.
The used target concentration saturates the
nanowell lane. Dilute the sample to reduce
the target concentration.

RA026 Critical An unexpected cluster is present.

RA027 Informational Lane has no valid nanowells.

RA028 Critical Target channel has no negative Result calculation is not possible if the

nanowells. number of negative nanowells is zero.
The used target concentration saturates the
nanowell lane. Dilute the sample to reduce
the target concentration.

RA029 Critical Positive control is invalid.

RA030 Critical Negative control is invalid.

RA031 Critical Copy number control is invalid.

RA032 Critical Wild type control is invalid.

RA033 Critical Variant control is invalid.

RA034 Critical Wild type concentration has no value.

RA035 Critical Variant concentration has no value.

RA036 Critical Variant percentage has no value.

RA037 Critical Copy number has no value.

RA041 Critical Critical instrument flag Restart the analyzer. If the flag occurs
repeatedly, contact your Roche Service
representative.

»& Restarting the analyzer (451)

RA042 Critical Initial control result is invalid.

RA043 Critical Positive control is invalid.

RA045 Critical Initial result of internal control is invalid.

RA048 Critical Variant control is invalid.

RCO005 Critical Not enough valid nanowells If the flag occurs repeatedly, contact your
Roche Service representative.

RD000 Critical Indel analysis failed. If the flag occurs repeatedly, contact your
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List of flags

Flag code  Severity Description Actions
RD001 Critical Verification of input data failed. If the flag occurs repeatedly, contact your
Roche Service representative.
RD002 Critical Merging verification failed. If the flag occurs repeatedly, contact your
Roche Service representative.
RDO004 Informational An unexpected cluster is present.
RD005 Critical Lane has no valid nanowells.
RD006 Critical Lane has no negative nanowells. Result calculation is not possible if the
number of negative nanowells is zero.
The used target concentration saturates the
nanowell lane. Dilute the sample to reduce
the target concentration.
RF001 Informational Normalized fluorescence trimmed
RF002 Critical Lane has no valid nanowells.
RLO00 Critical Integrity check calculation failed. If the flag occurs repeatedly, contact your
Roche Service representative.
RMO000 Critical Integrity check on lane failed. If the flag occurs repeatedly, contact your
Roche Service representative.
RN000 Critical CNV analysis failed. If the flag occurs repeatedly, contact your
Roche Service representative.
RNO001 Critical Verification of input data failed. If the flag occurs repeatedly, contact your
Roche Service representative.
RN002 Critical Merging verification failed. If the flag occurs repeatedly, contact your
Roche Service representative.
RNO004 Critical Lane has no valid nanowells.
RNO006 Critical Reference target concentration is zero.
RN007 Critical TOI concentration has no value.
RN008 Critical Reference target concentration has no
value.
RQ000 Critical Absolute quantification failed. If the flag occurs repeatedly, contact your
Roche Service representative.
RQO001 Critical Verification of input data failed. If the flag occurs repeatedly, contact your
Roche Service representative.
RQ002 Critical Merging verification failed. If the flag occurs repeatedly, contact your
Roche Service representative.
RQ003 Informational Potential linkage imprecision due to low
approximation iterations
RQ004 Critical Lane has no valid nanowells.
RQ005 Critical Channel has no negative nanowells. Result calculation is not possible if the
number of negative nanowells is zero.
The used target concentration saturates the
nanowell lane. Dilute the sample to reduce
the target concentration.
RX001 Informational Corrected fluorescence trimmed
S001 Informational System: Manual entry of plate barcode
S002 Critical System: Analysis package violation.The
maximum time between partitioning and
starting the run was exceeded.
S003 Informational System: Run aborted by operator.

EB Table of flags
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Flags

Flag code  Severity Description Actions
S004 Critical System: Run aborted by operator before
images were captured.
S005 Informational System: Run failed.
S006 Critical System: Run failed before images were
captured.
S007 Informational System: Preventive maintenance is
overdue.
S008 Critical System: Unexpected run abort
S009 Critical System: Result calculation failure
S010 Informational System - direct imaging run/
thermocycling bypassed
So011 Informational System - direct imaging run/plate re-
imaged
S012 Informational System - LED-check cannot be
performed due to abort of the run
S013 Critical This lane was not imaged during a direct
imaging run.
SS001 Critical Sample setup - lane marked as invalid by
operator
SS002 Critical Sample setup: Plate marked as invalid by
operator.
TC001 Critical Temperature out of range Check the following:
= The air inlet underneath the analyzer is
not blocked.
= The air outlet at the back of the analyzer
is not blocked.
= The ambient temperature in the laboratory
lies within the range specified for
operation.
»& Environmental conditions for the system
(183)
TC002 Critical Thermocycler: Temperature homogeneity Restart the analyzer. If the flag occurs
out of range repeatedly, contact your Roche Service
representative.

»& Restarting the analyzer (451)

EB Table of flags

Roche Diagnostics

Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1 Draft - Do Not Distribute

Ny

-Q’- If the same flag occurs repeatedly without cause,
contact your Roche Service representative.
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Displaying the flag callouts

Displaying the flag callouts

In the web application, the analyzer software, and the
development software, you can display flag callouts from
the flags.

In the web application and the development software,
flags are displayed together with results.

In the analyzer software, partitioning flags are displayed
together with the sample setups of diagnostic runs.

A flag callout always contains the flag severity and the
flag description.

» To display the flag callouts in the web
application

1 In the web application, in the Results column on the
dashboard, navigate to the Results of screen:
= For incomplete runs, choose the batch tile.

= For completed runs, choose the {count}
completed batches tile. Choose the batch and
choose the View button.

= The Results of screen is displayed.

2 Choose the Samples tab or the Controls tab.

3 In the Flag column, choose a flag link.
= The flag callout is displayed.

» To display the flag callouts in the
analyzer software for diagnostic runs
1 In the analyzer software, choose Routine >
Diagnostic run > Sample setup.
- The Sample setup panel is displayed.
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Flags

2 Mouse over the flag indicator.
= The flag callout is displayed.

» To display the flag callouts in the
development software

1 In the development software, in the Navigation area,
choose an analysis from the Analysis menu.

= The analysis tab is displayed in the work area.

2 Choose the Results button.

3 Mouse over an entry in the Flags column.
= The flag callout is displayed.
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List of messages on the partitioning engine

Message Actions

Bottle compartment is empty

Troubleshooting the partitioning engine

Messages alert you to events that prevent normal
operation of the partitioning engine.

In the partitioning engine software, messages are
displayed in the global information area.

*& About the global information area of the partitioning

engine software (83)

Load a partitioning fluid bottle and a liquid waste bottle.

*@l Replacing the partitioning fluid bottle and/or the liquid waste
bottle on the partitioning engine (460)

Bottle tag id/version is wrong

Replace the partitioning fluid bottle and the liquid waste bottle.

*él Replacing the partitioning fluid bottle and/or the liquid waste
bottle on the partitioning engine (460)

Down-Holder Sub-Controller

Refer to the event viewer for additional information.

»@ Displaying the event viewer in the partitioning engine software
(503)

Drive Controller

Refer to the event viewer for additional information.

»@ Displaying the event viewer in the partitioning engine software
(503)

Error

Try again. If the message persists, contact your Roche Service
representative.

Error while copying licences to USB

Try again. If the message persists, contact your Roche Service
representative.

Information

No action required.

No plate barcode was detected

= Reload the nanowell plate.

= If the message persists, unload the nanowell plate. In a diagnostic
workflow, invalidate the nanowell plate. In a development
workflow, consider pipetting a new nanowell plate.

= If the message persists for multiple nanowell plates, contact your
Roche Service representative.

»& Partitioning the nanowell plates (221)

»@ Invalidating nanowell plate lanes and/or nanowell plates in the
web application (535)

No Version Information

Contact your Roche Service representative.

Oil bottle is missing

Load a partitioning fluid bottle.

*é Replacing the partitioning fluid bottle and/or the liquid waste
bottle on the partitioning engine (460)

Oil bottle is not available

Load a partitioning fluid bottle.

*@ Replacing the partitioning fluid bottle and/or the liquid waste
bottle on the partitioning engine (460)

#R Partitioning engine messages

Roche Diagnostics
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List of messages on the partitioning engine

Message Actions

0il bottle signature is wrong Replace the partitioning fluid bottle.

*él Replacing the partitioning fluid bottle and/or the liquid waste
bottle on the partitioning engine (460)

Oil expiry date is elapsed Replace the partitioning fluid bottle.

*él Replacing the partitioning fluid bottle and/or the liquid waste
bottle on the partitioning engine (460)

Oil fill state is not available = Shut down the partitioning engine.
= Wait for 5 seconds.
= Start up the partitioning engine again.
= If required, initialize the partitioning engine.

*@ Shutting down the partitioning engine (437)
»@ Starting up the partitioning engine (231)

*@ Initializing the partitioning engine (505)

Oil onboard stability expired Replace the partitioning fluid bottle.

*@ Replacing the partitioning fluid bottle and/or the liquid waste
bottle on the partitioning engine (460)

Oil Pump Controller Refer to the event viewer for additional information.

»@ Displaying the event viewer in the partitioning engine software

(503)
. Partitioning Engine Controller Refer to the event viewer for additional information.
»@ Displaying the event viewer in the partitioning engine software
(503)
Plate expiry date is elapsed = Unload the nanowell plate.

= In a diagnostic workflow, invalidate the nanowell plate.

= In a development workflow, consider pipetting a new nanowell
plate.

imaoning engine

»@ Invalidating nanowell plate lanes and/or nanowell plates in the
web application (535)

Plate reused or empty = Unload the nanowell plate.
= Check if the nanowell plate is empty, i.e., not pipetted.
= Pipette an empty nanowell plate and try again.
* You cannot reload already partitioned nanowell plates.

»& Partitioning the nanowell plates (221)

Plate-Drawer Sub-Controller Refer to the event viewer for additional information.

»@ Displaying the event viewer in the partitioning engine software
(503)

#R Partitioning engine messages
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Troubleshooting the partitioning engine

Message Actions

Please exchange supply bottle

= Unload the bottle from the position of the partitioning fluid bottle.

= If the loaded bottle was a liquid waste bottle, decontaminate the
aspiration needle.

= Load a partitioning fluid bottle.
*@ Replacing the partitioning fluid bottle and/or the liquid waste
bottle on the partitioning engine (460)

»él Decontaminating the aspiration needle of the partitioning engine
(479)

Please exchange waste bottle

Replace the liquid waste bottle.

*é Replacing the partitioning fluid bottle and/or the liquid waste
bottle on the partitioning engine (460)

Please remove plate from drawer

Unload the nanowell plate.

Real-Time Controller not available

= Shut down the partitioning engine.

= Wait for 5 seconds.

= Start up the partitioning engine again.

= If required, initialize the partitioning engine.
»@ Shutting down the partitioning engine (437)
»@ Starting up the partitioning engine (231)

*@ Initializing the partitioning engine (505)

Real-Time-Controller

Refer to the event viewer for additional information.

»@ Displaying the event viewer in the partitioning engine software
(503)

Shutdown can not be executed

Try again. If the message persists, contact your Roche Service
representative.

The plate barcode could not be read

= Reload the nanowell plate.

= If the message persists, unload the nanowell plate. In a diagnostic
workflow, invalidate the nanowell plate. In a development
workflow, consider pipetting a new nanowell plate.

= If the message persists for multiple nanowell plates, contact your
Roche Service representative.

»@ Partitioning the nanowell plates (221)

*@ Invalidating nanowell plate lanes and/or nanowell plates in the
web application (535)

Waiting for Real-Time-Controller

= Shut down the partitioning engine.

= Wait for 5 seconds.

= Start up the partitioning engine again.

= If required, initialize the partitioning engine.
*@ Shutting down the partitioning engine (437)
»@ Starting up the partitioning engine (231)

*@ Initializing the partitioning engine (505)

Warning

Try again. If the message persists, contact your Roche Service
representative.

#B Partitioning engine messages

Roche Diagnostics
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List of messages on the partitioning engine

Message Actions

Waste bottle is missing Load a liquid waste bottle.

*él Replacing the partitioning fluid bottle and/or the liquid waste
bottle on the partitioning engine (460)

Waste bottle is not available Load a liquid waste bottle.

*él Replacing the partitioning fluid bottle and/or the liquid waste
bottle on the partitioning engine (460)

Waste fill state is not available = Shut down the partitioning engine.
= Wait for 5 seconds.
= Start up the partitioning engine again.
= If required, initialize the partitioning engine.
*@ Shutting down the partitioning engine (437)
»@ Starting up the partitioning engine (231)

*@ Initializing the partitioning engine (505)

ER Partitioning engine messages

If any of the messages persists even after the
recommended actions were performed, contact your
Roche Service representative.
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Troubleshooting the partitioning engine

Displaying the event viewer in the
partitioning engine software

The partitioning engine logs events in the event viewer
with event severity and event code.

» To display the event viewer in the
partitioning engine software

1 In the global information area, choose = > Event
Viewer.

—
= Error
—

(I} Initialize Instrurment l

iy Copy Logs to USB 1
= Event Viewer

(i) Information !

(!} Shut Down Instrument !

2 To close the event viewer, choose the Close button.
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Copying the logs from the partitioning engine to an external storage device

Copying the logs from the partitioning
engine to an external storage device

&

—
o Error
—

(I} Initialize Instrurment
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iy Copy Logs to USB 1
= Ewent Viewer
(i) Information !

('} Shut Down Instrument
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The logs from the partitioning engine contain relevant
data required by Roche for troubleshooting purposes.

If you encounter a problem with the partitioning engine
and contact your Roche Service representative, you may
be asked to provide the logs.

Roche reviews the logs upon your request only.

O External storage device, e.g., USB flash drive

O Enough memory on the external storage device

» To copy the logs from the partitioning
engine to an external storage device

1 At the back of the partitioning engine, remove the
COVeET.

2 Connect the external storage device to the
partitioning engine.

3 Inthe global information area, choose = > Copy
Logs to USB.

4 Wait until the logs are copied.

5 Disconnect the external storage device.

6 At the back of the partitioning engine, attach the
COVver.
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Troubleshooting the partitioning engine

Initializing the partitioning engine

When an error occurred on the partitioning engine, you
must initialize it.

You can only continue to work with the partitioning
engine after initialization.

During startup of the partitioning engine, initialization is
done automatically.

o_ O Error on the partitioning engine

» To initialize the partitioning engine
1 In the global information area, choose the = button.

2 From the drop-down menu, choose the Initialize

= Error
— Instrument command.
I Initiakize Instrurment l . L . .
! 3 Wait until initialization is complete and the
! partitioning engine is in Ready status.
i Copy Logs to USB 1
= Event Viewer 1 L]
(i) Information !
{1 Shut Down Instrument '

iaoning engine
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Restarting an unresponsive partitioning engine

Restarting an unresponsive partitioning
engine

If the partitioning engine and/or the partitioning engine
software are unresponsive, you must restart the
partitioning engine.

Always confirm that the partitioning engine and/or the

partitioning engine are unresponsive before you restart

the partitioning engine:

= Ensure the partitioning engine is not busy and
therefore not responding.

= Try to initialize the partitioning engine following the
normal initialization procedure.

= Try to shut down the partitioning engine following the
normal shutdown procedure.

*@ Initializing the partitioning engine (505)
»& Shutting down the partitioning engine (437)

—‘Q’- Only follow the procedure below if the
partitioning engine and/or the partitioning engine
software are unresponsive.

O Partitioning engine and/or partitioning engine
software unresponsive

» To restart an unresponsive
partitioning engine

itioning engine
r

1 If an external storage device is connected to the
partitioning engine, disconnect it.

2 At the back of the partitioning engine, switch the
power switch to the off position.

3 Wait a few seconds.

4 Start up the partitioning engine as described in
Starting up the partitioning engine (231) and follow
the instructions on the screen.

5 |If the partitioning engine does not start up or if the
error persists, contact your Roche Service
representative.
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Troubleshooting the analyzer

Messages in the analyzer software

Messages inform and alert you.

Depending on the severity of the message and your
system configuration, an additional callout and an
acoustic signal may be displayed to alert you to

messages.

*& Audio settings (563)

In this section

About messages in the analyzer software (509)

Displaying and confirming messages in the analyzer
software (511)

About messages in the analyzer software

About the message codes

About the message severity

Roche Diagnostics

Messages inform you about the analyzer status and alert
you to critical events.

Messages are listed on the messages panel in the
analyzer software.

If a message requires further user action, the action is
described on the detail panel of the message.

To resolve the event, perform the described actions.

If the error persists or if in doubt, contact your Roche
Service representative.

*& About the messages panel (121)

Each message is uniquely identified by its message code.

The message code is displayed in the VMlessage code
column of the messages table and on the detail panel of
a message.

The messages are categorized by the severity of the
event that triggered the message:

= Error messages:

Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1
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Messages in the analyzer software

- Triggered by errors. Working with the analyzer is
not possible anymore. Immediate action is
required to resolve the error.

- Error messages always need confirmation.
= Warning messages:

- Triggered by warnings. Working with the analyzer
is possible for the moment. No immediate action
is required, but it may be necessary to resolve the
warning soon.

- Some warning messages need confirmation.

= Information messages:

- Triggered by normal operation. Working with the
analyzer is not affected. No action is required.

- Information messages never need confirmation.

The message severity is indicated as follows:
= On the message callout (if applicable)
= In the Severity column of the messages table
= On the detail panel of a message
*& About the message indicator (108)

*& About the messages panel (121)

About the message callouts
For some messages, an additional callout is displayed.

If a callout is displayed, the corresponding message
always needs to be confirmed.

The Number of occurences value indicates how often
the event occurred that triggered the callout.

If the callout includes an action (e.g., to confirm the
messages), the action applies to all messages that are
represented by the callout.

To take a screenshot of the callout, choose the
button.

*& Managing screenshots in the analyzer software (447)

About archiving of messages Archiving includes the confirmed messages that are
older than the number of days configured for archiving.
The compressed archive file contains a CSV file of the
archived messages (Messages.csv).

After archiving is completed successfully, the archived
messages are deleted from the analyzer.

1
<}
N
=
@«
S
«
o
—
wd
(=7}
o
-
=
=)
-—
N
L
=2
=
=)
1S
[
(=
N

*@ Archiving (557)

Roche Diagnostics
Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1




Troubleshooting the analyzer

Displaying and confirming messages in the analyzer
software

You must confirm some messages.

You can either confirm each message separately or all
displayed messages at once.

When there are messages that need confirmation

» To display and confirm messages in
the analyzer software

1 In the global information area of the analyzer
software, choose the message indicator.

= The messages panel is displayed.

2 Optionally, you can do the following:
= Configure the columns of the messages table.
= Sort and/or filter the messages table.
= Export the table entries to Excel.

3 To display the details of a message, choose the
message.

- The message details are displayed on the right in
the detail panel.

4 To confirm a message, choose the message. On the
detail panel, choose the Confirm button.

- The confirmation is logged with user information
and time stamp.

5 To confirm all unconfirmed messages that are
currently displayed in the table, choose the Confirm
displayed messages button.

® Unconfirmed messages that are currently not
displayed (e.g., because the table is filtered) are
not confirmed.

- The confirmation is logged with user information
and time stamp.

6 To hide the messages panel, choose the message
indicator again.
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Problem reports on the analyzer

Problem reports on the analyzer

On the Problem report panel, you export basic problem
reports, create custom problem reports, and/or create
logs reports.

You can access the Problem report panel with any user
role.

In this section

About problem reports (512)
Exporting a basic problem report (514)
Creating a custom problem report (515)

Creating a logs report (516)

About problem reports

Problem reports contain relevant data required by Roche
for troubleshooting purposes.

If you encounter a problem with the analyzer and contact
your Roche Service representative, you may be asked to
provide a problem report.

Roche reviews your problem reports upon your request
only.

There are the following types of problem reports:
= Basic problem report
= Custom problem reports:

- Advanced problem report
- Extended problem report
- Complete problem report
= Logs reports:
- For today
- For the last 7 days (counted including today)
- For the last 30 days (counted including today)

- Forall
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Troubleshooting the analyzer

Basic and custom problem reports always belong to a
specific run and contain system and run information
from the time the run finished.

Logs reports are problem reports that cover a specified
time period and contain system and run information from
that period.

About basic problem reports The analyzer automatically creates a basic problem
report each time a run is finished:

= Run completed without errors (including the manual
run abort by the user)

= Run aborted after error or alarm

The basic problem reports are stored on the analyzer.
You can export basic problem reports to a network share
or external storage device.

About custom problem reports You can manually create custom problem reports from a
basic problem report, i.e., for the same run. The custom
problem reports (advanced, extended, complete) differ in
the extent of data that is included.

-Q— A complete problem report contains the images
from the corresponding run. As the analyzer
stores only the images of the last 5 runs, you
cannot create custom problem reports for older
runs.

You can only save custom problem reports in a network
share or on an external storage device. You cannot save
a custom problem report on the analyzer.

-‘Q’- Depending on the type of custom problem report,
creating a problem report may take a long time
and result in a large file.

About logs reports You can manually create logs reports for a specified time
period.

You can only save logs reports in a network share or on
an external storage device. You cannot save a logs report
on the analyzer.

About problem report files A problem report is saved as a single, compressed 7z file.

1
<
N
=
«
o
y+]
o
—
wd
(=7]
o
I;
=)
=)
-—
n
L
=2
-
(=)
| &
-
(=]
N

The files are password-protected. Problem reports can be
accessed by Roche only.
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Problem reports on the analyzer

By default, the files of basic and custom problem reports
are named:
PR_SN_RunName_TypeOfReport.7z.

You cannot change the name of a basic problem report.

By default, an advanced, extended, or complete problem
report has the same name (except the problem report
type) as the basic problem report it is created from. You
can change the name when creating the custom problem
report.

The files of logs reports are named:
PR_SN_Logs_YYYYMMDD_YYYYMMDD.7z
with the start and end date of the included time period.

You can change the name when creating the logs report.

Names of custom problem reports and logs report must
not contain the following characters:
2*<>/\:"|”

*@ List of naming placeholders (154)

Exporting a basic problem report
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On the Problem report panel, you export basic problem
reports that were created automatically by the analyzer.

O Optionally, external storage device, e.g., USB flash
drive

O Enough memory in the network share or on the
external storage device

» To export a basic problem report

1 Optionally, to export to an external storage device,
connect the external storage device to the analyzer.

2 In the analyzer software, choose Administration >
Problem report.

- The Problem report panel is displayed.

3 Optionally, sort, search, or filter the table.

Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1



Troubleshooting the analyzer

4 From the table, choose a problem report.

5 Choose the Export button.
- The Select folder dialog box is displayed.

6 In the folder browser, navigate to a folder.

7 Choose the Confirm button.
- A progress indicator is displayed.

8 Wait until the export of the problem report is finished.

@ If you cancel the export, all files that are already
exported to the folder are deleted again.

= The basic problem report is exported as a 7z file to
the folder.

9 Optionally, disconnect the external storage device.

Creating a custom problem report

On the Problem report panel, to create problem reports
that include additional data, you create custom problem
reports from basic problem reports.

20- Depending on the information and files stored on
the analyzer, not all types of custom problem
reports may be available.

@ Depending on the type of problem report (advanced,
extended, complete) and the amount of data, creating a
custom problem report may take a long time.

@ O Optionally, external storage device, e.g., USB flash
drive
%: O Enough memory in the network share or on the

external storage device

» To create a custom problem report

1 Optionally, to save to an external storage device,
connect the external storage device to the analyzer.

2 In the analyzer software, choose Administration >
Problem report.

- The Problem report panel is displayed.

3 Optionally, sort, search, or filter the table.
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Problem reports on the analyzer

Creating a logs report

Roche Diagnostics

4 From the table, choose a problem report.

5 Choose the Create custom report button.

- The Create custom report combo box is
displayed.

6 Optionally, change the name for the problem report.

©® The name must not contain the following
characters:
X< >/\:" |’

7 Choose the type of the custom problem report:
= Advanced
* Extended
= Complete
- The estimated file size of the problem report is
displayed in the combo box.
8 To change the export path, choose the -+ button.
= The Select folder dialog box is displayed.

9 In the folder browser, navigate to a folder.
10 Choose the Confirm button.

11 In the Create custom report combo box, choose the
Export button.
= A progress indicator is displayed.

12 Wait until the creation of the problem report is
finished.

@ If you cancel the creation, all files that are already
saved in the folder are deleted again.

= The custom problem report is saved as a 7z file in
the folder.

13 Optionally, disconnect the external storage device.

On the Problem report panel, to create problem reports
that contain data from a specified time period (and not
from a specific run), you create logs reports.

O Optionally, external storage device, e.g., USB flash
drive

Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1



Troubleshooting the analyzer

&

O Enough memory in the network share or on the
external storage device

» To create a logs report

1 Optionally, to save to an external storage device,
connect the external storage device to the analyzer.

2 In the analyzer software, choose Administration >
Problem report.
= The Problem report panel is displayed.

T ; _ 3 Choose the Create logs report button.
. T — - The Create logs report combo box is displayed.

4 Optionally, change the name for the logs report.

©® The name must not contain the following
characters:
X< >/\:"|”’

5 Choose for which time period the logs shall be
included:

= Today
= Last 7 days (counted including today)
= Last 30 days (counted including today)
= Al
- The estimated file size of the logs report is
displayed in the combo box.
6 To change the export path, choose the -+ button.
- The Select folder dialog box is displayed.

7 In the folder browser, navigate to a folder.
8 Choose the Confirm button.

9 In the Create logs report combo box, choose the
Export button.
= A progress indicator is displayed.

10 Wait until the creation of the problem report is
finished.

@ If you cancel the creation, all files that are already
saved in the folder are deleted again.

= The custom problem report is saved as a 7z file in
the folder.

11 Optionally, disconnect the external storage device.

Roche Diagnostics
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Initializing a paused analyzer

Initializing a paused analyzer

If the analyzer is paused, you must initialize the analyzer
before you can continue working.

L2 .
-0O- Whenever an alarm callout or error callout is
displayed, take a screenshot of the callout.

Initialize button displayed in the global information
area

O Analyzer in Analyzer paused status

» To initialize a paused analyzer

1 In the global information area, choose the Initialize
button.

- The analyzer is initialized.

2 If the error persists, contact your Roche Service
representative.
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Troubleshooting the analyzer

Restarting an unresponsive analyzer

If the analyzer and/or the analyzer software are
unresponsive, you must restart the analyzer.

Always confirm that the analyzer and/or the analyzer

software are unresponsive before you restart the

analyzer:

= Ensure the analyzer is not busy and therefore not
responding.

= If a message is displayed, follow the message
instructions.

= Try to shut down the analyzer following the normal
shutdown procedure.

*& Messages in the analyzer software (509)

»& Shutting down the analyzer (440)

-‘Q’- Only follow the procedure below if the analyzer
and/or the analyzer software are unresponsive.

&

O Analyzer and/or analyzer software unresponsive

» To restart an unresponsive analyzer

1 If an external storage device is connected to the
analyzer, disconnect it.

2 At the right side of the analyzer, press the power
button.

3 Wait a few seconds.

4 Start up the analyzer as described in Starting up the
analyzer (235) and follow the instructions on the
screen.

5 |If the analyzer does not start up or if the error
persists, contact your Roche Service representative.

Roche Diagnostics
Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1

1
<
N
=
«
o
y+]
o
—
wd
(=7]
o
I;
=)
=)
-—
n
L
=2
-
(=)
| &
-
(=]
N




Nanowell plate loading errors on the analyzer

Nanowell plate loading errors on the

analyzer

On the Plates panel in the analyzer software, the
statuses of the loaded nanowell plates indicate if there is
a nanowell plate loading error.

Before you can start the run on the analyzer, you must
resolve all nanowell plate loading errors so that all
loaded nanowell plates are in Valid status.

For development runs only, you can always resolve
nanowell plate loading errors by unloading the affected
nanowell plates from the analyzer.

*& About the nanowell plate status (114)

*& About run prerequisites (172)

In this section

Table of nanowell plate loading errors (520)

Resolving a nanowell plate ID reading error (521)

Table of nanowell plate loading errors

Status on Plates panel Cause

The following table lists the possible statuses of loaded
nanowell plates on the Plates panel in the analyzer
software, the causes, and possible actions.

Actions

Barcode scan failed The nanowell plate ID could not be read. Perform a procedure to resolve the nanowell

plate ID reading error.

*él Resolving a nanowell plate ID reading error
(521)

g Statuses of loaded nanowell plates
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Troubleshooting the analyzer

Status on Plates panel Cause Actions

Invalid barcode The nanowell plate ID does not meet the Unload the nanowell plate.

barcode criteria defined on the system. .
For a development run, either start the run

without the affected nanowell plate or replace it
with a freshly pipetted and partitioned nanowell
plate.

For a diagnostic run, invalidate the nanowell
plate in the web application. Then, start the run
without the invalidated nanowell plate.

»@ Invalidating nanowell plate lanes and/or
nanowell plates in the web application
(535)

Duplicate barcode While resolving a nanowell plate ID reading Correct the manually entered nanowell plate ID.
error, you entered the nanowell plate ID of
another loaded nanowell plate (both
affected nanowell plates are indicated). (521)

*él Resolving a nanowell plate ID reading error

Expired The nanowell plate is expired. Unload the nanowell plate.

For a development run, either start the run
without the affected nanowell plate or replace it
with a freshly pipetted and partitioned nanowell
plate.

For a diagnostic run, invalidate the nanowell
plate in the web application. Then, start the run
without the invalidated nanowell plate.

Results already exist The nanowell plate was already processed Unload the nanowell plate.
in a previous run.

Not partitioned The nanowell plate is not yet partitioned. Unload the nanowell plate. Partition it on a
partitioning engine that is assigned to this
analyzer. Reload the nanowell plate.

The nanowell plate was partitioned on a Unload the nanowell plate. Run it on the
partitioning engine that is not assigned to  analyzer the partitioning engine is assigned to.
this analyzer.

The assigned analyzer did not receive the ~ Unload the nanowell plate.
partitioning data, e.g., because the
connection failed. The partitioning data is
lost.

For a development run, either start the run
without the affected nanowell plate or replace it
with a freshly pipetted and partitioned nanowell
plate.

For a diagnostic run, invalidate the nanowell
plate in the web application. Then, start the run
without the invalidated nanowell plate.

g Statuses of loaded nanowell plates

Resolving a nanowell plate ID reading error

If the analyzer cannot read a nanowell plate ID, you must
scan or enter the nanowell plate ID manually.

In this case only, the Manual entry button on the Plates
panel is available.
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Nanowell plate loading errors on the analyzer

/ CAUTION!

Incorrect manual entering of nanowell plate ID

Incorrect manual entering of a nanowell plate ID may
cause incorrect results due to incorrect assignment
between order and result.

» If you scan or enter a nanowell plate ID manually,
ensure that you scan or enter the nanowell plate ID
correctly.

» If you must open the nanowell plate stack drawer and
remove the nanowell plates, ensure that you keep the
order of the nanowell plates in the stack to facilitate
identification of the affected nanowell plate.

The procedure to resolve a nanowell plate ID reading

error depends on the availability of the nanowell plate ID

in a sample setup report or other planning of the run:

= If you have the nanowell plate ID available
independently from the nanowell plate itself, you can
leave the nanowell plate stack drawer closed.

= If you need to refer to the nanowell plate itself for the
nanowell plate ID, you must open the nanowell plate
stack drawer and unload the nanowell plates.

About multiple nanowell plate ID reading
errors

-Q- You can only resolve 1 nanowell plate ID reading
error. If there is more than 1 nanowell plate ID
reading error, the Manual entry button on the
Plates panel is not available.

If there are multiple nanowell plate ID reading
errors, you must unload and discard the affected
nanowell plates except 1.

About unresolved nanowell plate ID reading If you cannot resolve a nanowell plate ID reading error,
errors you must do the following:

= For development runs, unload the affected nanowell
plates from the analyzer. Then, either start the
development run without the affected nanowell plates
or replace them with freshly pipetted and partitioned
nanowell plates.

= For diagnostic runs, unload the affected nanowell
plates from the analyzer. In the web application,
invalidate the nanowell plates in the sample setup.
Then, start the diagnostic run without the invalidated
nanowell plates.
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*@ Invalidating nanowell plate lanes and/or nanowell
plates in the web application (535)
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Troubleshooting the analyzer

o— O Nanowell plate status: Barcode scan failed

» To resolve a nanowell plate ID
reading error with nanowell plate 1D
available (without opening of the
nanowell plate stack drawer)

1 Ensure that there are nanowell plate ID reading
€errors:

= To open the nanowell plate stack drawer, choose
the Open drawer button.

= Check the placement of the nanowell plates in the
nanowell plate stack drawer.

= To close the nanowell plate stack drawer, choose
the Close drawer button.

= The analyzer reads the nanowell plate IDs again.
= The Plates panel is refreshed.

= If the nanowell plate ID reading errors persist,
continue with the following steps.

2 Optionally, if there is more than 1 nanowell plate ID
reading error, do the following:

= To open the nanowell plate stack drawer, choose
the Open drawer button.

= Unload the affected nanowell plates except 1.

= Discard the unloaded nanowell plates according
to local regulations. For a diagnostic run,
invalidate the unloaded nanowell plates in the
sample setup in the web application.

= To close the nanowell plate stack drawer, choose
the Close drawer button.

- The analyzer reads the nanowell plate IDs again.

The Plates panel is refreshed.

\

= If a single nanowell plate ID reading error persists,
the Manual entry button is available. Continue
with the following steps.

3 Compare the information on the Plates panel with
your sample setup report or other planning. Identify
the affected nanowell plate and determine its
nanowell plate ID.

4 On the Plates panel, choose the Manual entry
button.

5 In the table of nanowell plates, choose the field for
the nanowell plate ID of the affected nanowell plate.

- The numeric keyboard is displayed.
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Nanowell plate loading errors on the analyzer

6 CAUTION! Risk of incorrect, invalid, or delayed
results.
Ensure that you enter the correct nanowell plate ID.

On the numeric keyboard, enter the nanowell plate
ID.

7 Choose the Enter button.

8 On the Plates panel, choose the Accept changes
button.
= The nanowell plate status is updated.
= The nanowell plate ID reading error is resolved.

» To resolve a nanowell plate ID

- i withou w
reading error without nanowell plate
ﬁ ID available (with opening of the
%" nanowell plate stack drawer)
c 1 Ensure that there are nanowell plate ID reading
1] errors:
[<b) = To open the nanowell plate stack drawer, choose
"E the Open drawer button.
()] = Check the placement of the nanowell plates in the
_E nanowell plate stack drawer.
"5 = To close the nanowell plate stack drawer, choose
(=) the Close drawer button.
-‘% - The analyzer reads the nanowell plate IDs again.
(<} = The Plates panel is refreshed.
E = If the nanowell plate ID reading errors persist,
- continue with the following steps.
(=}
ot
[
o
N
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Troubleshooting the analyzer

Optionally, if there is more than 1 nanowell plate ID

reading error, do the following:

= To open the nanowell plate stack drawer, choose
the Open drawer button.

= Unload the affected nanowell plates except 1.

= Discard the unloaded nanowell plates according
to local regulations. For a diagnostic run,
invalidate the unloaded nanowell plates in the
sample setup in the web application.

= To close the nanowell plate stack drawer, choose
the Close drawer button.

= The analyzer reads the nanowell plate IDs again.

¥

The Plates panel is refreshed.

- If a single nanowell plate ID reading error persists,
the Manual entry button is available. Continue
with the following steps.

On the Plates panel, identify the affected nanowell
plate and take note of its position in the stack.

To open the nanowell plate stack drawer, choose the
Open drawer button.

Remove the nanowell plate stack from the nanowell
plate stack drawer.

O Ensure that you keep the order of the nanowell
plates in the stack.

Identify the affected nanowell plate in the stack and
determine its nanowell plate ID.

©® You can only use the nanowell plate if the
barcode and/or the nanowell plate ID on the label
are readable.

On the Plates panel, choose the Manual entry
button.

In the table of nanowell plates, choose the field for
the nanowell plate ID of the affected nanowell plate.

- The numeric keyboard is displayed.
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Nanowell plate loading errors on the analyzer

9 CAUTION! Risk of incorrect, invalid, or delayed
results.
Ensure that you enter the correct nanowell plate ID.

Scan or enter the nanowell plate ID of the affected
nanowell plate.

10 On the numeric keyboard, choose the Enter button.

11 Reload the nanowell plate stack in the nanowell plate
stack drawer.

12 To close the nanowell plate stack drawer, choose the
Close drawer button.
= The nanowell plate status is updated.
= The nanowell plate ID reading error is resolved.
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Troubleshooting the analyzer

Resolving an alarm of the analyzer

=
_‘ Alarm
Message code 048.001.00058
Message title Nanowell plate handler, arm: Submodule fatal occured
Category Analyzer
Severity Alarm
Message detail ‘Submodule fatal occured. Restart the analyzer. If the error persists, contact your Roche
Service representative.
Number of occurences 1

Roche Diagnostics
Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1

If an alarm occurrs on the analyzer, you cannot work with
the analyzer until the issue is resolved.

“0O- Whenever an alarm callout or error callout is
displayed, take a screenshot of the callout.

O Alarm callout displayed with Category = Analyzer,
Severity = Alarm, Ignore button, and Initialize
button

O Analyzer in Error status

» To resolve an alarm of the analyzer

1 To take a screenshot of the alarm callout, choose the
button.

2 |If you can deduce from the message details that a
restart of the analyzer cannot resolve the issue, e.g.,
because of a blown fuse, continue directly with step
7.

3 Choose the Initialize button.

= The callout is closed, the corresponding message
is confirmed, and the analyzer is restarted.

4 Shut down the analyzer as described in Shutting
down the analyzer (440).

5 On the right side of the analyzer, press the power
switch.

6 To start up the analyzer again, on the right side of the
analyzer, press the power switch again.

7 If the error persists or if you can deduce from the
message details that a restart of the analyzer cannot
resolve the issue, do the following:

= Choose the Ignore button.
= Contact your Roche Service representative.

527
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Resolving an alarm of the analyzer software

Resolving an alarm of the analyzer

software

If an alarm occurs in the analyzer software, you cannot
work with the analyzer until the issue is resolved.

I, .
- Whenever an alarm callout or error callout is

displayed, take a screenshot of the callout.
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Alarm callout displayed with Category = Software,
Severity = Alarm, and Shut down button.

To resolve an alarm of the analyzer
software

To take a screenshot of the alarm callout, choose the
@ button.

Choose the Shut down button.

= The alarm callout is closed, the corresponding
message is confirmed, and the analyzer software
is shut down.

Wait until shutdown is complete and the touch screen
turns dark.

Start up the analyzer as described in Starting up the
analyzer (235).

If the error persists, contact your Roche Service
representative.
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Troubleshooting in the development software

Locating the log files in the development
software

The log files contain relevant data required by Roche for
troubleshooting purposes.

If you encounter a problem with the development
software and contact your Roche Service representative,

you may be asked to provide the log files.

Roche reviews the log files upon your request only.

= O Optionally, external storage device, e.g., USB flash
drive
'z: O Enough memory

» To locate the log files

1 In the development software, in the Navigation area,
choose File > i > Help > Logs.

- A Windows Explorer is displayed at the location of
the log files.

2 From the Windows Explorer, copy the log files.
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Locating the log files in the development software
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Troubleshooting in the web application

Invalidating nanowell plate lanes and/or
nanowell plates in the web application

If nanowell plate lanes and/or nanowell plates of a
diagnostic sample setup are compromised, invalidate the
nanowell plate lanes and/or the nanowell plates in the
web application before you start the diagnostic run.

Examples for compromising events include:

= Pipetting errors

= Skipped partitioning of nanowell plate lanes that
contain reaction mixtures (partitioning indicator
remains gray)

= Dropped nanowell plates

If you invalidate nanowell plate lanes and/or nanowell

plates in the web application, the following applies:

= The system invalidates all results from invalidated
nanowell plate lanes.

= If you invalidate a nanowell plate lane that contains a
control, all orders of the sample setup for that test get
an invalid result.

= If you invalidate a nanowell plate, all nanowell plate
lanes of that nanowell plate are invalidated.

= If you invalidate all nanowell plate lanes of a nanowell
plate, the whole nanowell plate is invalidated.

= You must discard invalidated nanowell plates. You
cannot process invalid nanowell plates on the
analyzer.

Invalidating the compromised nanowell plate lanes and/
or nanowell plates allows you to invalidate the
subsequent results without discarding the whole sample
setup and the already partitioned nanowell plates.

You cannot exchange an invalid nanowell plate in a
diagnostic workflow.
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Invalidating nanowell plate lanes and/or nanowell plates in the web application

/ CAUTION!

Missing measurements or invalidated controls

Invalidating a nanowell plate lane that is required for
result calculation or contains a control may cause invalid
or delayed results.

» Take extra care to avoid wrongly invalidating a
nanowell plate lane that is required for result
calculation or that contains a control.

» If you must invalidate a nanowell plate lane, consider
the implications for result calculation and for the final
results.

El O Sample setup in the web application

&

O Diagnostic operator user role

» To invalidate a nanowell plate lane in
the web application

1 In the web application, in the Sample setups column
on the dashboard, choose a batch tile.

= The Sample setup screen is displayed.

2 To invalidate a nanowell plate lane, choose the tile
twice.

@ You can also choose several tiles at once.

- The Sample settings: combo box is displayed.

3 Select the Invalid lane check box.

4 Choose the Confirm button.
- On the Sample setup screen, the tile is grayed
out.
5 Choose the Confirm button.

= All results from invalidated nanowell plate lanes
are invalid.

- If the invalid nanowell plate lane contains a
control, all orders of the sample setup for that test
get an invalid result.
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Troubleshooting in the web application

To invalidate a nanowell plate in the
web application

In the web application, in the Sample setups column
on the dashboard, choose a batch tile.

- The Sample setup screen is displayed.

To invalidate a nanowell plate, choose the column
header twice.

= The Plate: combo box is displayed.

Select the Invalid plate check box.

Choose the Confirm button.

- On the Sample setup screen, the nanowell plate
is grayed out.

Choose the Confirm button.

= The nanowell plate is invalid. You cannot process
the nanowell plate on the analyzer.

= All results from invalidated nanowell plates are
invalid.
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Sending results again in the web application

Sending results again in the web

application

About failed sending of results
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In the web application, you can send again results of
completed batches that are already in Sent status.

You cannot send again results of completed batches that
are still in Send queued status or that were generated
with an analysis package in In validation status.

If automatic sending of results is configured but sending
of a result fails (e.g., because of a lost connection), the
system retries 3 times to send to result. If sending still
fails, the status of the result changes to Sent and you
must send again the result manually.

O Completed batch with results in Sent status available
in the web application

O Diagnostic approver user role

» To send results again in the web
application

1 In the web application, in the Results column on the
dashboard, choose the Completed batches tile.
= The Completed batches screen is displayed.

2 From the table, select the batch that has results that
you want to send again. Choose the View button.

- The Results of screen is displayed.

3 Navigate to the results in Sent status that you want
to send again:

= From the drop-down list, choose the analysis
package.

= Choose the Samples tab.
= Alternatively, use the search function.

O Results in Sent status are marked with the &=
icon in the Status column.

4 Select 1 or several results in Sent status.

©® You can send again several results at the same
time.
If you choose results in a different status, the
Send again button is unavailable.

5 To send the results again, choose the Send again
button.

- The Confirmation dialog box is displayed.
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Troubleshooting in the web application

6 Enter your password and choose the Send again

button.

=> The result status changes to Send queued or
Sent, respectively, marked with an == icon or an
== icon in the Status column (depending on LIS
connection status).

=> Your user name replaces the previous entry in the
Send by column.
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Sending results again in the web application
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User management in the analyzer software

User management

On the User management panel, you manage user
accounts.

The User management panel consists of the following
elements:

= Table of users
= Detail panel displaying the user settings

\ To access the User management panel, you need
administrator user role.

A Table B Detail panel

In this section

About user management (545)
List of user settings (547)
Managing users (549)

About user management

User management is performed in the analyzer software.
The users are then synchronized to the web application.

There is no user management for the partitioning engine
software and the development software. You do not need
to log on to the partitioning engine or the development
software.

About user roles The user roles define the actions that users of that user
role can perform in the analyzer software and the web
application.

The following user roles are predefined in the system:

User roles Permitted actions in the analyzer Permitted actions in the web application
software
Administrator = All tasks on the Administration = No access
panel

FB Predefined user roles
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User management

User roles Permitted actions in the analyzer Permitted actions in the web application
software

Diagnostic approver = Change own password = View orders, sample setups, run
= Manage problem reports information, and results
» Manage screenshots * Send results

= Export raw data files

Diagnostic operator = Perform diagnostic runs = Add, edit, and import orders
= Change own password = Create, edit, and delete sample
= Manage problem reports setups
= Manage screenshots = Create sample setup reports

= Enter run information
= Enter result notes

= Release results

= Create result reports

= Export raw data files

Development operator = Perform development runs = No access
= Manage run profiles
= Manage raw data files (batches)
= (Change own password
= Manage problem reports

= Manage screenshots

gm Predefined user roles
You cannot create, edit, or delete user roles.

Each user must have at least 1 user role. If a user has
more than 1 user role, they can perform all tasks of the
separate user roles.

About users Each person using the system must have their own,
unique user account. Do not use shared user accounts.

A user is identified by the credentials that are used to log
on to the system, i.e., user name and password.

Users created in the analyzer software are automatically
synchronized to the web application. Use the same
credentials to log on to the web application.

You cannot delete users. To deny system access
temporarily, lock a user. To deny system access
permanently, retire a user.

A default user "Admin FN" with administrator user role is
predefined in the system.
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User management in the analyzer software

-Q- To ensure full system access in case of a lost
administrator password, create a second user
with administrator user role directly after
installation of the system.

About passwords Passwords must comply with the global password policy
configured in the analyzer software in Administration >
Password settings.

»& Password settings (599)

List of user settings

User management requires the configuration of the user
settings.

- Administration > User management

User name Field to enter the user name.

The user name is part of the credentials that users must
enter to log on to the analyzer software and the web
application.

After a user is created, you cannot change the user
name.

For user names, the following rules apply:
= Must be unique

= Not case-sensitive

= 3to 30 characters

Full name Field to enter the full name of the user.
The full name of the logged on user is displayed in the
global information area of the analyzer software and the

web application.

For full names, the following rule applies:
= 3to 50 characters

Password Field to enter the password.
The password is part of the credentials that users must
enter to log on to the analyzer software and the web

application.

For passwords, the following rules apply:
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User management

Administrator

Diagnostic operator

Diagnostic approver

Development operator

Locked:

Retired:

Roche Diagnostics

= (Case-sensitive
= 4 to 20 characters

Additionally, the password must conform to the global
password policy configured in Administration >
Password settings.

»& Password settings (599)

Check box to assign administrator user role.

Check box to assign diagnostic operator user role.

Check box to assign diagnostic approver user role.

Check box to assign development operator user role.

Check box to lock a user.

A locked user cannot log on to the analyzer or the web
application.

Lock a user manually to deny system access temporarily.
If a user tries to log on and reaches the maximum
number of failed logon attempts that is configured in the
global password policy (Administration > Password

settings), the user is locked automatically.

To unlock a user and to grant system access again, clear
the check box.

You cannot lock the default administrator account
"Admin FN".

Default value = unlocked

Check box to retire a user.

Retire a user to deny system access permanently, e.g.,
users that ceased working in the laboratory.

You can unretire a user. However, if you want to deny
system access only temporarily, lock and unlock such
users instead.

Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1



User management in the analyzer software

You cannot retire the default administrator account
"Admin FN".

Default value = not retired

Password never expires Check box to prevent the mandatory change of a user’s
password after the expiry period that is configured in the
global password policy (Administration > Password
settings).

You can only apply this setting to each user individually.
You cannot apply this option globally to all users.

Default value = disabled

Change password at next logon: Check box to force a user to change their password at
the next logon, e.g., for new users or after the
administrator changed a user’s password.

If this setting is enabled, the user must change their
password in the analyzer software or the web application,
depending on where they log on first. The new password

is then synchronized to the other software component.

After the user has changed their password, this setting is
disabled again.

Default value = enabled

Allow EDI access Check box to allow access to the analyzer via EDI
connection.

Default value = disabled

Managing users

On the User management panel, you create, edit, lock,
unlock, and retire users, and change their passwords.

You must create a separate user for each person using
the system.

Roche Diagnostics
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/ CAUTION!

Weak passwords

Weak passwords may allow unauthorized access to the
system, data manipulation or loss, or unauthorized
access to personal information, which may cause
incorrect, invalid, or delayed results.

» Use strong passwords.
» Do not share passwords.
» Do not write down passwords.

» Do not share user accounts.

You cannot delete users. To deny system access
temporarily, lock a user. To deny system access
permanently, retire a user.

-Q— To ensure full system access in case of a lost
administrator password, create a second user
with administrator user role directly after
installation of the system.

O Administrator user role

» To create a user

1 Choose Administration > User management.
- The User management panel is displayed.

2 Choose the Create button.
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3 In the Enter user details dialog box, enter the
required information:

* Full name
= User name
= Password

= Diagnostic operator and/or Development
operator

©® Ensure that you enter the correct user name. You
cannot change it later.
You must assign an operator user role in this step.
For administrator user role or diagnostic approver
user role, you must change the user role later in
the detail panel.

4 Choose the Confirm button.

- The user is created and added to the table on the
User management panel.

5 Optionally, in the detail panel, change the user role
and/or apply additional settings:
* Administrator, Diagnostic operator,
Diagnostic approver and/or Development

operator
= Locked
* Retired

= Password never expires

= Change password at next logon:

= Allow EDI access

@ If you lock or retire the user, the user cannot log
on to the system.

6 Choose the Save button.

» To edit a user

1 Choose Administration > User management.
- The User management panel is displayed.

2 Optionally, sort, search, or filter the table.

3 From the table, choose a user.

4 To change the full name, enter the new full name in
the Full name field.

@ You cannot change the user name.
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To assign or to remove a user role, select or clear the
corresponding check box:

* Administrator

= Diagnostic operator

= Diagnostic approver

= Development operator

To allow or deny system access, do one of the
following:

= To prevent a user temporarily from logging on,
select the Locked: check box.

= To allow a user to log on again, clear the Locked:
check box.

= To prevent a user permanently from logging on,
select the Retired: check box.

@ You must retire users that are not used anymore.
You cannot delete a user.
You cannot lock or retire the default administrator
user "Admin FN".

To change the individual password requirements of
the user, select or clear the corresponding check
boxes:

= Password never expires
= Change password at next logon:

To allow or deny the user the EDI access, select or
clear the Allow EDI access check box.

Choose the Save button.

To change a user’s password

Choose Administration > User management.
- The User management panel is displayed.

Optionally, sort, search, or filter the table.

From the table, choose a user.

Choose the Change password button.
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5 In the Change password dialog box, enter the new
password twice. Choose the Confirm button.

6 Choose the Save button.

» To lock or unlock a user

1 Choose Administration > User management.
- The User management panel is displayed.

2 Optionally, sort, search, or filter the table.

3 From the table, choose a user.

4 In the detail panel, do one of the following:
= To lock a user, select the Locked: check box.
= To unlock a user, clear the Locked: check box.

5 Choose the Save button.

= In the table on the User management panel, a
locked user is indicated by an (¥} icon in the
Locked column.

» To retire a user

1 Choose Administration > User management.
- The User management panel is displayed.

2 Optionally, sort, search, or filter the table.
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3 From the table, choose a user.

4 |In the detail panel, select the Retired: check box.

@ Itis possible to unretire a user. However, to
prevent a user temporarily from logging on, use
the Locked: check box instead.

5 Choose the Save button.

O By default, the table on the User management
panel lists the active users only. To display the
retired users, from the filter drop-down list,
choose the All option.

= In the table on the User management panel, a
retired user is indicated by an {7} icon in the
Retired column.
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Archiving

About archiving

Roche Diagnostics

Administration of the analyzer software

On the Archiving panel, you schedule automatic
archiving, perform manual archiving, and clean up not
allocated orders.

To access the Archiving panel, you need administrator

user role.

In this section

About archiving (557)
Scheduling automatic archiving (560)

Archiving allows you to store auditable data and to free

up disk space on the analyzer. Archive regularly to
maintain system performance.

-‘Q’— The database of the system is stored on the hard
disk of the analyzer. Therefore, archiving
comprises data from the analyzer, the web
application, and the partitioning engine.

All archived data is deleted from the analyzer when the
archiving completes successfully.

If archiving fails, the data remains on the analyzer.

You can only save archives in a network share or on an
external storage device. You cannot save an archive on
the analyzer.

For archiving, the analyzer must be in Analyzer ready

status. During archiving, the analyzer is in Archiving
status.

During archiving, you cannot do any of the following on

the analyzer and/or in the web application:
= Perform runs.
= Access data that is affected by archiving, e.g., view

results that are applicable for archiving.
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About automatic archiving

Archiving setting

Possible values

= Perform a function that accesses data that is affected
by archiving, e.g., create a result report for results that
are applicable for archiving.

Automatic archiving allows you to free up disk space on
the analyzer regularly without manual intervention.

Scheduling automatic archiving helps to prevent
unscheduled downtime of the system because of
insufficient disk space.

As archiving can take a long time, schedule automatic
archiving for a time when the system is not needed, e.g.,

during the night.

The following table lists the Archiving settings:

Default value

Repeat every (in days) 1-52 weeks 4 weeks
Day of the week *  Monday Monday

= Tuesday

= Wednesday

= Thursday

= Friday

= Saturday

= Sunday
Start time: Anytime 2 a.m.
Archive data older than (in days) 1-365 days 30 days
Export path = Network share n/a

= External storage device

#  Archiving settings

Roche Diagnostics

Automatic archiving is always enabled (and cannot be
disabled), but will always fail until a valid path to a folder
is configured.

When you save the archive settings, the date for the next
due archiving is calculated from the last time automatic
archiving was performed plus the configured repetition
period. The next due date is displayed on the Archiving
panel.
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About cleaning up not allocated orders
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Administration of the analyzer software

Archiving is displayed as overdue on the Archiving

panel if the next due date is in the past because one of

the following applies:

= The next due date that is calculated when saving the
archive settings is already in the past.

= A scheduled automatic archiving failed.
For example, automatic archiving fails if the analyzer
is shut down at the scheduled execution time, or if
the export folder is unavailable or has not enough
memory.

If archiving is overdue, a corresponding warning
message is displayed upon startup of the analyzer. The
system does not retry an overdue automatic archiving.

Performing manual archiving or a failed automatic
archiving does not change the next due date for the
automatic archiving. The date is not recalculated.

To resolve the overdue automatic archiving, you can

either wait until the next due archiving or you can
change the archive settings to schedule the next
automatic archiving earlier.

Manual archiving allows you to free up disk space on
demand.

If automatic archiving fails or a message is displayed that
disk space is low, perform manual archiving to prevent
unscheduled downtime of the system.

For manual archiving, the Archive data older than (in
days) setting of automatic archiving also applies. For
example, if you automatically archive data older than

30 days, a manual archiving also includes only data that
is older than 30 days.

*& Performing manual archiving (467)

Cleaning up not allocated orders allows you to delete
outdated orders from the system. The orders are deleted
from the Orders screen in the web application.

You must refresh the screen in the web application for
the deleted orders not to be displayed anymore.
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About archived data

About archive files

For cleaning up not allocated orders, the Archive data
older than (in days) setting of automatic archiving also
applies. For example, if you automatically archive data
older than 30 days, only not allocated orders that are
older than 30 days are deleted.

Clean up not allocated orders regularly. Clean up not
allocated orders before you perform manual archiving.

»& Cleaning up not allocated orders (466)

The following data is archived:

= Raw data files of diagnostic runs and development
runs (as dpcrRaw files)

= Result reports of diagnostic runs (as PDF files)

= Audit trails (as CSV files)

= Messages (as CSV files)

If all completed batches are archived that are stored on
the system, the {count} completed batches tile is no
longer displayed on the dashboard of the web
application.

Archiving creates several separate files for the different
archived data sets. The files are then compressed and
saved as a single archive file (7z file).

To access the archived data again, decompress the
archive file. The raw data files of the runs can be opened
in the development software.

The archive files are named:
ARCH _YYYY-MM-DD_hh_mm_ss.7z

with the date and time the archive file was created.

*@ List of naming placeholders (154)

Scheduling automatic archiving

Roche Diagnostics

To free up disk space on the analyzer regularly without
manual intervention, schedule automatic archiving.
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/ CAUTION!

Unprotected archive files

Insecure transfer or storage of archive files may allow
for data manipulation, which may cause incorrect,
invalid, or delayed results, and/or unauthorized access
to personal information.

» Ensure that archive files are transferred securely, are
stored in a secure location, and are protected from
any unauthorized access and disaster.

» Ensure that any external storage devices (such as
USB flash drives) that contain archive files are
protected against unauthorized access.

If automatic archiving fails or disk space on the analyzer
is low, perform manual archiving.

*@ Performing manual archiving (467)

= O Optionally, external storage device, e.g., USB flash
drive
E: O Enough memory in the network share or on the

external storage device
O Administrator user role

» To schedule automatic archiving

1 Optionally, to configure archiving to an external
storage device, connect the external storage device to
the analyzer.

2 In the analyzer software, choose Administration >
Archiving.
- The Archiving panel is displayed.

3 Inthe Repeat every (in days) field, enter the
archiving frequency.

4 From the Day of the week drop-down list, choose a
day of the week.

5 To configure the start time, do one of the following:
= Manually enter a time in the Start time: field.
= Choose the (T} button and choose a time from the
drop-down list.

©® Schedule automatic archiving for a time when the
analyzer is not needed, e.g., during the night.

6 In the Archive data older than (in days) field, enter
a value.

©® The value also applies to the cleanup of not
allocated orders and to manual archiving.
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7 To configure the export path to the archive folder, do
the following:

= Choose the -+ button.
= In the folder browser, navigate to a folder.
= Choose the Confirm button.

8 In the Archiving panel, choose the Save button.

@ If you configured automatic archiving to an
external storage device, ensure that the external
storage device is connected at the scheduled
execution time. Automatic archiving fails if the
configured export path is unavailable.

- Automatic archiving is performed as scheduled.

= The Next archiving due at: field lists the next
scheduled archiving and the status of the
archiving.
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Audio settings

On the Audio settings panel, you configure if the
analyzer plays an acoustic signal at the end of a run and/
or when a message occurs.

To access the Audio settings panel, you need
administrator user role.

By default, both acoustic signals are enabled.

*& Messages in the analyzer software (509)

o— O Administrator user role

» To configure audio settings

1 In the analyzer software, choose Administration >
Audio settings.

= The Audio settings panel is displayed.

2 To enable the audio signals, select the End of run
check box and/or the System messages check box.

3 To disable the audio signals, clear the End of run
check box and/or the System messages check box.

4 To change the volume of the signals, move the
Volume slider.

@ The volume applies to any enabled audio setting.
If you move the Volume slider to the Off position,
you disable both audio signals.

5 Choose the Save button.
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Backup

About backups

About automatic backups

Roche Diagnostics

On the Backup panel, you schedule automatic backups
and perform manual backups.

To access the Backup panel, you need administrator
user role.

In this section

About backups (564)
Scheduling automatic backups (566)

A backup saves the current system status and allows you
to restore your system. Back up your system regularly to
minimize data loss. Contact your Roche Service
representative if a system restore becomes necessary.

-‘Q’— The database of the system is stored on the hard
disk of the analyzer. Therefore, backups comprise
data from the analyzer, the web application, and
the partitioning engine.

A backup does not change any data on the system.

You can only save a backup file in a network share or on
an external storage device. You cannot save a backup
file on the analyzer.

For a backup, the analyzer must be in Analyzer ready
status. During the backup, the analyzer is in Backup

status.

You cannot work on the system during a backup.

Automatic backups allow you to save the system status
regularly without manual intervention.

Scheduling automatic backups helps to prevent data
loss.
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As a backup can take a long time, schedule automatic
backups for a time when the system is not needed, e.g.,
during the night.

The following table lists the Backup settings:

Backup setting Possible values Default value
Enable automatic backup = Enabled Disabled
= Disabled
Repeat every (in days) 1-30 days 7 days
Start time: Anytime 2:00 a.m.
Export path = Network share n/a

= External storage device

g8 Backup settings

By default, automatic backups are disabled.

When you enable automatic backups and save the
backup settings, the date for the next due backup is
calculated from the current date plus the configured
repetition period. The next due date is displayed on the
Backup panel.

The automatic backup is displayed as overdue on the
Backup panel if the next due date is in the past because
one of the following applies:

= The next due date that is calculated when saving the
backup settings is already in the past.

[ ] = A scheduled automatic backup failed.
For example, an automatic backup fails if the analyzer
is shut down at the scheduled execution time, or if
the backup folder is unavailable or has not enough
memory.

If the backup is overdue, a corresponding warning
message is displayed upon startup of the analyzer. The
system does not retry an overdue automatic backup.

Performing a manual backup or a failed automatic
backup does not change the next due date for the
automatic backup. The date is not recalculated.

To resolve the overdue automatic backup, you can either
wait until the next due backup or you can change the
backup settings to schedule the next automatic backup
earlier.
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About manual backups

About backup content

About backup files

A manual backup allows you to save the system status
on demand.

If the automatic backup fails, perform a manual backup.

»& Performing a manual backup (469)

The following data is included in the backup file:
= Full database (e.g., orders and results)

= Analysis packages

= Analyzer-specific configurations

= Settings on the Administration panel (e.g., users and
connection settings)

= Analyzer metadata (e.g., serial number of the analyzer
and release configuration)

The following data is not part of the backup file:
= Raw data files

= Log files

= Audit trails

= Problem reports

= Screenshots

= Language packs and User Assistance packs

A backup file is saved as a single, compressed 7z file.
The backup files are named
BKP_YYYY-MM-DD_hh_mm_ss SN.7z

with the date and time the backup was created.

For data security, the backup files are password-
protected. Contact your Roche Service representative if a

system restore becomes necessary.

*@ List of naming placeholders (154)

Scheduling automatic backups

Roche Diagnostics

To save the system status regularly, schedule automatic
backups.
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/ CAUTION!

Unprotected backup files

Insecure transfer or storage of backup files may allow
for data manipulation, which may cause incorrect,
invalid, or delayed results, and/or unauthorized access
to personal information.

» Ensure that backup files are transferred securely, are
stored in a secure location, and are protected from
any unauthorized access and disaster.

» Ensure that any external storage devices (such as
USB flash drives) that contain backup files are
protected against unauthorized access.

If an automatic backup fails, perform a manual backup.

*& Performing a manual backup (469)

= O Optionally, external storage device, e.g., USB flash
drive
6: O Enough memory in the network share or on the

external storage device
O Administrator user role

» To schedule automatic backups

1 Optionally, to configure backups to an external
storage device, connect the external storage device to
the analyzer.

2 In the analyzer software, choose Administration >
Backup.

- The Backup panel is displayed.

3 Select the Enable automatic backup check box.

4 In the Repeat every (in days) field, enter the
backup frequency.

5 To configure the start time, do one of the following:
= Manually enter a time in the Start time: field.

= Choose the (T} button and choose a time from the
drop-down list.

6 To configure the export path to the backup folder, do
the following:
= Choose the =+ button.
= In the folder browser, navigate to a folder.
= Choose the Confirm button.

7 In the Backup panel, choose the Save button.
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@ If you configured automatic backups to an
external storage device, ensure that the external
storage device is connected at the scheduled
execution time. Automatic backups fail if the
configured export path is unavailable.

- Automatic backups are performed as scheduled.

= The Next backup due at: field lists the next
planned backup and the status of the backup.

)
1
@
S

=
)
»n
1 9
)
N

>
®
c
©
o

RS
wd

(-
)
c
)

=
®
1S
wd

2

=
£

=
=
<

N

Roche Diagnostics
Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1 Draft - Do Not Distribute




Connection settings

About connection indicators

List of connection settings

LIS group box

Sender

Communication protocol

Roche Diagnostics

Administration of the analyzer software

On the Connection settings panel, you connect the
system to an LIS and/or AVENIO Connect, enable access
via EDI, and/or enter the external IP address for NAT.

To access the Connection settings panel, you need
administrator user role.

When you connect the system to an LIS and/or to
AVENIO Connect, separate connection indicators are
added to the global information area of the analyzer
software.

»& About the connection indicators (109)

In this section

List of connection settings (569)

Configuring connection settings (572)

To configure a connection, you must enter the following
connection settings.

- Administration > Connection settings

For network-specific information, contact your local IT
administrator.

Field to enter the name that determines how your system
is displayed in the LIS.

For the sender name, the following rule applies:
= 1to 25 characters

Default value = "Digital LightCycler"

Drop-down list to choose the protocol for the
communication between the system and the LIS:

= HL7 (MLLP1)
= HL7 (MLLP2)
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IP address

Port

AVENIO Connect group box

Sender

Communication protocol

IP address

Port

Roche Diagnostics

= ASTM protocol

Default value = HL7 (MILLP2)

Field to enter the IP address of the LIS.

For the IP address, the following rule applies:
= Must conform to the format of IPv4 addresses.

Default value = 127.0.0.1

Field to enter the port of the LIS.

For the port, the following rule applies:
= Must be an integer number.

Default value = 55000

Name of the system that is displayed in AVENIO
Connect.

The Sender field is read-only. You cannot change the
default name "Digital LightCycler".

Drop-down list to choose the protocol for the
communication between the system and AVENIO
Connect:

= HL7 (MLLP1)
= HL7 (MLLP2)

Default value = HL7 (IMILLP2)

Field to enter the IP address of AVENIO Connect.

For the IP address, the following rule applies:
= Must conform to the format of IPv4 addresses.

Default value = 127.0.0.1

Field to enter the port of AVENIO Connect, e.g., 1788.

For the port, the following rule applies:
= Must be an integer number.

Default value = 1788
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Export path for raw data

EDI group box

Server name

Port

Allow the EDI to log off a user

Play sound if the EDI operates the drawer.

Administration of the analyzer software

Field to enter the export path for the raw data files of
AVENIO Connect runs.

To display the folder browser, choose the «+ button.

Field to enter the name of the EDI server.

For the server name, the following rules apply:
= 1to 25 characters

= Forbidden characters:
2*¥<>\/:"|

Default value = "EDI Server"

Field for the preconfigured port for the EDI server, i.e.,
50052.

The Port field is read-only. You cannot change the port.

Check box to allow an EDI user to log off a locally logged
on user.

Default value = enabled

Check box to enable a system sound if the nanowell
plate stack drawer of the analyzer is opened or closed

remotely.

Default value = enabled

External IP address or NAT address group box

IP address

Roche Diagnostics

If your network uses a router, configure NAT with
external IP address.

The external IP address is necessary to ensure that the
web application and the EDI can connect.

If you enter or change the external IP address, you must
restart the analyzer.

Field to enter the IP address for NAT as configured on
the network equipment.

For the IP address, the following rule applies:
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Must conform to the format of IPv4 addresses.

Configuring connection settings

On the Connection settings panel, you configure the
connections to an LIS and/or AVENIO Connect, enable
access via EDI, and/or enter the external IP address for
NAT.

For network-specific information, contact your local IT
administrator.

i you connect the system to both an LIS and to

AVENIO Connect, the IP addresses and ports
must be different.

&

Roche Diagnostics

Network-specific information (IP addresses, ports)

Administrator user role

To connect the system to an LIS

In the analyzer software, choose Administration >
Connection settings.

- The Connection settings panel is displayed.

To connect the system to an LIS, select the LIS check
box.

Optionally, in the Sender field, change the name for
your system.

©® The name determines how your system is
displayed in the LIS.

From the Communication protocol drop-down list,
choose the protocol.

@ For network-specific information, contact your
local IT administrator.

In the IP address field and in the Port field, enter the
required information.

@ If you connect the system to both an LIS and to
AVENIO Connect, the IP addresses and ports
must be different.

Choose the Save button.

- A connection indicator for the LIS connection is
added to the global information area of the
analyzer software.
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» To connect the system to AVENIO
Connect

1 In the analyzer software, choose Administration >
Connection settings.

- The Connection settings panel is displayed.

2 To connect the system to AVENIO Connect, select the
AVENIO Connect check box.

3 From the Communication protocol drop-down list,
choose the protocol.

@ For network-specific information, contact your
local IT administrator.

4 In the IP address field, and in the Port field, enter
the required information.

@ If you connect the system to both an LIS and to
AVENIO Connect, the IP addresses and ports
must be different.

5 To configure the export path for the raw data files,
choose the + button.

- The Select folder dialog box is displayed.
6 In the folder browser, navigate to a folder.
7 Choose the Confirm button.

8 Choose the Save button.

=> A connection indicator for the connection to
AVENIO Connect is added to the global
information area of the analyzer software.

» To enable system access via EDI

1 In the analyzer software, choose Administration >
Connection settings.

- The Connection settings panel is displayed.

2 To enable system access via EDI, select the EDI
check box.

3 Optionally, in the Server name field, change the
name.

4 Optionally, clear the Allow the EDI to log off a user
check box and/or the Play sound if the EDI

tration of the analyzer software

operates the drawer. check box. -g

5 Choose the Save button. 'E

» To configure NAT with external IP E
address

J

1 In the analyzer software, choose Administration > N

Connection settings.
= The Connection settings panel is displayed.
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Connection settings

Roche Diagnostics

®

To enter the external IP address, select the External
IP address or NAT address check box.

In the field, enter the IP address as configured on the
router.

Choose the Save button.

Restart the system.

To disconnect the system

In the analyzer software, choose Administration >
Connection settings.

- The Connection settings panel is displayed.

To disconnect the system from an LIS, clear the LIS
check box.

To disconnect the system from AVENIO Connect,
clear the AVENIO Connect check box.

To disable system access via EDI, clear the EDI check
box.

If a router is not used anymore, clear the External IP
address or NAT address check box.

Choose the Save button.

@ The network-specific information for LIS, AVENIO
Connect, and EDI is retained. If you reconnect the
system, you do not need to enter the information
again.

- The connection indicators for LIS and AVENIO
Connect are removed from the global information
area of the analyzer software.
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Laboratory information settings in the

analyzer software

Roche Diagnostics

On the Laboratory information panel, you configure
the name, address, and logo of your laboratory.

If configured, the laboratory information is included in all
reports generated in the analyzer software and the web
application.

For a logo file, the following restrictions apply:
= JPEG or PNG file

= File size: 10 MB or less

= Resolution: 1920 x 1080 pixels or less

The Laboratory name field is restricted in length from 1
to 50 characters.

To access the Laboratory information panel, you need
administrator user role.

O Optional:
Logo file (JPEG or PNG file) saved in network share or
on external storage device

O Administrator user role

» To configure laboratory information
settings in the analyzer software
1 Optionally, to import a logo file from an external

storage device, connect the external storage device to
the analyzer.

2 In the analyzer software, choose Administration >
Laboratory information.

- The Laboratory information panel is displayed.
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3 In the Laboratory name field, enter the name of your
laboratory.

4 To add a logo, choose the =+ button.
- The Select company logo dialog box is
displayed.
5 To choose the logo file, do the following:
= From the File type drop-down list, choose the file
type.
= In the folder browser, navigate to the folder of the
logo file.

= In the file browser, choose the logo file.

= Choose the Confirm button.
= A preview of the logo is displayed on the
Laboratory information panel.

6 In the Address line 1: field, Address line 2: field,
Address line 3: field, and Address line 4: field,
enter the address of your laboratory.

7 Choose the Save button.
- The laboratory information is included in reports.

8 Optionally, disconnect the external storage device.
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LIS mapping table

On the LIS mapping table panel, you edit LIS test
names.

The LIS mapping table lists each test of an analysis
package separately.

The LIS mapping table does not apply to development
workflows.

To access the LIS mapping table panel, you need
administrator user role.

About LIS test names To allow for correct communication between the system
and the LIS, the test names of all enabled analysis
packages must be mapped unambiguously to unique LIS
test names (1:1 relation).

The mapping ensures that the system can correctly
process the received LIS orders and report the
corresponding results.

The following rules apply:
= By default, the test name is used as the LIS test name.

= If you disable a version of an analysis package by
enabling another version, the system takes over the
LIS test names from the disabled version to the
enabled version.

= If enabling an analysis package results in conflicting
LIS test names with a different enabled analysis
package, you must immediately change the LIS test
names in the LIS mapping table.

= In the Status column of the LIS mapping table
panel, the conflicting LIS test names of both analysis
packages are marked with an error icon. To resolve
the conflict, it is sufficient to change the LIS test
names of 1 analysis package.

*& Managing analysis packages (586)
B

O Administrator user role

» To change a LIS test name

1 To display the LIS mapping table panel, do one of
the following:

= Choose Administration > LIS mapping table.

= Choose Administration > Manage analysis
packages > LIS mapping table.

Roche Diagnostics
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@ If enabling an analysis package results in
conflicting LIS test names, you must immediately
change the LIS test names from the Manage
analysis packages panel.

= The LIS mapping table panel is displayed.

- The table lists each test of an analysis package
and the mapped LIS test name.

2 Optionally, sort, search, or filter the table.

3 To display the tests with conflicting LIS test names
only, from the drop-down list, choose the Conflicts
option.

4 From the table, choose a test.

5 Do the following:

= |n the Edit LIS test name field, enter the new LIS
test name.

= Choose the Confirm button.

6 Choose the Close button.
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Manage analysis packages

On the Manage analysis packages panel, you manage
the analysis packages for diagnostic runs.

To access the Manage analysis packages panel, you
need administrator user role.

In this section

About analysis packages (579)
Managing analysis packages (586)

About analysis packages
Analysis packages provide all parameters necessary to
plan and to perform diagnostic runs and to generate
diagnostic results.
You use analysis packages in diagnostic workflows only.
You do not use analysis packages in development
workflows. For the run parameters of development runs,

you use run profiles only.

*& Run profiles in the analyzer software (298)

About the run parameters in analysis Analysis packages contain the following information and
packages parameters for diagnostic runs:
= General:

- Name of analysis package

- Version and creation date of analysis package
- lIssuer of analysis package

- Nanowell plate type

- Number of merged lanes

- Run profile

- Maximum time between partitioning and starting
the run

- Export settings for raw data files
- Report label
= Test-specific:

Roche Diagnostics
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About issuers of analysis packages

About analysis package files

About statuses of analysis packages

Roche Diagnostics

- Test names
- Targets and dyes

- Names and dilution factors of master mix
reagents

- Limits of detection, quantification, and/or validity
- Result names for final qualitative results

- Display of final quantitative results

- Control types, names, and valid ranges

- Analysis settings

- Clustering settings

Analysis packages can have the following issuers:

= For IVD workflows, the analysis packages are issued
by Roche. This is indicated by the Roche logo next to
the name of the analysis package.

= For LDT workflows, you create your own analysis
packages in the development software from the data
that was created and analyzed in development
workflows.

An analysis package file has a .dpcrAp file extension.

You can import analysis packages from a network share
or external storage device.

You can export analysis packages to a network share or
external storage device.

Analysis packages can be in the following statuses:
= Invalidation

= Enabled

= Disabled

After import into the analyzer software, an analysis
package is in In validation status. You can perform
diagnostic runs with such an analysis package, but the
results are complete immediately after the diagnostic run
finishes and cannot be released or sent to the LIS.

In the web application, analysis packages in In
validation status are marked with an ¢} icon.

To perform diagnostic runs with results that you can
release and send, you must enable the analysis package
before the run, i.e., the analysis package must be in
Enabled status.
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Before you can enable an analysis package in Disabled
status, you must revalidate it first to change its status to
In validation.

*@ To revalidate an analysis package (590)

About identification of analysis packages Each analysis package is uniquely identified by the
following identifiers:
= Name
= Version
= Name GUID
= Version GUID

The GUID information is derived from the name, version,
and issuer of the analysis package. This is to ensure that
the system can always differentiate between analysis
packages that have different issuers, even if the name
and the version are the same.

By default, only the name and the version are displayed
in the table on the Manage analysis packages panel
in the analyzer software (Administration > Manage
analysis packages). You can configure the table to
display the GUID columns as well.

»& Configuring table columns (142)

About importing analysis packages If you attempt to import an analysis package into the
analyzer software, all 4 identifiers (name, name GUID,
version, version GUID) are checked against the analysis
packages that already exist in the analyzer software.

The system behavior depends on the outcome of the
checks.

The following import logic is applied:
= The name does not match:
- The analysis package is new.

- The analysis package is imported.

= The name matches, but the name GUID differs
(regardless of version and version GUID):

- The analysis package has a different issuer and is
classified as being different.

- The analysis package is imported, but the name is
appended with a consecutive number.

= The name and name GUID match, but the version and
version GUID differ:

- The analysis package is a different version of an
existing analysis package.

Roche Diagnostics
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- The versions of the analysis package are
differentiated by the version and version GUID.

- The analysis package is imported.

= All 4 identifiers match:
- The analysis package already exists.

- The import is aborted.

- A corresponding warning message is displayed.

Importing analysis package into the analyzer software

Name, name GUID, version, and version GUID of imported analysis package are checked against existing analysis packages

Check System behavior

=N lysi k = Analysi kage i rted

Analysis package has unique Yes ew analysis package nalysis package importe
name (no matches)? ’ ’

*No
N hb Yes = Analysis package from different issuer = Analysis package imported

ames matc ) ut == | = Analysis package is different == | = Analysis package name appended with
name GUIDs differ?
number

*No
Names and name GUIDs Yes = Different version of analysis package = Version of analysis package imported
match? Versions and version == | (differentiated by version number) -
GUIDs differ?

*No

Yes = Same analysis package already exists = Import aborted
All 4 identifiers match? == | On system === | = \Warning message displayed
Checks and outcomes for importing an analysis package
About enabling a version of an analysis There can be several versions of the same analysis
package package in the analyzer software, but only 1 version can

be in Enabled status. All other versions must be in In
validation status or Disabled status.

If there is a version of an analysis package in Enabled
status and another version of the same analysis package
in In validation status, the tests from the enabled
analysis package are always assigned to LIS orders.

If you attempt to enable a version (e.g., the new version),
the system automatically checks the other versions (e.g.,
the old versions) for the following:

= Their status in the analyzer software.
= |f they are assigned to orders in the web application.
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The system behavior depends on the outcome of the
checks.

If all old versions are in In validation status or Disabled
status, the new version is enabled directly.

= If an old version in In validation status is assigned to
orders in the web application, these orders remain
unchanged. They are not updated to the new,
enabled version of the analysis package.

= Analysis packages in Disabled status cannot be
assigned to orders.

If an old version is in Enabled status, the system
automatically attempts to disable the old version before
enabling the new version (because only 1 version can be
in Enabled status):

= If the old version is not assigned to orders, the
versions are enabled and disabled as attempted.

= If a test of the old version is assigned to orders but
the new version lacks this test, the following applies:

- The versions are neither enabled nor disabled.

- The process is aborted and a corresponding
warning message is displayed.

- This also applies if a test is renamed in an
analysis package. The system considers a
renamed test as different, not as updated.

= If the old version is assigned to orders and the new
version has all tests, you are asked if you want to
delete the sample setups and/or update the orders:

- If confirmed, the sample setups are deleted and
the orders (including LIS orders) are updated to
the new version.

Any already partitioned nanowell plates cannot
be reused but must be discarded.

The versions are enabled and disabled as
attempted.

- If declined, the orders remain unchanged.
The versions are neither enabled nor disabled.
The process is aborted and a corresponding
warning message is displayed.
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Enabling new version of analysis package in the analyzer software

Status of old version and assignment to orders are checked

Check

Old version in Enabled

status?
*Yes

0ld version assigned to

orders?
*Yes

New version has all tests that
are assigned to orders?

*Yes

User wants to update orders?

*Yes

Orders allocated to sample
setup?

A A A A A

Yes

Consequences for versions of Consequences for orders

analysis package

No

No

= New version enabled = No change
= No change for old version === | = Old version in In validation status
remains assigned to orders

= New version enabled = No change

= Old version disabled >

= Enabling of new version aborted = No change

= No change for old and new version === | = Old version remains assigned to orders

= Warning message displayed

= Enabling of new version aborted = No change
= No change for old and new version === | * Old version remains assigned to orders
= Warning message displayed

= New version enabled = Orders updated to new version
= 0ld version disabled i
= New version enabled = Orders updated to new version
= 0ld version disabled > = Sample setups deleted
= Partitioned nanowell plates must be
disposed of

Checks and outcomes for enabling a new version of an analysis package

Roche Diagnostics

To enable the new version of the analysis package

without updating the orders, the old version must not be

assigned to orders. To achieve this, do one of the

following:

= Perform the diagnostic runs to finalize the orders for
the old version of the analysis package.

= Delete the orders in the web application for the old
version of the analysis package:

1) For orders that are already allocated, delete the
sample setups. The orders are then not allocated
again.

Dispose of any already partitioned nanowell
plates according to local regulations.

2) For all orders that are not allocated, deassign all
tests and analysis packages.
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2O You cannot delete LIS orders. If you do not want
to update the LIS orders, you must perform the
diagnostic runs.

Orders that are already processed, i.e., results in the web
application, are not updated to the new version of the
analysis package. However, the status of the analysis
package they were processed with is displayed as
Disabled on the Results of screen in the web
application.

*& Manage analysis packages (579)
*& About the screens in the web application (94)

»@ Editing not allocated orders in the web application

(252)
About enabling analysis packages and LIS To allow for correct communication between the system
test names and the LIS, the test names of all enabled analysis

packages must be mapped unambiguously to unique LIS
test names (1:1 relation).

The following rules apply:

= By default, the test name is used as the LIS test name.

= If you disable a version of an analysis package by
enabling another version, the system takes over the
LIS test names from the disabled version to the
enabled version.

= If enabling an analysis package results in conflicting
LIS test names with a different enabled analysis
package, you must immediately change the LIS test
names in the LIS mapping table.

»& LIS mapping table (577)

About disabling analysis packages If you attempt to disable an analysis package, the system

Roche Diagnostics
Digital LightCycler® System -

checks if the analysis package is assigned to orders in
the web application:

* You cannot disable an analysis package that is
assigned to orders.

= A corresponding warning message is displayed.

* You must delete the orders in the web application
before you can disable the analysis package.

*& Manage analysis packages (579)

»& Editing not allocated orders in the web application
(252)

*@ Cleaning up not allocated orders (466)
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Managing analysis packages

On the Manage analysis packages panel, you import,
enable, disable, revalidate, and export analysis packages,
and access the LIS mapping table panel.

You cannot delete an analysis package. Once imported,
you can only disable it.

To map the test names in the enabled analysis packages
to the LIS test names, you can access the LIS mapping
table panel directly from the Manage analysis
packages panel.

*& LIS mapping table (577)

E] O To import an analysis package:
Analysis package (.dpcrAp file) saved in network
share or on external storage device
O To export an analysis package:
Optionally, external storage device, e.g., USB flash
drive

.

o— Administrator user role

O

O To enable, disable, or revalidate an analysis package:
Analyzer in Analyzer ready status

» To import an analysis package

1 Optionally, to import from an external storage device,
connect the external storage device to the analyzer.

2 In the analyzer software, choose Administration >
Manage analysis packages.

- The Manage analysis packages panel is
displayed.

3 Choose the Import button.
- The Import analysis package dialog box is
displayed.

4 In the folder browser, navigate to the folder of the
analysis package.

5 In the file browser, choose the analysis package.

@ You cannot import the same analysis package
twice.

6 Choose the Import button.
- The analysis package is listed on the Manage
analysis packages panel.
- Depending on name and issuer of the analysis
package, the name of the analysis package may
be appended with a number.
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= The analysis package is in In validation status.

= You can perform diagnostic runs with an analysis
package in In validation status, but the results
are complete immediately after the diagnostic run
finishes and cannot be released or sent.

7 Optionally, disconnect the external storage device.

» To enable a new analysis package

1 In the analyzer software, choose Administration >
Manage analysis packages.
- The Manage analysis packages panel is
displayed.

2 Do the following:
= To check for other versions of the analysis
package that you want to enable, sort and/or filter
the table accordingly.
= If another version of the analysis package exists in
the analyzer software, continue with To enable a
new version of an analysis package (587).

3 From the table, choose an analysis package in In
validation status.

4 Choose the Enable button.
- The analysis package is in Enabled status.
= The system checks for conflicting LIS test names
with the other enabled analysis packages. If
duplicate LIS test names are found, an Error
dialog box is displayed.

5 |If required, resolve the conflicting LIS test names:
= In the Error dialog box, choose the Go to LIS
mapping table button.
= In the LIS mapping table panel, change the LIS
mapping names as described in LIS mapping table
(577).
= Choose the Close button.

O In the Status column of the LIS mapping table
panel, the conflicting LIS test names of both
analysis packages are marked with an error icon.
To resolve the conflict, it is sufficient to change
the LIS test names of 1 analysis package.

» To enable a new version of an
analysis package

1 In the analyzer software, choose Administration >
Manage analysis packages.

- The Manage analysis packages panel is
displayed.
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2 Do the following:

= To check for other versions of the analysis
package that you want to enable, sort and/or filter
the table accordingly.

= If no other version of the analysis package exists
in the analyzer software, continue with To enable
a new analysis package (587).

3 Optionally, if there is another version of the analysis
package in Enabled status or in In validation status,
check in the web application if that version of the
analysis package is assigned to orders:

= In the web application, in the Orders column on
the dashboard, choose the View orders tile.

= On the Orders screen, filter the orders for the
analysis package.

@ If the analysis package is assigned to orders but
you want to prevent an update of the orders to
the new version of the analysis package, you must
either perform the diagnostic runs or delete the
sample setups and orders.

4 In the analyzer software, from the table on the
Manage analysis packages panel, choose the new
version of the analysis package in In validation
status.

5 Choose the Enable button.

©® You cannot enable a new version of an analysis
package if it lacks a test that is still assigned to
orders from the old version of the analysis
package. First, you must delete the orders in the
web application.

= The system checks if there exists a previously
enabled version of the analysis package and if it is
assigned to orders.

= If the analysis package can be enabled directly, it
is set to Enabled status and a previously enabled
version is set to Disabled status (if applicable).

- If a previously enabled version of the analysis
package is assigned to orders, the Change
package status dialog box is displayed.

- The system checks for conflicting LIS test names
with the other enabled analysis packages. If
duplicate LIS test names are found, an Error
dialog box is displayed.
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6 If required, to confirm the deletion of the sample
setups and/or the update of the orders, in the
Change package status dialog box, choose the
Confirm button.

- The analysis package is set to Enabled status and
the previously enabled version is set to Disabled
status.

- In the web application, the sample setups are
deleted and the orders are updated, indicated on
the Orders screen.

= The system checks for conflicting LIS test names
with the other enabled analysis packages. If
duplicate LIS test names are found, an Error
dialog box is displayed.

7 |If required, resolve the conflicting LIS test names:

= In the Error dialog box, choose the Go to LIS
mapping table button.

= In the LIS mapping table panel, change the LIS
mapping names as described in LIS mapping table
(577).

= Choose the Close button.

© On the LIS mapping table panel, the conflicting
LIS test names of both analysis packages are
marked with an error icon. To resolve the conflict,

it is sufficient to change the LIS test names of
1 analysis package.

8 Optionally, in the Orders screen in the web
application, choose the Refresh button.

= The updated orders are displayed.

» To export an analysis package

1 Optionally, to export to an external storage device,
connect the external storage device to the analyzer.

2 In the analyzer software, choose Administration >
Manage analysis packages.

= The Manage analysis packages panel is
displayed.

3 Optionally, sort, search, or filter the table.
4 From the table, choose an analysis package.

5 Choose the Export button.
- The Select folder dialog box is displayed.

6 In the folder browser, navigate to a folder.

7 Choose the Confirm button.
- The analysis package is exported to the folder.
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8 Optionally, disconnect the external storage device.

» To disable an analysis package

1 In the analyzer software, choose Administration >
Manage analysis packages.

- The Manage analysis packages panel is
displayed.

2 Optionally, sort, search, or filter the table.

3 From the table, choose an analysis package in
Enabled status or in In validation status.

@ You cannot disable an analysis package that is
assigned to orders in the web application. You
must delete the orders first.

4 Choose the Disable button.
- The analysis package is in Disabled status.

= You cannot perform diagnostic runs with an
analysis package in Disabled status.

» To revalidate an analysis package

[<b)

e 1 In the analyzer software, choose Administration >
g Manage analysis packages.

= - The Manage analysis packages panel is
L~ ] .

o displayed.

2 2 Optionally, sort, search, or filter the table.

QNJ 3 From the table, choose an analysis package in
= Disabled status.

g 4 Choose the Revalidate button.

(a0} - The analysis package is in In validation status.
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Network share settings

On the Network share settings panel, you configure
the paths to network shares, i.e., folders in the network,
that you can then access in the folder browsers in the
analyzer software.

Configuring network shares enables the navigation to
import or export folders in folder browsers and facilitates
the consistent use of folders, e.g., for archive files or
backup files.

The Roche-provided firewall must allow access to
network shares. Contact your Roche Service
representative to configure the Roche-provided firewall.
To access the Network share settings panel, you need

administrator user role.

In this section

About the Network share settings panel (591)
List of network share settings (592)
Configuring network share settings (593)

About the Network share settings panel

About statuses of network shares

L]

Roche Diagnostics

The Network share settings panel lists all configured
network shares, their status, and their use.

When you access the Network share settings panel,
the system tests if the network paths are accessible:

= The UNC paths themselves that are configured as
network shares, e.g.,
\\server\Analyzer

= The network paths that are configured in other
screens of the Administration tab and include the
network shares, e.g.,
\\NetworkShare\Backup

The icons in the Accessible column indicate the status
of the network shares and their derived network paths:
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About use of network shares

ZNQ)

Available:

= Network share is accessible.

= All network paths that include the network share are
accessible.

Partial access:

= Network share is accessible.

= At least 1 of the network paths that include the
network share is not accessible.

No access:

= Network share is not accessible.

Pending:

= Network share is not tested yet.

Directly after you access the Network share settings
panel, all network shares are in Pending status. The
status check and the update of the status icon may take
some time.

To display a callout with the status legend, in the
Accessible column header, choose the (1 button.

If a network share is used, i.e., configured in a network
path, the use is listed in the Status of path used in
settings group box when you choose the network share
from the table on the Network share settings panel.

The listed use includes the icons that indicate the status
of the derived network paths:

Network path is accessible.

Network path is not accessible.

If no icon is displayed, the network path is currently
being tested.

List of network share settings

Roche Diagnostics

You must enter the network share settings to configure
network shares.

For network-specific information, contact your local IT
administrator.
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Display name

User name

Password

Administration of the analyzer software

Use an analyzer-specific account on the network server.

Field to enter the UNC path.

The UNC path must conform to the following formats:
= \\server-name\path
= \\IP-address\path

Example:
\\server\Analyzer\Backup

If you include folders in the UNC path, ensure that these
folders exist in the network.

Name that is listed in folder browsers for the network
share.

The display name must be unique.

User name of the analyzer-specific account on the
Server.

Password of the analyzer-specific account on the server.

Configuring network share settings

Roche Diagnostics

On the Network share settings panel, you create, edit,
and delete network shares.

You cannot delete network shares that are used, e.g., for
automatic export of raw data files. You must first delete
all configured uses of the network share before you can
delete the network share.

For network-specific information, contact your local IT
administrator.

O Network-specific information (paths, account)

O Folders and subfolders created in the network
O Administrator user role

Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1
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Network share settings

Roche Diagnostics

To create a network share

In the analyzer software, choose Administration >
Network share settings.

- The Network share settings panel is displayed.

Choose the Create button.

= An empty row for a new network share setting in
Pending status is added to the Network share
settings table.

- The fields on the right of the Network share
settings table are enabled for that network share
setting.

Enter the required information:

= UNC path

= Display name

= User name

= Password

@ You must at least enter the UNC path and a

display name.
The display name must be unique.

Choose the Test button.

If the test of the network share setting is successful
(i.e., the network share is accessible), choose the
Save button.

@ If you save the network share setting without
testing it, the test is performed automatically. The
result of the test is then displayed in the
Accessible column.

=> The network share is listed in the table on the
Network share settings panel and in the folder
browsers for import and export paths.

To edit a network share

In the analyzer software, choose Administration >
Network share settings.

=> The Network share settings panel is displayed.

From the table, choose the network share.
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3 To change the information in a field, do the following:
= Choose the field.
= Edit the field content.
= Press Enter.

4 Choose the Test button.

5 If the test of the network share setting is successful
(i.e., the network share is accessible), choose the
Save button.

@ If you save the network share setting without
testing it, the test is performed automatically. The
result of the test is then displayed in the
Accessible column.

= The edited network share is saved.

» To delete a network share

1 In the analyzer software, choose Administration >
Network share settings.

- The Network share settings panel is displayed.

2 From the table, choose a network share.
©® You cannot delete network shares that are used,
e.g., as folder for automatic archiving.

3 Choose the Delete button.

= The Remove network share dialog box is
displayed.

4 Choose the Confirm button.
- The network share is deleted from the Network
share settings table and from the folder
browsers in the analyzer software.
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Partitioning engine connection

Partitioning engine connection

On the Partitioning engine connection panel, you
assign partitioning engines to the analyzer.

To access the Partitioning engine connection panel,
you need administrator user role.

About partitioning engine connection An analyzer only processes nanowell plates that were
partitioned on an assigned partitioning engine. Therefore,
you must at least assign 1 partitioning engine to each
analyzer.

The assignment of the partitioning engine establishes the
connection between the instruments and ensures that
the partitioning data is sent to the analyzer and stored in
the system database.

To assign a partitioning engine to an analyzer, the

following prerequisites must be fulfilled:

= The partitioning engine and the analyzer must be
connected to the same network.

= The partitioning engine must be started up to be
detectable for the analyzer.

= The partitioning engine must not be assigned to a
different analyzer.

In the analyzer software, a partitioning engine is
identified by its serial number and IP address.

An assigned partitioning engine can have the following
connection statuses:

= Offline

= Connecting

= Connected

A partitioning engine needs to be assigned to an
analyzer only once:

After startup of the partitioning engine and the analyzer,
the connection is automatically established again.

About multiple instrument configurations You can assign several partitioning engines to each
analyzer.

Roche Diagnostics
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However, a partitioning engine can be assigned to 1
analyzer only at a time. To assign a partitioning engine to
a different analyzer, you must deassign it first.

In a configuration with multiple partitioning engines and
multiple analyzers, ensure that you assign each
partitioning engine only to the analyzer it will be used
with. Do not assign a partitioning engine to different
analyzers. Otherwise, the partitioning engine will connect
to the first available analyzer after startup, which might
not be the analyzer it is used with. This could lead to loss
of partitioning data.

/ CAUTION!

Incorrect assignment of partitioning engine to
analyzer

An analyzer only processes nanowell plates that were
partitioned on an assigned partitioning engine. If the
partitioning engine you used to partition the nanowell
plates is not assigned to the analyzer you want to
process the nanowell plates on, the information from the
partitioning engine may be lost, which may cause invalid
or delayed results.

» Ensure that the partitioning engine is assigned to the
analyzer.

v

Pay extra attention to the assignment of the
partitioning engines to the analyzers in a multiple
instrument configuration (multiple partitioning
engines and multiple analyzers).

o— O Partitioning engine and analyzer connected to the
same network

O Partitioning engine started up
O Administrator user role

» To assign or deassign a partitioning
engine

1 In the analyzer software, choose Administration >

Partitioning engine connection.

= The Partitioning engine connection panel is
displayed.

= The Available in network group box lists all
unassigned partitioning engines that are detected
by the analyzer.

- The Assigned partitioning engines group box
lists all partitioning engines that are assigned to
the analyzer.
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2 To assign a partitioning engine to the analyzer, do the

following:

= In the Available in network group box, choose
the partitioning engine.

= Choose the =+ button.

= The partitioning engine is assigned to the analyzer
you are currently working on and listed in the
Assigned partitioning engines group box.

- The partitioning engine cannot be assigned to
other analyzers anymore.

3 To deassign a partitioning engine from the analyzer,

do the following:

= In the Assigned partitioning engines group box,
choose the partitioning engine.

= Choose the 4= button.

= The partitioning engine is unassigned from the
analyzer you are currently working on and listed
again in the Available in network group box.

= The partitioning engine can be assigned to other
analyzers again.

tration of the analyzer software
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Password settings

List of password settings

Idle time before automatic logoff (1-60 min)

Number of days until password expiry (1-90)

Roche Diagnostics

Administration of the analyzer software

On the Password settings panel, you configure the
global password policy all passwords must conform to.

To access the Password settings panel, you need
administrator user role.

In this section

List of password settings (599)
Configuring password settings (601)

To define the global password policy, you can set the
following requirements for all passwords.

= Administration > Password settings

By default, all password settings are enabled.

Check box to enable auto logoff of users.
Field to enter the period of inactivity after which users
are logged off automatically.

To prevent unauthorized system access, set a short
inactivity time.

If a user is logged off automatically, the system discards
any pending changes of the user.

Default value = 15 min

Check box to enable automatic password expiry.
Field to enter the number of days after which users must
change their passwords.

You cannot enter "0" here. If you want the password of a
user never to expire, you must select the Password
never expires check box in Administration > User
management for the user.
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Password policy check box

Minimum password length (4-20)

Number of required uppercase letters in
password (0-3)

Number of required lowercase letters in
password (0-3)

Minimum number of digits in password (0-3)

Number of required special characters in
password (0-3)

Number of previous passwords not to be
reused (0-5)

Lock user accounts after failed logon
attempts (1-5).

Roche Diagnostics

You can only select the Password never expires check
box for each user individually. You cannot select this
option globally for all users.

Default value = 90 days

Check box to enable the following list of password
requirements.

You can only enable all or disable all password

requirements. To disable a single password requirement,
enter "0" in the corresponding field (if allowed).

Field to enter the minimum total length of passwords.

Default value = 6

Field to enter the minimum number of uppercase letters
that are required in passwords.

Default value = 1

Field to enter the minimum number of lowercase letters
that are required in passwords.

Default value = 1

Field to enter the minimum number of digits that are
required in passwords.

Default value = 1

Field to enter the minimum number of special characters
that are required in passwords.

Default value = 0

Field to enter the number of how far back old passwords
cannot be used again.

Default value = 0

Field to enter the maximum number of allowed failed
logon attempts.
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If a user tries to log on and reaches the maximum
number of failed logon attempts, the user is locked
automatically.

Default value = 3 attempts

Configuring password settings

On the Password settings panel, you enable and
disable password settings, and enter their values.

If you change the password settings, the new settings
only apply to passwords that are created later.

/ CAUTION!

Weak passwords

Weak passwords may allow unauthorized access to the
system, data manipulation or loss, or unauthorized
access to personal information, which may cause
incorrect, invalid, or delayed results.

» Ensure that the configured global password policy
enforces safe password handling.

M_

O Administrator user role

» To configure password settings

1 In the analyzer software, choose Administration >
Password settings.

- The Password settings panel is displayed.

2 To enable a password setting, select the check box.

©® The more password settings you enable, the
stronger passwords must be.

3 Optionally, change the value in the corresponding
field.

4 To disable a password setting, clear the check box.

5 Choose the Save button.
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Result settings

Result settings

On the Result settings panel, you configure automatic
export of raw data files and the diagnostic results
settings.

To access the Result settings panel, you need
administrator user role.

In this section

Automatic export of raw data files (602)

Diagnostic results settings (604)

Automatic export of raw data files

On the Result settings panel, in the Development raw
data group box and the Diagnostic raw data group
box, you configure automatic export of raw data files.

To access the Result settings panel, you need
administrator user role.

In this section

About automatic export of raw data files (602)

Configuring automatic export of raw data files (603)

About automatic export of raw data files

About export conditions

Roche Diagnostics

Automatic export of the raw data files spares you the
need to export the raw data manually.

By default, automatic export of the raw data files is
disabled.

»& About raw data files and runs (309)

For a development run, the export of the raw data file is
always possible.
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For a diagnostic run, the export of the raw data file is

only possible if the following conditions are met:

= All results of the diagnostic run must be complete,
i.e., released and sent. The run must be listed on the
Completed batches screen.

= The export of the raw data file must be enabled in the
analysis packages used for the diagnostic run.

-‘Q’- If a diagnostic run uses 2 or more analysis
packages with different export settings, the most
restrictive option is applied to the raw data file of
that run.

*& Analysis packages in the development software (412)

About manual export If the export path for automatic export is not available at
the end of a run (e.g., because the network is down or
the external storage device is not connected) or there is
not enough memory, the automatic export fails and you
must export the raw data manually.

*& Managing raw data files of development runs in the
analyzer software (312)

*@ Exporting raw data files of diagnostic runs from the
web application (315)

Configuring automatic export of raw data files

On the Result settings panel, you configure the
analyzer software to export the raw data files from
diagnostic and/or development runs automatically to a
network share or external storage device.

o_ O Enough memory in the network share or on the
external storage device

O Administrator user role

» To configure automatic export of raw
data files

1 Optionally, to configure export to an external storage
device, connect the external storage device to the
analyzer.

2 In the analyzer software, choose Administration >
Result settings.

= The Result settings panel is displayed.

Roche Diagnostics
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3 To configure automatic export of raw data files of
development runs, in the Development raw data
group box, do the following:
= Select the Auto-export of research raw data
check box.

= Next to the Export path field, choose the :-
button.

= In the folder browser, navigate to a folder.

= Choose the Confirm button.

4 To configure automatic export of raw data files of
diagnostic runs, in the Diagnostic raw data group
box, do the following:
= Select the Auto-export of research raw data

check box.

= Next to the Export path field, choose the -
button.

= In the folder browser, navigate to a folder.

= Choose the Confirm button.

O This setting only takes effect for diagnostic runs
that are performed with analysis packages that
allow export of the raw data.

5 Choose the Save button.

© If you configured automatic export to an external
storage device, ensure that the external storage
device is connected at the end of a run.
Automatic export fails if the configured export
path is unavailable.

= After a run finishes, the raw data file is exported
automatically to the folder.

Diagnostic results settings

On the Result settings panel, in the Diagnostic results
group box, you configure the diagnostic results settings.

To access the Result settings panel, you need
administrator user role.

In this section

About the diagnostic results settings (605)
Configuring diagnostic results settings (605)
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About automatic release and send

About inclusion of control results

Administration of the analyzer software

The diagnostic results settings spare you the need to
release and send diagnostic results manually in the web
application, and ensure that control results are included.

By default, the automatic release and sending of
diagnostic results are disabled, and the sending of
control results is enabled.

The diagnostic results settings do not apply to
development runs.

The diagnostic results settings for release and sending of

diagnostic results apply to the web application:

= If 1 or both settings are disabled in the analyzer
software, you must release and/or send the
diagnostic results manually in the web application.

= If both settings are enabled in the analyzer software,
diagnostic results are automatically released and sent
to the LIS. In the web application, the batches are
immediately listed on the Completed batches
screen after the diagnostic runs finish.

Even if the system is not connected to an LIS, you must
still send the results to change their status from Pending
send to Send queued or Sent, and complete the
batches.

Results for orders with analysis packages in In
validation status are complete immediately after the
diagnostic run finishes. You cannot release such results
or send them to the LIS.

The diagnostic results setting for the sending of control
results determines if control results are included when
diagnostic results are sent to the LIS, regardless of how
the diagnostic results are sent (manually or
automatically).

Configuring diagnostic results settings

Roche Diagnostics

On the Result settings panel, you configure the
analyzer software to send and/or release diagnostic
results automatically, and/or to include control results
when sending diagnostic results to the LIS.
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If you enable any of the diagnostic results settings, they
only apply to diagnostic results generated later. The
system does not catch up on releasing and/or sending
results or control results that were generated previously.

O Administrator user role

To configure diagnostic results
settings

In the analyzer software, choose Administration >
Result settings.

- The Result settings panel is displayed.

To configure the release setting for diagnostic results,

do one of the following:

= To enable the automatic release of results, select
the Automatically release results check box.

= To disable the automatic release of results, clear
the Automatically release results check box.

To configure the sending setting for diagnostic
results, do one of the following:

= To enable the automatic sending of results to the
LIS, select the Automatically send results check
box.

= To disable the automatic sending of results to the

LIS, clear the Automatically send results check
box.

To configure the setting for control results, do one of

the following:

= To include control results when sending
diagnostic results to the LIS, select the Send
control results check box.

= To exclude control results when sending
diagnostic results to the LIS, clear the Send
control results check box.

Choose the Save button.
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User Assistance and language settings

On the User Assistance and language settings panel,
you configure the language of the user interface and the
User Assistance for the analyzer software and the web
application.

To access the User Assistance and language settings
panel, you need administrator user role.

N

-g— In the development software, the language of the
user interface and the User Assistance is
determined by the Windows language settings.

In this section

About language packages and User Assistance
packages (607)

Importing language packages and User Assistance
packages (608)

Changing the system language (610)

About language packages and User Assistance packages

About language packages

Roche Diagnostics

Language configuration is done in the analyzer software.
The same language then applies to the web application.

You can choose 1 language only for both the analyzer
software and the web application, and the User
Assistance.

If you change the language, the change is applied to all
users. It is not possible to set individual users’ languages.

A language package contains the translations of the
analyzer software and the web application in 1 language.

To display the analyzer software and the web application
in a language, you must do the following:

1. Import the language package into the analyzer
software.

2. Change the language in the analyzer software, i.e.,
choose the language package.
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About User Assistance packages

When you choose a different language package,
or when you import a new version of the currently
active language package, you must restart the
analyzer for the change to take effect.

*& Restarting the analyzer (451)

A User Assistance package contains the translation of
the User Assistance publication that is accessible from
the analyzer software and the web application.

For the language of the User Assistance, the following

rules apply:

= If the User Assistance package is available in the
same language as the active language package, the
User Assistance is displayed in that language.

= If the User Assistance package is not available in the
same language as the active language package, the
User Assistance is displayed in English.

= You cannot choose the language of the User
Assistance independently of the language of the user
interface.

When you import a new version of the User Assistance
package in the currently active language, the new User
Assistance is displayed directly.

Importing language packages and User Assistance

packages

M_

Roche Diagnostics

On the User Assistance and language settings panel,
you import language packages and User Assistance
packages.

O Language package and/or User Assistance package
(ZIP files) saved in network share or on external
storage device

O Administrator user role

» To import a language package

1 Optionally, to import from an external storage device,
connect the external storage device to the analyzer.
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2 In the analyzer software, choose Administration >
User Assistance and language settings.

- The User Assistance and language settings
panel is displayed.
3 Choose the Import language package button.
- The Import language package dialog box is
displayed.

4 In the folder browser, navigate to the folder of the
language package.

5 In the file browser, choose the language package.

6 Choose the Import button.

- The language package is installed in the analyzer
software.

- The language package is listed in the table on the
User Assistance and language settings panel.

7 Optionally, disconnect the external storage device.

8 If you imported a new version of the currently active
language package, restart the analyzer as described
in Restarting the analyzer (451).

» To import a User Assistance package

1 Optionally, to import from an external storage device,
connect the external storage device to the analyzer.

2 In the analyzer software, choose Administration >
User Assistance and language settings.
= The User Assistance and language settings
panel is displayed.

3 Choose the Import User Assistance package
button.
= The Import User Assistance package dialog
box is displayed.

4 In the folder browser, navigate to the folder of the
User Assistance package.

5 In the file browser, choose the User Assistance
package.

6 Choose the Import button.

- The User Assistance package is installed in the
analyzer software.

= The User Assistance package is listed in the table
on the User Assistance and language settings
panel in the entry of the corresponding language
package.

7 Optionally, disconnect the external storage device.
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Changing the system language

On the User Assistance and language settings panel,
you change the language of the analyzer software, the
web application, and the User Assistance.

If you change the language, the change is applied to all
users. It is not possible to set individual users’ languages.
5: O Language package imported
O To display the User Assistance in the same language
as the analyzer language:
User Assistance package imported
O Administrator user role

» To change the system language

1 In the analyzer software, choose Administration >
User Assistance and language settings.
- The User Assistance and language settings
panel is displayed.

2 Optionally, sort, search, or filter the table.

3 From the table, choose the language package.

4 Restart the analyzer as described in Restarting the
analyzer (451).

= The user interface of the analyzer software and
the web application is displayed in the configured
language.

= If the corresponding User Assistance package is
available in the analyzer software, the User
Assistance is displayed in the same language.

= If the corresponding User Assistance package is
not available in the same language, the User
Assistance is displayed in English.
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Settings in the development software

Laboratory information settings in the

development software

You can configure the name, address, and logo of your
laboratory to be displayed on reports.

If configured, the laboratory information is included in all
reports created in the development software.

For a logo file, the following restrictions apply:

= O

Roche Diagnostics

JPEG or PNG file
File size: 10 MB or less
Resolution: 1920 x 1080 pixels or less

Optional:
Logo file (PNG or JPEG file)

To configure laboratory information
settings in the development software
Optionally, to import a logo file from an external

storage device, connect the external storage device to
the computer running the development software.

In the development software, in the Navigation area,
choose File > [l > Settings.
= The Settings dialog box is displayed.

In the Laboratory name: field, enter the name of
your laboratory.

To add a logo, choose the +- button.

Navigate to the logo file and choose the Open

button.

- A preview of the logo is displayed in the Settings
dialog box.

In the Address line 1: field, Address line 2: field,
Address line 3: field, and Address line 4: field,
enter the address of your laboratory.

Choose the Save button.
- The laboratory information is added to reports.

Optionally, disconnect the external storage device.
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About digital PCR

Partitioning
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Advantages of digital PCR
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Digital PCR allows for absolute quantification of a target
nucleic acid sequence without a standard curve.

Digital PCR consists of the following steps:

The system partitions the sample into a large number of
nanowells. This distributes the target molecules and
results in nanowells that contain the target and other
nanowells that do not contain the target.

The partitioned sample is run through an endpoint PCR
amplification and detection.

The fluorescence of the amplified target molecules is
detected separately for each nanowell.

Based on the detected fluorescence, the nanowells are
clustered in 2 distinct groups, representing the concept
of a "digital" measurement:
= Negative nanowells:
All nanowells that show no fluorescence because
they contain no target molecules.

= Positive nanowells:
All nanowells that show fluorescence because they
contain at least 1 target molecule.

To account for nanowells that contained more than 1
target molecule after partitioning, the number of target
molecules in the positive nanowells is normalized using
the Poisson distribution.

The concentration of the target in the sample is
calculated.

-“Q'— Digital PCR requires that the target molecules are
separated from each other during sample
preparation. Only then are the target molecules
distributed evenly across the nanowells after
partitioning and can be detected independently,
which allows for calculation of the concentration.

The advantages of digital PCR compared to real-time

PCR are the following:

= The target nucleic acid sequence is more
concentrated compared to non-target nucleic acid
sequences, resulting in less competition.

Draft - Do Not Distribute

n
Q
=

)

e
=

=
©

)
™
=

1]

e
<
{o)
N




About digital PCR

= Inhibitors are diluted relative to the target nucleic
acid sequence, resulting in less inhibition.

= No dependence on Cq values or PCR efficiency,
resulting in less influence of inhibitions.

The advantages result in higher precision, lower limit of
detection, and better multiplexing performance. As no
standards are required, there are lower reagents costs.
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Analytical principles

About tests and analyses

The system can apply 3 different analyses to determine
results: absolute quantification, CNV, and indel.

About absolute quantification tests and An absolute quantification (Abs Quant) test detects the
analyses fluorescence of a known target nucleic acid sequence.

From the detected fluorescence, absolute quantification
analysis calculates if the target is present (qualitative
result) and the concentration of the target in the sample
(quantitative result).

In CNV analysis and indel analysis, the system performs
absolute quantification analysis in the background on
each tested channel to provide the necessary parameters
for CNV and indel result calculation.

About CNV tests and analyses Copy number variation (CNV) is the occurrence of a
variable number of copies of a known genomic
sequence.

A variation is found by comparing the copy number of
the target of interest with the normal copy number of at
least 1 reference target. Target of interest and reference
target are different genomic sequences and are tested
independently.

A CNV test uses at least 2 channels:

= 1 channel detects the fluorescence in the presence of
the target of interest.

= 1 channel detects the fluorescence in the presence of
the reference target.

If you use more than 1 reference target, the mean of their
copy numbers is taken for analysis.

From the detected fluorescences and the normal copy
number of the reference target, CNV analysis calculates
if there is a variation in the copy number of the target of
interest (qualitative result) and the copy number of the
target of interest (quantitative result).

CNV analysis requires that the individual copies of the
genomic sequence are separated from each other during
sample preparation. Only then can the copies be
detected independently and can contribute to detecting
a difference between the target of interest and the
reference target. The system counts copies that are not
separated as 1 copy.
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Roche Diagnostics

and analyses

About indel tests and analyses

Insertion-deletion (indel) is the occurrence of unknown
mutations in a genomic sequence that are caused by the
presence (insertion) or absence (deletion) of nucleotides.

Such mutations are found by simultaneously testing for a
variant target and a reference target. The variant target
spans the mutation site, the reference target spans an
adjacent but stable site.

An indel test uses 2 channels:

= 1 channel shows fluorescence in the presence of the
reference target.

= 1 channel shows fluorescence in the presence of the
variant target.

The wild type sequence without any mutation in the
variant target is found if the fluorescence of both the
reference target and the variant target are detected
(double positive).

The variant sequence with a mutation in the variant
target is found if the fluorescence of the reference target
is detected, but no fluorescence of the variant target is
detected (positive-negative). This is why an indel test is
also called a drop-off test.

An indel test allows for the detection of any mutation in
the variant target. The mutated nucleotide sequence
does not need to be known. Consequently, an indel test
can test for different mutations at the same time.

From the detected fluorescences, indel analysis
calculates if a mutation is present (qualitative result) and
the percentage of the variant sequence in the sample
(quantitative result).
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Glossary

1D scatter plot

Scatter plot that shows a one-dimensional point set
visualization.

2D scatter plot

Scatter plot that shows a two-dimensional point set
visualization.

3D scatter plot

Scatter plot that shows a three-dimensional point set
visualization.

absolute quantification

Quantification that is used to determine the absolute
number of a target nucleic acid sequence.

amplification and detection

Process of generating multiple copies of nucleic acids
and the concurrent or subsequent detection of these
nucleic acids, usually using an automated thermal
cycler, fluorescent probes and an optical detection
system.

analysis package

Bundle of files that contains parameters and
specifications relevant for one or multiple tests.

aspiration and dispensing arm

Component that is pushed into different bottles to
aspirate and dispense liquids.

aspiration needle

Needle that is used to aspirate fluids.

ASTM protocol

Protocol defined by the ASTM International
organization in the standards E.1381 and E.1394.

confidence interval

Range of values within which a value of a parameter
will fall with a specified probability.

Roche Diagnostics

copy number variation

Genomic disorder that results in an abnormal number
of copies of one or more genes, such as duplication,
deletion, translocation, and inversion.

decontamination

Process that leads to the destruction of all nucleic
acids.

detection unit

Unit consisting of one or more measuring channels in
which the measurement takes place.

development run

Run during which tests for research and development
purposes are performed.

development workflow

Workflow for research and development purposes.

diagnostic run

Run during which diagnostic tests are performed.

diagnostic workflow

Workflow for diagnostic purposes.

digital polymerase chain reaction

Polymerase chain reaction method that is used to
directly quantify nucleic acid strands present in a
sample. The sample is separated into a large number
of nanowells and the reaction is carried out in each
nanowell individually. This separation allows a more
reliable collection and sensitive measurement of
nucleic acid amounts.

dilution

Process of adding a material, usually a liquid or gas,
to another material or substance for purposes of
decreasing the concentration of the former.

dilution factor

Ratio of the volume of an initial, concentrated solution
to the volume of the final, diluted solution.
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fluids door

Door that gives access to the fluids on the system.

fluorescence

Brief visible electromagnetic radiation signal that is
emitted as a result of absorption of radiation
(photons) by an atom, molecule, or ion.

fluorescent dye

Fluorescent chemical compound that absorbs and re-
emits light upon light excitation.

heatmap

Graphical representation of data where the intensity
of color corresponds to the related analytical data.

high resolution nanowell plate

Nanowell plate with a higher number of nanowells
that enables a detection of the target sequences with
a high resolution.

high sensitivity nanowell plate

Nanowell plate with a higher volume per nanowell
that enables a higher sensitivity regarding the target
sequences.

histogram

Graphical representation of a frequency distribution
of data, often by means of rectangles whose widths
are the class intervals and whose heights are the
corresponding frequencies.

HL?7 protocol

Standardized protocol defined by the HL7
organization that is used for communication between
healthcare applications.

indel

Small genetic variation happening through insertions
or deletions of nucleotides in the genome of an
organism.

inlet port

Opening on a nanowell plate into which a sample is
pipetted.

Roche Diagnostics

liquid waste bottle

Bottle for the collection of liquid waste that is
generated by the instrument.

master mix reagent

Reagent that is needed for various enzymatic
reactions and may contain enzymes, associated
buffers, primers, and probes.

master reagent

Reagent that is needed for PCR, but does not yet
contain primers and probes.

merge lanes

Functionality that considers up to 8 nanowell plate
lanes as if it were 1 lane in order to define a higher
sample volume for 1 sample.

multiplex test

PCR or nucleic acid test that enables the
simultaneous detection and discrimination of multiple
DNA or RNA targets.

nanowell plate

Flat plate with nanowells that is used for digital PCR
application.

nanowell plate drawer

Drawer that is used to load and unload single
nanowell plates onto and from the instrument.

nanowell plate frame

Holding frame of the nanowell plate.

nanowell plate handler

Handler that moves nanowell plates in the analyzer.

nanowell plate lane

Lane that represents the path of a sample and upon
which the sample is distributed into nanowells.

nanowell plate park position

Position where the nanowell plate is temporarily
placed after thermal cycling and before being loaded
onto the detection unit.

Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1



nanowell plate stack drawer

Drawer that is used to load and unload nanowell
plate stacks onto and from the instrument.

Network Address Translation

Internet Protocol translation process that allows a
network with private addresses to access information
on the internet.

partitioning fluid

Fluid that is used to seal the nanowells of a nanowell
plate.

partitioning fluid bottle

Bottle that contains partitioning fluid.

primer

Single-stranded nucleic acid that can initiate
replication of a nucleic acid template.

probe

Single-stranded nucleic acid with a fluorescent dye
that is used to identify specific DNA or RNA
molecules by binding to specific amplicon sequences
between primers.

reaction mixture

Mixture of reagents and sample.

Roche Service representative

Roche representative who may install instruments
and/or perform preventive maintenance and/or
service activities.

sample group

Group of samples that is created for statistical
analysis.

scatter plot

Chart that displays values for variables for a set of
data as a collection of scattered points, which can be
clustered.

target nucleic acid sequence

Nucleic acid sequence that is of interest.

Roche Diagnostics

thermal cycler

Component of an instrument used to repetitively heat
and cool a set of reactions to promote DNA
denaturation, hybridization, and amplification in PCR.

thermal cycler unit

Unit where thermal cycling is performed.

uninterruptible power supply

Device with a battery that allows limited continued
operation of an instrument or other device during a
power outage.

universal nanowell plate

Nanowell plate that is used for applications that do
not require high sensitivity nor high resolution
detection of the target sequences.

wild type

Strain, gene, or characteristic which prevails among
individuals in natural conditions.
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Index

A

Abbreviations, 12

Abs Quant - All analysis
- displaying, 371

- editing, 372

Absolute quantification
- color-coding, 149

- principles, 621

Absolute quantification analyses

- about, 359

- adding, 374

- Controls, 360

- controls valid ranges, 361
- development software, 359
- editing, 376

- editing Abs Quant - All, 371
- Internal controls, 361

- limits of detection, 362

- limits of quantification, 362
- Linkage panel, 368

- negative controls, 360

- panels, 363

- performing, 373

- positive controls, 360

- result columns, 363

- Result overview panel, 367
- Results panel, 363

- sample groups, 360

- Sample selection, 360

- samples, 360

- settings, 359

- Statistics panel, 370

- tabs, 359

- Target limits, 362

- valid ranges internal controls, 362

Roche Diagnostics

Absolute quantification tests
- control names, 419

- control types, 419

- controls, 419

- controls valid ranges, 419

- in analysis packages, 416

- internal controls, 419

- internal controls valid ranges, 420
- limits of detection, 418

- limits of quantification, 418
- result names, 418

- show quantitative results, 418
- test definitions, 416

- test details, 417

- test settings, 417
Accessories, 23

Alarms

- analyzer, 527

- analyzer software, 528
Analyses

- deleting, 359

- development software, 358
- displaying bar charts, 400
- duplicating, 358

- editing Abs Quant - All, 371
- performing absolute quantification, 373
- performing CNV, 386

- performing indel, 398

- renaming, 359

- working with, 358

Analysis package tabs

- development software, 137
Analysis packages

- about, 579

- about disabling, 585

- about enabling, 582
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- about import, 581 - settings, 412

- clustering settings, 428 - status, 580

- comments, 416 - Test definition, absolute quantification, 416
- Create analysis package, 412 - Test definition, CNV, 420

- creating, 429 - Test definition, indel, 424

- creating reports, 433 - test list, 417, 421, 424

- creator, 414 - tests, absolute quantification, 416
- deleting, 433 - tests, CNV, 420

- development software, 412 - tests, indel, 424

- dilution factors, 427 - thresholds, 428

- disabling, 590 - time limits, 415

- Edit, 414 - updating, 432

- enabling new, 587 - working with, 429

- enabling version, 587 Analysis settings

- exporting, analyzer software, 589 - absolute quantification, 359

- exporting, development software, 433 - CNV, 377

- files, 580 - development software, 136

- General settings, 414 - indel, 389

- history, 416 Analysis tabs

- identifiers, 581 - absolute quantification, 359

- importing, 586 - Analysis setup, 377, 390

- issuers, 580 - CNV, 377

- LIS test names, 585 - Controls, 360, 378, 391

- manage, 414 - development software, 134

- managing, 586 - indel, 389

- master mix reagents, 427 - Internal controls, 361

- MMXx overview, 427 - Sample selection, 360, 377, 389

- MMX settings, 427 - Target limits, 362, 379

- names, 413 Analyzer

- numbers of merged lanes, 415 - aborting runs, 450

- panels, 412 - about, 74

- plate types, 413 - changing language, 610

- report labels, 416 - changing password, 237

- result export restrictions, 415 - changing password at logon, 237
- revalidating, 590 - characteristics, 74

- run parameters, 579 - checking around, 476

- run profiles, 415 - cleaning, 476

- seed data, 428 - cleaning nanowell plate stack drawer, 477
- select, 414 - cleaning outside, 476

Roche Diagnostics
Digital LightCycler® System - Software version 1.0 - User Assistance - Publication version 1.1



- components, 74 - nanowell plate stack drawer, 74

- components inside, 76 - paused, 518

- configuring audio settings, 563 - power button, 75

- configuring automatic raw data export, 603 - power inlet, 76

- configuring AVENIO CONNECT connection, 573 - power switch, 75

- configuring diagnostic results settings, 605 - resolving alarms, 527

- configuring EDI connection, 573 - restarting, 451

- configuring laboratory information, 575 - scheduling automatic archiving, 560

- configuring LIS connection, 572 - scheduling automatic backups, 566

- configuring LIS test names, 577 - shutting down, 440

- configuring NAT with external IP address, 573 - space required, 184

- configuring network share settings, 593 - starting, 235

- configuring password settings, 601 - touch screen monitor, 74

- confirming messages, 511 - unloading, 227

- connecting partitioning engines, 596 - unresponsive, 519

- creating custom problem reports, 515 - USB ports, 75

- creating logs reports, 516 - weight, 184

- data maintenance, 466 Analyzer software

- decontaminating nanowell plate stack drawer, 477 - about, 106

- dimensions, 184 - amplification programs, 119

- disconnecting, 574 - audit trails, 449

- displaying messages, 511 - buttons, 106, 112

- displaying system information, 452 - changing language, 610

- electric power supply, 182 - changing password, 237

- exporting basic problem reports, 514 - changing password at logon, 237

- external keyboard, 79 - column headers sample setups, 116

- general specifications, 181 - configuring audio settings, 563

- hand-held barcode reader, 77 - configuring automatic raw data export, 603
- importing language packages, 608 - configuring AVENIO CONNECT connection, 573
- importing User Assistance packages, 608 - configuring diagnostic results settings, 605
- LAN port, 76 - configuring EDI connection, 573

- loading, 225 - configuring laboratory information, 575

- logging off, 439 - configuring LIS connection, 572

- logging on, 236 - configuring LIS test names, 577

- managing analysis packages, 586 - configuring NAT with external IP address, 573
- managing users, 549 - configuring network share settings, 593

- messages, 509 - configuring password settings, 601

- mouse, 78 - configuring table columns, 142

- nanowell plate loading errors, 520 - confirming messages, 511
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- connecting partitioning engines, 596 - run profiles, 298

- connection indicators, 109 - scheduling automatic archiving, 560
- cooling program, 120 - scheduling automatic backups, 566
- creating audit trails reports, 450 - searching tables, 143

- creating custom problem reports, 515 - sorting tables, 143

- creating logs reports, 516 - status indicator, 109

- deleting screenshots, 448 - tabs, 111

- detection formats, 120 - User Assistance, 108

- disconnecting, 574 - virtual keyboard, 125

- displaying messages, 511 - work area, 110

- displaying system information, 452 Analyzer software, buttons, 106, 112
- entering run information, 307 - Close drawer, 107, 114

- exporting basic problem reports, 514 - log off, 108

- exporting screenshots, 448 -log on, 108

- exporting to Excel, 147 - Manual entry, 114

- file browsers, 123 - Open drawer, 107, 114

- filtering tables, 143 - Plates, 107

- folder browsers, 123 - Run profile, 114

- global information area, 106 - Sample setup, 114

- icons message severity, 122 - screenshot, 110

- importing language packages, 608 - Shutdown, 109

- importing User Assistance packages, 608 Analyzer software, panels, 112

- incubation programs, 118 - Administration, 123

- logging off, 439 - Archiving, 557

- logging on, 236 - Audio settings, 563

- logon indicator, 108 - Backup, 564

- managing analysis packages, 586 - Change password, 237

- managing raw data files (development), 312 - Connection settings, 569

- managing screenshots, 447 - Edit run profile, 117, 303

- managing users, 549 - Laboratory information, 575

- message indicator, 108 - LIS mapping table, 577

- messages, 509 - Manage analysis packages, 579

- messages status, 122 - Manage run profiles, 299

- nanowell plate status, 114 - Manage screenshots, 447

- navigation bar, 111 - messages, 121

- overview, 106 - Monitoring, 120

- panels, 112 - Network share settings, 591

- resolving alarms, 528 - Partitioning engine connection, 596
- run prerequisites, 114 - Password settings, 599
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- Plates, 112

- Preventive maintenance, 482
- Problem report, 512

- Result settings, 602

- Sample setup, 115

- User Assistance and language settings, 607
- User management, 545
Archiving

- about, 557

- automatic, 558

- clean-up not allocated orders, 559
- data, 560

- files, 560

- manual, 467, 559

- performing manual, 468

- scheduling automatic, 561
Aspiration needle

- decontaminating, 480

- sharp, 27

Assignment mode

- web application, 95
Assignment mode disabled
- web application, 96

Audio settings

- about, 563

- configuring, 563

Audit trails

- about, 449

- analyzer software, 449

- archiving, 449

- creating reports, 450

- reports, 449

AVENIO Connect connection
- configuring, 573

- list of settings, 570

- overview, 67

Roche Diagnostics

Backups

- about, 564

- about automatic, 564

- about manual, 566

- content, 566

- files, 566

- manual, 469

- performing manual, 470

- scheduling automatic, 567
Bar charts

- development software, 135
- displaying, 400

Batch status

- web application, 93

Batch tiles

- web application, 93
Bottles

- replacing, 461

Breadcrumb on analysis package tabs
- development software, 138
Burns, 25

Button, development software
- analysis settings, 136

- clustering settings, 133

Cc

Cables, 23

Callouts

- about, 154

- displaying for flags, 494
Cards development software
- Clustering data, 339

- Sample setup table view, 323
Circuit breakers, 36
Cleaning

- about, 472

- analyzer outside, 477

- nanowell plate stack drawer, 478
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- partitioning engine outside, 474 - specificity, 344

- solutions, 472 - Standard, 343

Clustering Clustering data card

- about, 338 - development software, 339
- adjusting, 342 Clustering data table

- adjusting Automatic, 348 - development software, 132
- adjusting Automatic - External seed data, 349 Clustering method indicator
- adjusting Automatic (individual), 348 - development software, 132
- adjusting Manual, 350 Clustering settings

- adjusting thresholds, 350 - development software, 134
- adjusting thresholds 1D scatter, 351 Clustering tabs

- adjusting thresholds 2D scatter, Lasso, 353 - development software, 131
- adjusting thresholds 2D scatter, Spider, 354 Clustering, automatic

- adjusting thresholds 2D scatter, Threshold, 352 - 1D scatter plot, 346

- adjusting, automatic methods, 347 - 2D scatter plot, 346

- adjusting, manual method, 350 - 3D scatter plot, 346

- Automatic, 343 CNV

- Automatic - External seed data, 343 - color-coding, 149

- Automatic (individual), 343 - principles, 621

- axis ranges, 347 CNV analyses

- calculating clustering data 3D scatter, 355 - about, 376

- channels, 347 - adding, 386

- competition, 344 - Analysis setup, 377

- cross-reactivity, 344 - Controls, 378

- Custom, 343 - copy number controls, 378
- development software, 338 - copy number controls valid ranges, 378
- Export seed data, 345 - development software, 376
- exporting seed data, 356 - editing, 388

- Genotyping, 343 - limits of validity, 379

- graphs, 346 - negative controls, 378

- Import seed data, 345 - negative controls valid ranges, 378
- Indel, 343 - panels, 380

- Manual, 343 - performing, 386

- method, 343 - Reference target copy numbers, 379
- parameters, 343 - reference targets, 377

- Rare event detection, 343 - result columns, 380

- sensitivity, 344 - Result overview panel, 384
- settings, 342 - Results panel, 380

- sample groups, 377
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- Sample selection, 377

- samples, 377

- settings, 377

- Statistics panel, 385

- tabs, 377

- Target limits, 379

- targets of interest, 377
CNV tests

- control names, 423

- control types, 423

- controls, 423

- controls valid ranges, 423

- in analysis packages, 420

- limits of validity, 421

- Reference target copy numbers, 422
- result names, 423

- show quantitative results, 422
- test definitions, 420

- test details, 421

- test settings, 422
Color-coding

- about, 148

- absolute quantification, 149
- CNV, 149

- controls, 148

- final results, 149

- indel, 150

- nanowell plate types, 148

Column headers on Sample setup screen

- web application, 98

Column headers sample setups

- analyzer software, 116

Columns

- configuring, 142

Columns on dashboard

- web application, 92
Compatibility, electromagnetic, 23

Competition, 344

Roche Diagnostics

Components

- analyzer inside, 76

- system, 61

Conditions, operating, 22
Configuration, computer, 28
Configuring plate view

- development software, 139
Configuring table view

- development software, 140
Connection indicator

- partitioning engine software, 84
- web application, 90
Connection settings

- about, 569

- list, 569

Connections

- AVENIO Connect, 67

- configuring, 572

- disconnecting, 574

- EDI, 67

- indicator web application, 90
- indicators, 569

- indicators in analyzer software, 109
- LIS, 67

- list of settings, 569

- settings, 569

- supported characters, 185

- systems, 67

Consumables

- unspecified, 21
Contamination, partitioning engine, 29
Controls

- about, 165

- color-coding, 148

- final results, 173

- invalidated, 31

- types, 166
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Conventions used in this publication - analysis settings, 136

- abbreviations, 12 - analysis tabs, 134

- product names, 9 - assigning sample setups, 321

Copyright, 3 - bar charts, 135

Cross-reactivity, 344 - breadcrumb on analysis package tabs, 138
- button for analysis settings, 136

D - button for clustering settings, 133

Dashboard

- changing display of scatter plots, 341

- web application, 91 - closing, 442

Data security, 32, 36 - clustering, 338

Decontamination - Clustering data card, 339

- about, 472 - clustering data table, 132

- analyzer, 478 - clustering method indicator, 132

- partitioninge engine, 478 - Clustering settings, 134

- solutions, 472 - clustering tabs, 131

Delay, 34 - CNV analyses, 376

Detection formats - configuring laboratory information, 613

- unassigned sample setups, 403 - configuring plate view, 139

Development runs - configuring table columns, 142

- aborting, 450 - configuring table view, 140

- about, 309 - creating reports, 410

- assigning sample setups, 321 - display options, 132

- editing run profiles, 304 - displaying bar charts, 400

- managing raw data files, 312 - editing Abs Quant - All analysis, 371

- prerequisites, 172 - editing lane settings, 325

- starting, 301, 305 - editing lane settings (copy and paste), 335

- target and dye settings, 311 - exporting seed data, 356

- working with raw data files, 317 - exporting to Excel, 147

Development software - filtering tables, 143

- about, 126 - hand-held barcode reader, 77

- absolute quantification analyses, 359 - indel analyses, 388

- adding lane settings, 325, 406 - Laboratory information settings, 613

- adding run settings, 406 - log files, 531

- adjusting automatic clustering, 347 - menu commands, 127

- adjusting clustering, 342 - Navigation area, 127

- adjusting manual clustering, 350 - overview, 126

- analyses, 358 - panels on analysis tabs, 134

- analysis package tabs, 137 - performing absolute quantification analyses, 373

- analysis packages, 412 - performing CNV analyses, 386
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- performing indel analyses, 398

- plate view, 138

- projects, 294

- raw data files, 309

- run tabs, 130

- runs, 309

- Sample setup table view card, 323
- sample setup tabs, 136

- scatter plots, 132

- searching tables, 143

- sorting tables, 143

- specifications, 187

- starting, 240

- tab commands, 130

- tab navigation buttons, 129

- table view, 138

- tabs, 129

- unassigned sample setups, 402
- work area, 127

- working with analyses, 358

- working with analysis packages, 429
- working with raw data files, 317
- working with sample groups, 328
- working with unassigned sample setups, 405
Development software, columns

- Clustering method, 366, 395

- CN 68%CI max., 382

- CN 68%CI min., 382

- CN 95% CI max., 381

- CN 95% CI min., 381

- Conc. 68% max., 366

- Conc. 68% min., 366

- Conc. 95% CI max., 364

- Conc. 95% CI min., 364

- Concentration, 364

- Concentration mean, 370

- Concentration SD, 370

- Copies per nanowell, 366

- Copy number, 381

Roche Diagnostics

- Copy number mean, 385

- Copy number relative confidence, 383
- Copy number SD, 385

- Dilution factor, 323, 366, 395

- Dyes, 324

- Final result, 364, 381, 393

- Flags, 324, 341, 364, 381, 393

- for combinations of target of interest and master

mix reagent, 384

- for combinations of variant target and reference

target, 396
- for target combinations, 369
- for targets, 367
- Group, 370, 397
- Initial result, 365, 382, 394
- Lane, 340, 364, 367, 369, 381, 384, 393, 396
- Lane ID, 323
- Merged lanes, 365, 381, 394
- Merged lanes name, 325
- Merging, 325
- MM, 324, 364, 370, 393, 397
- MMx (TOI), 380, 385
- MMx expiry date, 325
- MMx lot number, 325
- Negative nanowells, 366, 395
- No. of positive nanowells, 365, 394
- Notes, 324
- Plate type, 365, 394
- Pos. NWs, 340
- Quality indicator, 340
- Ratio, 382
- Ratio 68%CI max., 383
- Ratio 68%CI min., 383
- Ratio 95% CI max., 382
- Ratio 95% CI min., 382
- Raw concentration, 366
- Raw copy number, 383
- Raw ratio, 383

- Raw variant, 395
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- Reference, 393

- Relative confidence, 366

- Run, 367, 369

- Run name, 366, 382, 384, 395, 396

- Sample

ID, 323, 339, 363, 367, 369, 380, 384, 392, 396

- Sample preparation notes, 324

- Sample type, 365, 381, 394

- Target, 363, 370

- Target names, 324

- TOl, 380, 385

- Total copies, 365

- Total valid nanowells, 340, 365, 394
- Variant, 392, 397

- Variant [%], 393, 397

- Variant [%] 68% Cl max., 395

- Variant [%] 68% Cl min., 395

- Variant [%] 95% Cl max., 393

- Variant [%] 95% CI min., 393

- Variant [copies/pl], 393

- Variant [copies/nanowell], 395

- Variant [copies], 394

- Variant SD, 397

- Wild type [copies/pl], 393

- Wild type [copies/nanowell], 395
- Wild type copies, 394
Development software, panels

- Edit, 414

- for analysis packages, 412

- General settings, 414

- MMx settings, 427

- Test definition, absolute quantification, 416
- Test definition, CNV, 420

- Test definition, indel, 424
Development workflows

- absolute quantification analyses, 359
- adding lane settings, 325, 406

- adding run settings, 406

- adjusting automatic clustering, 347

Roche Diagnostics

- adjusting clustering, 342

- adjusting manual clustering, 350

- analyses, 358

- analysis packages, 412

- assigning sample setups, 321

- changing display of scatter plots, 341

- clustering, 338

- CNV analyses, 376

- creating reports, 410

- displaying bar charts, 400

- editing Abs Quant - All analysis, 371

- editing lane settings, 325

- Editing lane settings (copy and paste), 335
- editing run profiles, 303

- entering run information, 307

- exporting seed data, 356

- final results, 174

- indel analyses, 388

- loading analyzer, 225

- managing raw data files, 312

- options, 63

- overview, 63

- overview, no unassigned sample setup, 194
- overview, with unassignedsample setup, 195

- partitioning, 221

- performing absolute quantification analyses, 373

- performing CNV analyses, 386
- performing indel analyses, 398

- performing, no unassigned sample setup, 275

- performing, with unassigned sample setup, 283

- projects, 294

- quick reference, no unassigned sample setup, 200

- quick reference, with unassigned sample setup, 208

- Raw data files, 309

- run profiles, 298

- Runs, 309

- unassigned sample setups, 402
- unloading analyzer, 227

- working with analyses, 358
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- working with analysis packages, 429
- working with raw data files, 317
- working with run profiles, 299

- working with sample groups, 328
- working with unassigned sample setups, 405
Diagnostic results

- automatic release, 605

- automatic sending, 605

- controls, 605

Diagnostic results settings

- about, 604, 605

- configuring, 606

Diagnostic runs

- aborting, 450

- adding run notes, 262

- exporting raw data files, 315

- prerequisites, 172

Diagnostic workflows

- creating result reports, 268

- creating sample setup reports, 259
- creating sample setups, 255

- editing orders, 252

- editing sample setups, 258

- entering run information, 261

- final results, 174

- loading analyzer, 225

- ordering, 250

- orders, 169, 250

- overview, 63, 193

- partitioning, 221

- performing, 243

- quick reference, 196

- releasing results, 265

- results, 263

- sample setups, 255

- sending results, 267

- types, 63

- unloading analyzer, 227

Roche Diagnostics

Digital PCR

- principles, 619

Display options

- development software, 132
Disposal, 41

Drawers, moving, 27

Dyes, 165

- settings development, 311

E

Edges, rough, 26

EDI connection

- configuring, 573

- list of settings, 571

- overview, 67

Edition notice, 2

Electric shock, 25
Electromagnetic compatibility, 23
Electromagnetic fields, 24
Equipment, personal protective, 21
Errors

- nanowell plate loading, 520

- pipetting, 28

- resolving nanowell plate ID reading, 521
Event viewer

- displaying, 503

Expiry date

- master reagents, 162

- partitioning fluid, 163

Export files, unprotected, 33, 36
Export of raw data files

- configuring, 603

Exporting to Excel, 146

- analyzer software, 147

- development software, 147

F

Fields, electromagnetic, 24
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File browsers G

- analyzer software, 124 Global information area

File extensions - analyzer software, 106

- analysis packages, 429 - partitioning engine software, 83

- projects, 294 - web application, 89

- raw data files, 312

- seed data files, 345 H

Filter Hand-held barcode readers, 77
- defining custom, 145 Heatmap

- deleting custom, 146 - development software, 132
Filtering High resolution nanowell plates, 160
- custom, 145 High sensitivity nanowell plates, 160
- deleting custom, 146 Histogram

- tables, 145 - development software, 132
Final results

- about, 173 I

- color-coding, 149 Icons for analysis packages

- controls, 173 - web application, 94

- development workflows, 174 Indel

- diagnostic workflows, 174 - color-coding, 150

- qualitative, 173 - principles, 622

- quantitative, 173 Indel analyses

- samples, 173 - about, 388

Fire, 25 - adding, 398

Flags - Analysis setup, 390

- about, 489 - Controls, 391

- callouts, 494 - controls valid ranges, 391

- displaying callouts analyzer software, 494 - development software, 388

- displaying callouts development software, 495 - editing, 400

- displaying callouts web application, 494 - limits of validity, 390

- list, 489 - master mix reagents, 390

- severity, 489 - minimum percentage of variant, 390
Fluids door - negative controls, 391

- partitioning engine, 72 - panels, 392

Folder browsers - performing, 398

- analyzer software, 123 - reference targets, 390

- top level, 124 - result columns, 392

Fuses, 36 - Result overview panel, 396

- Results panel, 392
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- sample groups, 389

- Sample selection, 389

- samples, 389

- settings, 389

- Statistics panel, 397

- tabs, 389

- variant controls, 391

- variant targets, 390

- wild type controls, 391
Indel tests

- control names, 426

- control types, 426

- controls, 426

- controls valid ranges, 426
- in analysis packages, 424
- limits of validity, 425

- minimum percentage of variant, 425
- result names, 426

- show quantitative results, 425
- test definitions, 424

- test details, 425

- test settings, 425
Initializing

- partitioning engine, 505
- paused analyzer, 518
Installation, 21

Intended use, 9

IVD kits, 162

K

Keyboard
- external, 79

- virtual in analyzer software, 125

L

Labels
- about, 38
- list, 38

- location analyzer, 40

Roche Diagnostics

- location partitioning engine, 39

- safety, 38

Laboratory information

- analyzer software, 575

- configuring development software, 613
- configuring, analyzer software, 575
- development software, 613

LAN port

- analyzer, 76

- partitioning engine, 73

Lane settings

- about, 325

- adding, 326, 408

- copying, 336

- dyes, 311

- editing, 326

- editing (copy and paste), 335, 336
- pasting, 336

- raw data files, 310

- rules (copy and paste), 335

- targets, 311

- unassigned sample setups, 402
Lanes

- invalidating, 536

Language packages

- about, 607

- importing, 608

Languages

- about, 607

License information

- downloading, partitioning engine, 452
Limits of detection

- about, 362, 418

- absolute quantification analyses, 362
- absolute quantification tests, 418

- lower limits, 362, 418

Limits of quantification

- about, 362, 418

- absolute quantification analyses, 362
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- absolute quantification tests, 418
- ranges, 362, 418

Limits of validity

- about, 379, 390, 421, 425

- CNV analyses, 379

- CNV tests, 421

- indel analyses, 390

- indel tests, 425

- ranges, 379, 390, 421, 425
Linkage, 368

Linkage panel

- absolute quantification, 368
Liquid waste bottle

- about, 160

- replacing, 464

LIS

- sending results again, 538
LIS connection

- configuring, 572

- indicator web application, 90
- list of settings, 569

- overview, 67

- supported characters, 185
LIS mapping table

- about, 577

LIS orders

- about, 252

LIS test names

- about, 577

- changing, 577

Log files

- copying development software, 531
- locating development software, 531
Logon indicator

- web application, 90

Logs

- copying from partitioning engine to USB, 504

Roche Diagnostics

Maintenance

- about, 177

- automatic, 177

- cleaning, 472

- cleaning analyzer, 476

- cleaning partitioning engine, 473

- cleaning solutions, 472

- cleaning up not allocated orders, 466

- data, 466

- decontaminating aspiration needle, 479

- decontamination, 177, 472, 478
- decontamination solutions, 472
- manual, 177

- manual archiving, 467

- manual backups, 469

- overview, 177

- preventive, 177, 482

- replacing bottles, 460

- schedule, 459

- scheduling automatic archiving, 560
- scheduling automatic backups, 566
Master mix reagents

- preparation, 163

Master reagents

- about, 162

- DNA, 162

- expiry date, 162

- handling, 33

- RNA, 162

Measurements, missing, 30
Mechanical stress, 37

Menu commands

- development software, 127
Merged lanes

- about, 311, 404

- characteristics, 62

- with sample groups, 329
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Messages

- about, 509

- archiving, 510

- callouts, 510

- codes, 509

- confirming, analyzer software, 511
- displaying, analyzer software, 511
- partitioning engine, 499

- partitioning engine software, 84
- severity, 509

- status in analyzer software, 122

Mouse, 78

Naming

- placeholders, 154
Nanowell plate drawer

- cleaning, 475

- decontaminating, 475

- partitioning engine, 72
Nanowell plate ID reading errors
- multiple, 522

- resolving, 521

- unresolved, 522

Nanowell plate IDs

- incorrect, 28

Nanowell plate lanes

- invalidating, 536

- unpartitioned, 29
Nanowell plate loading errors
- about, 520

- list, 520

Nanowell plate stack drawer
- analyzer, 74

- decontaminating, 477
Nanowell plate types

- incorrect, 27

Roche Diagnostics

Nanowell plates

- about, 159

- characteristics, 159

- color-coding, 148

- delayed processing, 30

- high resolution, 160

- high sensitivity, 160

- improper handling, 28

- invalidating, 537

- loading analyzer, 225

- partitioning, 221

- status in analyzer software, 114
- types, 159

- universal, 160

- unloading analyzer, 227
NAT with external IP address
- configuring, 573

- list of settings, 571
Navigation area

- development software, 127
Navigation bar

- analyzer software, 111
Network share settings, 592
Network shares

- about, 591

- creating, 594

- deleting, 595

- editing, 594

- list of settings, 592

- settings, 591

- status, 591

- use, 592

Notes indicator

- web application, 104

0]

Onboard stability
- partitioning fluid, 163
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Orders - intializing, 505

- about, 169, 250 - LAN port, 73
- cleaning up not allocated, 466 - List of messages, 499
- creating, 252 - logs, 504
- creating manually, 251 - nanowell plate drawer, 72
- deleting, 252 - partitioning, 221
- diagnostic workflows, 169, 250 - power inlet, 73
- editing, 252 - power switch, 72
- editing not allocated, 253 - priming, 232
- importing lists, 251 - radio equipment specifications, 185
- lists, 250 - replacing bottles, 460
- web application, 250 - shutting down, 437
- space required, 185
P - starting, 231
Panels

- touch screen monitor, 71

- analyzer software, 112 - unresponsive, 506

- partitioning engine software, 85 - USB ports, 73
Panels on analysis tabs - weight, 184

- development software, 134 Partitioning engine connection

Partitioning engine - about, 596

- about, 71 - multiple instruments, 596

- assigning to analyzer, 597 Partitioning engine software

- characteristics, 71 - about, 83

- cleaning, 473 - connection indicator, 84

- cleaning nanowell plate drawer, 474 - event viewer, 503

- cleaning outside, 473 - global information area, 83

- components, 71 - messages, 84

- contamination, 29 - overview, 83

- deassigning from analyzer, 597 - panels, 85

- decontaminating aspiration needle, 479 - status indicator, 84

- decontaminating nanowell plate drawer, 475 — work area, 85

- dimensions, 184 Partitioning engine software, buttons

- displaying system information, 452 — menu, 83

- downloading license information, 452 Partitioning engine software, panels

- electric power supply, 182 - event viewer, 88

- fluids door, 72 - Information, 88

- general specifications, 182  Liquids, 87

- incorrect assignment, 31 - Plate setup, 85

- incorrect loading, 29, 34, 35
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Partitioning fluid

- about, 163

- characteristics, 163
- expiry date, 163

- onboard stability, 163
Partitioning fluid bottle
- about, 163

- replacing, 463

- RFID tags, 163

Parts, 21

- moving, 26
Password settings

- about, 599

- configuring, 601

- list, 599

Passwords

- about, 547

- about changing, 237
- changing, 237

- changing at logon (analyzer software), 238

- changing at logon (web application), 238

- list of settings, 599

- policy, 599

- weak, 32

Plate combo box

- web application, 99
Plate view

- about, 139, 150

- columns, 151

- development software, 138
- tiles, 152

Plates

- invalidating, 537

- loading analyzer, 225

- partitioning, 221

- unloading analyzer, 227
Positions

- sample setups, 153

Roche Diagnostics

Power button

- analyzer, 75

Power inlet

- analyzer, 76

- partitioning engine, 73
Power interruption, 22
Power switch

- analyzer, 75

- partitioning engine, 72
Preparation

- master mix reagents, 163
- reaction mixtures, 163
Prerequisites

- development runs, 172
- diagnostic runs, 172
-runs, 172

Preventive maintenance
- settings, 482

- System behavior, 482
Primers, 164

Principles

- absolute quantification, 621
- analyses, 621

- CNV, 621

- digital PCR, 619

- indel, 622

- tests, 621

Probes, 164

Problem reports

- about, 512

- about basic, 513

- about custom, 513

- creating custom, 515
- exporting basic, 514
Product names, 9
Projects

- about, 294

- closing, 297

- creating, 295
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- data, 294

- development software, 294
- file extension, 294

- opening, 296

- saving, 296

- working with, 295

Q

Quick references

- development workflows, no unassigned sample

setup, 200

- development workflows, with unassigned sample

setup, 208

- diagnostic workflows, 196

R

Raw data files

- about, 309, 602

- about export (development), 313

- about renaming (development), 312
- automatic export, 602

- content, 310

- deleting development, 314

- development software, 309

- export conditions, 602

- export conditions, diagnostic, 315

- export options, diagnostic, 315

- exporting and opening diagnostic, 316
- exporting and saving diagnostic, 317
- exporting development, 314

- exporting, web application, 315

- importing, 319

- lane settings, 310

- managing, analyzer software, 312

- manual export, 603

- naming, 312

- opening, 318

- renaming, 319

- renaming development, 313

- run settings, 310

Roche Diagnostics

- target and dye settings, 311

- working with, development software, 317

Reaction mixtures

- preparation, 163

Reference target copy numbers
- CNV analyses, 379

- CNV tests, 422

- ranges, 379, 422

Releasing results, 265
Replacing

- bottles, 461

- partitioning fluid bottle, 463
- waste bottle, 464

Reports

- analysis packages, 433

- creating, 410

- results, 268

- sample setup development software, 321

- sample setups, 259

- unassigned sample setups, 410
Resolving

- alarms analyzer, 527

- alarms analyzer software, 528

- nanowell plate ID reading errors, 521
- paused analyzer, 518

Restarting

- unresponsive analyzer, 519

- unresponsive partitioning engine, 506
Result overview panel

- absolute quantification, 367

- CNV, 384

- indel, 396

Result settings

- about, 602

Results

- adding notes, 263

- color-coding, 149

- controls, 173

- creating result reports, 268
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- deleting notes, 263

- development workflows, 174
- diagnostic workflows, 174

- editing notes, 263

- failed sending, 538

- final, 173

- final in web application, 103
- missing measurements, 30
- releasing, 265

- samples, 173

- sending, 267

- sending again, 538

- status in web application, 102
- viewing notes, 263

Results panel

- absolute quantification, 363
- CNV, 380

- indel, 392

Revision history, 2

RFID tags

- partitioning fluid bottle, 163
Run data

- exporting CSV development software, 320
Run information

- about development, 307

- about diagnostic, 261

- analyzer software, 307

- entering development, 307
- entering diagnostic, 261

- web application, 261

Run prerequisites

- analyzer software, 114

- development, 172

- diagnostic, 172

Run profiles

- about, 298

- analysis packages, 415

- analyzer software, 298

- default, 298

Roche Diagnostics

- deleting analyzer software, 302

- duplicating analyzer software, 301

- editing analyzer software, 304

- exporting analyzer software, 302

- exporting development software, 320
- importing analyzer software, 302

- opening analyzer software, 300

- renaming analyzer software, 300

- starting development runs, 301, 305
- status, 299

- viewing development software, 320
Run settings

- adding, 407

- dyes, 311

- raw data files, 310

- unassigned sample setups, 402

Run tabs

- development software, 130

Runs

- aborting, 450

- about development, 309

- adding lane settings, 325

- assigning sample setups, 321

- deleting development software, 321
- development software, 309

- editing lane settings, 325

- editing lane settings (copy and paste), 335
- incorrect types, 30

- prerequisites, 172

- renaming development software, 319
- viewing details development software, 320
- viewing run profiles development software, 320

- working with sample groups, 328

S

Safety information
- about safety labels, 38
- accessories, transducers, cables, 23

- aspiration needle, 27
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- assignment of partitioning engine, 31 - unsupported characters, 31

- circuit breakers, fuses, 36 - waste, 33

- computer configuration, 28 - weak passwords, 32

- consumables, 21 Sample groups

- contaminated partitioning engine, 29 - about, 328

- data security, 32, 36 - adding samples, 330

- disposal, 41 - creating, 329

- electric shock, 25 - deleting, 333

- electromagnetic compatibility, 23 - renaming, 332

- electromagnetic fields, 24 - updating, 331

- export files, 33, 36 - with merged lanes, 329

- fire, burns, 25 Sample IDs

- installation, 21 - unsupported characters, 31
- introduction, 19 Sample settings combo box
- invalidated controls, 31 - web application, 100

- labels, 38 Sample setup report

- labels analyzer, 40 - creating development software, 321
- labels partitioning engine, 39 Sample setup table view card
- leakage of samples, 30 - development software, 323
- list of safety labels, 38 Sample setup tabs

- master reagents, 33 - development software, 136
- mechanical stress, 37 Sample setups

- missing measurements, 30 - about, 255

- moving drawers, 27 - assigning, 322

- nanowell plate IDs, 28 - creating, 255

- nanowell plate types, 27 - creating reports, 259

- nanowell plates, 30 - deleting, web application, 445
- nanowell plates handling, 28 - diagnostic workflows, 255
- operating conditions, 22 - editing, 258

- partitioning engine, 34, 35 - matching, 317

- parts, 21 - partially matching, 317

- personal protective equipment, 21 - plate view, 150

- pipetting errors, 28 - positions, 153

- power interruption, 22 - web application, 255

- run types, 30 Samples

- sharps, rough edges, moving parts, 26 - final results, 173

- skin, 26 - leakage, 30

- transport, 21

- unpartitioned nanowell plate lanes, 29
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Scatter plots

- changing display, 341

- development software, 132

Screens

- web application, 94

Searching

- tables, 144

Seed data

- about, 345

- compatibility, 347

- exporting, 356

Sending results, 267

Sensitivity, 344

Settings

- preventive maintenance, 482

Sharps, 26

Skin, 26

Sorting

- tables, 144

Specifications

- analyzer, dimensions, 184

- analyzer, electric power supply, 182

- analyzer, general, 181

- analyzer, space required, 184

- analyzer, weight, 184

- development software, 187

- partitioning engine, dimensions, 184
- partitioning engine, electric power supply, 182
- partitioning engine, general, 182

- partitioning engine, radio equipment, 185
- partitioning engine, space required, 185
- partitioning engine, weight, 184

- system, consumables, 186

- system, environmental conditions, 183
- system, general, 181

- system, reagents, 186

- system, supported characters, 185

- web application, 187

Specificity, 344

Roche Diagnostics

Statistics panel

- absolute quantification, 370

- CNV, 385

- indel, 397

Status

- analyzer, 109

- batch in web application, 93

- messages in analyzer software, 122
- nanowell plates in analyzer software, 114
- results in web application, 102

- run profiles, 299

Status indicator

- partitioning engine software, 84
Stress, mechanical, 37

Supplies, loss, 35

System

- architecture, 65

- archiving, 557

- backups, 564

- changing language, 610

- components, 61

- configuring AVENIO CONNECT connection, 573
- configuring EDI connection, 573

- configuring LIS connection, 572

- configuring LIS test names, 577

- configuring NAT with external IP address, 573
- connecting, 572

- connections, 67

- consumables, 186

- data flow, 65

- data maintenance, 466

- diagnostic results settings, 604

- disconnecting, 572, 574

- displaying information, 452

- disposal, 41

- dyes, 165

- environmental conditions, 183

- export of raw data files, 602

- features, 61
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- general specifications, 181
- labels, 38
- maintenance overview, 177

- maintenance schedule, 459

- manage analysis packages, 579

- merged lanes, 62

- messages, 509

- overview, 61

- password settings, 599

- preventive maintenance, 482
- problem reports, 512

- reagents, 186

- result settings, 602

- supported characters, 185
- user management, 545

- workflows, 63

System information

- displaying, 452

- displaying, analyzer, 452

- displaying, partitioning engine, 452

T

Tab commands

- development software, 130
Tab navigation buttons

- development software, 129
Table view

- about, 139

- development software, 138
Tables

- configuring columns, 142
- defining custom filter, 145
- exporting as Excel, 146

- filtering, 143

- placing columns, 142

- searching, 143

- sorting, 143

Roche Diagnostics

Tabs

- analyzer software, 111

- development software, 129
Targets

- settings development, 311
Touch screen monitor

- analyzer, 74

- partitioning engine, 71
Trademarks, 4

Transducers, 23

Transport, 21

u

Unassigned sample setups
- about, 402

- adding, 405

- adding lane settings, 406
- adding run settings, 406
- assigning, 322

- creating reports, 410

- deleting, 406

- detection formats, 403

- development software, 402
- duplicating, 406

- lane settings, 402

- matching, 317

- partially matching, 317

- renaming, 405

- run settings, 402

- working with, 405
Universal nanowell plates, 160
USB ports

- analyzer, 75

- partitioning engine, 73
User Assistance

- analyzer software, 108

- web application, 91
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User Assistance packages - editing sample setups, 258

- about, 608 - entering run information, 261
- importing, 609 - exporting raw data files (diagnostic), 315
User management - filtering tables, 143
- about, 545 - final results, 103
- list of settings, 547 - global information area, 89
User roles, 545 - hand-held barcode reader, 77
Users - icons for analysis packages, 94
- about, 545, 546 - invalidating lanes, 535
- about passwords, 547 - invalidating plates, 535
- changing passwords, 552 - LIS connection indicator, 90
- creating, 550 - logging off, 438
- editing, 551 - logging on, 234
- list of settings, 547 - logon indicator, 90
- locking, 553 - notes indicator, 104
- retiring, 553 - ordering, 250
- roles, 545 - orders, 250
- unlocking, 553 - overview, 89
- Plate combo box, 99
w .
- releasing results, 265
Waste, 33

- results, 263

Waste bottle - results status, 102

- about, 160 - Sample settings combo box, 100

- replacing, 464 - sample setups, 255

Web application - screens, 94

- about, 89 - searching tables, 143

- assignment mode, 95 - sending results, 267

- assignment mode disabled, 96 - Sending results again, 538

- batch status, 93 - sorting tables, 143

- batch tiles, 93 - specifications, 187

- changing password at logon, 237 — User Assistance, 91

- column headers on Sample setup screen, 98 Web application, buttons

- columns on dashboard, 92 - dashboard, 90

- creating result reports, 268 Web application, screens

- creating sample setup reports, 259 - Completed batches, 104

- creating sample setups, 255 _ Edit orders. 96

- dashboard, 91 - Orders screen, 95

- deleting sample setups, 445 - Results of, 100

- editing orders, 252 - Sample setup, 97
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Work area

- analyzer software, 110

- development software, 127

- partitioning engine software, 85
Workflows

- development, 63

- diagnostic, 63

- loading analyzer, 225

- overview, 63

- overview, development, no unassigned sample
setup, 194

- overview, development, with unassigned sample
setup, 195

- overview, diagnostic, 193
- partitioning, 221

- performing development, no unassigned sample
setup, 275

- performing development, with unassigned sample
setup, 283

- performing diagnostic, 243

- quick reference, development, no unassigned
sample setup, 200

- quick reference, development, with unassigned
sample setup, 208

- quick reference, diagnostic, 196

- unloading analyzer, 227
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